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1Using PREMIER+™ 2 Font Create
Welcome to PREMIER+™ 2 Font Create. PREMIER+™ 2 Font Create helps you create 
beautiful fonts and SuperDesigns for PREMIER+™ 2 Embroidery. You can create fonts using 
most TrueType®/OpenType® computer fonts, or digitize characters and SuperDesigns over 
scanned or clipart pictures.

It is assumed that you have a good working knowledge of the stitch types available in PREMIER+™ 2 
Create, and that you are already familiar with the concepts and tools used for digitizing with PREMIER+™ 2 
Create. When features are in both modules, the information may refer to PREMIER+™ 2 Create rather than 
PREMIER+™ 2 Font Create.

Sample Files
Fonts are found in subfolders of the folder ProgramData\VSMSoftware\Premier+2 \Fonts. 
You can open copies of a few of the fonts and SuperDesigns in the PREMIER+™ 2 
Embroidery System to see how they have been digitized. There is also a MyFonts folder, 
which is intended for fonts you design yourself, or fonts created in PREMIER+™ 2 
QuickFont.

To open a copy of a system font in PREMIER+™ 2 Font Create, load it in the Create or Edit Font dialog using 
the option ’Copy and edit an existing’.

Starting PREMIER+™ 2 Font Create

Windows® 10; Windows® 8 Start Screen
1 At the bottom left of your computer screen, open the Windows® 10 or Windows® 8 Start Screen.
2 Type "Prem" and the Search Screen will appear.
3 Ensure Apps is selected.
4 Click on PREMIER+™ 2 Embroidery  to launch it.
5 Click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 Font Create . PREMIER+™ 2 

Font Create will start.

Windows® 7 Start Menu
1 Click the Start button at the bottom left of your computer screen and the Start menu appears.
2 Move the arrow pointer to All Programs and another menu will appear.
3 Move the arrow pointer to PREMIER+™ 2 Embroidery System and a menu of programs will appear.
4 Click on PREMIER+™ 2 Embroidery  to launch it.
5 Click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 Font Create . PREMIER+™ 2 

Font Create will start.

Shortcuts
An alternative to the Start screen/menu method described previously is to use a Shortcut 
to PREMIER+™ 2 Embroidery. This is created automatically during the installation process.

Windows® 10 (Start Screen); Windows® 8 
1 Click on the PREMIER+™ 2 Embroidery  tile in the Start Screen.
2 Click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 Font Create . PREMIER+™ 2 

Font Create will start.
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Windows®  10 (Desktop); Windows® 7 
1 Close or minimize any programs you have running.
2 Double-click on the Shortcut to the PREMIER+™ 2 Embroidery System folder. A list of the programs 

appears.
3 Double-click on PREMIER+™ 2 Embroidery  to launch it.
4 Click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 Font Create . PREMIER+™ 2 

Font Create will start.

Closing PREMIER+™ 2 Font Create

Exit
Ends the PREMIER+™ 2 Font Create session. You can also use the Close command on the 
Control menu.

Shortcuts
■ Mouse: Click the Close icon  on the title bar or double-click the Control menu box.
■ Keys: Alt + F4

When you close PREMIER+™ 2 Embroidery, all other PREMIER+™ 2 Embroidery System modules will close 
automatically.

About PREMIER+™ 2 Font Create
Access via the Help menu. The version number of PREMIER+™ 2 Font Create is given here. 
You will need this if you contact technical support at any time.

Shortcut
■ Keys: Alt, L, A
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Parts of the Software Window
Windows
PREMIER+™ 2 Font Create contains two windows: Design and Paint. Switch between 
windows by clicking the tabs at the top of the window, or use the shortcut keys Ctrl + Tab.

Only the Paint tab is available in PREMIER+™ 2 Font Create. The Draw tab used in PREMIER+™ 2 Create is 
not available.

Paint Window
Use the Paint window to load, scan or create a background picture for your font or 
SuperDesign. Modify a picture as desired, or draw your own picture. The Paint window 
contains a control panel to the right of the work area.

Design Window

Use the Design window to add new areas, lines and columns of stitching, as well as 
commands, to your character or SuperDesign, and to change the properties of stitching 
that you have already created.

Title BarQuick Access Ribbon Bar

Status Bar Work Area

Font Design PanelRibbon Bar Tabs

Filmstrip

Toolbar
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Font Tab

The Font Tab in the Design Panel contains functions for opening, saving, exporting, and 
editing the font or SuperDesign set, and for viewing and positioning the font grid, 
guidelines and background characters. Choose a background font and a character set, 
then select a character or SuperDesign for editing. Set the Nearest Point positions for 
fonts, and load and save thumbnail pictures for SuperDesigns. Preview the font or 
SuperDesign set at varying sizes.

Work Area
The work area is the area with a grid where characters and SuperDesigns are digitized and 
edited. Stitch objects are drawn as outlines in the appropriate colors. Use PREMIER+™ 2 
Configure to change the background grid color or the background color.

Grid and Snap
The background grid is shown as pale blue lines. Set the Grid Size in the View tab, and use 
the View Grid icon  to turn the grid on or off.

The Font Grid is shown as dots. It is used to align the points placed when designing 
characters. Use Show Font Grid  to turn the font grid on or off.

When editing points for a character or SuperDesign, use Snap to Grid  to force points to 
snap to positions at the font grid spacing.

Open or save the font or SuperDesign set
Set the recommended size
Change the font or SuperDesign properties

Use a Windows system font as a background for each character
Adjust the Font Grid & Guidelines, and place Navigation objects
Update the thumbnails when the font or set is saved
Select a Character Set

View other pages of characters within the font

Select a character to edit (digitized characters are green)

Open or save a thumbnail picture for the selected SuperDesign
Select the Nearest Point position for the current character

Adjust the size for previewing the font or SuperDesign set

Copy multiple characters, e.g. upper to lower case
Insert extra points on straight or curved lines
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Guidelines
The blue lines at the top and to the left of the grid are guidelines. There are six horizontal 
and six vertical guidelines. They provide additional visual reference points.

To position the guidelines, select Move Guidelines  and then click and drag the 
guideline to the desired position. The guidelines always snap to the dots of the font grid.

The guidelines are docked initially on the top and at the left of the grid. The suggested 
positions for the horizontal guidelines give the cap height, x height and descender depth. 
You may also wish to use a horizontal guideline to show the height of your start and end 
stitches, which is particularly useful for continuous fonts. Use the vertical guidelines to 
mark the right edge of characters that are the same width (for instance, 'b', 'd', 'p').

Baseline
The baseline is the line on which most characters will sit. It is a special red guideline which 
is placed at the base of the capital A when the font is created.

Use Move Guidelines  to change the position of the baseline.

File Formats

Font and SuperDesign Files
PREMIER+™ 2 Font Create stores and loads font and SuperDesign files with the extensions 
.efnt and .esds respectively, together with .vsmres files. These are special databases 
containing a set of digitized objects for each character or SuperDesign. The SuperDesign 
files also contain miniature thumbnails of the SuperDesigns for display on the 
SuperDesign tab of the PREMIER+™ 2 Embroidery ribbon bar. (Any background pictures 
used for digitizing are not stored in .efnt or .esds files.)

Thumbnail .png files for fonts are created automatically.

When you use a system font in PREMIER+™ 2 Font Create, make a copy of it by selecting ’Copy and edit an 
existing’ in the Create or Edit Font dialog box. The copy is placed in your MyFonts folder.

Overview of Object Types
With PREMIER+™ 2 Font Create, you create (or digitize) lettering or SuperDesigns over any 
image on your computer screen. The embroidery areas you create are called objects and 
may be divided according to the type of stitches they produce (lines, columns, fill areas or 
command).
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Lines
Stitch objects place individual stitches or lines of stitches. The stitch objects are Single 
Stitches and Running, Double, Double Zigzag, Triple Stitch lines and motif lines. Closed 
lines may enclose fill areas. 

Set Single Stitches to any length from 2mm to 12mm. Set Running Stitches to any length 
from 0.3mm to 12mm. Set double, double zigzag and triple stitch to any length from 1mm 
to 12mm. Draw a line or place points to define Freehand Running, Double, Double Zigzag 
or Triple Stitch lines. To produce straight lines, hold down the Ctrl key while placing points.

Columns
Satin stitches in columns are parallel to each other and may be placed in straight or curved 
sections, depending on whether the Ctrl key is held down. You can also place columns of 
feathered satin, Richelieu Bars and tapered motifs.

The recommended maximum length for satin stitches in a column is 10mm, otherwise the stitches may be 
loose and not lie flat. To create a column wider than this, either overlap satin columns, or use one of the 
over 250 fill patterns to create smaller alternating stitches.
Create satin borders or lines where a line of satin stitches of constant width is desired. 
Draw a line or place points to define a satin border or line. To produce straight lines, hold 
down the Ctrl key while placing points.

Fill Areas
Fill area types include Pattern Fill, Motif Fill, Shape Fill, Radial Rill, Spiral Fill, QuiltStipple Fill, 
Contour Fill, Crosshatch Fill and MultiWave Fill.

Pattern Fill areas contain small stitches placed using one of over 250 patterns, or single or 
multigradient fills. Use at least three points to define the edge of a fill area, which can be 
any shape and can also have holes defined inside it. The stitches can be at any angle and 
the density can be constant or varied as desired.

Commands
Commands include Color Changes between different color blocks of your design, Stops 
that tell the embroidery machine to stop without a color change, and Alignment Stitches 
that are used to align the embroidery when stitching out.

Running Double Triple
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Creating Fonts and SuperDesigns
This overview covers the following topics:

■ Making a New Font

■ Using the QuickFont Wizard as a Shortcut

■ Making a SuperDesign Set

Making a New Font
You do not need to digitize every character in a font (see “Character Sets” on page 17 for 
suggestions on characters to digitize). Follow these steps to make a new font.

■ Start a New Font
■ Select a Background Picture
■ Digitize the Letter A for Baseline and Continuous Fonts

or
Digitize the Letter A for Nearest Point Fonts

■ Digitize Other Characters
■ Standardize the Font (Optional)
■ Reopen a Partially Completed Font
■ Back Up the Font File

Start a New Font
1 Start PREMIER+™ 2 Font Create and the Create or Edit 

Font dialog box appears. See “Create or Edit Font” on 
page 39.
Alternatively, you can start or open a font by opening a 
New Window, or by clicking Create or Edit Font .

2 In the Font Information dialog box, enter a Name for 
the font.

3 Ensure the File type is set to Font.
4 Click ’Create a new’. This will create a new font.

Alternatively, you can open an existing font that you 
created, or open a copy of one of your fonts, or a system 
font.

5 In the New Font section, give the font a name.
6 Select the desired Joining Point method.

Baseline fonts use trims between the characters in a 
word.
Nearest Point fonts are designed to use running stitch 
connection between small characters.
Continuous fonts join lowercase letters for a script 
effect.

7 Enter the desired Minimum and Maximum size for 
characters in the font.
This will be the recommended size range used for the font in PREMIER+™ 2 Embroidery.

8 Click OK. The Create or Edit Font dialog closes, and the letter ’A’ (ASCII character 065) of the new font 
is selected in the Font page of the Design window. See “Creating and Editing Fonts” on page 37.
The letter A must be digitized first. A warning message will be displayed if you select any other character.
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9 The default thread color can be seen in the FilmStrip on the left of 
the work area. Right-click this color and select Properties.

10 Select the desired thread color for your font in the Color Selection 
dialog box.

11 Click one of the Create ribbon bar tabs and select the desired Area 
and Line type.
Click Options for the selected area or line type to set the pattern, angle, 
density etc. The options set for the letter ’A’ will be the default settings 
for all characters in the font.

12 Click Save  to save your color change.

Select a Background Picture
There is a letter ’A’ in the background on the work area. This is the letter A from the first font on your 
computer (often Arial). This background font can be changed.

13 To digitize over a background picture from a TrueType® or 
OpenType® font character, click Font Background . The 
Font Background dialog box opens. See “Font Background” 
on page 46.
If there is a warning message about the letter ’A’, click OK to 
continue.

14 Select the desired Font and Style.
You can use Horizontal and Vertical offset to adjust the 
position of your letters relative to the red baseline, and use 
Scale to adjust the size of the background pictures.

15 Click OK to close the Font Background dialog box. The A 
from your selected font now forms the background picture.
The background font and its position are stored with the font, so when you reload the font the background 
font is reloaded with the created letters.

16 You can digitize over an existing picture instead of a character in one of the fonts on your computer. 
Click the Paint tab, then in the File menu click Open Picture . Browse to the picture and click Open.

17 To digitize over a small part of an existing picture, in the Paint window select, crop and resize the 
desired area of the picture, then return to the Design window.

Use Fill Background to Hoop  to help with the positioning of the desired part of the picture on the 
baseline.

18 Once a picture is displayed, resize and position the picture so that the character you create sits on the 
baseline. The left edge of the character should be at or close to the left edge of the grid. Right-click to 
set the picture in place.
When you are sizing the first picture for the letter A (ASCII character 065), leave enough space above the 
top of the character to allow for accents above uppercase letters in the extended and super-extended 
Character Sets.

19 Use Save Picture  to ensure that the modified picture will be available in the correct position if you 
wish to edit the character later, as pictures are not saved within the font file.
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Digitize the Letter A for Baseline and Continuous Fonts
20 Click the Design tab to return to the Design window, then click the 

Font tab.
21 Click Move Guidelines . 
22 Click and drag a guideline from the top of the work area to move a 

horizontal guideline to the top of the A to set the cap height.
23 Move vertical guidelines to each side of the A to set the character 

width.
24 When you have placed your guidelines as desired, right-click or click 

Move Guidelines again to deselect, then click Save .
25 Click the Create tab.
26 Digitize the letter A (ASCII character 065) using the stitch types on 

Create page to the right of the work area.
27 Click an object to display its points and reshape the object as desired. Right-click it to show its 

properties.
28 Click the Font tab, then click Save . This saves the character you are working on, and other changes 

to the font.
If you try to select another character without saving a warning message will be displayed. The letter A 
(ASCII character 065) must be digitized first because it is used to set the size of the font in PREMIER+™ 2 
Embroidery. The size of all other characters is set relative to character 065.

Digitize the Letter A for Nearest Point Fonts
A nearest point font requires four versions of each character.

29 Digitize the A character (ASCII 065) using the stitch types on the Create page of the Design window. 
The first version of the A character (ASCII 065) must start at the bottom left and end on the bottom 
right.

30 Click Save  to save the first version of the letter A.
A warning message will be displayed if you select any other character to work on before the first version of 
the letter A (ASCII character 065) has been created.

31 In the Font page, click the second Nearest Point icon (Top Left to Top Right ). Notice that the 
background picture stays in place.

32 Digitize each character version, ensuring that the start and end point are in the correct place.
Once you have digitized at least one version of the letter A (ASCII character 065), you can select other 
characters to work with. However, it is recommended to digitize all versions of a character before selecting 
the next character to digitize.

33 Click Save  to save the changes you have made to the character.

Digitize Other Characters
34 Click on the next character to digitize (the letter B). A picture of the letter B will be placed in the 

background.
Alternatively, use Ctrl + Page Up and Ctrl + Page Down, or Ctrl + Shift + Page Up and Ctrl + Shift + Page 
Down to move between all characters, or all digitized characters. See “Selecting Characters and 
SuperDesigns for Editing” on page 43.

35 Look at the letter A in the Font tab.
36 If you digitized all of the versions, the A in the Font tab will be a solid green. If only some of the 

versions have been digitized, it will be half green, half white.
37 If required, load or paste a picture. After sizing and positioning, save the picture .
38 Digitize the character as desired, then save it. You will be warned if you select another function 

without saving.
39 If you are working on a nearest point font, work through each character version, ensuring that the 

start and end point are in the correct place. The currently selected Nearest Point icon shows the 
expected start and end points.
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40 Click Save  in the Font tab to save the changes you have made to the character.
41 Repeat as desired.

Standardize the Font (Optional)
42 Click Universal Properties  to 

standardize the use of object types within a 
font, to change the object types used 
within a font, and to select which properties 
will be editable.
Universal Properties will make the properties 
of all characters in the font the same as the 
properties for the letter ’A’.
Use Universal Properties to correct any 
properties inconsistencies when creating a 
font.

43 In Colors, select the colors to make 
consistent across the font, then click the 
Colors icon  to change the selected 
color in the Color Selection dialog box.
When you have changed a color, there will be 
an asterisk (*) by Color in the Select Object 
pane.

44 In ’Select Object’, select a line or fill type to be standardized, then click Properties to change the 
properties for that stitch type.

45 Make the desired changes in the Properties dialog box, then click OK. The edited stitch type is now 
marked with an asterisk (*), for example: Running Stitch *.
Do not use Universal Properties on a font where complex properties were used, for example if more than 
one fill pattern or motif was used, or if fill areas of the same type are stitched at different angles. If you are 
not sure how using Universal Properties will affect your font, edit a copy, not the original.

46 You can also change a stitch type for the whole font. Select the stitch type in the Select Object pane, 
then choose a new stitch type from the Convert drop-down list.

47 Click Convert to change it to the new stitch type.
If you make a mistake, use Reset to return to your original settings.

48 Make any other desired changes to the colors and stitch types, then click Next. The Universal 
Properties - Finalizing dialog box appears.

49 In ’Allow Editable’, select the line and fill types to be made editable in other PREMIER+™ 2 Embroidery 
System modules.

50 Click OK to standardize the font.
51 Click Save  in the Font tab to save the changes you have made, then click Exit  to close 

PREMIER+™ 2 Font Create.

Reopen a Partially Completed Font
52 Start PREMIER+™ 2 Font Create and the Create or Edit Font dialog box appears. 
53 In File, select Font.
54 Select ’Edit an existing’. The Category drop-down list becomes available.
55 In Category, select MyFonts, or the Category where you saved your font.
56 In the Name drop-down list, select the font that you want to continue working on.

To work on a copy of a font, select ’Copy and edit an existing’, and select the font from the drop-down list. 
Give the copy a name.
System fonts must be copied to be tested or used.

57 Click OK to select the font.
58 Click on the character you would like to edit or digitize. The background font that you selected before 

will be loaded with the font.
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If you were using individual pictures for the letters, use Open Picture  to reload the background picture 
you saved previously.

59 Click an object to display its points and reshape the object as desired. Right-click it to show its 
properties.

60 Click Save  in the Font tab to save the changes you have made to the character.
61 Continue to select and digitize characters as desired.
62 When you are ready to end your session, save the font.
63 To remove unused space in the font file, click Universal Properties , then click Next. 
64 In the Universal Properties - Finalizing dialog box, select (check) Compress font. Then click Finish.

Fonts are compressed automatically whenever they reach a certain size, however it is good practice to 
compress the font as a final step.

65 Click Exit  to close PREMIER+™ 2 Font Create.
You must close the font file when you wish to test your font in PREMIER+™ 2 Embroidery.

Back Up the Font File
An entire character set can take several days to digitize. It is recommended to make 
regular backup copies of the font file.

If you are not sure what the effects of an edit will be, edit a copy of your font, not the original.
66 Browse to the folder ProgramData\VSMSoftware\Premier+2\Fonts\MyFonts and select the fonts you 

want to back up.
67 If desired, browse to a different folder where you wish to keep backup copies of the font. For instance, 

you could create a folder in 'My Documents' called 'Font Backups' and use this for storing backup 
copies. This will also prevent the backup copies from appearing in the font list in PREMIER+™ 2 
Embroidery.

68 Paste the copies into the destination folder.
69 Change the name for the backup of your font. For instance, include the date and time in the name to 

indicate when the backup was made.

Using the QuickFont Wizard as a Shortcut
If you wish to base a new font on a TrueType® or OpenType® font, you can use the 
QuickFont Wizard in PREMIER+™ 2 Embroidery to get you started.

1 Open PREMIER+™ 2 Embroidery and use the QuickFont Wizard to generate a font based on the 
desired TrueType® or OpenType® font.

2 Start PREMIER+™ 2 Font Create and in the Create or Edit Font dialog box, select ’Edit an existing’ and 
browse to the folder in ProgramData\VSMSoftware\Premier+2\Fonts that corresponds to the 
category in which you made the font. For instance, if you created the font in the MyFonts category, 
the font will be stored in the MyFonts folder.

3 Open the font you created.
4 Click on the character you would like to edit.
5 To digitize over a background picture from a TrueType® or OpenType® font character, click Font 

Background , select the Font and Style, and make any desired adjustments to Scale and Horizontal 
and Vertical Offset, then click OK.

6 To digitize over a picture, in the Paint tab load the picture, size and position it as required, then use 
Save As Picture .

7 Edit the character as desired, then edit each subsequent character in turn.
8 Click an object to display its points and reshape the object as desired. Insert or delete objects, too. 

Right-click it to show its properties.
9 As with creating new fonts, it is recommended to make regular backup copies of the font file.
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Making a SuperDesign Set
A SuperDesign set may have a maximum of 9 SuperDesigns. Follow these steps to make a 
new SuperDesign set.

■ Start a New SuperDesign Set
■ Add a Background Picture
■ Digitize the First SuperDesign
■ Digitize Other SuperDesigns
■ Standardize the SuperDesign Set (Optional)
■ Reopen a Partially Completed SuperDesign Set
■ Back Up the SuperDesign File

Start a New SuperDesign Set
1 Start PREMIER+™ 2 Font Create and the Create or Edit 

Font dialog box appears.
2 In File, select SuperDesign Set. Notice that Open and 

the New Font options are unavailable.
SuperDesigns are placed individually in PREMIER+™ 2 
Embroidery, therefore joining point is irrelevant. All 
SuperDesign sets are saved in one folder. 

3 Enter a Name for the SuperDesign set.
4 Enter the desired Output Size Range.
5 Click OK and the work area appears ready for you to 

digitize the first SuperDesign, as shown in the title 
bar.

6 Right-click the initial color in the FilmStrip, and select 
Properties. Choose the desired thread color in the 
Color Selection dialog box.

7 In the Create tab, select the desired Area and Line 
type from the Control Panel.

8 Click Save  in the Font tab to save the changes you 
have made
Click Options for the selected area or line type to set the 
pattern, angle, density etc. The options set for the first 
SuperDesign in a set will be the default settings for all 
other SuperDesigns in the set.

Add a Background Picture
9 To digitize over an existing picture, click the Paint tab, then in the File menu click Open Picture . 

Browse to the picture and click Open.
10 To digitize over a small part of an existing picture, load the picture into the Paint window, select, crop 

and resize the desired area of the picture, then return to the Design window.
11 Once a picture is displayed, resize and position the picture as desired, then right-click to set it in place.
12 Use Save Picture  to ensure that the modified picture will be available in the correct position if you 

wish to edit the SuperDesign later, as pictures are not saved within the SuperDesign file.
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Digitize the First SuperDesign
13 Move the guidelines to the desired positions.
14 Digitize the SuperDesign using the stitch types on the Create page in 

the Design window. You will be warned to save the SuperDesign if you 
select a new function.
Unlike the fonts, you can digitize a SuperDesign set in any order. It is not 
necessary to start with the first design, although this is advisable. The first 
design is used to set the size of the SuperDesigns in PREMIER+™ 2 
Embroidery. The size of all the SuperDesigns in the set is set relative to the 
first design.

15 Click Save  in the Font tab to save the changes you have made to the 
SuperDesign.

Digitize Other SuperDesigns
16 In the Font page, choose the next SuperDesign to digitize.

Alternatively, use Ctrl + Page Up and Ctrl + Page Down, or Ctrl + Shift + Page Up and Ctrl + Shift + Page 
Down to move between all SuperDesigns, or all digitized SuperDesigns. See “Selecting Characters and 
SuperDesigns for Editing” on page 43.

17 If required, load or paste a picture and save the picture.
18 Digitize the SuperDesign as desired, then save it. You will be warned if you select another function 

without saving.
19 Repeat as desired until the maximum of 9 SuperDesigns have been digitized.
20 Click Save  in the Font tab to save the changes you have made to the SuperDesign.

Standardize the SuperDesign Set (Optional)
21 Click Universal Properties  to standardize the use of object types, or to change the object types, 

within a SuperDesign set, and select which properties will be editable.
Universal Properties will make the properties of all SuperDesigns in the set the same as the properties for 
the first design in the set.

22 In Colors, edit a color to make the colors consistent across the SuperDesign set.
23 In ’Select Object’, choose the line and fill types to be standardized.

Use Universal Properties to correct any properties inconsistencies when creating the SuperDesign set.
Do not use Universal Properties on a SuperDesign set where complex properties were used, for example if 
more than one fill pattern or motif was used, or if fill areas of the same type are stitched at different angles. 
If you are not sure how using Universal Properties will affect your SuperDesign set, edit a copy, not the 
original.

24 You can also change a stitch type for the whole SuperDesign set. Select the stitch type in the Select 
Object pane, then choose a new stitch type from the Convert drop-down list.

25 Click Convert to change it to the new stitch type.
If you make a mistake, use Reset to return to your original settings.

26 Make any other desired changes to the colors and stitch types, then click Next. The Universal 
Properties - Finalizing dialog box appears.

27 In ’Allow Editable’, select the line and fill types to be made editable in other PREMIER+™ 2 Embroidery 
System modules.

28 Click OK to standardize the SuperDesign set.

Reopen a Partially Completed SuperDesign Set
29 Start PREMIER+™ 2 Font Create and the Create or Edit Font dialog box appears. 
30 In File, select SuperDesign.
31 Select ’Edit an existing’. The Category drop-down list becomes available.
32 In Category, select MyFonts, or the Category where you saved your SuperDesign set.
33 In the Name drop-down list, select the SuperDesign set that you want to continue working on.
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To work on a copy of a SuperDesign set, select ’Copy and edit an existing’, and select the SuperDesign set 
from the drop-down list. Give the copy a name.
System SuperDesign sets must be copied to be tested or used. SuperDesign sets that you create or 
customize can only be used from the SuperDesigns folder.

34 Click OK to select the SuperDesign set.
35 In the Paint window, use Open Picture  to reload the background picture you saved previously for 

a design.
36 In the Design window, click an object to display its points and reshape the object as desired. Right-

click it to show its properties.
37 Click Save  in the Font tab to save the changes you have made to the SuperDesign.
38 Continue to select and digitize SuperDesigns as desired.
39 When you are ready to end your session, save the SuperDesign set.
40 To remove unused space in the SuperDesign file, click Universal Properties , then click Next. 
41 In the Universal Properties - Finalizing dialog box, select (check) Compress font. Then click Finish.

SuperDesign sets are compressed automatically whenever they reach a certain size, however it is good 
practice to compress the SuperDesign set as a final step.

42 Click Exit  to close PREMIER+™ 2 Font Create.
You must close the SuperDesign file if you wish to test your SuperDesign set in PREMIER+™ 2 Embroidery.

Back Up the SuperDesign File
A SuperDesign set can take some time to digitize. At the end of a long session of digitizing, 
you should make a backup copy of the SuperDesign file.

If you are not sure what the effects of an edit will be, edit a copy of your SuperDesign set, not the original.
43 Browse to the folder ProgramData\VSMSoftware\Premier+2\SuperDesigns\MySuperDesigns and 

select the SuperDesign sets you want to back up.
44 If desired, browse to a different folder where you wish to keep backup copies of the SuperDesign sets. 

For instance, you could create a folder in 'My Documents' called 'SuperDesign Backups' and use this 
for storing backup copies. This will also prevent the backup copies from appearing in the 
SuperDesign list in PREMIER+™ 2 Embroidery.

45 Paste the copies into the destination folder.
46 Change the name for the backup of your SuperDesign set. For instance, include the date and time in 

the name to indicate when the backup was made.
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2Designing Fonts

Joining Point
Baseline Fonts
This is the simplest font type. Stitches for these characters should start on the extreme left 
of the character and end on the extreme right, while also trying to keep the start and end 
points on or near the baseline. Space is added between the characters in PREMIER+™ 2 
Embroidery. Choose Trim Connection when using baseline fonts in PREMIER+™ 2 
Embroidery.

Nearest Point Fonts
Nearest point fonts use special logic in PREMIER+™ 2 Embroidery to determine the best 
way to join characters together. Space is added between the characters in PREMIER+™ 2 
Embroidery. Choose Running Stitch Connection between characters in PREMIER+™ 2 
Embroidery to avoid the need for trimming with small characters. Each character has four 
versions to give different start (on the left) and end (on the right) points as follows:

In PREMIER+™ 2 Embroidery, the correct character versions are automatically selected to 
give the shortest joining distances between each character. Here, the two Ms are 
connected in different ways (top left to bottom right and bottom left to top right):

Bottom Left to Bottom Right Top Left to Top Right

Bottom Left to Top Right Top Left to Bottom Right
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Continuous Fonts
Continuous fonts are typically used to give a flowing handwriting effect for script. When 
continuous fonts are used in PREMIER+™ 2 Embroidery, no space is added between the 
lowercase letters. (The Gap setting is not used.) All other characters are connected the 
same way as baseline fonts.

All the lowercase letters in a continuous font should start and end at the same height 
above the baseline to ensure they connect correctly in PREMIER+™ 2 Embroidery.
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Character Sets
You do not need to digitize every character in a font. For instance, if you are designing a 
Fun or Monogram font, you may prefer to digitize only the uppercase characters.

The available character sets are: Extended, Super Extended, Western 1, 2, 3 and 4, Cyrillic 1 
and 2, and Hiragana 1. These correspond to the character sets that can be chosen in the 
QuickFont Wizard of PREMIER+™ 2 Embroidery. The fonts that are provided with 
PREMIER+™ 2 Embroidery use the Extended character set.

Different character sets are available, depending on the selected file type.

The more characters in a font, the greater the amount of time needed to create that font. Nearest Point 
fonts require four versions of each character. Therefore, such a font will take longer to create.
Select the desired set from the Character Set drop-down list on the Font page. See 
“Creating and Editing Fonts” on page 37.

Font Format Character Set Default Set

PREMIER+™ 2 Embroidery 
Font

Extended
Super Extended
Cyrillic 1
Cyrillic 2
Hiragana 1

Extended

HUSQVARNA VIKING® Font Western 1
Western 2
Western 3
Cyrillic 1
Hiragana 1

Western 1

PFAFF® Font Western 4
Cyrillic 2
Hiragana 1

Western 4
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Creating a Basic Character Set
To make a basic character set that is appropriate for general text, you need letters, 
numbers and some punctuation. As a minimum, consider digitizing the following 
characters:

A B C D E F G H I J K L M
N O P Q R S T U V W X Y Z

a b c d e f g h i j k l m n
o p q r s t u v w x y z

0 1 2 3 4 5 6 7 8 9 spc ! " @
$ £ % & * ( ) - + _ \ = / ?
' ; # , . :

Their positions and ASCII codes in the Font page are as follows:

You can optionally leave out the lowercase letters to have an uppercase font. This is 
usually indicated by having UC in the font name. Monograms are complex (often multi-
color) characters that are intended for stitching at large sizes. A basic uppercase character 
set is often appropriate for monograms.

spc
032

!
033

"
034

#
035

$
036

%
037

&
038

'
039

(
040

)
041

*
042

+
043

,
044

-
045

.
046

/
047

0
048

1
049

2
050

3
051

4
052

5
053

6
054

7
055

8
056

9
057

:
058

;
059

=
061

?
063

@
064

A
065

B
066

C
067

D
068

E
069

F
070

G
071

H
072

I
073

J
074

K
075

L
076

M
077

N
078

O
079

P
080

Q
081

R
082

S
083

T
084

U
085

V
086

W
087

X
088

Y
089

Z
090

\
092

_
095

a
097

b
098

c 
099

d
100

e
101

f
102

g
103

h
104

I
105

j
106

k
107

l
108

m
109

n
110

o
111

p
112

q
113

r
114

s
115

t
116

u
117

v
118

w
119

x
120

y
121

z
122

128

£
163
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Extended Character Set
The extended character set is a good choice if the font will be used for Western languages 
other than English. The fonts that are provided with PREMIER+™ 2 Embroidery use the 
Extended character set. In addition to the basic character set, the following characters 
should be digitized to make a complete extended character set:

À Á Â Ã Ä Å Æ Ç È É Ê Ë Ì Í
Î Ï Ð Ñ Ò Ó Ô Õ Ö Ø Ù Ú Û Ü
Ý Þ ß

à á â ã ä å æ ç è é ê ë ì í
î ï ð ñ ò ó ô õ ö ø ù ú û ü
ý þ ÿ

The positions and ASCII codes of the extended character set in the Font page are as 
follows:

spc
032

!
033

"
034

#
035

$
036

%
037

&
038

'
039

(
040

)
041

*
042

+
043

,
044

-
045

.
046

/
047

0
048

1
049

2
050

3
051

4
052

5
053

6
054

7
055

8
056

9
057

:
058

;
059

=
061

?
063

@
064

A
065

B
066

C
067

D
068

E
069

F
070

G
071

H
072

I
073

J
074

K
075

L
076

M
077

N
078

O
079

P 
080

Q
081

R
082

S
083

T
084

U
085

V
086

W
087

X
088

Y
089

Z
090

\
092

_
095

a
097

b
098

c 
099

d
100

e
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f
102

g
103

h
104

i
105

j
106

k
107

l
108

m
109

n
110

o
111

p
112

q
113

r
114

s
115

t
116

u
117

v
118

w
119

x
120

y
121

z
122

128

£
163

À
192

Á
193

Â
194

Ã
195

Ä
196

Å
197

Æ
198

Ç
199

È
200

É
201

Ê
202

Ë
203

Ì
204

Í
205

Î
206

Ï
207

Ð
208

Ñ
209

Ò
210

Ó
211

Ô
212

Õ
213

Ö
214

Ø
216

Ù
217

Ú
218

Û
219

Ü
220

Ý
221

Þ
222

ß
223

à
224

á
225

â
226

ã
227

ä
228

å
229

æ
230

ç
231

è
232

é
233

ê
234

ë
235

ì
236

í
237

î
238

ï
239

ð
240

ñ
241

ò
242

ó
243

ô
244

õ
245

ö
246

ø
248

ù
249

ú
250

û
251

ü
252

ý
253

þ
254

ÿ
255
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Super-Extended Character Set
This provides all the characters in the extended character set, plus extra useful characters 
and punctuation marks. In addition to the extended character set, the following 
characters should be digitized to make a complete super-extended character set:

< > [ ] { | } ~ Š Œ Ž ‘ ’ “
” ˜ ™ š œ ž Ÿ ¡ ¢ ¥ © ®

The positions and ASCII codes of the super-extended character set in the Select Character 
dialog box are as follows:

spc
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{
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|
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}
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~
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Š
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‘
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¥
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©
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®
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ÿ
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Other Character Sets
The following character sets are also available.

Western 1
The following characters are in the Western 1 character set:

ABCDEFGHIJKLMNOPQRSTUÜVWXYZÅÄÖ- <

abcdefghijklmnopqrstuüvwxyzåäö,.

1234567890ÆæØøàáçëèéêíóùúÑñß&?!’@

Western 2
The Western 2 character set contains fewer characters. Generally, it will convert to a font 
more quickly than the other character sets. The following characters are in the Western 2 
character set:

ABCDEFGHIJKLMNOPQRSTUÜVWXYZÅÄÖ-.

abcdefghijklmnopqrstuüvwxyzåäö,.

1234567890ÆæØø?!-,.

Western 3
The following characters are in the Western 3 character set:

ABCDEFGHIJKLMNOPQRSTUÜVWXYZÅÄÆÖ-

abcdefghijklmnopqrstuüvwxyzåäæö.

1234567890ØøàáçëèéêíóùúÑñß&?!’@,.

Western 4
The following characters are in the Western 4 character set:

ABCDEFGHIJKLMNOPQRSTUVWXYZ.,-

abcdefghijklmnopqrstuvwxyz.,-

ÅÄÖÜÆOEØÉÇÑ€$§ß&?!¿¡

åàáäâãèéëêìíïîòóöôõæoeøùúüûçñ@©

1234567890.,:;-+=%\/*°ˆ?~`´'"_

Cyrillic and Hiragana fonts
Cyrillic and Hiragana (Japanese) fonts are also available.

Creating Cyrillic and Hiragana fonts requires a TrueType font with the relevant set of Unicode characters.

Cyrillic 1
The following characters are in the Cyrillic 1 character set:

Cyrillic 2
The following characters are in the Cyrillic 2 character set:
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Hiragana 1
The following characters are in the Hiragana 1 character set:
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Design Assistants
Picture
Use a picture in the background as a guide for digitizing a character. A picture should be 
positioned so that the character sits on the baseline. The left edge of the character should 
be at or close to the left edge of the grid. Enlarge the picture to increase the detail shown.

Use Font Background  to choose any of the TrueType® and OpenType® fonts installed on your computer 
as a background for creating a font. See “Font Background” on page 46.
When resizing the background picture, use guidelines to keep characters of similar height 
and width in the font in proportion.

Allow space for accents above uppercase letters in the extended and super-extended Character Sets, even 
if you are creating a basic character set initially.

Snap to Grid
Use Snap to Grid  to force points to snap to positions according to the font grid spacing. 
Snap to Grid may be used to position points perfectly so that the same design elements 
on different characters line up correctly. For instance, if you have a satin border around all 
your characters, you can ensure that the curve around the ‘O’ and ‘Q’ is identical.

Use Snap to Grid when editing point of an area.
Snap to Grid is enabled when highlighted. Click to deselect.

Grid snap can be restrictive when designing SuperDesigns or unusual characters.
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Guidelines
The blue lines at the top and to the left of the grid are guidelines. There are six horizontal 
and six vertical guidelines. They provide additional visual reference points.

Move Guidelines
Use Move Guidelines  to move the guidelines and baseline. Click Move Guidelines and 
the pointer changes to the double-arrow pointer . Click and drag the guideline to move 
it to the desired position. The guidelines always snap to the dots of the Font Grid.

Shortcut
■ Font Page: 

The guidelines are initially docked at the top and to the left of the grid. Place the 
horizontal guidelines to give positions for the cap height, x height and descender depth. 
You may also wish to use a horizontal guideline to show the height of your start and end 
stitches, which is particularly useful for continuous fonts. Use the vertical guidelines to 
mark the right edge of characters that are the same width (for instance, 'b', 'd', 'p').

The same guideline positions are used for the whole font or SuperDesign set. The same 
height and width can therefore be used for each similar character. For instance, 'a' and 'u' 
would normally be the same height and width, while 'm' and 'w' would be wider.

Baseline
Most of the characters in a font should sit on the baseline. It is a special red guideline 
which is fixed in position when the font is created. Quotation marks and other special 
characters sit above the baseline. When setting the baseline, allow enough space below it 
for descenders. For instance, the tail on the 'y' character is a descender.

Use Move Guidelines  to move the Baseline.

In PREMIER+™ 2 Embroidery, characters in a word or phrase are placed according to their 
distance from the baseline. Therefore, use of the baseline should be consistent in a font.

For fonts with a baseline joining point, start every character on the baseline, or at the same 
height above the baseline, at the extreme left. If required, use a navigation stitch to move 
to the point where the character begins.

As SuperDesigns do not use a Baseline, altering the Baseline for a SuperDesign set will have no effect.

Navigation
Use Navigation  to mark out the space needed for a Space character as a Navigation 
object.
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Shortcut
■ Font Page: 

Create a Space Character for your Font
1 In the Font panel, select the very first character in your font (the Space character).
2 Click Navigation .

The start point is automatically created at the leftmost side of the baseline.
3 Click somewhere along the baseline to place the far side of the Space character.

The Navigation object appears in the FilmStrip.
4 Right-click to deselect the Navigation tool.

You can now see the nodes for the Navigation object in the work area.
5 On the FilmStrip, ensure that the green start point for the Navigation object is on the left and the red 

end point is on the right.
6 Adjust the nodes of the Navigation object to create a Space character of the desired width.

The optimum width of the Space character will vary with the font. However, setting the space character at 
75% of the width of the capital A is a good start.
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Design Considerations
Before you start digitizing a font or SuperDesign set, you should make some decisions 
about the basic style and design. Advance planning is also helpful for the following:

■ Colors
■ Tie Offs
■ Underlay Stitches
■ Compensation
■ Overlaps and Underlay Bars
■ Traveling Stitches inside a Character or SuperDesign
■ Separating Columns
■ Mitered Corners
■ Large Lettering
■ Serifs

Colors

Consistency
It is possible for each character to have a different color. However, the same colors should 
be used throughout a font if it is intended to have a uniform appearance. For instance, 
change the first thread color in the Letter A to the desired color, and select the desired 
area and line types. These settings will be used for all other letters in the font.

Font colors can be standardized in the Universal Properties  wizard. See “Universal Properties” on 
page 48.

Tie Offs
Automatic tie offs are generated when creating stitch objects, unless Tie Off Before and 
After Trims has been deselected in Creating Stitches Preferences  in PREMIER+™ 2 
Create. To create additional tie offs, place your own with two to four single stitches.
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Underlay Stitches
Underlay, or packing, is used below pattern fills and satin areas, columns and borders to 
stabilize fabric.

Areas, columns and borders in a font or SuperDesign set can have underlay automatically 
generated. Select the required underlay type for the stitch type when creating the letter A 
for a font. This will ensure the best result if different pattern properties are chosen in 
PREMIER+™ 2 Embroidery. For instance, if the fill angle is changed, the automatic underlay 
angle will also change appropriately.

For satin areas, select Zigzag or Edge Walk underlay in Satin Area properties. Generally, if 
satin is wider than 2mm then you should use some underlay. Satin underlay can be a 
running line just inside the satin shape (edge walk or tramline), a widely spaced zigzag of 
single stitches across the satin shape, or a combination of the two.

Compensation
Compensation is a property of satin columns and fill areas that make the stitches at the 
edges of the area slightly longer to overcome the effects of pulling.

To add compensation to a satin column, click the satin column so that its points appear 
and right-click to see its properties. Enter the desired compensation value from 0 to 30 
and click OK.

To add compensation to a fill area, click the fill area so that its points appear and right-click 
to see its properties. Click the Options tab. Enter the desired compensation value from 0 to 
10 and click OK.

Edge Walk Zigzag Edge Walk plus 
Zigzag
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Overlaps and Underlay Bars

Overlaps
Use overlaps to prevent pulling from creating gaps between blocks of stitches that have 
different stitch directions. Make a satin column or fill area slightly larger so that it lies over 
or under an adjacent block.

Underlay Bars
Underlay bars provide additional stitching to prevent a split at an overlap. Underlay bars 
are useful for stitching characters or SuperDesigns at large sizes or when wide sections of 
satin or fill are overlapped. They can also help on stretchy fabrics, such as wool knits.

Underlay bars are usually digitized as a small satin column placed where overlapping satin 
columns meet. An underlay bar is stitched before either of the overlapping columns. The 
Straight Column used for an underlay bar should have a stitch angle similar to the top 
stitches on the overlap.

There are no overlaps so the end sections on the G will pull 
and leave gaps, as indicated by the arrows.

Extending the arms of the G makes an overlap
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On the left of the picture, column A is overlapping column B. If they were simply stitched 
out like this, a split is likely to appear along the line where they meet because of the pull 
caused by the stitches in column A. An underlay bar is shown on the right. Even if column 
A pulls the fabric to make a split, the split will not be seen because the stitches in the 
underlay bar will show through.

Traveling Stitches inside a Character or SuperDesign
Good digitizing minimizes the need for movement stitches within a design, and uses 
single or running stitches under areas whenever possible. This is particularly important in 
font design. You should aim to start on the left of a character and end on the right, 
stitching so that any movement between sections is covered once the character is 
completely stitched.

Also, consider where sections start and end. For instance, when you digitize a fill area, the 
start and end point are the same. Move to the point where you want to start the next 
object and digitize the fill area from there. Hide the traveling stitches by moving only 
through areas that have not yet been digitized.

For some fonts, the traveling stitches may be used as part of the design of the characters. 
For instance, if you have a decorative font with leafy details, the running stitch lines that 
go to the leaves could be curved.

Separating Columns
Satin columns that follow each other may share a common end/start point. However, this 
can make editing difficult at a later stage if you want to adjust one column without 
changing its neighbors. You may prefer to have a short loop of Running Stitch or even a 
couple of Single Stitches between adjacent columns.

No stitches between columns A short loop of running stitch separates 
the columns

The second column is moved
without changing the first
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Mitered Corners
A mitered corner using satin columns allows the stitches to flow smoothly around the 
corner, instead of simply having a block of stitches in one direction and then the next 
block of stitches in a different direction. Whether or not to use mitered corners is a style 
choice for each font. Recommended output size is also a factor, as mitered corners are 
often more desirable for large lettering.

Large Lettering

Satin
The recommended maximum length for satin stitches in a column is 10mm, otherwise the 
stitches may be loose and not lie flat. When satin is used for very large lettering, some 
columns could exceed this width. Techniques to overcome this include:

■ Overlapping satin columns
Use parallel satin columns that overlap each other to make up the full width of the desired 
column.

■ Use a satin pattern
Apply a pattern to the columns. This makes the stitch length short, preventing long 
stitches across the span of the column. If you have used more than one pattern, do not use 
Universal Properties, as the differing texture will be lost.

■ Use a fill area with Pattern 36
Fill Pattern 36 is a satin effect pattern that can be used to cover large areas. If you have 
controlled the angle of the stitching on individual areas and used other fill patterns in your 
font, do not use Universal Properties.

No miter. Two separate columns are 
placed next to each other with stitches 
at right angles (an overlap would be 
recommended).

Basic miter. Place the points with the Ctrl 
key held down so that the stitches flow 
around the corner.

Advanced miter. The stitches only start 
to change angle near the corner. Acute 
angles (less than 90°), such as those 
found on italic characters, benefit from 
advanced miters.
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Appliqué
Appliqué is an effective technique for large lettering. Use the Appliqué options in the Fill 
Area and Line options with a border line but no fill, or a lightly stitched specialty fill, and 
create your appliqué letters with the QuickCreate, Freehand Create, or Precise Create 
functions.

The letters are created to stitch out as follows:

1 A Running Stitch  line shows the outline of the SuperDesign or character.
2 At the end of the outline a Stop  command is inserted so the appliqué fabric can be placed over 

the outline.
3 Another Running Stitch  line is used to sew down the fabric that has been positioned over the 

outline.
4 Another Stop  command enables the appliqué fabric to be trimmed.
5 A Satin Line  or other border is used to stitch down the edge of the fabric.

Alternatively, use the QuickFont Wizard in PREMIER+™ 2 Embroidery to create appliqué characters from a 
TrueType® or OpenType® font. Then use PREMIER+™ 2 Font Create to make adjustments and add other 
design elements as desired.

Fill With a Border
A Pattern Fill area with a Satin Line border is an effective technique for large lettering. The 
large lettering allows a number of repeats of the chosen fill pattern to show, while the 
border adds a neat outline to each character.

Serifs
If you are digitizing a font with serifs, consider how you will digitize the serifs themselves 
so that all the characters in the font look consistent.

Outline the character with 
running stitch

Sew down the fabric with 
running stitch

Stitch down the edge of the 
fabric with Satin Line
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Fill Fonts
If you are digitizing a font as a series of fill areas, serifs can simply be included as part of the 
fill area shape. You may need to place more points around the serifs so that the shape is 
reproduced accurately. To produce straight lines, hold down the Ctrl key while placing 
points.

Satin Fonts
Techniques for digitizing the serifs in satin fonts include:

■ If the serif is very narrow (hair serif), simply use Double Stitch.
■ If the font is small, digitize the serif as part of the satin column at 

the end of the letter arm.

■ If the font is large, digitize the serifs separately so that the satin 
columns do not exceed a width of 10mm.

■ For a font of any size, you may prefer to digitize the entire end of 
the arm, including the serifs, so that the stitches are at a right 
angle to the letter arm. This works well for slab serifs.

In all cases, plan the object sequence so that your end points for each satin column are in 
the desired position. For complex serifs, use traveling stitches and overlaps to achieve the 
best result.
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Special Techniques and Effects
Drop Shadow with Two Colors
A drop shadow or three-dimensional effect uses a second copy of a character behind 
itself. The example shown here is from the Brush Block 2C UC 20-30 font included with 
PREMIER+™ 2 Embroidery.

To create a drop-shadow effect, digitize the shadow first, then the main character on top. 
The distance that the shadow is offset should be consistent for each character.

Only digitize the parts of the shadow that will show, plus enough overlap to make sure the 
shadow does not separate from its character.

Alternatively, create a drop-shadow effect using PREMIER+™ 2 Embroidery. For a large offset where the 
shadow is close to separating from the top text, it is possible to place two copies of the same text in 
PREMIER+™ 2 Embroidery, as shown here.

Techniques to emphasize the drop shadow include use of color, fill angle and running 
stitch outlines.

Color
A light color at the front and a dark color at the back will give the strongest effect.

Fill Angle
If the characters are digitized with fill areas, use the stitch angles to exaggerate the effect. 
For instance, put horizontal or vertical stitches at the front of the character, and then apply 
an angle to the stitches at the back. Do not use Universal Properties on the font, so as to 
allow control over the fill angles.

Outline with Running Stitch
After placing satin or fill areas, use running stitch to outline the shapes to enhance the 3D 
appearance. Alternatively, create the characters entirely as outlines using running, double 
or triple stitch.
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Character Samples
There are two samples shown here, which illustrate some of the principles of digitizing 
fonts.

Block Letter G
This example of a block letter G uses edge walk and zigzag underlay, overlaps and serifs.

1 This is the shape of the G, as it might appear in a background picture.
2 First, stabilize the fabric using an edge walk underlay of Running Stitch  inside the character 

shape.
Alternatively, you can place both types of underlay automatically, by selecting them in Satin Column 
Options.

3 The character is to be stitched at a large size, so add zigzag Running Stitch  inside the edge walk 
line.

4 The shape of the character is then built up. It will be stitched out so that it is not wider than 10 or 
12mm at any point, so use blocks of Continuous Satin . Notice how the columns are arranged at 
the serifs without needing movement stitches between objects. Traveling stitches are not shown.

5 In the final result, the satin columns fully cover the underlay stitches. They are shown here in different 
colors so you can see how they work together, but underlay stitches should actually be the same or a 
similar color to the stitches on top so they do not show. The satin columns would normally be denser 
than this to hide the underlay stitches completely.

Underlay Bars could also be used where the satin columns overlap at different angles. For clarity, this has 
not been shown.

Picture of the G Stabilize the fabric with 
edge walk underlay

Use zigzag running stitch 
within the underlay

Build up the G with satin blocks Satin columns cover the underlay 
stitches
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Script Letter B
This example of a letter B in a script style uses a number of satin columns. (The columns 
are shown after placing underlay. A large shape with narrow columns such as this would 
need edge walk, and perhaps some light zigzag underlay.)

1 Place a column of Continuous Satin to create the vertical stroke of the B. Finish the sequence just 
inside the top loop. Place a short sequence of single stitches to move to where the next column will 
start.

2 Place another short column of Continuous Satin for the top of the vertical stroke and then traveling 
stitches to the top of the curl.

3 Place a column of Continuous Satin, then use a Single Stitch to travel across.

4 Place a column of Continuous Satin until half way down the top loop of the B. This will cover the ends 
of the other columns. Place traveling stitches to the end of the lower loop.

5 Place a column of Continuous Satin back to the beginning of the lower loop, and place a short 
traveling stitch across the gap.

6 Place a final column of Continuous Satin and end at the point shown by the arrow.

Create the vertical stroke of 
the B

Create the top stroke and 
move to the curl

Create a column and travel

Create the top curl and 
move to the lower loop

Create the lower loop and 
travel across the gap

Finish the letter
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7 The final stitchout will be like this, with the overlapping columns 
hiding each other and the traveling stitches.
Underlay Bars could also be used where the satin columns overlap at 
different angles. For clarity, this has not been shown.
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3Creating and Editing Fonts

Create or open fonts in the Create or Edit Font dialog box. Then select and edit characters 
in the Font page of the Design window. See “Create or Edit Font” on page 39.

To use a system font or SuperDesign set in PREMIER+™ 2 Font Create, select ’Copy and edit 
an existing’ to open a copy for editing. (Only a few system fonts and SuperDesigns are 
available.)

If you attempt to open a protected (system) font or SuperDesign set, the error message "This font is a 
system font and cannot be edited. Select option to copy and edit existing and try again." will appear.
Some icons such as New, Open and Save As are not available on the Main toolbar or File menu in the 
Design  window. Use the equivalent font digitizing functions in the Font page of the Control Panel. The 
Hoop is not available as it is not required for font digitizing.
Hoops are not available in PREMIER+™ 2 Font Create. Set the minimum and maximum size 
for your characters and SuperDesigns when creating the font or SuperDesign set in the 
Create or Edit Font dialog, or change the maximum and minimum size using Size 
Options . See “Create or Edit Font” on page 39 and “Size Options” on page 51.

New Window
Use File, New Window in the Design window to open an additional PREMIER+™ 2 Font 
Create window so that you can create or open a font or SuperDesign set. The Create or Edit 
Font dialog box opens for you to create or select a font. See “Create or Edit Font” on 
page 39.

Open or save the font or SuperDesign set
Set the recommended size
Change the font or SuperDesign properties

Use a Windows system font as a background for each character
Adjust the Font Grid & Guidelines, and place Navigation objects
Update the thumbnails when the font or set is saved
Select a Character Set

View other pages of characters within the font

Select a character to edit (digitized characters are green)

Open or save a thumbnail picture for the selected SuperDesign
Select the Nearest Point position for the current character

Adjust the size for previewing the font or SuperDesign set

Copy multiple characters, e.g. upper to lower case
Insert extra points on straight or curved lines



38          PREMIER+™ 2 Font Create   Creating and Editing Fonts 

To move between open PREMIER+™ 2 Font Create windows, hover over the PREMIER+™ 2 Font Create icon 
on the taskbar, and select the desired window.

Shortcut
Keys: Alt, F, I

Create or Edit Font
Use Create or Edit Font  to create a new font or SuperDesign set, or to open an existing 
font or SuperDesign set.

You will be asked if you wish to save changes to the currently open font or SuperDesign set.

Click Create or Edit Font  and the Create or Edit Font dialog box appears. See “Create or 
Edit Font” on page 39.

Shortcut
■ Font Page: 

The Create or Edit Font dialog box also appears when PREMIER+™ 2 Font Create is opened, and when New 
Window is selected.



PREMIER+™ 2 Font Create   Creating and Editing Fonts              39

Create or Edit Font
Use the Create or Edit Font dialog to Create a new font or SuperDesign set, or to open an 
existing font or SuperDesign set.

The Create or Edit Font dialog appears when Create or Edit Font  is selected, when PREMIER+™ 2 Font 
Create is opened, or when New Window is selected.
Set the options as desired then click OK. An existing font or SuperDesign set is opened, or 
a new blank font or SuperDesign file is created and opened.

File

Font
Select this option to create or open a font, then set all the other options.

SuperDesign Set
Select this option to create or open a SuperDesign set for use in PREMIER+™ 2 Embroidery. 
Notice that Joining Point is unavailable.

SuperDesigns are placed individually in PREMIER+™ 2 Embroidery, therefore joining point is irrelevant.

Create or Edit
Choose whether to open an existing font or SuperDesign set, open a copy, or create a new 
font or SuperDesign set.

Choose from:

■ Create a new
■ Edit an existing
■ Copy and edit an existing

Use ’Copy and edit an existing’ to edit a copy of a system font (if available), or to create a copy of one of 
your own fonts for editing.

Use a font file
Use a SuperDesign set

Create a new font or set

Open a font or set
Copy and open a font or set

Select a Category and
name to open

Name the font and set
its size and type

Name the SuperDesign set
and set its recommended
size
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Open
Use Open to select an existing font or SuperDesign set. Select the Category and Name for 
the desired font or SuperDesign set.

If you try to open a system font or SuperDesign set for editing, a warning message is displayed: "This font is 
a system font and cannot be edited. Select option to copy and edit existing and try again." Choose ’Copy 
and edit an existing’, then open the font or SuperDesign set again (if available).

New Font
All new fonts are automatically created in the MyFonts category. You can move them to another category 
after creation.

Name
Enter the desired name for the font.

Joining Point
Use the joining point options to choose how the characters in your font will be joined 
together.

Baseline
This is the simplest font type. Space is added between the characters in PREMIER+™ 2 
Embroidery. Choose Trim Connection in PREMIER+™ 2 Embroidery to trim the thread 
between the characters in lettering. See “Baseline Fonts” on page 15.

Nearest Point
Nearest point fonts use special logic in PREMIER+™ 2 Embroidery to determine the best 
way to join characters together. Space is added between the characters in PREMIER+™ 2 
Embroidery. Choose Running Stitch Connection between characters in PREMIER+™ 2 
Embroidery to avoid the need for trimming with small characters. Each character has four 
versions to give different start (on the left) and end (on the right) points. See “Nearest 
Point Fonts” on page 15.

Continuous
Continuous fonts are typically used to give a flowing handwriting effect for script. When 
continuous fonts are used in PREMIER+™ 2 Embroidery, no space is added between the 
lowercase letters. (The Gap setting is not used.) All other characters are connected the 
same way as baseline fonts. See “Continuous Fonts” on page 16.

Size
Set the recommended minimum and maximum font sizes between 3mm and 200mm. The 
size range is used in PREMIER+™ 2 Embroidery.

The initial settings for fonts are minimum 12mm and maximum 25mm.

New SuperDesign
All new SuperDesign sets are automatically created in the MySuperDesigns Category. You 
can move them to another Category after creation.
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Name
Enter the desired name for the font or SuperDesign file.

Size
Set the recommended minimum and maximum SuperDesign sizes between 5mm and 
200mm. The size range is used in PREMIER+™ 2 Embroidery.

The initial settings for SuperDesigns are minimum 40mm and maximum 60mm.

Export As EDO
Use Export as EDO  to export the currently selected character or SuperDesign as a 
design outline (.edo) file with a new name. It may then be loaded into PREMIER+™ 2 Create 
or inserted into another font or SuperDesign set. The Save As dialog box appears.

Browse to the folder where you want to save the file, enter a file name and click Save. The 
file with the new name is created.

The Design Size in the exported .edo file is set to the Maximum output size that you chose when creating 
the font.

Shortcut
■ Font Page: 

Save
Use Save  to save any changes to the currently selected font or SuperDesign set.

This saves changes to the whole font or SuperDesign set. To save an individual character or SuperDesign 

use Export as EDO  or Export Embroidery . To edit a copy of the font or SuperDesign set, use Create 

or Edit Font  to copy the font or SuperDesign set and then edit it. See “Export As EDO” on page 41, 
“Export” on page 174 and “Create or Edit Font” on page 39.
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Shortcuts
■ Font Page: 
■ Keys: Ctrl + S

Exit
Close the current font or SuperDesign file and exit the current window.

Shortcuts
■ Control Icons: 
■ Keys: Alt + F4
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Editing Characters
These features relate to whole characters or SuperDesigns.

Character Set
Select the desired character set from the drop-down list. The available character sets are: 
Extended, Super Extended, Western 1, 2, 3 and 4, Cyrillic 1 and 2, Hiragana 1 and Special 
Characters.

The selected character in the chosen font and style will be used as the background picture 
for digitizing. The picture can be moved and sized as desired.

See “Character Sets” on page 17.

Character
This shows the ASCII code of the currently selected character.

Selecting Characters and SuperDesigns for Editing
Click to select a character from the Font Table, or a SuperDesign from the SuperDesign 
Table. 

Use Next Page  and Previous Page  to view other pages of characters in a font.

Table of Font Characters
See “SuperDesign Table” on page 44 for SuperDesign sets.
The table of font characters shows all the characters that can be 
created for a font for PREMIER+™ 2 Embroidery. 

The table of font characters only appears if Font was selected in Create or 
Edit Font. See “Create or Edit Font” on page 38.
Click a character to select it and work on it.

A warning message may appear telling you to save your work.
■ Characters highlighted in green have been digitized.
■ The selected character is highlighted in orange.
■ Nearest Point characters where some, but not all variations have been digitized are 

highlighted in green and white. See “Nearest Point” on page 44.

The letter A (ASCII character 065) must be digitized first, as it is used to set the relative size of all the other 
characters when they are used in PREMIER+™ 2 Embroidery.
Click Next Page  and Previous Page  to view all characters in the font.

Use the Character Set drop-down to select a different set of characters. 

Use Font Background  to choose a different font as a background for designing. See 
“Font Background” on page 46.
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SuperDesign Table
The Select SuperDesign table shows a grid of 9 squares for selecting a SuperDesign to 
digitize or edit.

SuperDesigns are numbered from 1 to 9 in the SuperDesign table and in the SuperDesign gallery in 
PREMIER+™ 2 Embroidery.
System SuperDesigns may have more than one set of nine, or a different style, but you can only edit the first 
nine. SuperDesign sets you create may have a maximum of nine SuperDesigns.
Click a SuperDesign to select it.

Undigitized SuperDesigns are blank. Digitized SuperDesigns show a thumbnail of the 
digitized shape on a green background.

To add or edit a SuperDesign, click the desired SuperDesign.

Nearest Point
The Nearest Point feature is only available if you are working on a Nearest Point font.
Nearest point fonts require four versions for each character. The Nearest Point icon shows 
which character version you are working on. Click another Nearest Point icon to select a 
different version.

The Nearest Point icons are unavailable if you are not working on a nearest point font.

Identifying Start and End Points
You can easily see the start and end points of each character by looking for the Color 
Change at the start and the red end point of the last object on the FilmStrip. This is 
especially useful when checking through a nearest point font to make sure that the start 
and end points are in the right place for each character definition.

For hints on designing Nearest Point fonts, see “Nearest Point Fonts” on page 15.

Shortcuts
■ Font Page: , , , 

Keys: Ctrl + Shift + 1;
Ctrl + Shift + 2;
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Ctrl + Shift + 3;
Ctrl + Shift + 4

Thumbnail
Thumbnails for SuperDesigns are generated automatically if ’Create / Update Thumbnails’  
is selected. You can use a different thumbnail by deselecting this option and loading your 
own picture as a thumbnail.

The thumbnail options are only available when editing SuperDesigns.

Create / Update Thumbnails
Select Create / Update Thumbnails to generate thumbnails automatically from 
SuperDesigns.

Open Picture
Use Open Picture  to open an image file to use as a thumbnail for the current 
SuperDesign.

The image must be 60x60 pixels saved as a Portable Network Graphics (PNG) file with 32 
bits per pixel using 8 bit alpha channel.

Note: Create / Update Thumbnails must be deselected to prevent the image from being automatically 
replaced when the SuperDesign set is saved.

Save Picture
Use Save Picture  to save an image file used as the thumbnail for the current 
SuperDesign.

Preview Size
Use the slider to set the font display size. Drag the slider to 
set the size from the smallest recommended size for the 
font or SuperDesign set, to the largest recommended size. 
The Size corresponds to the height of the character A, or 
first SuperDesign in a set.

Use Preview Size to preview characters or designs at the full range of recommended sizes.
When you use Export as EDO or Export Embroidery for a character or SuperDesign the height is set to the 
Preview Size.
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Font Background
Use Font Background  to choose any of the 
TrueType® and OpenType® fonts installed on 
your computer as a background for creating a 
font.

The selected character in the chosen font and 
style will be used as the background picture for 
digitizing. The picture can be moved and sized 
as desired.

Select a font, and its scale and horizontal and 
vertical offset. Click OK to select the font as a 
background.

Font
Click the drop-down arrow at the end of the Font box to choose from any of the TrueType® 
and OpenType® fonts installed on your computer. The characters are displayed in the 
selected font.

Style
Choose from Regular, Bold, Italic and Bold Italic. The characters are displayed in the 
chosen style if it is available for the chosen font.
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Scale %
Scale allows a consistent size to be used for the background picture for every character in 
the font.

Horizontal Offset
The Horizontal Offset moves the background picture of the character along the Baseline.

Vertical Offset
The Vertical Offset adjusts the vertical position of the background picture relative to the 
Baseline.

Undo and Redo
Undo and Redo for Digitizing
There are unlimited levels of undo and redo available when you are digitizing and editing 
characters and SuperDesigns. The undo and redo steps are reset when you select a 
different character or SuperDesign for digitizing.

Undo and Redo for Placing Pictures
Unlimited undo and redo are available when you are manipulating a background picture, 
until you right-click to set it in place.

Undo
Use Undo  to reverse the last action. Unlimited Undos are possible except in the Paint 
window, where there is a maximum of 10. Every time you click on Undo, the previous 
action is reversed. If you are not satisfied with the result of the Undo, click Redo.

Undo can remove a whole group of objects, for example a number of fill areas created at 
one time. To remove the last created area, click Delete Object. To remove an area that was 
not the last created, select it then click Delete Object.

The zoom commands cannot be reversed using Undo.

Shortcuts
■ Edit Toolbar: 
■ Keys: Ctrl + Z; Alt, E, U

Redo
Use Redo  to reverse the last action that was undone by Undo. If you are not satisfied 
with the result of the Redo, click Undo. 

Shortcuts
■ Edit Toolbar: 
■ Keys: Ctrl + Y; Alt, E, E
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Editing Fonts
When editing a font or SuperDesign set in PREMIER+™ 2 Font Create, you can either edit 
the original, or make a copy of it before editing.

Open a font or SuperDesign set for editing in the Create or Edit Font dialog. See “Create or 
Edit Font” on page 39.

System fonts and SuperDesign sets cannot be edited, but the Create or Edit Font dialog 
will make a copy for editing.

If you attempt to open a protected (system) font or SuperDesign set, the error message "This font is a 
system font and cannot be edited. Select option to copy and edit existing and try again." will appear.
It is assumed that you are already familiar with stitch types from using PREMIER+™ 2 
Create.

Setting Properties for all Characters in a Font
To edit a character in a font or a SuperDesign, right-click to access a dialog box to alter an 
object’s properties, such as pattern or stitch length.

To set the properties for all characters in a font, set the Options in the Create page for the 
letter ’A’ (or for the first design in a SuperDesign set), these will then be the default 
properties for all other characters in the font, or designs in the set. Use Universal 
Properties  to make existing characters in a font use the same stitch properties (e.g. 
angle) as the letter ’A’, or all SuperDesigns in a set use the same properties as the first 
SuperDesign. You can also change the stitch type used throughout a font or SuperDesign 
set with Universal Properties.

See “Universal Properties” on page 48.
This is only useful for fonts and SuperDesigns with a single setting for a particular object, e.g. pattern fills.

Show Font Grid
Use Show Font Grid  to show or hide the dotted grid for designing characters.

Shortcut
■ Font Page: 

Universal Properties
Use Universal Properties  to edit or convert object types or thread colors across the 
entire font or SuperDesign set, and to set the object properties that will be available for 
editing in other PREMIER+™ 2 Embroidery System modules.

Click Universal Properties , and the Universal Properties wizard opens at the Edit and 
Convert page. See “Universal Properties — Edit and Convert” on page 49.

Shortcut
■ Font Page: 
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Universal Properties — Edit and Convert
Use Universal Properties — Edit and Convert to standardize the use of object types within 
a font or SuperDesign set, and to define the objects that can be edited in other modules.

You cannot use Undo to reverse changes made by Universal Properties.
A single value will be used for all, taken from the value used in the letter A for a font, or the 
first SuperDesign in a set.

Do not use Universal Properties on a font or SuperDesign set where complex properties were used, for 
example if more than one fill pattern or motif was used, or if fill areas of the same type are stitched at 
different angles. If you are not sure how using Universal Properties will affect your font, change a copy, not 
the original.

Select Object
Select the object type to be edited or converted.

Edit
Edit the properties for the selected object type. Click the Properties button and the Area 
Properties dialog for that object type opens. For example, if you select Running Stitch, the 
properties for running stitch will open. See “Fill Area and Line Properties” on page 86.

Make any desired edits, then click OK to save the changes. The stitch type that you edited 
will now be marked with an asterisk, e.g. Running Stitch *.

Convert
Use Convert to change all objects of a particular stitch type in a font or SuperDesign set to 
another stitch type. For example, change a Pattern Fill to another object type, e.g. a Motif 
Fill.

Select the object type that you want to change in the Select Object pane, then choose the 
object type that you want to convert to from the drop-down list. Click the Convert button 
to make the change.

The original and destination object type are shown in the dialog, for example: 
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Pattern Fill > Motif Fill

You can Convert any fill to any other fill, or to a Satin Area. You can also Convert any column type to any 
other column type (for example, Satin Column to Feathered Satin). For Line types, you can only Convert 
between Running Stitch, Satin Line and Triple Stitch.

Colors
To change the colors of the font or SuperDesign set, select a color block and then click 
Colors  to open the Color Selection dialog. Change the color and click OK to save your 
changes.

If you change a color in Universal Properties, all of the characters in that font, or SuperDesigns in the set, 
will then use the same colors as ’A’, or the first SuperDesign. The colors in a set will remain unchanged if no 
color edits are made.

Reset
Click Reset to return to the original settings for the font or SuperDesign set.

Next
Click Next to select which object types to make editable in your font or SuperDesign set.

Universal Properties — Finalizing

Use Universal Properties — Finalizing to define the objects that can be edited in other 
PREMIER+™ 2 Embroidery System modules.

Compress Font
Select Compress Font to remove unused space in the font or SuperDesign file so it is 
smaller on the hard disk.

Fonts are compressed automatically whenever they reach a certain size during creation. Use Compress 
Font to optimize a final version.

Allow editable
Select the object types that can be edited in other modules.
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You can make all fill types, line types and column types editable. As single stitches, alignment stitches and 
Stop commands affect the embroidery structure rather than the visible design, you may decide not to 
make them editable.

Finish
Click Finish to confirm your changes to the font or SuperDesign set.

Size Options
Use Size Options  to open the Size Options dialog box.

Use the Size Options dialog box to set the recommended minimum and maximum size for 
the font or SuperDesign set. Although system SuperDesigns may have different default 
sizes, the default initial size for a SuperDesign set you create will always be the 
recommended minimum.

Hoops are not available in PREMIER+™ 2 Font Create.  Set the minimum and maximum size for your 
characters and SuperDesigns when creating the font or SuperDesign set in the Create or Edit Font dialog, 

or change the maximum and minimum size using Size Options .

Minimum Size
Set the minimum size for the letters in the font, or the designs in a SuperDesign set.

Maximum Size
Set the maximum size for the letters in the font, or the designs in a SuperDesign set.

Shortcut
■ Font Page: 

Multiple Character Copy
Use Multiple Character Copy  to duplicate a range of characters within your font. Use 
this when creating a font that is upper or lower case only, or to add characters with 
accents to the font.

Using Multiple Character Copy saves creating the lower case versions of each character in an upper case 
only font separately, so that when the lower case keys are used on the keyboard, an uppercase character 
will be placed.
Select an option from the drop-down menu:

■ Copy Upper to Lower Case
■ Copy Lower to Upper Case
■ Copy Diacritic by Character
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■ Copy Diacritic by Shape

Copy Upper to Lower Case
Copies all upper case characters to their lower case equivalents, including all diacritic 
characters (characters with accents).

Copy Lower to Upper Case
Copies all lower case characters to their upper case equivalents, including all diacritic 
characters (characters with accents).

Copy Diacritic by Character
Copy all Latin characters to their equivalent diacritic (accented) characters, and some 
similar characters based on shape alone.

For example, A is copied to À, Á, Â, Ã, Ä and Å, and lower case a is copied to à, á, â, ã, ä and å.

Copy Diacritic by Shape
Copies the diacritic characters for the upper case ’A’ to others with similar diacritic shapes, 
both lower and upper case.

For example, À is copied to È, Ì, Ò, Ù, à, è, ì, ò and ù.

Shortcut

■ Font Page: 

Insert Points on Straight Lines
Use Insert Points on Straight Lines  to add points to straight lines with few points on 
them. Round (curve) points are inserted along the selected line between widely spaced 
square (straight) points.

If there are insufficient points along the lines defining a character, kerning may be affected. Also, if a 
curved Line Type is used in the Letter tab of PREMIER+™ 2 Embroidery, letters with insufficient points may 
become distorted when reshaped.
With a character open, select the line to add points to, then click Insert Points on Straight 
Lines . Round points will be added between widely spaced square points.

Shortcut
■ Font Page: 
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Pictures for Fonts
Picture Size
The best size for a background picture for PREMIER+™ 2 Font Create is 800 pixels wide x 
1200 pixels high. A smaller picture will be relative to this size. A larger picture will be 
scaled down to fit the work area. When a picture is saved, the size is exactly 800 x 1200 
pixels so that it can be reloaded in the same position.

Scanning
To use a scanned picture, use the software provided with your scanner to save the picture. 
Alternatively, scan a picture into PREMIER+™ 2 Font Create or PREMIER+™ 2 Create, make 
adjustments, then select and save the desired part of the picture before using it in 
PREMIER+™ 2 Font Create.

Copy a Picture into PREMIER+™ 2 Font Create
1 In your chosen module, copy the picture or selected part of a picture that you wish to use as a 

background picture in PREMIER+™ 2 Font Create.
2 Return to PREMIER+™ 2 Font Create.
3 Click the Paste icon. The image in the clipboard is pasted into the top left corner of the grid.
4 Click and drag inside the picture to move it to the desired position.
5 Click and drag any of the corner resize handles on the picture to change its size. Hold down the Ctrl 

key while resizing to keep the proportions the same.
6 Right-click to deselect the picture.

The picture is now set in place. If it is in the wrong position you will need to start again.
7 Use Save Picture  to save the picture in its current position.

Save Picture
Use Save Picture  to save the background picture in its current position.

The picture under the character or SuperDesign is not stored as part of the font or 
SuperDesign file. Therefore, use Save Picture after you have moved and sized a new 
background picture. If you wish to edit the character or SuperDesign later, the modified 
picture will be available in the correct position.

By default, the picture is saved to the folder ProgramData\VSMSoftware\Premier+2 \My 
Pictures

Pictures are saved in JPEG format (with a .jpg extension), which uses compression to store 
the picture with a small file size. When a picture is saved the size is exactly 800 x 1200 so 
that it can be reloaded in the same position.

Shortcut
■ Font Page: 

Save a Background Picture for a Letter or SuperDesign
1  Open Picture or Paste to load a picture in the Paint window.
2 Size and position the picture as required.
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3 Click the Save Picture icon and a Save As dialog box is shown.

4 The Save In folder is automatically set as ProgramData\VSMSoftware\Premier+2\My Pictures. If 
desired, change the Save In folder.
You can also create folders for storing your pictures. For instance, if you are working on several fonts in 
MyFonts, you could create subfolders in the FontPics folder to keep the pictures separate for each font.

5 The name is automatically set to the previously saved picture name. If desired, change the name.
6 Click Save and the picture is saved. The picture is displayed with white space added, if needed to fit 

the work area.

Line Properties
Use the Line properties dialog box to set the properties for the chosen line type from the 
Universal Properties dialog box.

To access the Line properties dialog box, click a line type in the Universal Properties dialog 
box.
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Use the Line Properties dialog box to change the properties for a Line:

You cannot change the line type in the Line options dialog box. Use Convert to change the line type.

Fill Properties
Use the Fill properties dialog box to set the properties for the chosen fill type from the 
Universal Properties dialog box.

To access the Fill properties dialog box, click a fill type in the Universal Properties dialog 
box.

Use the Fill Properties dialog box to change the properties for a Fill.

Running Stitch Triple Stitch

Double Stitch Satin Line

Double Zigzag Motif Line

Pattern Fill Spiral Fill Curved Crosshatch Fill

Motif Fill QuiltStipple Fill MultiWave Fill

Shape Fill Contour Fill Echo Fill

Radial Fill Crosshatch Fill Satin Area
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Getting Started with PREMIER+™ 2 Font Create
■ Adjust a Font Created in PREMIER+™ 2 QuickFont
■ Changing Fonts with Universal Properties
■ Design a Font Over Letter Graphics

Adjust a Font Created in PREMIER+™ 2 QuickFont
Adjusting a font created in PREMIER+™ 2 QuickFont is a good way to get to know 
PREMIER+™ 2 Font Create.

1 Open PREMIER+™ 2 Embroidery, click the Letter tab, click Font Manager , and then click the 
QuickFont Wizard icon . The Select Font page will appear.

2 Click the drop-down arrow for Font and choose Cambria from the list of fonts. The previews will show 
the appearance of the 'ABC', ’abc’ and '123' characters in the font.
Cambria is one of the standard Windows® fonts.

3 Ensure the Style is set to Regular, and File Type is set to ’For using in the PREMIER+ 2 Embroidery 
System’, and the character set is set to Extended.

4 Click Next and the Set Stitch Options page will appear.
5 Set the Stitch Type to Pattern Fill + Satin Border . The previews now show a pattern fill with a 

border.
6 Click the Stitch Options button and the Pattern Fill dialog box will appear.
7 Ensure the Pattern is set to 3 from the Standard 1 Category, and that Density is set to 2. Click OK.
8 Click the Border Stitch Options button and the Satin Line dialog box will appear.
9 Set Width to 3.0mm and click OK.

The borders of the letters in the font 
are redrawn at the new thicness.

10 Click the Thread Color icon  and 
the Color Selection dialog box will 
appear. 

11 In the Quick Colors, set the color to a 
dark blue. Click OK.
The Pattern Fill in the font is now the 
dark blue that you selected.

12 Click Next. The font is generated, 
and the Output Options page will 
appear.

13 Use Next and Previous to preview 
the other letters in the font.

14 Leave the Font Name unchanged.
15 Click Finish to close PREMIER+™ 2 

QuickFont.
You can see this font in the MyFonts section of the Font Gallery  in PREMIER+™ 2 Embroidery. The Font 
Gallery automatically detects and previews any new fonts you add to MyFonts.

16 In PREMIER+™ 2 Embroidery, click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 
Font Create . PREMIER+™ 2 Font Create will start.

17 In the Create Or Edit Font dialog box, select Edit an existing.
The MyFonts Category is automatically selected.

18 In the Name drop-down menu, select the Cambria font that you just created.
19 Click OK to close the Create Or Edit Font dialog box, and open the font in PREMIER+™ 2 Font Create. 

The font opens at the letter ’A’.
The letter A (ASCII character 065) is digitized first because it is used to set the size of the font in PREMIER+™ 
2 Embroidery. The size of all other characters is set relative to character 065.

20 In the Font panel on the right, click the buttons to view some of the other characters, but come back 
to the letter A.
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Note that each letter has at least two objects, a separate Pattern Fill and Satin Line object.
21 In the FilmStrip, click on the Satin Line for the outer border of the A. It uses a lot of points.

When designing a font, points are needed for kerning (the spacing between the letters on a line) as well as 
for the outline itself. These points are used when placing lettering in PREMIER+™ 2 Embroidery.

22 In the Font panel on the right, click Universal 
Properties . The Universal Properties — Edit and 
Convert dialog box opens.
This dialog box is used to make changes to the objects of a 
particular type in all letters in a font. The colors and stitch 
types that you selected in PREMIER+™ 2 QuickFont can be 
seen.
For more information on Universal Properties, see “Universal 
Properties” on page 48.

23 In Select Object, click Pattern Fill to select it, then click the 
Properties button.

24 In the Pattern Fill dialog box, change the Pattern for the fill 
to the first pattern in Squares 2 (number 205), then click 
OK.
There is now an asterisk by Pattern Fill. This indicates that its properties have been edited.

25 Click Next.
26 In the Universal Properties — Finalizing dialog box, click Finish. The letter A shows the pattern that 

you selected.
27 In the Font panel on the right, click the buttons to view some of the other characters. All of them now 

use the same fill pattern as the letter A. Then click to return to the letter A.
28 In the Font panel on the right, click Universal Properties  and in the Universal Properties — Edit 

and Convert dialog box click the dark blue thread color for the fill. The Color Selection dialog box 
opens.

29 In the Quick Colors, click the orange square, then click OK.
This time Color has an asterisk by it.

30 Click Next, and then click Finish. The pattern fill for all letters is now orange.
Use Universal Properties to change the thread colors and the stitch properties for the object types for all 
letters in a font.

31 With the letter A selected, click Universal Properties .
32 In the Edit and Convert dialog box, click Pattern Fill.
33 In the Convert drop-down list, select QuiltStipple Fill. Then 

click Convert.
The Pattern Fill is now flagged as being converted to 
QuiltStipple Fill.

34 Click Properties. The QuiltStipple Fill dialog box opens.
35 Set the Gap to 3.5mm, then click OK.
36 Click Next. The Universal Properties — Finalizing dialog 

box appears.
37 In Allow Editable, Satin Line is selected (checked), but 

QuiltStipple Fill is not. Check the QuiltStipple Fill checkbox.
Allow Editable makes the stitch type available for editing in PREMIER+™ 2 Embroidery, so you can change 
settings such as density, pattern, and so on.
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38 Click Finish. All of the letters in the font now use QuiltStipple Fill.
You could have created a new font using the new settings you chose above in 
PREMIER+™ 2 QuickFont, but you cannot use a fill type other than Pattern Fill. 
With PREMIER+™ 2 Font Create you can customize a font created in 
PREMIER+™ 2 QuickFont to use other stitch and border types.

39 In the Font panel, click Save  to save the changes that you made.
40 Close PREMIER+™ 2 Font Create.
41 In the Letter tab of PREMIER+™ 2 Embroidery, scroll to the MyFonts 

section in the font gallery.
42 Select the Cambria font that you just made.
43 In the Stitch Type  drop-down list select QuiltStipple Fill. You can adjust 

the settings for this fill in QuiltStipple Fill dialog box.
44 Create some lettering with your font.
45 In PREMIER+™ 2 Embroidery, click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 

Font Create . PREMIER+™ 2 Font Create will start.
46 In the Create Or Edit Font dialog box, select Copy and edit an existing.
47 In the MyFonts category, select your Cambria font in the Name drop-down menu.
48 In the New Font section, change the name to Cambria QuiltStipple. Then click OK.

In the title bar, your new font name is now used. The name there also indicates that you are viewing letter 
number 65, the large A.

49 In the Font panel, click Save , then close PREMIER+™ 2 Font Create.
This is a quick and easy way to backup the work on your font, before you make further changes.

Changing Fonts with Universal Properties
Universal Properties is a poweful tool for customizing fonts you created in PREMIER+™ 2 
QuickFont, or drew in PREMIER+™ 2 Font Create.

1 In PREMIER+™ 2 Embroidery, click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 
Font Create . PREMIER+™ 2 Font Create will start.

2 In the Create Or Edit Font dialog box, select Copy and edit an existing.
3 In the MyFonts category, select your Cambria QuiltStipple font in the Name drop-down menu.
4 In the New Font section, change the name to Cambria Echo Motif. Then click OK. The letter A of your 

font is displayed in the work area.
5 In the Font panel, drag the Preview Size slider to the right. The border and fill change as the letter size 

is increased.
The minimum and maximum size are those set by PREMIER+™ 2 QuickFont when you created the font. 
They are the recommended size range for a PREMIER+™ 2 QuickFont fill and border font.

6 Click Size Options  to open the Size Options dialog box.
See “Size Options” on page 51.

7 Set the Minimum Size to 3mm, and the Maximum Size to 
12mm (they should currently be 80mm and 120mm). Click 
OK.

8 The Preview Size slider now shows the range 3mm to 
12mm.
You can make any size changes that you like within the 3mm 
to 200mm size range for all fonts in PREMIER+™ 2 Font 
Create. You choose whether the quality is acceptable.

9 Look at the Font panel and Quick Access toolbar. There is no Undo button on the Font panel, and the 
one on the Quick Access toolbar is unavailable (grayed out).
Many functions in PREMIER+™ 2 Font Create have no Undo. Take care, and make frequent backup copies.

10 Click Size Options  to open the Size Options dialog box and set Minimum Size back to 80mm and 
Maximum Size back to 120mm.
When you create a font, test it at various sizes and select your desired Size Options based on those tests.

11 With the letter A selected, click Universal Properties .
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12 In the Edit and Convert dialog box, click QuiltStipple Fill.
13 In the Convert drop-down list, select Echo Fill. Then click Convert.
14 Click Properties to change the settings for the Echo Fill.
15 In Echo Area select External and Internal Lines and set gap to 2.0mm. Then click OK.
16 In Colors click the orange thread color for the fill. The Color Selection dialog box opens.
17 In the Quick Colors, click the yellow square, then click OK. The changed Color has an asterisk by it.
18 Click Satin Line and in the Convert drop-down menu select Motif Line. Click Convert.
19 Click Properties and in the Motif Line dialog box set Category to Hand Stitches 1, and select pattern 6.
20 Set Width for the motif to 2.0mm.

Select a small motif when creating a border for a letter.
21 Click OK to close the Motif Line dialog box, then click Next.
22 In Finalizing, select (check) both Motif Line and Echo Fill to make them editable, then click Finish. Your 

font has been transformed.
Note that no Undo is available for Universal Properties. Your changes are permanent.

23 In the Font panel, click Save  to save the changes that you made.
24 Close PREMIER+™ 2 Font Create.
25 In the Letter tab of PREMIER+™ 2 Embroidery, scroll to 

the MyFonts section in the font gallery.
26 Select the Cambria Echo Motif font.
27 In the letters box enter the word "friends", then click 

Apply.
The external Echo Fill lines overlap, with a striking effect. The kerning for this font is based on the position 
of the points in the Motif Line, not on the echo lines outside. Some other stitch types such as Feathered 
Satin also go outside the object boundary. For example, this will affect a Satin Column font created in 
PREMIER+™ 2 QuickFont and converted to Feathered Satin.

28 In the Stitch Type  drop-down menu note that both Echo Fill and Motif Line are editable. Adjust 
their settings as desired.

29 In PREMIER+™ 2 Embroidery, click Accessories  on the QuickLink toolbar, then click PREMIER+™ 2 
Font Create . PREMIER+™ 2 Font Create will start.

30 In the Create Or Edit Font dialog box, select Copy and edit an existing.
31 Open a copy of your Cambria Echo Motif  font.
32 In the FilmStrip, right-click the Echo Fill area for the A and select Properties.
33 In the Fill Area and Line dialog box, select Satin Line in the Line drop-down list.
34 Click the Line tab, then select Insert Color Change.
35 Click Line Thread Color  to change the color of this line.
36 Change the color from the default blue to the yellow in Quick Colors, then click OK twice. There is now 

a satin line under the motif line.
37 In the Font panel, click Save , then click Universal Properties . There is now an entry for Satin 

Line in Select Object.
38 Click Next and select Satin Line to make it editable, then click Finish.
39 Select the letter B. No satin line has been added to the B.

PREMIER+™ 2 Font Create does not recognize the Satin Line as being part of the Echo Fill area, so it does 
not add the line to the other existing fills.

40 In the FilmStrip, right-click the Echo Fill area for the B and select Properties.
41 In the Fill Area and Line dialog box, select Satin Line in the Line drop-down list.
42 Click the Line tab, then select Insert Color Change.
43 Click Line Thread Color  to change the color of this line.
44 Change the color from the default blue to the yellow in Quick Colors, then click OK twice. There is now 

a satin line under the motif line for the B.
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45 Click Save , click the A, then click Universal Properties .
46 In Select Object click Satin Line, then click Properties. 
47 In the Satin Line dialog box, change Width to 1.5mm, then click OK.
48 Click Next, then click Finish. The satin line on the A is much narrower.
49 Click the B. The satin line on the B is also much narrower.

If the stitch type is already there, and its settings are the same as those for the A, 
Universal Properties will change them all to the new settings. This is useful when 
customizing a font from PREMIER+™ 2 QuickFont, but more so when you design 
the letters individually in PREMIER+™ 2 Font Create.

50 Try adding a Satin Line to some of the other letters, and then changing them 
with Universal Properties. When you have finished, close PREMIER+™ 2 Font 
Create.
Try creating other fonts in PREMIER+™ 2 QuickFont, then converting them in PREMIER+™ 2 Font Create. It 
is easiest to obtain good results with bold fonts in Pattern Fill + Satin Border. Narrow fonts work better in 
Satin, but are challenging to convert to other column types. 
Look carefully at how PREMIER+™ 2 QuickFont constructs the letters. This affects how they will convert to 
other stitch types, and how much you can change the settings. This knowledge will be useful when you 
come to draw your own font in PREMIER+™ 2 Font Create.

51 Open the Letter tab of PREMIER+™ 2 Embroidery. You now probably have at least one font that you 
do not wish to keep. You can delete unwanted fonts in Font Manager . 

52 Alternatively, delete or copy font files in Windows® File Explorer.
53 Browse to the folder ProgramData\VSMSoftware\Premier+2\Fonts\MyFonts.

There are three files for each font. The .efnt and .vsmres files describe the font, and the .png file is used to 
display the font in the Font Gallery.

54 Select all three files for any font you want to delete, and delete them. When you next open 
PREMIER+™ 2 Embroidery, the font will no longer be present in the Font Gallery.
To backup a font, copy these three files to your backup folder.

Design a Font Over Letter Graphics
Use any TrueType® or OpenType® font on your computer to design a font that you could 
not make in PREMIER+™ 2 QuickFont.

1 In PREMIER+™ 2 Embroidery, click Accessories  on the 
QuickLink toolbar, then click PREMIER+™ 2 Font 
Create . PREMIER+™ 2 Font Create will start.

2 In the Create Or Edit Font dialog box, select Create a new.
The font will automatically be placed in the MyFonts 
Category.

3 In the New Font section, change the name to Triple Stitch 
Calibri. 

4 For Joining Point, ensure that Baseline is selected 
(checked).
This will create a font using separate letters rather than a 
handwriting style (Continuous) or running stitch connected 
(Nearest Point) font. See “Joining Point” on page 15.

5 Set Minimum Size to 7mm and Maximum Size to 15mm.
You can change this size later using Size Options .

6 Click OK. A letter A for your new font is displayed in the 
work area, but it is not from the font Calibri.
When PREMIER+™ 2 Font Create is opened, the letters of the 
first font on your computer (often Arial) are automatically 
displayed.

7 Click Font Background .
Use Font Background to choose any of the TrueType® and OpenType® fonts installed on your computer as a 
background for creating a font. See “Font Background” on page 46.
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8 A message is displayed, "The letter ’A’ must be created. Do you 
want to continue?" Click OK to select a different background 
font.
The Font Background dialog box appears, with the first font on 
your computer selected. See “Font Background” on page 46.

9 In the Font drop-down menu, select the font Calibri.
You will see many other fonts in the list, depending on what 
programs are installed on your computer. For instance, several 
decorative fonts are installed with Microsoft® Word.
Calibri is a plain unembellished font that will work well at small 
sizes using a single line of stitching. Use it for a quilt label or other 
small project.

10 Ensure that Style is set to Regular, that Scale is set to 100%, and that both Offset options are set to 0.
These last options affect the size of the letters, and their position relative to the baseline.

11 Click OK to select the font Calibri. The shape and size of the letter A changes in the work area.
The letter A is positioned on the orange baseline, with its left edge touching the left side of the grid. See 
“Design Assistants” on page 23 for more information on the baseline, and the guidelines used when 
creating a font from pictures of characters loaded in the Paint window.

12 Click the Precise Create tab.
13 Deselect Fill, and in the Line drop-down menu select Triple Stitch .

In PREMIER+™ 2 QuickFont you can create fill, outline, and satin column fonts. You cannot create single 
line fonts. A Triple Stitch line creates a bold effect at a small size.

14 Click Create Area or Line  to select it.
15 Hold down the Ctrl key, and place two square points for the crossbar in the middle of the A.
16 With the Ctrl key still held, adjust the two points that you placed so that the line is straight.

Use the grid points as a guide when placing the square points. If desired, use Snap to Grid  to force 
points to snap to the font grid spacing. See “Snap to Grid” on page 23.

17 Right-click to complete the line. The line appears at the top of the FilmStrip, below the default thread 
color.
For a smooth effect, follow the center of the lines making up the A character when placing points.

18 Hold down the Ctrl key, and place three points for the sloping sides of the A. Right-click to complete 
the line.
Plan the order of the lines used to create a character, so that the line ends are hidden under other lines.

19 In the Font panel, click Save . The  font is saved.
20 In the Font panel, select the letter B. The letter A is now now green.

Letters that have been digitized are marked in green. See “Table of Font Characters” on page 43.
21 Ensure that Create Area or Line  is still selected, and click at the top right of the lower part of the B.
22 Holding down the Ctrl key to place square points at either end of the long stroke for the B, and for the 

other straight sections, place points for the outline of the B.
23 Right-click to finish, then click Save  in the Font panel.
24 Select the letter C and place points for the C. Right-click to finish, then click Save  in the Font panel.
25 Select the letter D, and place points to create the letter. Place square points for either end of the 

downstroke, and for the other straight sections.
26 Right-click to finish, then click Save  in the Font panel.
27 In the Letter tab of PREMIER+™ 2 Embroidery, scroll to the MyFonts section in the font gallery.
28 Select the font Triple Stitch Calibri.
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29 Enter the text ABCD and DDBAC. It is likely that these letters are 
too close together.
If you used the minimum of points to create the letters, the outlines 
may be very smooth, but will not have enough points for successful 
kerning.

30 Return to PREMIER+™ 2 Font Create.
You may get a Font error message. This happens if you try to edit a 
font in PREMIER+™ 2 Font Create that is already open in PREMIER+™ 
2 Embroidery. Create lettering in a different font in PREMIER+™ 2 
Embroidery  to unlock your font and try again, or close both 
programs and then reopen. 

31 In PREMIER+™ 2 Font Create, click the View tab.
32 Adjust the Background slider so that you can see the embroidery lines better against the background 

letter, and click 2D View  to see the stitch line more clearly.
33 Return to the Precise Create tab.
34 Select the sloping lines for the outside of the A.
35 Click Insert Points on Straight Lines . Extra points are added to the sloping lines on the A.
36 Select the horizontal line across the middle of the A, then click Insert Points on Straight Lines . 

Extra points are added to this line.
While the horizontal line in the A is not involved in kerning, it is used by the lettering envelopes in 
PREMIER+™ 2 Embroidery. Ensure that there are no large gaps between points when creating letters.

37 Click Save  in the Font panel, then select the letter B.
38 Select the line for the letter B.
39 If the downstroke is not completely vertical, hold the Ctrl key and adjust the square points to make 

the line vertical.
An angle on a stitch line is more visible in 2D View.

40 Adjust any other lines that should be vertical or horizontal.
Use Zoom to Rectangle  and Zoom to Fit  to view the lines more clearly, and use Insert Points  to 
add an extra round point near a square point to create the desired curve.

41 Click Insert Points on Straight Lines . Extra points are added to the straight lines on the B.
42 Click Save  in the Font panel, then select the letter D.
43 Adjust the straight line on the D as you did for the B, then use Insert Points on Straight Lines  to 

add points to that line.
44 Click Save  in the Font panel, and return to PREMIER+™ 2 Embroidery. 
45 In the Letter tab recreate the text you created above.

The spacing around the straight lines has improved, but where the lines curve the letters are still too close 
together.

46 Return to PREMIER+™ 2 Font Create.
If you get a Font error message, create some lettering in a different font in PREMIER+™ 2 Embroidery to 
unlock your font, or close both programs and then reopen.

47 Use Insert Points  in the Home tab to add points to the curved lines for the B, then adjust the 
curves so they are smooth.
In particular, ensure that the outermost part of a curve has a point on it. If there is no point, the Letter tab in  
PREMIER+™ 2 Embroidery cannot detect that part of the curve.
Note that the stitch line does not always follow the points in the curve. This is because at small font 
sizes the curve points are closer together than the stitch points.

48 In the Font Panel, drag the Preview Size slider to view the letter B as it will be seen at the larger sizes. 
The larger the size, the more closely the stitch line follows the design line.
The default stitch length is 2mm. If this is changed to a smaller size, there may be machine problems when 
stitching out. This gives a bottom limit to the size for the letters in a font.

49 Adjust the points on the curves on the letter B for viewing at all sizes.
50 Click Save  in the Font panel when you have finished adjusting the letter B.
51 Select the letter C and add points to the curve, ensuring that there is a point at the leftmost part of 

the C.



PREMIER+™ 2 Font Create   Creating and Editing Fonts              63

52 Adjust the points so that the stitch line follows the design line, and that the C looks good at all sizes in 
the range. Then click Save  in the Font panel.

53 Adjust the straight and curved lines in the letter D so that it looks good at all sizes, then Save  it.
If needed, delete points as well as adding them, but ensure that you have enough points for good kerning.

54 Select the letter E, and in the 
Precise Create tab select Triple 
Stitch  only, and create first 
the central horizontal bar with 
two square points, and then the 
top, vertical and bottom line 
with four square points.

55 Adjust the lines so that they are 
vertical or horizontal, and then 
select the outer line and use 
Insert Points on Straight 
Lines  to add points for 
kerning.

56 Save  the letter E.
57 Create the letters F and G.
58 When creating the G, place 

sufficient points on the curved 
parts for good kerning as you 
design the letter, then use Insert 
Points on Straight Lines  to 
add points between the straight 
parts of the line after 
adjustment.

59 Click Save  in the Font panel, and return to PREMIER+™ 2 Embroidery. 
60 Test letters A to G in the Letter tab of PREMIER+™ 2 Embroidery.

The letters may be close, but they do not overlap. Adding points has 
improved the kerning.

61 Look at the Stitch Type  drop-down menu in the ribbon bar. Stitch 
Type is grayed out (unavailable).
This is because Triple Stitch is not editable in this font.

62 Return to PREMIER+™ 2 Font Create.
If you get a Font error message, create some 
lettering in a different font in PREMIER+™ 2 
Embroidery to unlock your font, or close both 
programs and then reopen. 

63 Select the letter A, then click Universal 
Properties . The default color blue and Triple 
Stitch are the only Object types available. You 
have used these object types for all of the letters 
in the font.
If desired, you could now change the color of all of 
the letters in this font, or Convert to another line 
type.

64 Click Next. The Universal Properties — Finalizing 
dialog box appears.
For more information on using Finalizing, see 
“Universal Properties — Finalizing” on page 50.
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65 Select (check) Triple Stitch to make it editable.
In the Digitized Characters box, only the letters that 
you have created so far are shown.

66 Click Finish to close Universal Properties.
67 Go to the Letter tab in PREMIER+™ 2 Embroidery.
68 Look at the Stitch Type  drop-down menu. 

Triple Stitch is now available. You can now edit 
the stitch properties for this font.

69 Return to PREMIER+™ 2 Font Create and create 
the other letters for this font, or alternatively 
choose a different font on your computer and 
create letters using your own choice of color, 
stitch type and size.
When creating a font, use Navigation  to mark 
out the space needed for a Navigation object (a 
Space character). See “Navigation” on page 24.
Use Multiple Character Copy  to duplicate a range of characters in a font, for example if lower and 
upper case are identical, or to created accented versions of characters. See “Multiple Character Copy” on 
page 51.
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4Glossary & Troubleshooting

Glossary
Ascender
An ascender is the part of a lowercase letter that is the upper stroke, generally 
above the x height. For instance, 'h' and 'b' have ascenders. The height of 
ascenders may be different from the cap height, so it may require a guideline to 
mark the height.

ASCII
ASCII, also referred to as 'ASCII code', is a standard set of numerical values that 
correspond to letters, numbers and punctuation marks in a Western European 
alphabet. For instance, the letter 'A' has the ASCII number 065.

PREMIER+™ 2 Font Create uses ASCII numbers to decide which character to work 
with. Not all fonts have 'standard' characters in them. For instance, symbol fonts 
have simple pictures in place of letters. ASCII allows the same symbol to be 
consistently referenced, just as with characters for writing.

ASCII is an acronym of 'American Standard Code for Information Interchange'.

Baseline
The baseline is the line on which all the characters sit so that they line up 
horizontally. Do not place the baseline at the bottom of the area where 
characters are digitized as you must allow for descenders on characters such as 
'g', 'p', 'y', etc. Not all characters actually sit on the baseline. Quotation marks and 
other special characters sit above the baseline.

Cap Height
The height of the capital (uppercase) letters in a font. It is usual to position a 
guideline at the cap height so that all the uppercase letters can match the cap 
height correctly.

Character
Character is a general term for any letter, number, punctuation mark or any other 
symbol that appears in a font.

Database
Fonts and SuperDesign sets are stored as a database. This database contains a 
design outline file for each character or shape that has been digitized. However, 
the database only stores design information, so no pictures are stored as they 
would be in an .edo file saved from PREMIER+™ 2 Create.
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Descender
A descender is a part of a letter or other character that extends below the 
baseline. For instance, the tail on a 'y' is a descender. Even the small tail on a 
comma is a descender. Another example of a descender is the part of the cedilla 
(Ç and ç) that is below the baseline.

Font
A font is a collection of character shapes. All current versions Microsoft® Windows 
use TrueType® and/or OpenType® fonts, which have a fixed order in which the 
character shapes appear in the font. This is so that when you press 'h' on the 
keyboard, the letter h appears on the screen.

Fonts can contain any shape, so they can represent any alphabet. Also, Symbol 
fonts can contain collections of useful shapes, such as bullet points.

Gap
In PREMIER+™ 2 Embroidery there is a Gap control that is used to change the 
spacing between all the letters in some text. In typographic terms, this is known 
as Tracking.

Kerning
Kerning is the adjustment of spacing between certain pairs of letters to improve 
the appearance of the text. For instance, when some of the lowercase letters are 
placed after 'T', the appearance is improved if the lowercase letter is tucked in 
under the arm of the 'T'.

In the example, gap 'a' has no kerning, whereas gap 'b' has been kerned to give a 
more natural and appealing appearance to the text.

Ligature
A ligature is a combined character, such as the æ character used in 
'encyclopædia'. Some typographic systems automatically make ligatures from 
other characters, but this is not widely supported on Windows® at present. If you 
wish to have ligatures in your font, you must digitize them as specific characters 
in your font.

Markout
Markout is an outline for part or all of a design, usually using thread of a dark or 
contrasting color. It may be created using running, double or triple stitch 
depending on the effect desired and the sequence of the embroidery.
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SuperDesign
A design element that can be selected and used on the SuperDesign tab in 
PREMIER+™ 2 Embroidery.

OpenType
OpenType® is an extension of TrueType® which also incorporates Type 1 font 
support. PREMIER+™ 2 Font Create uses OpenType® fonts for character selection 
and background pictures.

Overshoot
An overshoot is the part of a rounded or pointed character (for instance, o, O, A) 
which extends slightly above the normal height for the character (x height for 
lowercase, cap height for uppercase) and/or slightly below the baseline. The 
overshoot compensates for the optical illusion of a square shape looking slightly 
bigger than a rounded or pointed shape of the same height.

Packing Stitches
See Underlay Stitches.

Sans Serif
A font that does not have serifs is said to be 'sans serif', which is French for 
'without serif'. An example of a sans serif font is Arial.

Serif
Serifs are the small extra strokes at the ends of the main strokes that form letters. 
The three main types of serif are hair (very thin), slab (rectangular blocks) and 
wedge (triangular).

An example of a serif font is Times New Roman, which uses both hair and wedge 
serifs.

Tracking
Tracking is the technical typographic term used to describe the spacing between 
all the characters in a piece of text. Typographic specialists describe tracking as 
'tight' or 'loose', where tight tracking brings letters closer together and loose 
tracking spreads them out.

The Gap setting on the Letters tab of the PREMIER+™ 2 Embroidery Control panel 
is used to adjust tracking.
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TrueType
TrueType® is a digital font technology used by Microsoft in Windows® operating 
systems. TrueType® fonts contain an outline description of each character in the 
font, which can be scaled to any degree without losing the shape detail. 
PREMIER+™ 2 Font Create uses TrueType® fonts for character selection and 
background pictures.

Underlay Stitches
Underlay, or packing, is used below fill and satin areas to stabilize fabric. For 
pattern fill areas, satin areas and satin columns you can automatically create 
underlay using the desired Underlay setting in the properties dialog box for that 
stitch type.

Satin underlay can be a running line just inside the satin shape (edge walk or 
tramline), a widely spaced zigzag of single stitches across the satin shape, or a 
combination of the two.

x Height
The x height is the height in a font of the lowercase 'x'. During the design phase of 
a font, a guideline would be positioned to show the x height, so that all the 
lowercase letters match the x height correctly.
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Troubleshooting: Error Messages
Managing Font and SuperDesign Files

"This name already exists; do yo wish to overwrite it?"
This message will appear if you try to make a new font or SuperDesign set and the name 
you wish to use is already in use. If you click Yes, the existing font or SuperDesign set will 
be replaced by an empty file.

"Cannot create Font file."
This message may appear for the following reasons:

■ The category folder where you are trying to create the font or SuperDesign set does not 
exist. For instance, the folder has been moved or deleted.

■ You do not have access rights on the computer to create a new font or SuperDesign set in 
the relevant folder. This may happen if, for instance, the computer administrator installed 
the PREMIER+™ 2 Embroidery System, but you are logged in as a user that does not have 
full administrative rights.

"This font is a system font and cannot be edited. Select option to copy and 
edit existing and try again."
This message will appear if you try to open a system font or SuperDesign file. To open a 
font or SuperDesign file, it must first be copied. It will also appear if you try to open a font 
that is open and locked in PREMIER+™ 2 Embroidery. Preview text in a different font in 
PREMIER+™ 2 Embroidery to unlock the font, or close both programs, then reopen.

This message may also appear if you try to open a file that has been deleted or renamed. 

"Error. Font File is wrong version."
This message may appear if you try to open a font or SuperDesign file that has become 
corrupted, or if you attempt to open a file with the correct file extension that is not a 
proper font or SuperDesign file. A file may become corrupt if your computer shuts down 
while you have the font or SuperDesign set open in PREMIER+™ 2 Font Create.

"Error. Cannot open Font file."
This message appears if you try to edit a font in PREMIER+™ 2 Font Create that is open and 
locked in PREMIER+™ 2 Embroidery. Preview text in a different font in PREMIER+™ 2 
Embroidery to unlock the font, or close both programs, then reopen.

Digitizing Characters and SuperDesigns

"The letter ’A’ must be created. Do you want to continue?"
This message will appear if you try to select any character other than A (ASCII number 65) 
for digitizing when A has not yet been digitized.

It will also appear if you use Font Background to change the background font before 
creating the letter A in your new font.
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Troubleshooting: Other Topics
Using Pictures

"Why do I need to save an imported picture?"
When a new picture is loaded, you will probably need to move and resize it. You should 
save the picture so that you can then reload the picture without having to remember the 
exact changes you made.

"Why does my picture keep disappearing?"
The picture under the current character or SuperDesign is not stored as part of the font or 
SuperDesign file. It is removed when you do one of the following:

■ Select a new character or SuperDesign to work with
■ Load a font
■ Create a new font

Hence, if you select a different character or SuperDesign, then go back to the one where 
you loaded the picture, the picture will no longer be in the background. If a new font or 
character has been selected and Use For Background Picture is checked, a different font 
character will appear. Reload the previously saved picture.

"I only want to work on a small part of a picture, but I can’t make the 
desired part of the picture big enough. How can I do this?"
To digitize over a small part of an existing picture, load the picture into the PREMIER+™ 2 
Font Create Paint Window, select and crop the desired area of the picture, then use Save 
As Picture to save the edited version. Then start digitizing in the Design window.

"I wish to use a TrueType character as the background picture for a 
SuperDesign, but there is no way to select one when digitizing a 
SuperDesign set."
This feature is only available when designing fonts. If you wish to have a TrueType® 
character as the background for a SuperDesign (for instance, a character from a symbol 
font), do one of the following:

■ Open a font. Use Font Background to load the desired background font, then select the 
desired character. In the Paint window use Save as Picture to save the picture of the 
character. Reopen the SuperDesign set, select the desired SuperDesign, then use Open 
Picture to load the picture of the character.

■ Create a picture of the desired character in the Paint Window, or in another module. Copy 
the picture and then use Paste to place it in the background for your SuperDesign. For 
instance, use the Text function on the Draw page of PREMIER+™ 2 Create to make your 
picture. This is useful if the desired character does not appear in the Select Character 
dialog box, which may happen with symbol fonts.
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"I am saving pictures for the characters or SuperDesigns I am digitizing, 
but I am worried that they are taking up a lot of space on my computer."
If you save pictures for all 224 possible characters in a font, you could use up to 10Mb of 
hard disk space, using only pictures generated from TrueType® font characters. This is 
acceptable, given the storage capacity of modern computers.

Editing the Design

"How do I set the size of the work area for my characters and 
SuperDesigns?"
Hoops are not available in PREMIER+™ 2 Font Create. Set the minimum and maximum size 
for your characters and SuperDesigns when creating the font or SuperDesign set in the 
Create or Edit Font dialog, or change the maximum and minimum size using Size Options 

. See “Create or Edit Font” on page 39 and “Size Options” on page 51.

The default initial size for a character or SuperDesign in PREMIER+™ 2 Embroidery is always the height of 
the upper case A or first SuperDesign when the minimum size is used.

Control Points, Gap and Kerning

"Some of the letters in my font overlap each other when I use it in 
PREMIER+™ 2 Embroidery."
Control points are the points you place to digitize an object. For example, Single Stitches 
have two control points (one at each end), and Satin Columns have as many points as you 
placed when constructing the column.

The gap (or tracking) between characters is a standard distance between each character, 
measured using the control points. Occasionally, characters might overlap because there 
are not enough control points.

Similarly, automatic kerning is used in PREMIER+™ 2 Embroidery to improve the 
appearance of text by moving certain pairs of characters closer together. There must be 
enough control points to ensure that the character pairs do not overlap each other.

Such issues may be found in a very plain font using only a few satin columns or very 
simple fill areas. Ensure there are plenty of control points by putting down underlay 
stitches first. Alternatively, if using a specialty fill with a border, insert extra points into the 
outline of your characters.

Use Insert Points on Straight Lines  to add extra points automatically to a straight 
border line for a fill area or column. Use Insert Points  to add points to a line by hand. 
See “Insert Points on Straight Lines” on page 52.
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Using System Fonts and SuperDesigns

"Why can’t I see many of the system fonts and SuperDesigns in the Create 
or Edit Font dialog box?"
Only a few of the system fonts and SuperDesigns are available for copying and editing in 
PREMIER+™ 2 Font Create. Use these to study how to create your own fonts. You may also 
refine fonts that you created in PREMIER+™ 2 QuickFont.

Using Old Personal Fonts and SuperDesigns

"How can I  import a font that I created in 6D™ Font Digitizing or 6D™ 
QuickFont?"
You cannot transfer font files that you created in 6D™ Font Digitizing or 6D™ QuickFont 
directly into the PREMIER+™ 2 Embroidery System. However, you may export .edo files of 
the characters from 6D™ Font Digitizing and insert them into a new font in PREMIER+™ 2 
Font Create.

For fonts created in 6D™ QuickFont it is recommended to make the font again, as the 
routines to create font characters have been improved.

Use the name of your old 6D™ QuickFont font when selecting the options to create the new version of the 
font in PREMIER+™ 2 QuickFont. See Output Options in the PREMIER+™ 2 QuickFont Reference Guide or 
Help for information on font naming.

"How can I  import a SuperDesign set that I created in 6D™ Font 
Digitizing?"
You cannot copy the SuperDesign files that you created in 6D™ Font Digitizing directly 
into the PREMIER+™ 2 Embroidery System. However, you may export .edo files of the 
designs from 6D™ Font Digitizing and insert them into a new SuperDesign set in 
PREMIER+™ 2 Font Create.
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Checking a Nearest Point Font
After you have created a nearest point font, you should check through it to ensure that all 
the required characters are present in four versions and have the correctly defined start 
and end points.

Check that all Nearest Point characters are correctly digitized
1 Open the desired font.
2 Inspect the Character table on the Font page. All of the characters that you digitized should be a solid 

green. If any are half green, half white, you have missed digitizing some of the character versions. Go 
to the relevant character and digitize the missing versions.

3 In the character table on the Font page, select the character you digitized that is first in the character 
set. This is so you start at the beginning and work through the characters in order. The character will 
be displayed, and the Bottom Left To Bottom Right character version is selected automatically.

4 Check that the character start point is at the bottom left of the character. The first object in a 
character is a Color Change , so this should be easy to identify.

5 Check on the FilmStrip that the end of the character is at the bottom right, as indicated by the red end 
point.

6 If the start and end points of the character area in the wrong place, edit the character until the points 
are positioned correctly.

7 In the Font page select the Top Left To Top Right icon . This version of the character will appear.
8 Check the start and end points are at the top left and top right respectively.
9 If the start and end points of the character area in the wrong place, edit the character until the points 

are positioned correctly.
10 Select the Top Left To Bottom Right icon . This version of the character will appear.
11 Check the start and end points are at the top left and bottom right respectively.
12 If the start and end points of the character area in the wrong place, edit the character until the points 

are positioned correctly.
13 Select the Bottom Left To Top Right icon . This version of the character will appear.
14 Check the start and end points are at the bottom left and top right respectively.
15 If the start and end points of the character are in the wrong place, edit the character until the points 

are positioned correctly.
16 In the Font page select the next character you digitized, and repeat the checking process.
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5Creating Design Elements

Creating Designs
A design in PREMIER+™ 2 Create is composed of areas, lines, columns and commands 
(objects). 

After creating any fill or satin area, or column, emboss it by placing needle points to 
enhance the pattern.

Use lines as individual stitch lines or borders around an 
area or appliqué. 

Lines are defined by points, which can be moved to change the 
shape of the line, and any area it encloses. 
Choose a fill type (e.g. pattern fill, motif fill and so on), 
and a line type (e.g. satin line or running stitch) for each 
area, and add an appliqué fabric and placement 
stitches.

Set the Fill, Line and Appliqué buttons as desired by 
clicking to turn that area type on or off. Then choose 
line and fill types from the drop-down menu below the 
button. In the Options for Fill Area and Line, set the 
properties for your line and fill. After selecting the stitch types, use one of the Create 
functions to make a new stitch object.

Any line type can be converted to another line type after creation, and most area types can be directly 
changed to any other area type. 
Create columns by placing alternate points. 

Commands are instructions such as a change of thread color, an alignment stitch, or a 
stop.

Right-click to deselect a Create function when you have finished, or simply select another Create tool.
When an embroidery is created from a design, each line or area is converted to stitches, 
and the stitch order is controlled by the order of the objects in the design.

You can see the order of objects in the FilmStrip in the Design window.
There are several ways to add objects to a design:

■ Use the ExpressDesign Wizard to create a whole design, with all the necessary lines, areas 
and commands. Edit or add to the design as desired.

■ Use the Home and Create tabs to add new objects to a design which can be based on a 
picture shown in the background, or to insert complete design elements, embroideries, 
SuperDesigns or font characters. 

■ Use the Edit tab, the FilmStrip and the context (right-click) menu to select objects to copy 
and paste, and to reshape object outlines.
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Creating Areas and Lines
Areas and lines are created using the QuickStitch™, QuickTrace, Shape, Freehand Create 
and Precise Create features, or automatically with the ExpressDesign Wizard. 

Draw a line with the Freehand and Precise Create features, or follow a line in a picture with 
QuickStitch™, QuickTrace and the ExpressDesign Wizard.

You can change an open line to a closed one, or vice versa using the Closed Border switch on the Line tab of 
the Fill Area and Line Properties dialog box. This allows you to create a fill area with a closed or open 
border.
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Quick Create
Use the features of the Quick Create tab (QuickStitch™, QuickTrace and Shape) to create 
design areas automatically.

Creating with QuickStitch™, QuickTrace and Shape

Click in a defined color area, or on a defined color line, in the background picture to create 
a QuickStitch™ or QuickTrace line or fill. The area outline is filled or the line is followed 
automatically. 

Use Color Tolerance to choose the color shades used when defining the area.
Select the desired QuickStitch™ or QuickTrace function, according to the type of stitches 
you want over the picture area you are about to select. Then, click in the desired area of 
the picture for QuickStitch™ functions or on the desired line for QuickTrace functions.

Using Color Tolerance with QuickStitch™ and QuickTrace
1 Select your stitch types, then select the desired QuickStitch™ or QuickTrace function, according to the 

type of stitches you want over the picture area you are about to select. 
2 Click in the desired area (for example, on the cat’s left side) of 

the picture for QuickStitch™ functions or on the desired line for 
QuickTrace functions.

3 If Color Tolerance is enabled, the Color Tolerance dialog box 
will appear. 
A red and cyan highlight shows the area of the picture that will 
be filled or traced. If you have chosen to detect holes, any holes 
in the area will be highlighted by green and yellow lines. Using 
Color Tolerance is recommended. 

4 Use the slider to adjust the Color Tolerance value until the 
required part of the picture is selected.
The Color Tolerance dialog box has a slider control, which is 
initially set to 0. This is the tolerance control. As the tolerance value 
is increased, this increases the possible range of colors, by 
similarity to the color clicked, that may be selected by the red and 
cyan highlight. 
For example, if you have an area of your picture that is shaded in different shades of green, you can use 
color tolerance to select all the shades and make a single area.
Even when the tolerance is left at 0, the blue and white pattern gives a useful preview of the area that will 
be used for the new object.

5 Select the number of points to use for the outline; High will show more detail, while Low will be 
smoother.

6 Click OK to confirm the desired area is highlighted, and the line or area is created.

Add Color changes

Select stitch types and appliqué

Create a fill area or line automatically
Select a Shape and create it as a line or fill area

Cut a hole in a fill area

Draw a wave line in a MultiWave Fill area
Emboss a line on a fill area or column

Trace a picture as a line of stitches

Create a Satin Area

Set the properties for the stitch types
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Color Tolerance Off
When Color Tolerance is not enabled, the stitch object(s) are created immediately, using 
only the color area that was selected. You can use the Color Tolerance option in 
Preferences  to turn Color Tolerance off, but this is only advisable if your picture has 
well defined flat color areas, and you have no need to select more than one color area to 
create new objects.

Creating Shapes
Use Shape  to place a selected shape in the work area. Then resize the shape, and set its 
properties. Select a fill and line to draw a fill area surrounded by a border, or select a line 
type only to draw a closed line with no fill.

Creating with Freehand Create and Precise Create
The Freehand and Precise Create tabs’ functions are used to make new stitch objects by 
creating object outlines directly on the design. The outlines may follow a background 
picture, if desired, but the Freehand and Precise Create functions do not require a picture. 
Most of the Freehand Create functions are used by drawing an outline, and most of the 
Precise Create functions are used by placing points or drawing Bezier lines to define an 
outline.

Freehand Create
When using the Freehand Create functions, lines and areas  are created by drawing 
outlines on the design with a pen on a graphics tablet, or by dragging with the mouse.

All of the Freehand Create tools work in the same way, except for Commands and Columns.

Draw a Fill Area with Freehand Create
1 Select the stitch types.
2 In the Freehand Create tab, click Create Freehand Area or Line .
3 Draw one continuous line to create a line or area. 
4 Lift the pen or release the mouse button to complete the line or area. 
5 Repeat to draw as many new areas or lines as desired. 
6 Right-click to deselect the Freehand Create function when you have finished, or simply select another 

tool.
The Freehand Create functions provide a natural drawing experience and are generally recommended. 
When zoomed in, use the Scroll Bars to assist in drawing new objects.

Add Color changes, Single & Alignment stitches, and Stops
Select stitch types and appliqué Draw a fill area or line

Cut a hole in a fill area
Draw a wave line in a MultiWave Fill areaEmboss a line on a fill area or column

Place points for a Column

Draw a Satin Area

Set the properties for the stitch types
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Precise Create
With the Precise Create functions, lines and areas  are created by placing a series of 
points that define the outline. 

All of the Precise Create tools work in the same way, except for Commands and Columns.

Place Points with Precise Create
1 Select the stitch types.
2 In the Precise Create tab, click Create Precise Area or Line . The Freehand Point pointer  

appears.

To create an area with Bezier lines, use Bezier Mode . See “Bezier Mode” on page 222.
3 Place each point with a single click.

Hold down the Ctrl key to place square points for the precise positioning of corners and straight line 
sections.

4 Click and drag  to reposition an existing point.
5 Click Delete to remove the last placed point.
6 Right-click when the area is complete.
7 Repeat to place as many new areas or lines as desired. 
8 Right-click to deselect the Precise Create function when you have finished, or simply select another 

tool.

Bezier Mode
Use Bezier Mode  to draw shapes with finely graduated curves. Control the exact shape 
of the line using the black handles to either side of  the points you place.

Click to place Corner points, or click and drag to place curve points with 
handles.

For information on Control Points and the other Bezier Line editing tools, see “Convert 
Points and Bezier Lines” on page 346. 

The Precise Create functions may be easier to use for the exact positioning of corners, straight lines and 
curves than the Freehand Create functions. 

Area Types
Any area can have a border, or no border. The border can be closed or open, and it can use 
any line type. Holes can be defined inside any fill area. Appliqué properties may be set for 
any area or line. Use Break Apart on the Edit tab to change an area with a border into 
separate fill area and line objects.

Any fill area can be converted into a Satin Area, however any holes in the fill area will be lost. (Any Border 
lines will be retained, including the borders of the holes.)

Add Color changes, Single & Alignment stitches, and Stops
Select stitch types and appliqué Create a fill area or line

Cut a hole in a fill area
Draw a wave line in a MultiWave Fill areaEmboss a line on a fill area or column

Create a Column

Create a Satin Area

Set the properties for the stitch types

Use Bezier Mode
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Pattern Fill
Pattern Fill areas  contain small stitches with repeating patterns. Select from one of the 
themed categories, or import a picture as a My Fill pattern. A pattern fill area can have 
holes defined inside it. The stitches can be at any angle and the density can be constant, 
gradient or multicolor as desired. Constant density fill areas can also have automatic 
underlay, which is turned off automatically for gradient density areas.

If you change a gradient density fill back to standard, then you should also select the desired underlay.

Shape Fill
Shape Fill areas  use one of 75 different shapes. Vary the stitch density, use running 
stitch or motif lines for the fill and add holes.

Motif Fill
Motif Fill areas  contain repeated small stitches placed using one of the Universal or 
machine motif patterns. A motif fill area can also have holes defined inside it. The motifs 
can be at any angle and at different sizes, and different motifs can be used on alternating 
lines.

Radial Fill
Radial Fill areas  use a pattern of radiating lines from an origin point that can be moved. 
Vary the stitch density and add holes.

Fill Area with Satin border and holes 
using Pattern Fill 109 from Hearts

Pattern Fill Area with Multicolor 
Gradient

Motif Fill Area with two motifs, 13 
and 19, from Hand Stitches 2

Shape Fill Area using Shape 23 
and Motif 1 from Hand Stitches 1

Radial Fill with origin moved to top 
of heart

Spiral Fill using Gradient Density
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Spiral Fill
Spiral Fill areas  use a spiral pattern from an origin point that can be moved. Use 
constant or gradient density, and add holes.

QuiltStipple Fill
QuiltStipple Fill areas  use stipple stitch in curved or straight lines. Vary the gap 
between stitch lines, use running or triple stitch, and add holes.

Contour Fill
Contour Fill areas  use contour stitch lines. Vary the gap between stitch lines and the 
length of the stitches, use running, double or triple stitch, and add holes.

Crosshatch Fill
Crosshatch Fill areas  use diamond, square and parallel crosshatch patterns, or select 
the angles for the crosshatch. Set the gap, style, line angle, stitch type and stitch length for 
the crosshatching, and add holes to the fill.

Crosshatch fill is often selected for lace designs, typically using a Double Zigzag stitch type.

MultiWave Fill
MultiWave Fill areas  use a wave pattern defined by a line, or lines, drawn on the fill 
area. Vary the density, or use a motif for the stitch lines.

Echo Fill
Echo Fill  places echo lines within and/or around a shape. Choose from rounded, square 
and diagonal corners, set the gap between the echo lines and the number of lines, and 
select the stitch type and length.

QuiltStipple Fill using a curved 
style

Contour Fill, using Triple Stitch and 
a 3.0mm gap

Crosshatch Fill, using Diamond 
style and an Angle of 75 degrees
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Curved Crosshatch Fill
Curved Crosshatch Fill areas  use curving lines in the crosshatch, which can be used to 
create a feeling of depth. They are used in quilting, and to create free-standing lace.

Satin Areas
Satin Areas  contain zigzag stitches that fill the area from one 
end to the other at the same density. The stitch angle changes 
with the shape of the area, and can be adjusted as desired. 
Choose automatic edge walk and/or zigzag underlay, and if 
desired select a pattern.

Satin Areas can be converted into any type of fill area. They cannot be 
created with a border, but a border can be placed around them using the 
Fill Area and Line properties dialog.

Columns
Create Columns by placing points, or on the Precise Create tab by drawing Bezier lines. 
The Column functions are found both on the Freehand and Precise Create tabs. Place 
alternate points to define a column of any length.

Columns may be converted into Satin Areas using the Convert to Satin Area  option, but Satin Areas 
cannot be converted into any type of column.

Satin Column
Use Satin Column  to create a straight or curving column of 
parallel stitches. The column may be of any length. If desired, add a 
pattern. Choose from over 250 patterns, similar to Pattern Fill, or 
create your own My Fill patterns. The density can be constant, 
gradient or multicolor as desired.

The recommended maximum length for satin stitches is around 8-10mm, 
otherwise the stitches may be loose and not lie flat. To create satin wider than 
this, use a pattern, overlap satin columns, or use a satin area.

Curved Crosshatch Fill, using 
Square style and a Gap of 5mm

MultiWave Fill, using a density of 15, 
a MultiWave Line, and a Hand 

Stitches 1, Pattern 1 motif

Echo Fill using Internal and 
External Lines, and rounded 

corners
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Feathered Satin
For lifelike realistic feathers or fur, use Feathered Satin , where 
the start and end points of the stitches are random rather than all 
parallel. Feathered satin may also be created with only one side 
feathered – the side where the first (A) or second (B) point was 
placed.

Richelieu Bars
Use Richelieu Bars  to create a column of short sections of satin 
perpendicular to the direction of the column. Choose the number of 
bars, and the width of the satin.

Richelieu bars are typically used for cutwork designs.

Tapered Motifs
Use Tapered Motifs  to create a line of motifs that vary in size 
according to the width of the column.

Tapered motifs are often used in lace designs.

Line Types
Choose a line type before drawing the line, or change it afterwards in Fill Area and Line 
properties.

Running, Double and Triple Stitches
Set Running Stitch  from 0.3-12.0 mm in 0.1mm steps (standard, or cutwork needle 
lines with secure points). Set Double , Double Zigzag  and Triple  Stitch to any 
length from 1mm to 12mm.

Feathered Both Sides Feathered Side A Feathered Side B

Running Double Triple
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Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh.

Motif Line
Motif Lines  are lines of the chosen Universal or machine 
motif patterns.

Satin Line
Create Satin Lines  where a line or border of satin stitches of 
constant width is desired. The line will be created along the center of the chosen line.

Individual satin lines and the satin borders used around fills or appliqué are identical.

Appliqué
Select Appliqué  to use appliqué fabric and placement stitches with a fill area that you 
create. Select an appliqué fabric in the Appliqué Selection dialog box, and choose a 
placement method in the Fill Area and Line options Appliqué tab.

Commands
Commands are instructions such as the Color Change  that changes the thread at the 
start of a new color block. The Stop  tells an embroidery machine to stop without a 
color change. 

Color changes, stops and alignment stitches are indicated by special blue, red and pink 
markers when in 2D or Object mode.

Alignment Stitches
Use Alignment Stitches  to add stitches at the beginning of an embroidery that you can 
use to align the embroidery, for example if it is being stitched over a background picture.

Alignment Stitches are typically placed at the beginning of an embroidery. They will be 
inserted after the currently selected object, but may be moved if desired. Alignment 
Stitches are created as a cross, but may be altered after placement.

Color Change Stop Alignment Stitch



PREMIER+™ 2 Create   Creating Design Elements              85

Single Stitch
Use Single Stitch  to create single stitches that will be 
embroidered at whatever length they are made. 
Alternatively, if you select to Break Up into Smaller Stitches 
they will be broken up into stitches of Running Stitch at any 
length from 1mm to 12mm.

Single stitches cannot be converted to any other line type.

Creating Motifs, Machine Stitches and Stamps
In the Draw window, create a drawing that will be suitable as a repeated element. You can 
then export the selected area as a My Motif  for use in any motif line or fill type, or as a 
.spx machine stitch  for certain sewing machines. Save the drawing in .4qb format in 
case you wish to edit it later, or use it as a stamp in PREMIER+™ 2 Modify.

The Reverse Path function on the Draw tab is useful if you copy, paste and mirror part of the drawing.
Import motifs  to change or combine them, or to save them as machine stitches. Import 
machine stitches  to create motifs. See “Motifs, Machine Stitches and Stamps” on 
page 142.

Objects Created in the ExpressDesign Wizard
Lines and areas created in the ExpressDesign Wizard may be modified in the same way as 
those created by any other method. When the ExpressDesign Wizard is used to create a 
new design or load a picture, the design will fit the hoop or use the selected design size.

Columns are not created by the ExpressDesign Wizard. Any satin will be a Satin Area or a Satin Line.
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Fill Area and Line Properties
Use the Fill Area and Line properties dialog box to change the fill and line type for a 
previously created area. Then edit the properties using the tabs in the dialog.

The options available in the two drop-down lists vary, depending upon the selected fill and line type.
You can change a previously created area to any other fill or line type in the drop-down lists, including No 
Fill or No Border Line.
To access the Fill Area and Line properties dialog, click the Fill Area and Line button in the 
Options area of one of the Create tabs. Alternatively, right-click an existing line or fill on 
the FilmStrip or in the work area.

If accessed from the Options button, you cannot change the fill and/or line type.

Fill
Select the Fill type from the drop-down list:

No Fill Spiral Fill MultiWave Fill

Pattern Fill QuiltStipple Fill Echo Fill

Motif Fill Contour Fill Satin Area

Shape Fill Crosshatch Fill

Radial Fill Curved Crosshatch Fill

Choose a fill type
Choose a line type
Change the line or fill properties

Set the appliqué method
Set options for your favorites

Select a fill category and pattern
Use a Gradient fill

Set the properties for a gradient fill

Click Apply to preview and OK 
to finalize your changes

Set underlay, angle and compensation
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Line
Select the Line type from the drop-down list:

Click the Line tab and select Insert Color Change for a different color for a fill area border. 
See “Secondary Colors” on page 149.

Appliqué
Select the appliqué method before 
or after creating an area or line. 
Choose from:

• None
• Standard Appliqué
• Pre-cut Piece
• Pre-placed Piece
• Cut-out

Standard Appliqué
Stitch a running line to show where 
appliqué fabric should be placed, 
then stop to position the fabric. Stitch down the appliqué fabric with double stitch, then 
stop so the fabric may be trimmed. Finish the edges with the selected border stitching.

Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork 
needles.

Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.

Pre-placed Piece
Place the appliqué fabric before stitching.

Place the appliqué layer in position, then stitch down the appliqué fabric with double 
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border 
stitching.

Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example 
for reverse appliqué.

No Border Line Triple Stitch

Running Stitch Satin Line

Double Stitch Motif Line

Double Zigzag
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Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the 
stitched outline. Finish the edges with the selected border stitching.

Select Fabric
Use Select Fabric to choose a fabric for your appliqué in the Appliqué Selection dialog box.

Click Select Fabric and the Appliqué Selection dialog box appears. See “Appliqué 
Selection” on page 186.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.
Placement stitches are set to 2.0mm initially. To alter the stitch length for individual lines, use the Break 
Apart function for the area.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.

Favorites
Use the Favorites tab of the Fill Area and Line properties dialog to make the chosen 
settings into favorites, or to return to the original settings.

Save these options as my favorite
Use ’Save these options as my favorite’  to save the chosen options as the favorite for 
this area or line type.

The favorite option must always be applied from the Favorites tab. It is not the same as the current settings, 
used to create new areas.

Apply my favorite to these options
Use ’Apply my favorite to these options’  to use your favorite settings for the area or line 
type instead of the settings shown. 

Set these options as the current settings
Use ’Set these options as the current settings’  to use the chosen options as the default 
for new areas of this type. 

Reset these options to the system default
Use ’Reset these options to the system default’  to change the settings for the selected 
area or line type to the system default. 
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Show a text summary for these options
Use ’Show a text summary for these options’  to display details of the chosen area or 
line settings.

Save a Fill and Line Type as a Favorite
1 To open the Fill Area and Line properties dialog, right-click an existing line or fill, or click the 

appropriate Options button in the Quick Create, Freehand Create or Precise Create tab.
2 Select a Fill type from the Fill drop-down list.
3 Select a Line type from the Line drop-down list.

The Fill and Line type menus will only be available if you opened an existing line or fill.
4 Edit the tabbed pages below as desired.

For details on the options available, for Line types see “Using Lines” on page 316 and for Fill types see 
“Using Fill Areas” on page 232.

5 Click the Favorites tab, then click ’Save these options as my favorite’ .
This will save your settings as a favorite in case you want to use these settings frequently. Click ’Show a text 
summary for these options’ to view your settings.

Column Properties
Use the Column properties dialog to change the column type for a previously created 
area. Then edit the properties for the selected column type using the Options tab. Use the 
Favorites tab to select favorites, or to return to the original settings.

You can change a previously created column to any other column type in the drop-down list. Use Convert 

to Satin Area  to change to a satin area.

To access the Column properties dialog before creation, select one of the Column options 
in the Options section of the Freehand Create or Precise Create tab. After creating stitches, 
right-click an existing selected column on the FilmStrip or in the work area.

Choose a column type

Change the properties as desired

Click Apply to preview and OK 
to finalize your changes
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If accessed from the Options button, you cannot change the column type.

Convert to Satin Area
Click Convert to Satin Area  to change the column to a Satin Area. The Fill Area and Line 
Properties dialog for Satin Area is displayed. See “Satin Area Options” on page 296.

Click Undo  to change back to a column.

Favorites
Use the Favorites tab of the Column properties dialog to make the chosen settings into 
favorites, or to return to the original settings.

Save these options as my favorite
Use ’Save these options as my favorite’  to save the chosen 
options as the favorite for this column type.

The favorite option must always be applied from the Favorites tab. It is not the same as the current settings, 
used to create new areas.

Apply my favorite to these options
Use ’Apply my favorite to these options’  to use your favorite settings for the column 
type instead of the settings shown.

Set these options as the current settings
Use ’Set these options as the current settings’  to use the chosen options as the default 
for new areas of this type.

Reset these options to the system default
Use ’Reset these options to the system default’  to change the settings for the selected 
column type to the system default.

Show a text summary for these options
Use ’Show a text summary for these options’  to display details of the chosen column 
settings.

Object Properties
The following settings can be changed for stitch objects before or after they are created:

■ Density
■ Compensation
■ Underlay
■ Stitch Length
■ Satin Line Width
■ Fill and Satin Patterns
■ Gap and Shape
■ Start, End and Origin
■ Motif
■ Feathered Side
■ Alignment Stitch Type
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The settings for new areas and lines are set by selecting a stitch type in the Options area of 
the Create tab and adjusting them in the properties dialog for that stitch type. 
Alternatively, select an area with the desired properties and save them as your Favorite  
or Current  settings.

Not all settings can be changed for all stitch types. 
Options that set properties for new objects are only applied when using the Create tabs to make stitch 
objects. Objects created in the ExpressDesign Wizard do not use the current settings, but may be changed 
after finishing the wizard.

Density
Density of stitching may be set from 2 to 40, except for Pattern Fills , Spiral Fills , 
Satin Column  and Satin Area  (2 to 80), and Richelieu Bars  and Satin Line  (2 
to 15).

Pattern  and Spiral  Fill areas and Satin Columns  may also have density gradients, 
or variable multi-density. The higher the number, the farther apart the stitches and the 
fewer stitches are produced. Pattern fills and Satin Columns may also have multicolor 
gradient density.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Compensation
All stitches have a tendency to pull in. The pull varies according to fabric weight and type. 
Compensation is used to make a whole design or areas within it 'bolder' by increasing 

Pattern Fill Area with Multicolor 
Gradient

Pattern Fill Area with Gradient 
Density Fill
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their relative size. The higher the number, the bolder the areas appear. You can also alter 
compensation for any individual area of satin or fill.

Embroidery on thicker fabrics usually looks better with higher compensation, while on thin materials such 
as satin or twill a lower value or zero setting is usually more appropriate. As you create a design, use 
overlaps to prevent pulling from creating gaps between blocks of stitches that have different stitch 
directions. This provides 'built-in' compensation.
Compensation may be set from 0 to 30 for satin and 0 to 20 for fill areas. The setting for any 
Satin Column , Satin Area  and Pattern Fill  in the design is shown in the Area and 
Line properties for that satin or fill.

Compensation does not apply to feathered satin, satin line, or any fill other than pattern fill.

Underlay
Underlay is used to stabilize an area of fabric before stitching over it. Automatic underlay is 
optionally available for Pattern Fill areas, Satin Areas, Satin Column, Richelieu Bars and 
Satin Line. To create underlay for other object types, use running stitch or single stitches.

Embroidery designs created with the ExpressDesign Wizard have an option to create underlay for the 
whole design.

Stitch Length
Stitch Length can vary according to the object type as follows:

■ Single Stitches : each stitch may be set from 1-12mm in 1mm steps, or embroidered 
without breaking up into smaller stitches.
The current maximum stitch length for new Single stitches, if it is desired to break them up into smaller 

stitches, is shown in the Preferences .

■ Running Stitch  may be set from 0.3-12.0mm in 0.1mm steps.
Cutwork needle lines are automatically set to 0.3mm.

■ Double Stitch , Double Zigzag  and Triple Stitch  may be set from 1-12mm in 
0.1mm steps.

■ Motif Line  stitches may be set from 1-20mm in 0.1mm steps.

■ Motif Fill : the length of the running or triple stitches making the motif shapes can be 
set from 1-12mm in 0.1mm steps.

■ Feathered Satin  (feathered both sides or one side): the maximum length of the stitches 
may be set from 2-30mm in 1mm steps.

■ Shape Fill : where Motifs are used, the length of the running or triple stitches making 
the motifs can be set from 1-12mm in 0.1mm steps.

Satin Compensation Pattern Fill Compensation
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■ QuiltStipple , Contour , Crosshatch , Curved Crosshatch  and Echo  Fill: the 
length of the running or triple stitches making the fill can be set from 1-12mm in 0.1mm 
steps.

Check the current setting by clicking the Options button in one of the Create tabs.

Satin Line Width
Satin line or border width may be set from 1 to 12mm in 
0.1mm steps.

Fill and Satin Patterns
Choose from over 250 system patterns or any imported My Fill 
pattern for Pattern Fill areas, Satin Areas and Satin Columns. 
Choose any available motif for motif fill areas, lines and tapered 
motifs columns. Check the current setting by clicking the Fill 
Area and Line button in the Options area of one of the Create 
tabs. See “Fill and Satin Patterns” on page 369.

Patterns in categories other than Standard are recommended for use in 
relatively large fill areas, as they have repeating patterns which work well when 
'tiled' together. Pattern 36 produces a 'satin effect' fill stitch. The first four patterns 
in the Gradient & Lace category (253-256) are recommended for multicolor 
gradient. The other eight (257-264) are suitable for a weave pattern combined 
with parallel crosshatch, as used for lace designs.

Set the angle of orientation for the stitches in Pattern, Motif and 
Crosshatch and Curved Crosshatch fill areas to any degree. Check the current setting by 
clicking the Fill Area and Line button in the Options area of one of the Create tabs.

Gap and Shape
The QuiltStipple , Contour , Shape , Crosshatch , 
Curved Crosshatch  and Echo  styles of fill have additional 
properties that are unique to these fill styles. QuiltStipple fills 
can have curved or straight stipple stitching, and a gap setting 
controls the spacing of the lines of stipple stitch. Contour fill also 
uses a gap setting that controls the spacing of the lines of 
Contour stitch. Shape fills have a choice of 75 shapes, which 
control the path of the stitching. Crosshatch and Curved 
Crosshatch fills can use diamond, square and parallel styles. 
They have a gap setting that controls the spacing between the lines in the crosshatch. 
Echo fills can use internal or external lines, varying the number or spacing. They also have 
a choice of three styles, with curved, square or diagonal corners.

Richelieu Bars may have a minimum gap or number of bars specified.

Start, End and Origin
Fill and satin areas have adjustable green start  and red end  points, which can be 
moved to any point defining the shape of the area. Use this to control the connection 
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between an area and the objects that precede or follow it. For example, this is useful for 
shortening or hiding movement stitches so the need for trimming is reduced.

Pattern, Shape, Radial and Spiral fill areas also have an orange origin . For Pattern Fill, 
the origin marker also has an adjustment handle .

In a pattern fill area, the origin is the start point for the repeating pattern. In Shape, Radial and Spiral fills, 
the origin is the point from which stitches radiate. For a pattern fill area, move the origin to change the 
position of the pattern, and rotate the handle to change the angle. For Shape, Radial and Spiral fills, move 
the origin to move the radiation point of the fill. The origin may be moved anywhere on the work area.

Motif
Choose any available motif for Motif Fill areas  and Lines . 
Motifs can also be used in Shape , MultiWave  and Curved 
Crosshatch  fills, and tapered motifs columns . The size of 
motifs can be changed, and they can be stitched in either 
running or triple stitch. For motif fill areas, a second motif can be 
chosen for alternating lines, and the spacing, offset and angle of 
lines can be changed. Check the current setting by clicking the 
Fill Area and Line button in the Options area of one of the Create 
tabs.

Feathered Side
Individual areas that were created as both sides feathered, Feather Side A or Feather Side B 
may have their feathered edges changed. See “Feathered Satin” on page 83.

Alignment Stitch Type
Alignment stitches are added at the beginning of an 
embroidery to align it, for example, with a background picture 
on fabric. 

Alignment stitches are initially placed as a cross . Use the 
Alignment Stitches properties dialog to change the stitch type. 
Select the desired stitch and right-click to choose from cross 

, top left , top right , bottom left , bottom right  
and point .

Feathered Both Sides Feathered Side A Feathered Side B
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Global Properties
The properties of all visible objects of a chosen type can be changed with Global 
Properties. 

Global Properties is not used for Stops, and has no effect on Color Changes. 

Shortcut
■ Keys: Alt, E, G; Right-click FilmStrip, B

Change Object Settings with Global Properties
1 Use the Edit tab and the Design Panel to hide any objects you do not wish to affect. For example, hide 

objects by color, or use the Hide Object Types filters.
2 Select an object of the desired type.
3 Right–click in the FilmStrip or on the work area and select Global Properties from the context menu. 

The properties dialog box for the object will appear, with the current settings taken from the selected 
object. 

4 Adjust the properties as desired.
5 Click OK. 

All the settings in the dialog box will be applied to all visible objects of the same type.
When you click OK, the settings are applied globally even if you did not change anything. For 
example, if you have a fill area that already has the desired settings, select the fill area then select 
Global Properties and click OK to replicate the settings on all visible fill areas.
Global Properties is only available if a single object is selected.

Change Properties for Selected Objects
The properties of all selected objects of a chosen type can be changed at once.

You cannot change properties for multiple Stops or Color Changes at the same time. 

Change the Settings for Selected Objects
1 Hold the Ctrl key and in the FilmStrip click each of the objects that you want to affect.
2 With the desired objects selected, right–click one of your chosen objects.
3 Select Properties from the context menu. The properties dialog box for the object will appear, with 

the current settings taken from the selected object. 
4 Adjust the properties as desired, then click OK.

All the settings in the dialog box will be applied to all selected objects of the same type.
When you click OK, the settings will be applied to all selected objects, even if you did not 
change anything. For example, if you have a fill area that already has the desired settings, 
select the objects you want to change, right-click the fill area with the desired settings and 
select Properties from the context menu. In the Fill Area and Line properties dialog click 
OK to replicate the settings on all selected fill areas.

If more than one type of object is selected, only the object selected first will have its properties changed.
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Changing Stitch Types
To change a stitch type to another stitch type, select the line or fill area, then right-click. 
(Alternatively, right-click on the object in the FilmStrip of the Design window and select 
Properties.) In the Fill Area and Line properties dialog select the desired Line or Fill type 
from the drop-down menus at the top.

Stitch types in the following two groups may be changed to any other stitch type in either 
of these groups:

Lines

Areas

When converting to a Satin Area, any holes in the fill area will be lost.
Objects in the following groups may be changed to any other stitch type in that group:

Columns

Any Column can be changed into a Satin Area using the Convert to Satin Area  option, but it cannot be 
changed back.
The following object types cannot be changed into another type of object:

■ Single Stitch
■ Stop Command
■ Color Change
■ Alignment Stitch

Running Stitch Satin Line

Double Stitch Motif Line

Double Zigzag No Border Line

Triple Stitch

Pattern Fill QuiltStipple Fill Echo Fill

Motif Fill Contour Fill No Fill

Shape Fill Crosshatch Fill Satin Area

Radial Fill Curved Crosshatch Fill

Spiral Fill MultiWave Fill

Satin Column Richelieu Bars

Feathered Satin Tapered Motifs
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Design Size and Creating Embroideries
The purpose of creating a design is to generate an embroidery from the finished design. 
Before creating an embroidery you may wish to consider how the design size will affect 
the finished embroidery.

The size of a design is mainly controlled by the hoop size used.

You can create a design for many different hoop sizes from the same design outline (.edo) file. However, 
you need to consider how this will affect the size of individual parts. For example, a satin line for an 
embroidery size of 150mm may look better as a running stitch line if the embroidery size is 80mm. The 
recommended maximum length for satin stitches is around 8-10mm, otherwise the stitches may be loose 
and not lie flat. To create a satin sections wider than this, either overlap satin sections, or use one of the fill 
patterns to create smaller alternating stitches
When creating designs, remember the outside edge of some stitch types may extend 
beyond the hoop. For example, satin borders have stitches generated on both sides of the 
center line and feathered satin sections have stitches that go beyond the points placed to 
define the feathered satin. The design size is measured according to the distance between 
the outermost control points. However, the embroidery may be larger than the desired 
design area or hoop size if stitches are created that extend beyond the outermost points, 
as in the example. This is easy to see in 3D View, but in Object View you could create areas 
that are too large without realizing.

You will be able to save the design outline file, but if you select Export Embroidery a 
message will appear: Embroidery is too large or will not fit in hoop. Click OK to continue.

Change to a larger hoop  to stitch out the design, or in the Modify Block menu on the 
Home tab, select Scale Fit to Hoop  to automatically adjust the actual size of the design 
to fit in the hoop.

Use Change Design Size  to alter a design automatically to a new size, allowing for the 
stitch objects used such as satin borders.

The stitches created go outside the hoop. The points for both the satin line and 
feathered satin are inside the hoop.
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6ExpressDesign Wizard
Use the ExpressDesign Wizard to create new designs automatically from pictures. There 
are three design types that can be created in the ExpressDesign Wizard: Express 
Embroidery, Express Trace and Express Border.

Additionally, when started with New , the ExpressDesign Wizard can be used to load a 
picture for a new design, load an existing design or start a new design without a picture.

Express Embroidery
Create a new design by converting color areas in a picture to fill and 
satin areas, using running stitch or satin border outlines where 
necessary.

Express Embroidery works best when using pictures that have well 
defined, flat color areas and outlines.

Express Trace
Create a new design by tracing outlines in the picture. Use light or 
heavy running stitch to create redwork or blackwork style designs, 
create quilt stencils and so on. Use satin border of constant width for 
designs that demand broader outlines.

Express Border
Create a new design by creating borders around 
shapes in a picture. The border can be created as a satin 
border, an outline of running, double or triple stitch, or 
a border of motifs; all, optionally, with appliqué.

Load a Picture into the Paint Window
Create a new design by loading a picture, and optionally 
rotating and cropping the picture. Select a hoop or design size 
and reduce colors, then the wizard finishes. The picture is 
loaded into the PREMIER+™ 2 Create Paint window.
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Load a Vector Picture as Objects into the 
Draw Window
Create a new design by loading a picture. Select a hoop or 
design size and then the wizard finishes. The picture is loaded 
into the PREMIER+™ 2 Create Draw window.

Load a Background Picture into the Draw 
Window
Create a new design by loading a bitmap, or other non-vector (raster) picture, as the 
background in the PREMIER+™ 2 Create Draw window. The wizard finishes. Use the picture 
as a background when creating a drawing.

Load Existing Design
Open an existing design to preview it in the wizard, then close the wizard and load the 
design in PREMIER+™ 2 Create. The Design window of PREMIER+™ 2 Create is shown.

Start a New Design with no Picture
Select a hoop, then close the ExpressDesign Wizard and start with an empty work area in 
PREMIER+™ 2 Create.

New
Use New  to clear the PREMIER+™ 2 Create screen and start a new design. You are 
prompted to save the current design if changes have been made. The ExpressDesign 
Wizard will start and the Choose Design Type page will appear.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + N

New Window
Use File, New Window in the Design window to open an additional PREMIER+™ 2 Create 
window so that you can start a new design with the ExpressDesign Wizard, insert an 
embroidery or design, or paste a block to start a new design.

To move between open PREMIER+™ 2 Create windows, hover over the PREMIER+™ 2 Create icon on the 
taskbar, and select the desired window.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + Shift + N
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Insert ExpressDesign
Use Insert ExpressDesign  to create a new design in the ExpressDesign Wizard. Insert 
ExpressDesign is used to add new design elements to an existing design, but can also be 
used to create the first part of a new design, or used repeatedly to compose a design from 
elements created in the ExpressDesign Wizard.

Use ExpressDesign into Rectangle to create a new design that is a best-fit to a rectangular 
area you draw, and use ExpressDesign into Hoop to create a new design that is a best-fit to 
the currently selected hoop and orientation.

ExpressDesign into Rectangle
Use the ExpressDesign into Rectangle  option to create a new design in the 
ExpressDesign Wizard that is a best-fit to a rectangular area you draw.

In the Insert ExpressDesign  drop-down, click ExpressDesign into Rectangle  and the 
mouse pointer will change to the draw rectangle pointer . Click and drag on the work 
area to draw a rectangle of the desired size. When you release the mouse button, the 
Choose Design Type page of the ExpressDesign Wizard will appear.

If the rectangle is wrong and you wish to try again, click Cancel when the ExpressDesign Wizard appears. 
Then click ExpressDesign into Rectangle again.
Choose the desired design type, then choose a picture and step through the rest of the 
ExpressDesign Wizard. When you Finish, the new design will be placed where you drew 
the rectangle, and will fit the rectangle proportionally, depending on the picture shape. 
Use Save  to keep the new design. Use Export  to save in other formats, and optimize 
for stitching.

Shortcuts
■ Home Tab, ExpressDesign Wizard Drop-Down: 
■ Keys: Alt, H, IR, IR

Insert an ExpressDesign in the Work Area
1 In the Home tab, click Insert ExpressDesign , and Into Rectangle . The mouse pointer will 

change to the draw rectangle pointer .
2 Click and drag on the work area to draw a rectangle of the desired size. When you release the mouse 

button, the Choose Design Type page of the ExpressDesign Wizard will appear.
If the rectangle is wrong and you wish to try again, click Cancel when the ExpressDesign Wizard appears, 
then select Insert ExpressDesign again.

3 Choose the desired design type and click Next.
4 Choose a picture then step through the rest of the ExpressDesign Wizard. The pages will appear 

according to the chosen design type.
The rectangle you drew is used to automatically set the size of the new design, according to the portion of 
the design area you selected with the rectangle and the current hoop. Hence, the Design Size page of the 
wizard will not appear.

5 At the end of the wizard click Finish. The new design will be placed where you drew the rectangle, 
and will be a best fit to the rectangle depending on the picture shape.

6 Move, resize, mirror, rotate, copy and cut the new design as desired. When the new design is 
positioned and sized as desired, right-click to deselect it.
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ExpressDesign into Hoop
Use the ExpressDesign into Hoop  option to create a new design in the ExpressDesign 
Wizard that is a best-fit to the currently selected hoop and orientation. 

If desired, click Change Hoop  and choose a different hoop size before using ExpressDesign into Hoop.

In the Insert ExpressDesign  drop-down, click ExpressDesign into Hoop  and the 
Choose Design Type page of the ExpressDesign Wizard will appear. Choose the desired 
design type, then choose a picture and step through the rest of the ExpressDesign Wizard. 
When you Finish, the new design will be placed in the center of the hoop. Use Save  or 
Save As  to keep the new design, together with any other designs in the work area. Use 
Export  to save in other formats, and optimize for stitching.

Shortcuts
■ Home Tab, ExpressDesign Wizard Drop-Down: 
■ Keys: Alt, H, IR, IH

Send To Wizard
Use Send To Wizard  to send the picture, as it appears in the Draw or Paint window, to 
the ExpressDesign Wizard. The picture can be used to create an Express Embroidery, 
Express Trace or Express Border design, or if it is a vector drawing in the Draw window, it 
can be loaded directly into the Design window as an .edo (design) file from the Send to 
Wizard (retain individual object layers) dialog.

Send To Wizard  is not available if objects have already been created for the design.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + K

Send a Picture to the ExpressDesign Wizard
1 Click File, New  or File, New Window , and the Choose Design Type page of the ExpressDesign 

Wizard will appear.
2 To load a picture with the wizard, select Load a Picture into the Paint Window, or Load a Vector Picture 

as Objects into the Draw Window, click Next, choose a picture and step through the wizard.
When a picture is loaded by the ExpressDesign Wizard, the colors may be reduced. If you wish to avoid this, 
use the next method.

3 If you wish to draw your own picture or load a picture directly onto the Draw or Paint window of the 
main PREMIER+™ 2 Create screen, select Start a New Design with no Picture, then select whether to 
use a Draw or Paint window. Select a hoop and click Finish. 

Then to load a picture, in the Draw tab use File, Open Drawing  or File, Insert Drawing , or in the 

Paint tab use File, Open Picture , File, Insert Picture  or From Scanner or Camera .
4 Draw and/or edit the picture as desired on the Draw or Paint window.
5 When your changes to the picture are complete, click Save As Drawing  or Save As Picture  and 

save the picture with a new name.

It is recommended to save your finished picture with Save As Drawing  (or Save As Picture in the Paint 
window) before using Send To Wizard, as the ExpressDesign Wizard may make changes to your picture.
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6 The whole picture will be sent to the wizard. If you have an area of the picture selected, the selection 
will not affect this. 

Alternatively, in the Paint window you can select the desired area with Box Select  or Freehand 

Select , then Crop  the picture. As Crop  only removes rectangular areas of the picture, the results 
will be the same whichever selection tool you use.

7 Click File, Send To Wizard .
In the Draw window you will be asked if you want to Merge all layers, or Retain individual object 
layers. If you choose Retain individual Object Layers, the picture will be loaded into the Design 
window as an .edo (design) file, otherwise the Choose Design Type page of the ExpressDesign Wizard 
will appear.
In the Paint window the Choose Design Type page of the ExpressDesign Wizard will appear.

8 Click Next and the next page of the wizard will appear, according to the chosen design type.
The Choose Picture, Rotate and Crop Picture and Design Size pages will not appear.

9 Continue through the ExpressDesign Wizard to create your design.

Send to Wizard (retain individual object layers)
If Send to Wizard  is used for a vector drawing in the Draw window, a dialog asks if it 
should be merged, or if the layers should be retained. 

If the layers are retained it is loaded directly into the Design window as an .edo (design) 
file.

Merge all layers (flatten)
The layers in the drawing are flattened and the Choose Design Type page of the 
ExpressDesign Wizard will appear.

Retain individual object layers
The drawing is treated as a complete design, and is loaded as an .edo (design) file into the 
PREMIER+™ 2 Create Design window.

Lines are converted to running (0.5 or 1mm), triple (2mm), or satin (3mm or above) depending on their 
width. Filled areas are converted to pattern fill.
Running stitch and Triple stitch length is 2mm and Satin density is 4 initially. Fill is pattern 3 and density 2.
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Choose Design Type

Express Embroidery
Create a new design by converting color areas in a picture to fill and 
satin areas, using running stitch or satin border outlines where 
necessary.

Express Trace
Create a new design by tracing outlines in the picture. Use light or 
heavy running stitch to create redwork or blackwork style 
embroidery, create quilt stencils and so on. Use satin border of 
constant width for larger designs or when a bolder outline is more 
pleasing.

Express Border
Create a new design by simplifying a picture into solid color areas. 
Borders are created around these shapes as satin, appliqué, running 
stitch, double stitch, triple stitch or motifs.

Load a Picture into the Paint Window
Create a new design by loading a raster picture, and optionally 
rotating and cropping the picture. Select a hoop or design size and 
reduce colors, then the wizard finishes. The picture is loaded into 
PREMIER+™ 2 Create.

When a picture is loaded by the ExpressDesign Wizard, the colors may be 
reduced. This is to make it easier to use the QuickStitch™ features.

If desired, the picture may be edited and then sent to the wizard with Send To Wizard .

Create an embroidery 
automatically

Load a picture

Load a design
Start with an empty work area
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This option is only available when starting the ExpressDesign Wizard with File, New , or 
File, New Window .

Load a Vector Picture as Objects into the Draw 
Window
Create a new design by loading a picture. Select a hoop or design 
size. The wizard then finishes. The picture is loaded into PREMIER+™ 
2 Create.

If desired, the picture may be edited and then sent to the wizard with Send To 

Wizard . There is an option in Send to Wizard to load the picture directly as 
an .edo (design) file.
This option is only available when starting the ExpressDesign Wizard with New , or File, 
New Window.

Load a Background Picture into the Draw 
Window
Load a non-vector (raster) picture as a background to design over 
in the Draw window. The wizard then finishes. The picture is loaded 
as a background into PREMIER+™ 2 Create.

This option is only available when starting the ExpressDesign 
Wizard with File, New , or File, New Window .

Load Existing Design
Open an existing design to preview it in the wizard, then close the 
wizard and load the design in PREMIER+™ 2 Create. The Design 
window of PREMIER+™ 2 Create is shown.

This option is only available when starting the ExpressDesign 
Wizard with File, New , or File, New Window .

Start a New Design with no Picture
Select the Draw or Paint window, or no background. Select a hoop, 
then close the ExpressDesign Wizard and start with a blank work 
area in PREMIER+™ 2 Create.

A new blank picture is automatically created at a size of the selected 
hoop.

This option is only available when starting the ExpressDesign 
Wizard with File, New , or File, New Window .

Use this option if you wish to create your own picture or load and edit an existing picture without reducing 
colors. Then either send the picture to the ExpressDesign Wizard from the Paint or Draw window, or create 
and adjust stitch areas over the picture in the Design window.
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Choose Picture

Use the Choose Picture page to select the picture you wish to convert to a design. Select a 
picture from clipart, or one you have previously scanned or created in an image editor. 
Alternatively, paste a captured picture.

Load a Picture
Click Load a Picture  to open a picture from clipart, or one you have previously scanned 
or created in an image editor. After selecting a picture, the preview box will show the 
selected picture with its name underneath. Click Next to continue.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
Image File Format uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

PREMIER+™ 2 Embroidery Extra also includes additional clipart, which may be used in the 
ExpressDesign Wizard. The additional clipart is installed to 
Documents\Premier+2\Samples\Premier+2Emb\Pics2.

Select a picture file on
your computer

Paste a copied picture

Import a file from a
scanner or camera

The picture is previewed

Load a picture from Facebook®, 
Instagram®, Flickr®, or Twitter®

Choose a picture folder

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture



106          PREMIER+™ 2 Create   ExpressDesign Wizard 

Select a Picture file
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 Click on a picture to select it.
4 Click OK to open the picture in the Choose Picture page.
5 Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture  to load the picture in the Clipboard Block. The picture is shown in the 
preview area.

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s 
scanning or downloading program to another program, in this case the PREMIER+™ 2 Create module of 
the PREMIER+™ 2 Embroidery System. If the manufacturer provides the appropriate software components 
needed for WIA compliance, these should have been installed when the device was installed.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the Picture, it will be shown 
in the Choose Picture page.

Social Media Picture
Load a picture from Facebook® , Instagram® , Flickr® , or Twitter® . Log in to the 
Social Media website to load the desired picture.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Back
Return to the Choose Design Type page.

Next
Go to the Rotate and Crop Picture page, or to the Design Size page when loading a vector 
picture into the Draw window.

Finish
For loading a background picture into the Draw window, close the ExpressDesign Wizard 
and load the picture onto the main screen.
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Rotate and Crop Picture

Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the design, and to rotate the picture to any angle from 0 to 359 degrees. The 
picture is automatically cropped to remove excess background color. If required, adjust 
the crop lines to select the desired part of the picture.  Use Perspective Correction to 
adjust for perspective or skew.

Sometimes, the automatic crop area may not appear to remove as much background color as possible. 
This can happen when the background color appears to be a plain color, such as white, but actually has 
minor variations that are not immediately visible. For example, this often happens with the JPEG-JFIF 
Compliant (*.jpg, .jif, .jpeg) picture format.
Click and drag anywhere inside the crop box to move the crop box. Click and drag outside 
the crop box to draw a new crop box.

Rotate
Rotate the picture to any angle from 0 to 359 degrees. When the picture is rotated 
between the 90 degree steps, the picture is made larger and the detected background 
color is added. If there is no distinctive background color, white is used.

Select All
Click the Select All button to select the whole picture. Alternatively, double-click the 
picture to select the whole picture.

Reset
Click Reset to set the crop lines back to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Change the angle of the picture

Zoom in and out

Select the whole picture or 

Adjust the crop lines as desired

use the default crop settings

Correct the perspective in the picture Save the edited picture
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Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Choose Picture page.

Next
Go to the:

• Design Size page for an Express Embroidery, and when loading a picture into the Paint 
window

• Outline Finder and Expander page for an Express Trace
• Monochrome Threshold page for an Express Border.
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Outline Finder and Expander

The Outline Finder and Expander page of the ExpressDesign Wizard only appears if you 
are creating an Express Trace design. If the picture consists of mainly solid color areas, use 
this page to create outlines appropriate for tracing.

Find Outlines
Select this option to find the outlines in your picture and show them in the preview area.

Find Outlines looks for distinctive boundaries between color areas in the picture. Pictures that have 
gradual color changes, such as photographs or previously scanned pictures saved in JPEG format, may not 
have strong color boundaries that can be detected by Find Outlines.
It is usually not necessary to Find Outlines in a picture that already has black outlining. 
However, if there are additional color boundaries that do not have outlining in the picture, 
you may still wish to use Find Outlines.

Expand
This is only available when Find Outlines is selected. Use this option to increase the 
thickness of outlines that have been found, by adding up to 5 pixels on each side of the 
lines. It is initially set to 1. Lines are traced down the center by Express Trace, so setting 
Expand to at least 1 will allow curves to be traced more smoothly and continuously.

If Expand is set to 0 (zero), the outlines found in the picture will be only one pixel wide. When a line changes 
direction, this may cause a break in the line where pixels only meet at the corner. This may cause a line to 
be traced in multiple sections, or not at all. Therefore, it is recommended to set Expand to at least 1.
If desired, use higher Expand values to merge outlines when parallel outlines are close 
together. Alternatively, you may be able to exclude unwanted lines by using Monochrome 
Threshold on the next page.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 

Find the outline in the picture

Increase the thickness of the line

Preview your changes



110          PREMIER+™ 2 Create   ExpressDesign Wizard 

or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Preview
The preview shows the picture. If Find Outlines is selected, the preview shows the outlines 
that have been found, and the effect of using Expand.

Back
Return to the Rotate and Crop Picture page.

Next
Go to the Monochrome Threshold page.
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Monochrome Threshold

The Monochrome Threshold page of the ExpressDesign Wizard appears if you are creating 
an Express Trace or Express Border design.

The Monochrome Threshold turns all shades or colors in the picture into either black or 
white. It acts on the whole picture. The Monochrome Threshold creates defined areas that 
are suitable for creating the final designs.

Interior details, within enclosed shapes in the picture, will not be preserved when creating Express Border.
Move the Monochrome Threshold slider bar to the desired setting, or enter a value directly 
in the box, then click Next.

Adjust the Monochrome Threshold between 0 and 255 by typing in a number, clicking on 
the left or right of the slider bar or by clicking and dragging the slider bar. To make more of 
the image black, move the slider to the right or type a higher number in the box. To make 
more of the image white, move the slider to the left or type a lower number in the box.

Original Picture
The thumbnail on the left shows the original picture. This allows you to see which colors in 
the picture have been turned black or white.

Preview
The preview picture shows the result of applying the Monochrome Threshold.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Adjust the color sensitivity

Original picture

Preview monochrome version
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Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Rotate and Crop Picture page for an Express Border design, or to the Outline 
Finder and Expander page for an Express Trace.

Next
Go to the Design Size page.
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Design Size

The Design Size page only appears when creating a new design, from New or New 
Window.

To specify the design size, either select Fit Design to Hoop to ensure the design fits the 
desired hoop, or choose Enter Design Size to specify the width or height of the design.

Fit Design to Hoop
The current hoop name and hoop size are shown, with a thumbnail of the hoop. The 
selected hoop is remembered, next time you use the ExpressDesign Wizard.

Click Change Hoop to choose a different hoop in the Hoop Selection dialog box. The new 
design will be a best fit to the selected hoop and orientation.

Fit the design to the hoop
Enter a size for the design

Preview the hoop

Select a different hoop

Set the size of the design

Select the hoop size Choose a machine or hoop group

Enter a size for a custom hoop Select the hoop orientation

Add the hoop
to My Hoops
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Hoop Group
The drop-down list of Hoop Groups shows all the machine Hoop Groups, and the My 
Hoops group, if used.

Hoop Size
The drop-down Hoop Size list shows the hoops in the chosen Hoop Group. Select the 
desired hoop size and a picture of the hoop will be shown in the Preview.

Included in My Hoops
Select (check) Included in My Hoops to add the selected hoop to the My Hoops list. Use 
the My Hoops list to create a list of your favorite hoops.

The selected hoops will be displayed in the My Hoops group in the order that they were selected.

Orientation
Select Natural or Rotated orientation according to the shape of the embroidery that is to 
fit in the hoop. Natural orientation is similar to the way the hoop would appear when you 
sit in front of your machine; note the position of the bracket.

It is recomended to use natural hoop orientation for designs with Twin Needle colors.

Enter Size
To enter a hoop size that is not listed in any of the Hoop Groups, click the Enter Hoop Size 
box so that it is selected (checked). The Width and Height boxes will become available. 
You can enter any size from 10mm to 4000mm. The preview shows the shape of the hoop 
you enter.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.

Enter Design Size
Select the dimension you wish to set (the Width or Height of the design), usually the 
longest side, then enter the size of the design.

Enter Design Size is not available if one of the Start a New Design with no Picture options was selected in 
the Choose Design Type page.

Back
Return to the:

• Rotate and Crop Picture page for an Express Embroidery and when loading a picture 
into the Paint window

• Monochrome Threshold page for an Express Trace or Express Border
• Choose Picture page when loading a vector picture into the Draw window
• Select Background Type page when starting a new design with no picture.

Next
Go to the:

• Choose Thread Colors Page for an Express Embroidery
• Express Trace Options or Express Border Options for those design types
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• Reduce Colors Page for loading a picture into the Paint window

Finish
For Start a New Design with No Picture, and for Load a Vector Picture as Objects into the 
Draw Window, close the ExpressDesign Wizard and open the main screen.
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Express Embroidery Options
There are two wizard pages used to set additional options for creating an Express 
Embroidery.

Choose Thread Colors

The Choose Thread Colors page of the ExpressDesign Wizard only appears when you are 
creating an Express Embroidery. Use the Choose Thread Colors page to match thread 
colors to colors in the picture, to set the number of colors, and to choose the color order. 
Select whether or not to keep the background and, if desired, pick a different background 
color. Optionally, choose whether or not to expand thin lines and set the sensitivity to 
small areas in the picture.

Color Selection

Number of Colors
The Number of Colors is initially set to the Recommended number of colors. The 
ExpressDesign Wizard determines the optimal number of colors for converting the picture 
into thread colors. When this number is changed, the list of colors and the preview are 
updated.

The maximum Number of Colors is 256. For pictures with less than 256 colors, the 
maximum is the total number of colors in the picture.

The total number of colors in photographs and other complex color pictures may be shown as 256+. This 
may mean that there are a lot of small color areas in the picture. This can also happen with clipart in JPEG-
JFIF Compliant (.jpg, .jif, .jpeg) format, as this format introduces minor color variations that may not be 
visible.

Apply
Click Apply to recalculate the threads with the new number of colors.

Select a Thread Range

Delete all colors

Move colors up & down the list
Change a thread color

Remove the background color

Choose a color from the picture

Zoom in and out

Choose a thread

Delete a color

Return to the original color list

Pick a background color from the picture
Enhance detail in the picture

Set the number of colors
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Reset
Use Reset to return the color list to the initial set of colors. The colors are also re-ordered 
from light to dark. The colors in the picture will be matched to thread colors from the 
thread range shown in the Change All To box. Any custom thread matches that are 
required must be re-selected with Change Thread.

Change All To
Click the drop-down arrow to choose a different thread range. When a thread range is 
chosen, each picture color in the list will be assigned the nearest matching thread color 
from the chosen thread range.

When a new thread range is chosen, all custom thread matches set by Change Thread will be lost.

Picture and Thread Color List
The color list shows the colors that have been automatically selected. The colors are 
picked to give the closest representation of the original picture with the current Number 
of Colors. Each time the number of colors is changed, this list is updated.

Sometimes, when the Number of Colors is reduced to a low number, colors will be chosen that are averages 
of two or more prominent colors in the picture. This can give a posterized appearance to the Reduced 
Colors Preview. If this effect is not desired, increase the Number of Colors.
The list shows a sample of each color currently selected from the picture. Initially, the 
colors are shown from light to dark, with each picture color automatically matched to a 
thread color from the thread range shown in Change All To. The color order can be 
changed. This affects the order that colors are used in the final design.

The basic color order is set by this list. However, the order for stitch types is satin, then fill, then outlines 
(running stitch or satin border). Hence, if black is moved so that it is first in this list, it will still be last in the 
final design if it is only used for outlining.
The same thread color may be matched to two or more colors in the picture. Each thread 
color can be individually changed with Change Thread. When thread colors are changed 
in the list, the Thread Color Preview is updated.

When more than one color in the picture is matched to the same thread color, the number of color changes 
in the final embroidery is reduced.

Move Up and Move Down
Use Move Up and Move Down to change the order of colors in the list.

Change Thread
Click a color in the list, then click the Change Thread button. The Color Selection dialog 
box will appear so that a different thread color can be chosen. Alternatively, double-click a 
color in the list and the Color Selection dialog box will appear.

It is recommended only to use Change Thread after the main thread range has been selected.

Pick
Click Pick to add thread colors to the list by clicking the desired colors in the Source 
Picture.
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When Pick is selected, the pointer changes to an eyedropper  over the source picture. 
Click the picture to pick up the color under the tip of the eyedropper, and the nearest 
matching thread color from the selected Thread Range will be automatically selected and 
added to the thread color list. The Thread Color Preview will be updated to show any other 
areas that can use the selected thread color.

The thread color is picked for the clicked color according to the RGB (red, green, blue) value at the point 
clicked. If there is already a thread color assigned to that exact RGB value, it will be highlighted in the list 
instead of adding a thread color to the list.

Delete
Delete the picture color currently highlighted in the list. The deleted color is replaced with 
the nearest remaining picture color in the list. The Thread Color Preview is re-displayed, 
with the reduced set of thread colors.

Delete All
Click Delete All to remove all the thread colors from the list if you wish to use Pick to 
choose colors from the Source Picture.

Background Color
The background color is automatically determined. It is the color which is used the most 
along the edges of the picture. If desired, select a different background color.

Current Background Color
The large color square shows the current background color.

Pick Background Color
Click Pick Background Color  to choose a different color from the Source Picture as the 
background color. When Pick Background Color is selected, the pointer changes to an 
eyedropper  over the source picture. Click the picture to pick up the color under the tip 
of the eyedropper. The sample of the current background will change. Depending on the 
choice for Automatically Remove Background Color, the Thread Color Preview may show 
the effect of removing the selected color.

Automatically Remove Background Color
When this is selected, the Thread Color Preview will show any areas that will be removed 
as a checkerboard pattern.

When removing the background color, choose between:

• Remove main background only
Any areas of the background color that are connected to the edges of the picture will 
not be used in the final design. Use this option when there are significant design 
elements in the background color within the design.

• Remove all background color areas
Any areas of the background color will not be used in the final design. Use this option 
when the background shows through gaps in the composition. Also choose this if you 
wish to remove a background color that is not connected to the edges of the picture.
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Removing Multiple Background Colors
Some pictures may have more than one background color, even after color reduction. To 
remove additional unwanted background colors, change the thread color so that all the 
background colors use the same thread color.

If the thread color used for the background color is the same as for a color area that you wish to keep, 
change the background thread color to a 'false color' that is not needed for this design.

Picture Options
Click the Picture Options button to see the Picture Options dialog box, which is used to set 
the Black Lines option and set the Area Sensitivity.

Black Lines
There are three options for handling black lines in your picture. Expand Pixel-Thin Lines is 
chosen by default.

Select No Change if you feel that outlines in the picture do not need to be expanded or 
reduced.

Select Expand Pixel-Thin Lines to make black lines thicker, to prevent broken lines where 
pixels join at corners. This option is on by default, to ensure that outlines in the picture are 
continuous.

Select Reduce Thick Lines if your picture has very heavy outlines, and you prefer to have 
markout stitching in your picture rather than satin outlines.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture 
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the 
ExpressDesign Wizard is used.

Use High sensitivity to increase the detail extracted from the picture. This is useful, for 
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to 
decrease the detail extracted from the picture. This is useful, for example, when unwanted 
details are retained in the design at Medium.

Previews

Source Picture
This shows the original picture, after being rotated and cropped, in full color.

Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This 
gives an approximate indication of where thread blocks will be in the final design.

If variegated threads have been selected, only the first color is shown in the preview.

Zoom
Use the Zoom functions to change the view of the picture. The same area of the picture is 
shown in both previews when the zoom level is changed.
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Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Design Size page.

Next
Go to the Fabric and Stitch Type Options page.
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Fabric and Stitch Type Options

The Fabric and Stitch Type Options page of the ExpressDesign Wizard only appears when 
you are creating an Express Embroidery. Use the Fabric and Stitch Type page to choose the 
typical fabric that the design will be stitched onto, and the preference for fill areas or satin 
areas.

Fabric Advisor

Fabric
Choose the fabric on which the design will be stitched. Adjustments are made in the 
embroidery creation process to suit the chosen fabric, such as the type of underlay chosen 
for individual areas of satin or fill.

Design Underlay
Choose Design Underlay to provide stitching below the whole embroidery, in addition to 
automatic underlay in different areas.

When Design Underlay is turned off it is easier to convert pattern fill areas to lightly stitched specialty fills.

Preferred Stitch Type
This affects whether areas are likely to be created as satin or fill. If you prefer satin, move 
the slider to the right. If you prefer fill, move the slider to the left. The design size also 
influences whether areas are created as satin or fill, as this affects the size of individual 
areas.

To see the effect of different options, click Refresh Preview to regenerate the design.

Refresh Preview
Refresh the preview with your new settings.

If a change is made to the options, you must click Refresh Preview before you can click Finish.

Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 

Choose a fabric type

Add underlay to the design

Create more satin or
more fill areas

View the design information

Preview the embroidery

Place on the work area
Make further edits
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change when the embroidery is exported, depending on the Optimize for Sewing 
Options.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This 
allows you to view and check the final design before closing the ExpressDesign Wizard.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the ExpressDesign Wizard.

If a change is made to the options, you must click Refresh Preview before you can click Finish.
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Express Trace Options

The Express Trace Options page of the ExpressDesign Wizard only appears if you are 
creating an Express Trace design. Select whether lines in the picture will be traced with 
light running stitch, heavy running stitch or constant width satin. Also select the thread 
color.

Trace Method

Double Trace 
Trace the picture with Double Stitch where possible, with a layer of Running Stitch where 
necessary.

Quadruple Trace 
Trace the picture with Triple Stitch where possible, with an additional layer of Running 
Stitch where necessary.

Satin Line Trace 
Trace the picture with satin line, using the same width and density for the satin line 
throughout.

Stitch Options
Click the Stitch Options button to see the options for the selected QuickTrace Method.

• If Double Trace or Quadruple Trace are selected the Trace Options dialog box is 
displayed.

• If Satin Line Trace is selected the Satin Line dialog box is displayed. See “Satin Line” on 
page 325.

Trace Options
Use the Trace Options dialog box to set the Stitch Length of the running stitch to use for 
Double Trace and Quadruple Trace, from 1 to 12mm in steps of 0.1mm. The initial setting is 
2mm.

Choose a stitch line type

Set the properties for the line

Select the thread color

Enhance detail in the picture

View the design information
Place on the work area
Make further edits

Preview the embroidery
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Thread Color
Set the Thread Color for the stitches. Click the Color Change button  to choose a 
different color in the Color Selection dialog box. The thread sample is updated with the 
selected color.

Picture Options
Click the Picture Options button to see the Picture Options dialog, which is used to set the 
Area Sensitivity.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture 
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the 
ExpressDesign Wizard is used.

Use High sensitivity to increase the detail extracted from the picture. This is useful, for 
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to 
decrease the detail extracted from the picture. This is useful, for example, when unwanted 
details are retained in the design at Medium sensitivity.

Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 
change when the embroidery is exported, depending on the Optimize for Sewing 
Options.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Preview
The preview shows the lines in the picture that will be traced. If desired, use the Zoom 
controls to change the view of the preview.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify 
settings before previewing the design again.
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Finish
Accept the final design and close the ExpressDesign Wizard.
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Express Border Options

The Express Border Options page of the ExpressDesign Wizard only appears if you are 
creating an Express Border design. Use the Border Options to select the type of stitching 
used for the borders, appliqué settings, and to choose the thread color.

Border Type
Select the type of border to create around areas of the picture from one of the following:

■ Satin Line : see “Satin Line” on page 325.

■ Running Stitch : see “Running Stitch” on page 317.

■ Double Stitch : see “Double Stitch” on page 319.

■ Triple Stitch : see “Triple Stitch” on page 323.

■ Motif Line : see “Motif Line” on page 326.

When Appliqué is selected, the preview shows where the appliqué fabric should be placed.

Stitch Options
After selecting the type of border, click the Stitch Options button to show the properties 
for that border type. If desired, adjust the properties and click OK.

Appliqué
Select Appliqué  to use appliqué within the borders of the design.

■ Click Select Fabric to change the appliqué fabric. See “Appliqué Selection” on page 186.
■ Click Appliqué Options to select the appliqué type. See “Appliqué Options” on page 128.

When Appliqué is selected, the preview shows where the appliqué fabric should be placed.

Thread Color
Set the Thread Color for the stitches. Click the Color Change button  to choose a 
different color in the Color Selection dialog box. The thread sample is updated with the 
selected color.

Choose a stitch type 
for the border
Set the properties for the border

Select the thread color

Enhance detail in the picture

View the design information
Place on the work area
Make further edits

Add appliqué to the design
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Picture Options
Click the Picture Options button to see the Picture Options dialog, which is used to set the 
Area Sensitivity.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture 
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the 
ExpressDesign Wizard is used.

Use High sensitivity to increase the detail extracted from the picture. This is useful, for 
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to 
decrease the detail extracted from the picture. This is useful, for example, when unwanted 
details are retained in the design at Medium sensitivity.

Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 
change when the embroidery is exported, depending on the Optimize for Sewing 
Options.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Preview
The preview shows where the borders will be created. It allows you to view and check the 
final design before closing the ExpressDesign Wizard.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the ExpressDesign Wizard.
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Appliqué Options
Select the appliqué method, and set the appliqué piece margin.

Appliqué Method
When appliqué is created, additional stitches are added at the beginning of the appliqué 
piece for placing the appliqué fabric. Use these options to determine how these stitches 
are added.

Select the appliqué method before or after creating an area or line. Choose from:

• None
• Standard Appliqué
• Pre-cut Piece
• Pre-placed Piece
• Cut-out

Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to 
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the 
fabric may be trimmed. Finish the edges with the selected border stitching.

Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork 
needles.

Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.

Pre-placed Piece
Place the appliqué fabric before stitching.

Place the appliqué layer in position, then stitch down the appliqué fabric with double 
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border 
stitching.
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Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example 
for reverse appliqué.

Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the 
stitched outline. Finish the edges with the selected border stitching.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.
Placement stitches are set to 2.0mm initially. To alter the stitch length for individual lines, use the Break 
Apart function for the area.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.
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Reduce Colors

The Reduce Colors page of the ExpressDesign Wizard appears if you are loading a picture 
for a new design into the Paint window. 

Use the Reduce Colors page to reduce the number of colors in the picture. This helps 
reduce the number of colors, or 'flatten' some complex areas of color, to make the picture 
easier to use with QuickStitch™ and QuickTrace features.

To load a picture without reducing the number of colors, use Insert Picture  or Open Picture  on the 
File menu for the Paint tab. See “Insert Picture” on page 373 and “Open Picture” on page 374.

Color Selection

Number of Colors
The Number of Colors is initially set to the Recommended number of colors. When this 
number is changed, the list of colors and the preview are updated.

The maximum Number of Colors is 256. For pictures with less than 256 colors, the 
maximum is the total number of colors in the picture.

Recommended
The ExpressDesign Wizard determines the optimal number of colors for the picture. This 
optimal number is shown as the Recommended number of colors, out of the total number 
of colors.

The total number of colors in photographs and other complex color pictures may be shown as 256+. This 
may mean that there are a lot of small color areas in the picture. This can also happen with clipart in JPEG-
JFIF Compliant (.jpg, .jif, .jpeg) format, as this format introduces minor color variations that may not be 
visible.

Automatically Picked Colors
The color list shows the colors that have been automatically selected. The colors are 
picked to give the closest representation of the original picture with the current Number 
of Colors. Each time the number of colors is changed, this list is updated.

Set the number of colors

Zoom in and out

Preview the color changes
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Sometimes, when the Number of Colors is reduced from the Recommended number, 
colors will be picked that are averages of two or more prominent colors in the picture. This 
will give a posterized appearance to the Reduced Colors Preview. If this effect is not 
desired, increase the Number of Colors.

Previews

Source Picture
This shows the original picture, after being rotated and cropped, in full color.

Reduced Colors Preview
This shows the picture with the reduced set of colors.

If you do not like the way graduated color areas are split into flatter color areas, even after adjusting the 

Number of Colors, click Cancel. Use Open Picture  in the Paint window to open the picture and edit the 

picture as desired. Save the edited picture it with a new name with Save As Picture .

If you wanted to create an Express Embroidery from the picture, use Send To Wizard  to open the edited 
picture directly into the ExpressDesign Wizard. If you wanted to open the picture in the ExpressDesign 

Wizard to create a new design, click File, New  then open the newly saved picture on the Choose Picture 
page of the wizard.

Zoom
Use the Zoom functions to change the view of the picture. The same area of the picture is 
shown in both previews when the zoom level is changed.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Rotate and Crop Picture page.

Finish
Close the ExpressDesign Wizard and load the final picture onto the main screen.
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Open Existing Design
This page only appears if you choose the Load Existing Design option on the first page of 
the ExpressDesign Wizard.

Load a Design
Click the Load a Design  icon. The Open dialog box will appear. After selecting a design, 
the preview box will show the selected design with its name underneath. Click Next to 
continue.

Preview
The preview area shows the objects in the selected design, with the name of the design 
underneath.

Back
Return to the Choose Design Type page.

Finish
Close the ExpressDesign Wizard and load the chosen design on the main screen.

Select a design file on
your computer

The design is previewed

Click Open to load the 

Browse to a different folder

Click on a design to select it

Search for a design

Change the view or icon size

selected design

Hover to view the selected 
design’s details



PREMIER+™ 2 Create   ExpressDesign Wizard              133

Select Background Type
This page only appears if you choose the Start a New Design with no Picture option on the 
first page of the ExpressDesign Wizard.

Draw Window
Create a new design by drawing a vector picture. Select a hoop or 
design size. The wizard then finishes and the Draw window is 
displayed.

Paint Window
Create a new design by painting a raster picture. Select a hoop or 
design size. The wizard then finishes and the Paint window is 
displayed.

No Background
Create a new design with fills and lines on the Design window. 
Select a hoop or design size. The wizard then finishes and the 
Design window is displayed. The Draw window is also available.

Create a design by drawing 
a vector picture
Create a design by painting
a raster picture
Create a design with fills and
lines on the design window
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Using the ExpressDesign Wizard
Create a Petal Design with the ExpressDesign Wizard

1 Click File, New , or File, New Window  and the Choose Design Type page of the ExpressDesign 
Wizard will appear.

2 Leave Create Express Embroidery selected 
and click Next. The Choose Picture page will 
appear.

3 Click Load a Picture  and the viewer will 
appear.

4 In the Picture Viewer, browse to 
Documents\Premier+2\Samples\Create 
\Pics. The pictures in the folder will be 
shown.
If you position the arrow pointer over a 
thumbnail without clicking, the name of the 
picture will be shown. The picture is called 
'Petals.wmf'. Alternatively, select an icon 
display that shows the names.

5 Click the 'Petals.wmf' thumbnail, 
and then click OK. The picture is 
loaded onto the Choose Picture 
page, with its name shown 
below the preview area.

6 Click Next and the Rotate and 
Crop Picture page will appear.
Notice that the picture has no 
background color yet. This is 
because pictures in Windows 
Meta File (wmf) format can have 
an empty background. However, 
after the picture is cropped, white 
is used by the ExpressDesign 
Wizard to replace empty areas. 

When white thread is not desired in the background of an Express Embroidery, it may be removed on the 
Choose Thread Colors page. The white background is ignored by Express Trace and Express Border.

7 No adjustment of the crop area is required, so click Next and the Design Size page will appear.
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8 In Design Size, select Fit Design To Hoop.
9 Click Change Hoop and the Hoop Selection dialog box appears.
10 Under Enter Size, ensure that Enter Hoop size is not selected (checked).
11 Select the Universal Hoop Group, then set Hoop Size to 240mm x 150mm - Universal Large Hoop 2. 

Ensure the Orientation is Rotated, and click OK. The chosen hoop is previewed.
12 Click Next and the Choose 

Thread Colors page will appear. 
Notice that all 5 of the 5 possible 
colors have been automatically 
picked.

13 If the thread range in the 
Change All To box is not set to 
Robison-Anton Rayon 40, click 
the drop-down arrow at the end 
and select Robison-Anton Rayon 
40.

14 Under Background Color, the 
large white square shows that 
white is the detected 
background color. The white 
background is not required, so 
ensure Automatically Remove 
Background Color is selected. A 
check pattern in the Thread Color Preview shows where there will be no stitches.

15 Click Next. Stitches will be 
created, then the Fabric and 
Stitch Type Options page will 
appear.

16 Ensure that the Fabric is set to 
Woven.
Notice that the design is 
previewed on the selected fabric. 
This may differ from the fabric 
selected in PREMIER+™ 2 
Configure, but the background 
color chosen in PREMIER+™ 2 
Configure is always used.

17 Ensure the Design Underlay 
option is turned off and leave 
the Preferred Stitch Type slider 
all the way to the left.
Some of the petals will be 
changed to lightly stitched fill patterns that would reveal the underlay if it is left on.

18 Click Finish and the final design and its picture are shown on the work area.
19 Click the Edit button  next to the Notes box on the Design Panel.
20 In the Notes dialog box enter 'Floral'.
21 Use the quick keyword selector to add the keywords ’Flowers and Gardens’. Then click OK.

Notes entered for the design will also be saved in the embroidery when it is exported in .vp4 format. Notes 
are used to search for embroideries by key words in Windows® Explorer.

22 Click Save  and browse to the folder Documents\Premier+2\My Designs.
23 Change the File name to 'PetalsBasicFill' and click Save.

This saves your project as a design file in .edo format.
Use this design to create a variety of filled petals. See:

■ Pattern Fill Petals: “Change a Fill Area to a Leaf Pattern” on page 235, “Create a Single Color 
Gradient Fill in a Petal” on page 239 and “Use a Bee for a My Fill Pattern” on page 287.
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■ Density Effect Petals: “Fill a Petal with a Multicolor Gradient Density Fill” on page 241, “Use 
a Radial Fill in a Petal” on page 255 and “Fill a Petal with a Spiral Fill with Gradient Density” 
on page 259.

■ Shape Fill Petals: “Use Shape Fills in Three Petals” on page 253.
■ Motif Line and Fill Petals: “Use Motif Fills in Two Petals” on page 247 and “Create a Flower 

with Motif Lines” on page 329.

Create Appliqué Areas with Express Border
1 Click New  or File, New 

Window. The Choose Design 
Type page of the 
ExpressDesign Wizard will 
appear.

2 Click Create Express Border .
3 Click Next and the Choose 

Picture page will appear.
4 Click Load a Picture . In 

Documents\Premier+2 
\Samples\Create\Pics, click the 
'Petals.wmf' thumbnail, then 
click OK. The picture will be 
loaded onto the Choose Picture 
page.

5 Click Next and the Rotate and 
Crop Picture page will appear.

6 No rotation or adjustment of 
crop lines is required, so click 
Next and the Monochrome 
Threshold page will appear.
Only the thick outlines are dark 
enough to show at the default 
Monochrome Threshold. They 
make three fully enclosed shapes 
that will become solid shapes 
later in the ExpressDesign 
Wizard.
Move the slider to view which 
parts of the picture are selected 
at different Monochrome 
Threshold levels, then return the 
slider to its original position.

7 Click Next and the Design Size 
page will appear.

8 Select Fit Design To Hoop. 
9 Click Change Hoop, and in the Hoop Selection dialog box, 

select 240mm x 150mm - Universal Large Hoop 2 with 
Rotated Orientation.

10 Click Next. The picture will be processed and the Express 
Border Options page will appear.

11 In Border Type, ensure that Satin Line  is selected.
12 Click Stitch Options.
13 In the Satin Line dialog box set Width to 4.0mm, and ensure 

that Underlay is selected (checked). 
14 Click OK to close the Satin Line dialog box.
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15 Ensure that Appliqué  is selected. The preview shows 
the areas where appliqué fabric will be stitched.

16 Click Appliqué Options and the Appliqué Options dialog 
box will appear.

17 Ensure that Standard Appliqué is selected.
18 Click OK.
19 Click the Thread Color icon  and the Color Selection 

dialog box will appear.
20 Ensure the Thread Range is set to Robison-Anton Rayon 40. 

Type 2275 in the Find Thread box to select 2275 (Slate 
Blue).
This matches the border color that was automatically selected for the Express Embroidery in “Create a 
Petal Design with the ExpressDesign Wizard” on page 134.

21 Click OK. The border lines in the 
preview are updated to show 
the new thread color.

22 Click Finish. The new design is 
shown on the work area.
Notice that the petals in the 
background picture are solid 
areas of color, indicating it is an 
appliqué section.

23 In the Design Panel, click the 
Edit button  next to the 
Notes box.

24 In the Notes dialog box enter 
'Floral'.

25 Use the quick keyword selector 
to add the keywords ’Flowers 
and Gardens’. Then click OK.

26 Click Save . Browse to the 
folder Documents\Premier+2\My Designs. Change the File name to 'PetalsBasicApplique' and click 
Save to save the design as an .edo file.
Use this design to create a variety of appliqué petals. See:

■ PetalsAppliqué1: “Change Satin Line to Motif Line in an Appliqué Petal” on page 332 and 
“Insert QuiltStipple Fill in a Petal” on page 262.

■ PetalsAppliqué2: “Change Satin Line to Picot Motif Line” on page 333, “Insert Motif Fill in 
an Appliqué Petal” on page 248 and “Create a Contour Fill Flower” on page 264.
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Load PetalsBasicApplique in the ExpressDesign Wizard
1 Click File, New , or File, New Window  and the Choose Design Type page of the ExpressDesign 

Wizard will appear.
2 Select the Load Existing Design 

option.
3 Click Next and the Open 

Existing Design page will 
appear.

4 Click Load a Design .
5 In the Viewer dialog box, click 

the browse folder icon with 
three dots .

6 Browse to the folder 
Documents\Premier+2\Sample
s\Create \Edo.
Alternatively, use the file you 
created in “Create Appliqué 
Areas with Express Border” on 
page 136.

7 Click OK and the designs in the 
folder will be shown.

8 Click the 'PetalsBasicApplique' 
thumbnail. The viewer will 
close and the design will be 
loaded onto the preview area.
The full name of the design is 
shown, it is called 
'PetalsBasicApplique.edo'.

9 Click Finish and the design will 
be loaded onto the work area.
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Load a Fleur de Lys as a Picture in the Draw Window
1 In the Quick Access toolbar, click Change Hoop  and the Hoop Selection dialog box appears.
2 Ensure that Enter Hoop Size is not selected.
3 Ensure the Hoop Group is set to Universal. Click the drop-down arrow for Hoop Size and select 

100mm x 100mm - Universal Square Hoop 1. Click OK.
4 Click the View tab, and ensure that Grid size is set to 5mm.
5 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 

Before and After Trims is selected.
6 Click File, New , or File, New Window  and the Choose Design Type page of the ExpressDesign 

Wizard will appear.
7 Click Load a Vector Picture as 

Objects into the Draw Window, 
then click Next.

8 Click Load a Picture  and the 
viewer will appear.

9 In the Picture Viewer dialog 
box, browse to 
Documents\Premier+2 
\Samples\Create\Pics.

10 Click to select 'Fleur de lys.wmf', 
then click OK The picture will 
be loaded onto the Choose 
Picture page, with its name 
shown below the preview area.

11 Click Next and the Design Size 
page will appear.

12 Click Enter Design Size.
13 Change the Size to 90mm and 

click Width.
14 Click Finish. The picture will be 

shown on the work area.
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7Viewing Pictures and Designs
Use the View tab to set how you view the design, background picture, and hoop.

View Mode
Use View Mode to switch between 3D , 2D , and Object  representation of 
stitches. 3D View  shows how the embroidery will be stitched out with three-
dimensional shading. 2D View  shows the individual stitches with no shading. Stitches 
using multicolor threads are drawn using only the first color. Object View  shows the 
outline of the objects in the design.

3D View
3D View  shows how the embroidery will be stitched out with three-dimensional 
shading.

Shortcuts
■ View Tab, View Mode: 
■ Keys: Ctrl + T; Alt, V, 3

2D View
2D View  shows individual stitches with no shading. Stitches using multicolor threads 
are drawn using only the first color. 

Shortcuts
■ View Tab, View Mode: 
■ Keys: Alt, V, 2

3D View 2D View Object View 

Show and adjust the grid Show and fade the background

Change the view mode

Choose a different hoop

View the Design Panel & FilmStripMeasure an object or design
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Object View
Object View  shows the outline of the objects in the design. 

Shortcuts
■ View Tab, View Mode: 
■ Keys: Ctrl + R; Alt, V, O

Show Grid
Use Show Grid  to turn the background grid on and off. The grid may be used to help 
align stitch objects and control points.

The grid size set in the Design window also affects the Paint and Draw windows.
The grid size is initially set to 10mm. Adjust its Size between 1 and 50mm, depending on 
what setting is most suitable for your screen resolution and designs. Type in a figure and 
press ENTER (or use the up and down arrows to change the number). Turn the background 
grid on or off using Show Grid.

The grid size is measured in pixels of the background picture, so the apparent grid size will vary according 
to the dimensions of the picture stored in a design.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, G

Snap To Grid
Use Snap to Grid  in the Draw tab to align objects to the Grid lines when they are drawn 
(Shapes, Polygon Draw) or moved. The grid is initially set at 10mm intervals.

Shortcuts
■ Keys: Ctrl + . ; Alt, D, N
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Background
Use the Background slider bar to show, fade or hide the background picture in the Design 
window. Change the view of the background picture to make it easier to see the stitch 
objects for the design.

The display of the picture in the Paint or Draw window is not affected by showing, fading or hiding the 
background picture in the Design window.

Design Panel
Use the Design Panel to view the design information, to view and change colors, to view 
and change the Notes and Settings, and to view the Clipboard and Overview window.

Use Background On  to show 
the picture in the background.

Use Fade  to show the picture 
in the background with the colors 

faded by 50%.

Use Background Off  to hide the 
picture. 

Check the design information

View and change the threads and effects for the design

Change a thread color
Show and hide secondary thread colors
Select the Notes or Settings information

View the contents of the Clipboard

Dual thread effect

Edit the Notes or Settings information
View the current window position in the work area

Puffy foam effect

Secondary thread colors for fills with borders, or color gradients
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Color Change and Pick Color
Use Color Change  and Pick Color  on the Create tabs, or Insert Color Change  in 
the FilmStrip to select a new thread color for the stitch objects you are about to add to the 
design. The first Color Change is initially set to medium blue. A Color Change command is 
shown by a small blue circle with a C .

To change an existing color, double-click the desired color in the color worksheet on the 
Design Panel, or select the color in the worksheet and click Change Color . 
Alternatively, right-click the color in the FilmStrip and select Properties. The Color 
Selection dialog box opens.

To delete a color change, select the Color Change in the FilmStrip or on the work area, 
then click the Delete icon , use the Delete key, or right-click in the FilmStrip and select 
Delete. The first Color Change in a design may not be deleted.

To insert a color, select the object after which the color change is desired, and click Color 
Change  on one of the Create tabs, or right-click in the FilmStrip and select Insert Color 
Change from the context menu. Alternatively, select Pick Color  and choose a color 
from the background picture.

Select a color from the Color Selection box that appears. You may choose any thread 
shade from the available thread manufacturers' palettes (for instance, Sulky Rayon 40 or 
Robison-Anton Cotton 50) or a thread you have added to MyThreads. Select colors by 
visual selection or by typing in a shade number. Alternatively you can choose a ’Quick 
Color’ Theme and then select one of the 32 Quick Colors. See “Quick Color Themes” on 
page 201. Optionally, add a thread or needle effect to the selected thread. Once the 
desired color is selected, click OK.

Extra design property colors for some objects can be set in the properties dialog for that 
object, for example multigradient fills and the border for a fill area. They then appear as 
secondary colors in the color worksheet, and can be adjusted from there. See “Secondary 
Colors” on page 149.
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Color Selection
The Color Selection dialog box appears when you click Add Color Change , right-click a 
color change marker , or right-click an object in the FilmStrip and select Insert Color 
Change. Alternatively, on the Design Panel select a color in the worksheet and click Color 
Change , or double-click a color in the color worksheet.

You may choose any thread shade from the available thread manufacturers' palettes (for 
instance, Robison-Anton Rayon 40 or Sulky Cotton 30) or a thread you have added to 
MyThreads. Select colors by visual selection or by typing in a shade number. Alternatively, 
click one of the Quick Colors to select the nearest matching thread color. Once the desired 
color is selected, click OK.

When you select a new thread color, the color worksheet will show the change and the 
work area will show the block of stitches in the new color.

To keep the full color information including thread shade numbers, export your 
embroideries as file type .vp4.

Using the Color Selection Dialog
1 On the Design Panel, select a thread color and click Color Change . Alternatively, on one of the 

Create tabs, click Color Change  or pick a Quick Color. Alternatively, click Pick Color , and the 
pointer changes to an eyedropper . Click the desired color area in the picture, and the Color 
Selection dialog box opens with the selected color displayed.
The Color Selection dialog box also appears when you double-click a color in the color worksheet, when 

you right-click with a color change marker  selected, or when you right-click a color in the FilmStrip and 
select Properties.

2 If required, change the thread range. Select the desired thread range from all thread ranges or only 
MyThreadRanges. The available shades for the thread range will be shown in the list.
The Abbreviation shows the reference used for the thread range when threads from that range are added 
to MyThreads.

3 Click a color in the list to select a thread shade visually. Use the scroll bar to browse through the list of 
threads.

4 If you know the shade number, click in the Find Thread box then type the required shade number.

Select a thread range

Show chosen thread ranges

Search for a thread number

Click a thread color
to select a thread

View the thread information

Click a Quick Color to select
a matching thread color

Choose a Quick Color Theme

Puffy Foam height

Twin needle gap
& second color

Second thread
color

Wing needle

Felting needle

Cutwork needle
angle



PREMIER+™ 2 Create   Viewing Pictures and Designs              145

5 Alternatively, choose a Quick Color Theme then click the desired Quick Color. The nearest shade that 
is available from the current thread range will be selected. This is also a quick way to jump to threads 
of that color (for example, click light yellow in the Standard Theme to jump to light yellow thread 
shades).

6 If desired, add a thread or needle effect. Then click OK to confirm the color selection. The dialog box 
closes, and your changes are displayed in the work area.

Effects
Use the Effects area of the Color Selection dialog box to show the results of using thread 
effects or special needles.

Only one thread effect can be used on any thread.
Choose an effect. If you choose Puffy Foam, set the foam height. If you choose Twin 
Needle, set the Twin Needle size. Click the color icon for the Second Color if you wish to 
use a different thread color. For Dual Thread, it is recommended to change the Second 
Color. For Twin Needle, this choice depends on the desired result. For Felting Needle select 
a color for the roving fiber for felting. For Cutwork Needle, choose the angle for your 
needles.

Puffy Foam
Use Puffy Foam to show the three-dimensional effect of stitching over embroidery foam.

Click the drop-down arrow and select the height of the puffy foam, between 2.0mm and 
6.0mm. The height is initially set to 3.0mm.

Dual Thread
Use Dual Thread to show the effects of stitching out two threads 
through the same needle. This is particularly suited to blending 
threads for special effects, such as mixing a rayon thread with a 
metallic thread, as in the center of the star.

Puffy Foam Show the effect of stitching over embroidery foam

Dual Thread Show the effect of using two threads in one needle

Twin Needle Show the effect of using a twin needle

Wing Needle Show the effect of using a wing needle for hemstitch or 
heirloom designs

Felting Needle Show the effect of using a felting needle with a roving fiber

Cutwork Needle Select a cutwork needle in one of four angles
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Twin Needle
Use Twin Needle to show the effect of stitching out the color 
block with a twin needle. This creates a horizontal offset between 
the original thread color in the left-hand needle, and a second 
thread color in the right-hand needle.

There are several ways that the Twin Needle effect can be used, 
including:

• Use with running stitch to create a ribbon effect, typically 
using the same thread color in both needles

• Use with a low density fill area to blend two different thread 
colors and also have a lightly shadowed effect

• Use with a dense fill area to create a shadow effect

It is recommended to use natural hoop orientation for designs with Twin 
Needle colors.

Twin Needle Size
This is only available if the Twin Needle effect is selected for the 
current color block. Click the drop-down arrow and select the 
size of the gap between the twin needles. This is initially set to 3.0mm.

Preview the effect of changing the twin needle size to help decide which needles to buy. 
Ensure that the desired size is recommended for embroidery on your machine.

Second Color
The second color is initially set to the same color as the original color block. Click the color 
change button  to choose a different thread for the second color. The Color Selection 
dialog box appears. Select the desired thread and click OK. The thread sample will change, 
and the thread range and thread number are shown.

Wing Needle
Use Wing Needle  to show the effect of stitching out the 
color block with a wing needle and the chosen thread. 

The wing needle creates holes in the fabric, for hemstitch and 
other heirloom techniques. 

To see the holes more than the stitch, use a fine thread such as Poly 60 
weight. To see the actual stitching, Rayon 40 weight is ideal.
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Felting Needle
Use Felting Needle  to show the effect of embellishing 
the selected color block using a felting needle and a 
contrasting roving fiber.

Choose a color for the roving fiber for the felting in the Color 
Selection dialog box. In projects without a roving fiber, 
choose a felting needle color similar to the back of the 
fabric.

If a system font or SuperDesign with Felting Needles is inserted, or if you 
select Felting Needle in PREMIER+™ 2 Create, the stitching will be 
adjusted using the settings in Preferences. By default, stitching using the Felting Needle color effect is 
broken up into very short stitches of 0.4mm. In other modules the effect is purely visual; for example, to see 
how felting will look in a pre-made design.
When Exporting an embroidery with a Felting Needle effect, the option "Flip design for felting or reverse 
embroidery" is initially selected in the Export dialog box. See “Export” on page 174.

Cutwork Needle
Use Cutwork Needle  to show the line that would be used by cutwork needles to 
automatically cut holes in your fabric areas, or create appliqué areas. Use cutwork needle 
lines for reverse appliqué embroideries and free-standing lace, or simply to cut out a 
shape or design.

Choose the cutting angle for the cutwork needle.

(When creating cutwork needle lines in PREMIER+™ 2 
Create or PREMIER+™ 2 Modify, or converting running lines 
to cutwork needle lines in any PREMIER+™ 2 module, you 
may use two needles, or for more precise work use four needles.)

Show and Hide Objects
Use the color worksheet in the Design Panel, and the Hide Object Types filter buttons in 
the Edit tab to show and hide the desired blocks of colors and object types in the design. 
You can also use the Draw Range slider bars on the Edit tab and the FilmStrip to change 
the view of the design.

Use any combination of color block display, object filters, draw range and FilmStrip 
options to hide objects. Hiding objects leaves the visible objects available for other 
functions without affecting the hidden objects. Use this to help when you need to select a 
particular set of objects that might be difficult to isolate directly with the Select functions. 
For example, you may wish to change the pattern in all fill areas of one type using Global 
Properties, or select a number of objects to copy them.
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Color Worksheet
The thread colors are shown 
in the color worksheet on 
the Design Panel, in the 
order in which they are 
used. 

The objects using a 
particular thread color are 
called a color block. The 
color worksheet can be used 
to change thread colors and 
to hide and show the 
objects in any of the color blocks. Displaying the objects according to their color is an easy 
method of showing sections of a design. The functions for viewing objects by color are on 
the Edit tab.

When you pause the arrow pointer over a thread color in the worksheet, the corresponding objects in the 
embroidery are highlighted. Also, a popup description of the thread color appears.
If you have set a Draw Range, then only the objects in the color blocks that are visible 
within the range will be displayed. Similarly, any objects hidden by object filters are 
hidden even if the color is visible.

The first color in the design is at the top of the list, followed by all the thread color blocks. 
The check boxes show which color blocks are hidden. The numbers show the order in 
which the colors are used, and the samples show solid blocks of each thread color in 3D.

Click a thread sample to access the Color Selection dialog box for selecting a different 
thread color, or adding a thread effect. Click a check box to show or hide a color block, 
together with any secondary colors, for example the other colors in a multigradient 
object. When a color is hidden, its check box in the Color Worksheet is not selected, as 
shown here:

The number of color blocks shown in the color worksheet varies with the size of the 
window. If there are many colors, use the scroll bar to see the desired section of the list.

Hidden Visible

Pause over a thread color
to see its name

Click a color block to select it

Use the color worksheet to

Change the selected color

display or hide a color

Thread effect symbol

Show or hide secondary colors

Secondary thread color
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Secondary Colors
Extra design property colors for some objects are set in the properties dialog for that 
object, for example multigradient fills and the border for a fill area. They then appear as 
secondary colors in the color worksheet, and can be adjusted from there.

A multicolor gradient fill or satin column will show a hatched pattern in the FilmStrip. To 
view these colors in the worksheet, ensure that Design Property Colors  below the 
color worksheet in the Design Panel on the right of the Design window is selected.

Display Range
The Display Range functions on the Edit tab are used to hide and show the objects in the 
design by color block sequence. 

The Display Range functions are: Draw Previous Color Block , Draw Next Color Block , 
Display All Objects , the Draw Range, Only Selected , Only from Start  and Only To 
End .

Draw Previous Color Block
Use Draw Previous Color Block  to step through the color blocks in reverse order.

Pattern Fill with a border The FilmStrip and 
worksheet show both 

colors

Set a separate border color in the 
Line tab of the Properties dialog

Multigradient Pattern Fill 
with a border

The FilmStrip and 
worksheet show all 

colors

Set the colors for the multigradient 
fill in the Properties dialog
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Shortcuts
■ Edit Tab: 
■ Keys: Alt, E, P

Draw Next Color Block
Use Draw Next Color Block  to step through the color blocks one at a time.

Shortcuts
■ Edit Tab: 
■ Keys: Alt, E, N

Display All Objects
Use Display All Objects  to display all objects and commands in the design.

Shortcuts
■ Edit Tab: 
■ Keys: Alt, E, A; Right-click FilmStrip, A

Draw Range
The Draw Range is set with the Start and End slider bars, 
which determine the range of visible objects. Each step 
when you click a + or - button is one distinct object or 
command, similar to stepping through objects with the arrow keys.

Use the Draw Range to isolate objects that you want to select with Select All Visible. Also, 
for complex designs, use the Draw Range to make objects easier to select when changing 
their properties. For instance, you could isolate a fill area so that it is easier to click, and 
then right-click to change its pattern in the Fill Properties.

Changes in the Draw Range are matched by the range of visible objects in the FilmStrip. 
Similarly, using Display Only Selected, Display Only From Start and Display Only To End on 
the FilmStrip context menu will automatically change the slider bar positions. The Draw 
Range sliders also help to show which part of the design is visible when the FilmStrip is 
used to hide objects.

Display All Objects on the FilmStrip context menu and Display All Objects  both reset 
the Draw Range to show all objects.

Also, turn off colors and object types with the color worksheet and object filters to hide or 
show almost any set of objects in combination with the Draw Range. For instance, you can 
hide any alignment stitches that you place, so that you never adjust part of the design by 
accident.

The upper slider bar sets the first object at the Start of the visible objects. The lower slider 
bar sets the End object. Use the Draw Range to set the Start or End object in any of the 
following ways:
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1 Click and drag the slider box along the slider bar.

2 Click the plus or minus at the ends of the slider bar to progress 
by one object at a time. Click and hold to progress more rapidly.

3 Click in the space on the slider bar on either side of the slider 
box to move in that direction and jump through the objects 
rapidly. You can also click and hold, but the slider box will stop 
when it reaches the arrow pointer.
In all cases, the work area will show the range of objects as the Start or End object 
changes.

When you set a Draw Range, only the objects in the color blocks that are visible within the range will be 
displayed.

Only Selected
Use Only Selected  to show only the currently selected object. Use this if you wish to 
isolate a single object. For example, once the object is isolated, you can easily select it with 
Select All Visible  to move, resize, flip and rotate the object.

Shortcuts
■ Edit Tab: 
■ Keys: Alt, E, Y; Right-click FilmStrip, S

Only From Start
Use Only from Start  to show only the currently visible objects from the start to the 
selected object. That is, hide all objects after the selected object.

Shortcuts
■ Edit Tab: 
■ Keys: Alt, E, S; Right-click FilmStrip, F

Only To End
Use Only To End  to show only the currently visible objects from the selected object to 
the end of the design. That is, hide all objects before the selected object.

Shortcuts
■ Edit Tab: 
■ Keys: Alt, E, E; Right-click FilmStrip, E
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Hide Object Types
The Hide Object Types (filter) buttons are used to 
hide and show the objects in the design according 
to the type of object and/or by color block 
sequence. When a filter is used to hide objects, the 
objects are hidden in the work area and the 
FilmStrip.

The filters are: Lines , Fills , Satin Areas , Columns , Single Stitches , Stops 
and Colors , Groups  and Appliqués .

If there are no objects of the relevant type in the design, or they are all already hidden by other means, the 
filter button cannot be clicked down.

Lines
Use the Lines filter  to hide and show Running, Double and Triple Stitches, Motif Lines 
and Tapered Motifs.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HL

Fills
Use the Fills filter  to hide and show all Fill Area types, including any border lines around 
fill areas.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HF

Satin Areas
Use the Satin Areas filter  to hide and show Satin Areas.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HA

Columns
Use the Columns filter  to hide and show Satin Column, Richelieu Bars, Feather Satin 
and Satin Lines.

The Columns filter will hide any fill areas with a satin border.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HC
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Single Stitches
Use the Single Stitches filter  to hide and show Single and Alignment Stitches in the 
design. Single Stitches are generally used for traveling stitches within the design, and for 
underlay. They often do not affect the appearance of a design, so you may find it useful to 
hide them.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HS

Stops and Colors
Use the Stops and Colors filter  to hide and show Color Changes and Stops.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HP

Groups
Use the Groups filter  to hide and show Groups.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HG

Appliqués
Use the Appliqués filter  to hide and show Appliqué areas.

Shortcuts
■ Edit Tab, Hide Object Types: 
■ Keys: Alt, E, HQ
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FilmStrip
Use the FilmStrip to view the numbered sequence of objects, select an object, change the 
sequence of objects, select objects to display, delete objects, insert Color Changes and 
Stops, view the properties of the selected object and change the properties of objects 
globally or in a selection.

When you pause the arrow pointer over an object or group in the FilmStrip, the corresponding object 
outline(s) are highlighted in the work area.

FilmStrip Items
Starting at the top, the FilmStrip shows the numbered sequence of objects in the design. 
When all objects are visible, the first object at the top of the list is a Color, or a Group 
starting with a Color, then any other objects that make up the design. 

The last object in the design is at the bottom of the list, together with the Layout Order 
and display functions. The currently selected object is also highlighted in the FilmStrip, 
and objects can be selected directly in the FilmStrip.

When objects are hidden, using the color worksheet, object filters, slider bars or FilmStrip 
options, they are also hidden in the FilmStrip.

Each item in the FilmStrip shows four pieces of information: the number, color, object and 
object type.

For Pattern Fill, the fill number is also shown.

View the object color in
the Thread Color Bar

The first object is a color or group

Objects are shown by their
shape or a marker

View the name of the object type

Scroll up and down the FilmStrip

Use the Layout Order buttons
to move objects in the FilmStrip Select the last visible object

No line between linked objects

Line between chains of linked objects 

Both fill and border colors are shown

Multicolor gradient fill area

Display group contents
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Thread Color Bar
The color bar shows the color of each object, together with an icon representing any 
thread effect, even when the Color Changes are hidden.

A fill area with a differently colored border will show two colors. A multicolor gradient fill or satin column 

will show a hatched pattern. To view these colors in the worksheet, ensure that Design Property Colors  
below the color worksheet in the Design Panel on the right of the Design window is selected.

Object
Each object is represented graphically. Markers are shown for 
Colors and Stops. A Color Change also shows a thread sample. 
Alignment stitches show the type of stitch. All other object types 
show the shape of the objects as black outlines.

Object Type
The name of the object type is shown.

Scroll Bar
Use the scroll bar to move rapidly up and down the FilmStrip.

Showing Groups in the FilmStrip
Groups are shown in the FilmStrip with an orange header. The 
Group header is a solid orange block when selected, and an orange 
outline when not selected. The objects within the group have a 
pale gray background in the FilmStrip, as opposed to the white 
background for objects that are not part of a group. When the 
header for a group is selected, all other items in the group are also 
selected, and are highlighted.

Use Display Group Contents  to view the objects within groups in the Filmstrip.

Select Objects in the FilmStrip
Until an object is deliberately selected, the last visible object is selected automatically in 
the work area. To select the desired object, click it in the FilmStrip. It is also selected on the 
work area. If necessary, use the scroll bar on the side of the FilmStrip so that you can see 
the desired object in the FilmStrip. Also, when you click an object on the work area, the 
object is highlighted in the FilmStrip.

If you have zoomed in, the selected object may not be shown on the visible part of the design. To see the 

object, either Zoom To Fit  or use the scroll bars on the edges of the work area.
Only visible objects may be selected. If the view is changed so that the selected object is no longer visible, 
the last visible object is selected automatically.
To select a sequence of objects, click the first object and hold the Shift key. Then select the 
last object in the sequence.

To make a custom selection of objects, click the first object, then hold the Ctrl key and click 
each of the other desired objects in turn. You can also add objects to a sequence in this 
way.
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Change the Sequence of Objects
Single objects or a selection of objects may be moved up and down the FilmStrip with 
click and drag. This changes the order of the objects, and hence changes the order in 
which the stitches are created for the final embroidery.

To move an object, click and drag the desired object up or down the FilmStrip. A bar 
moves up and down the list to show the new list position. Release to drop the object at 
the desired point. Movement stitches are automatically inserted or removed as needed.

To move a selection of objects up or down the FilmStrip, hold the Ctrl key and click one of 
your selected objects. A bar will show where the objects can be inserted in the FilmStrip. 
Move the bar up or down the FilmStrip to the desired insertion point. To insert the objects, 
release the mouse button.

If objects are dragged or inserted between two items in a group they will become part of that group, except 
if they are inserted immediately after the group header. To insert at the beginning of the group, drag into 
the middle, then move up.
If desired, use the color worksheet and Hide Object Types buttons to hide other objects. 
This can make it quicker to move the desired object.

Hidden objects will not be moved.
To move to a part of the list that is not visible, move the pointer above the top or below 
the bottom of the list and the list will scroll automatically. To scroll faster, move the pointer 
further above or below the list. Move the pointer back into the list to stop scrolling.

Moving the pointer onto the scroll bar has no effect when dragging an object up or down the FilmStrip.
Moving an object up and down the FilmStrip does not change the position of the object 
on the work area. However, it may change the appearance of the design according to 
whether or not it changes the overlap with adjacent objects.

The first visible object may not be moved in the FilmStrip. Also, objects may not be moved above the first 
visible object in the FilmStrip. This ensures that, when it is visible, the initial color change in the design 
cannot be moved and nothing can be moved before it.

Layout Order
The Layout Order buttons are used to move objects within the FilmStrip.

You can also select multiple objects in the work area with Select Last Visible. See “Select Last Visible” on 
page 351.

Move Forwards
Move Forwards  brings the object one step down the FilmStrip.

Shortcuts
■ FilmStrip: 
■ Keys: Ctrl + [; Right-click FilmStrip, L, F

Move Backwards
Move Backwards  brings the object one step up the FilmStrip.
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Shortcuts
■ FilmStrip: 
■ Keys: Ctrl + ]; Right-click FilmStrip, L, B

Move to Front
Move to Front  places the object at the bottom of the FilmStrip or Group.

Shortcuts
■ FilmStrip: 
■ Keys: Ctrl + Shift + [; Right-click FilmStrip, L, N

Move to Back
Move to Back  places the object at the top of the FilmStrip or Group.

Shortcuts
■ FilmStrip: 
■ Keys: Ctrl +Shift + ]; Right-click FilmStrip, L, C

FilmStrip Options
Right-click on an individual item in the FilmStrip to see a menu of options relating to the 
currently selected object.

Alternatively, use the Edit tab.

Display Only Selected
Use Display Only Selected  to show only the currently selected object or group of 
objects. (It will show all objects between any that are selected.) Use this if you wish to 
isolate a single object. For example, once the object is isolated, you can easily select it with 
Select All Visible  to move, resize, flip and rotate the object.

Display Only From Start
Use Display Only from Start  to show only the currently visible objects from the start to 
the selected object. That is, hide all objects after the selected object.

Display Only To End
Use Only To End  to show only the currently visible objects from the selected object to 
the end of the design. That is, hide all objects before the selected object.

Display All Objects
Display all objects and commands in the design.

Use Display Group Contents  to switch between viewing the objects within Groups in 
the FilmStrip, and seeing only the Group heading rows in the FilmStrip. See “Display Group 
Contents” on page 340.

Cut
Cut the selected object(s) and place on the clipboard.



158          PREMIER+™ 2 Create   Viewing Pictures and Designs 

Copy
Copy the selected object(s) to the clipboard.

Paste
Paste the object(s) on the clipboard back into the design.

Duplicate
Make a copy of the selected object(s) which is automatically pasted into the work area.

Delete
Delete the selected object(s) from the design.

Insert Color Change
Insert a Color Change after the currently selected object. The Color Selection dialog box 
appears so you can choose the new color.

PREMIER+™ 2 Create remembers the last thread color added to the design. This thread color will be initially 
selected in the Color Selection dialog box.

Insert Stop
Insert a Stop command after the currently selected object.

Group
Group the selected objects together.

Ungroup
Split the currently selected group into the objects which make it up.

Select Similar from Visible
Select all visible objects with similar properties.

Select Similar from Group
Select all objects with similar properties that are in the same Group.

Properties
Show the properties dialog box for the selected object. This is the same as using right-click 
on the work area.

Global Properties
Show the properties dialog box for the selected object. When the settings in the dialog 
box are confirmed with the OK button, all visible objects of the same type will also have 
their properties changed to match the settings.

Layout Order
Use Move Forwards and Move Backwards to move an object one step up or down the 
FilmStrip, and use Move to Front and Move To Back to move an object to the bottom or 
top of the FilmStrip or Group.
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FilmStrip Options for Multiple Selected Objects
Select several objects of the same type in the Filmstrip and right-click on one of them to 
see a menu of options relating to multiple selected objects. The options displayed are: 
Display Only Selected, Display Only From Start, Display Only To End, Display All Objects, 
Cut, Copy, Paste, Duplicate, Delete, Group, Ungroup, Properties and Layout Order.

Display Functions
Use the Display functions to display the objects selected in the FilmStrip. You can then 
further refine your selection.

Use Display Group Contents  to switch between viewing the objects within Groups in the FilmStrip, and 
seeing only the Group heading rows in the FilmStrip. See “Display Group Contents” on page 340.

Properties
Show the properties dialog box for the selected object type. From here you can change all 
objects of the currently selected type in your selection. To select an object type, click the 
FilmStrip and check your selection in the Status bar.

All objects of the selected type will be modified, including any previously customized.

Layout Order
Use Move Forwards and Move Backwards to move the selected objects one step up or 
down the FilmStrip, and use Move to Front and Move To Back to move the selected objects 
to the bottom or top of the FilmStrip or Group.

Get Length
Use Get Length  to measure the distance between any two points on the work area. 
Click the Get Length icon  and the mouse pointer changes to the Measure pointer . 
Then click and drag a line across the design. The length of the line is displayed.

For example, use this to obtain the width of a picture or design, or the distance between 
two sections.

The length is shown in millimeters or inches, according to the setting for Show Measurements in 
PREMIER+™ 2 Configure. The alternative units are shown in parentheses.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, L
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Measure a Distance with Get Length
1 In the View tab, click the Get Length  icon. The pointer changes to 

the measure pointer .
2 Click and drag across the part of the design you want to measure. A line 

will show the length you are measuring, and a tooltip displays the 
distance.
If desired, make a note of the number.

3 Repeat the click and drag to measure any other distances, as required.
4 Right-click to deselect the function.



PREMIER+™ 2 Create   Viewing Pictures and Designs              161

Design Player
Use Design Player  to play through the stitches in the design as if they were being 
stitched from an exported embroidery. All parts of the embroidery that are within the 
hoop area are shown, whether or not they are selected.

The current Optimize for Sewing settings from PREMIER+™ 2 Configure are used.

The Design Player will not open if part of the design is outside the hoop.

Share
Use Share  to save or share a still picture or video of your design. Share over 
Facebook® , Flickr® , Twitter®  and YouTube® . See “Share Picture” on page 164 
and “Share Video” on page 165.

Shortcuts
■ Quick Access Toolbar or Home Tab: 
■ Keys: Ctrl + J; Alt, 0; Alt, H, J

Using the Design Player
1 Click File, New , or File, New Window  and the Choose Design Type page of the ExpressDesign 

Wizard will appear.
2 Select the Load Existing Design option, then click Next and the Open Existing Design page will 

appear.
3 Click Load a Design , and in the Open dialog box browse to the folder 

Documents\Premier+2\Samples\Create\Edo, select the design ’Bicycle.edo’, and click Open.
4 Click Finish to load the design onto the work area.
5 Click Design Player .

The Design Player dialog opens.
6 Use the Play button  at the bottom left to start playing through the stitches in the design.
7 Use the controls to play forwards or backwards through the embroidery at different speeds, jump to 

the start or end of the stitches, and stop at any time.

Start or pause play

Control play with
the slider

Design Information

Jump to first stitch

Jump to last stitch

Rewind

Play at double the
current speed
Share the animation online
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Life View
Use Life View  to show how an embroidery exported from the project will look. Use Life 
View  at any time when you want to see the design with no objects selected in 3D with 
real-world perspective, and when you want to see the effects of glow in the dark and solar 
reactive threads. Zoom in to see detail, and move and rotate the embroidery in a three-
dimensional view.

Life View will not open if part of the embroidery is outside the hoop.

Shortcuts
■ Quick Access Toolbar or Home Tab: 
■ Keys: Ctrl + L; Alt 9; Alt, H, L

Position
Use the position  slider to move to another part of the Life View window.

Click and drag the cross marker in the center of the box to view the desired part of the 
embroidery, using the zoom slider to control the magnification.

Rotation
Use the rotation  slider to view the stitching in the embroidery in 3D.

Click and drag the cross marker in the center of the box to change the angle at which the 
embroidery is viewed, and allow you to visualize the project in varying real-world views.

Alternatively, click and drag directly in the embroidery preview area to change the angle of view.
Use the zoom and position sliders to select the part of the embroidery to view.

Design Information

Move around the window

Change the 3D viewing angle

Zoom in and out

Light and dark effects
Reset
Animate the preview
Share your animation online
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Zoom
Use the zoom slider to change the magnification of the embroidery. 

Drag the slider bar to the right to magnify the view of the embroidery, and to the left to 
shrink the view of the embroidery. The box below the zoom bar displays the current 
magnification. 

Click the marker in the center of the zoom bar (100%) to view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in PREMIER+™ 2 
Configure.

When zoomed in, use the position slider to move around the embroidery.

Design Information
Life View shows the dimensions (Width  and Height ), the number of stitches  and 
the number of colors  in the embroidery.

Glow in the Dark
Use Glow in the Dark  to view the effect of using glow in the 
dark threads. The preview will darken to simulate the lights 
dimming, and the glow in the dark threads will be shown in their 
luminescent colors.

Glow in the Dark  is only available if glow in the dark thread colors are 
used in the design.

Solar Reactive
Use Solar Reactive  to view the effect of using photochromic threads. The preview 
simulates the sun shining on the design, and the photochromic threads change shade to 
show the colors they become in sunlight.

Solar Reactive  is only available if photochromic thread colors are used in the design.

Play Demo
Use Play Demo  to animate the preview and show the embroidery at different angles 
automatically. Click to start and stop the animation.

Photochromic threads change color in sunlight.
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Play My Demo
Use Play My Demo  to animate the preview using your own demo. 
Use the menu options to add the current position as a point in the 
demo, or reset to create a new demo.

The My Demo animation will be used for Life View in all modules. It is stored in the 
AnimationPath.txt file in the folder: 
\User\AppData\Local\VSMSoftware\Premier+2\LifeView

Copy this file to another location as a backup before creating additional My Demo animation paths for 
Life View.

Reset
Use Reset  to set Rotation, Position and Zoom back to the default settings.

Share
Use Share  to save or share a still picture or video of your design. Share over 
Facebook® , Flickr® , Twitter®  and YouTube® . See “Share Picture” on page 164 
and “Share Video” on page 165.

Share Picture
Save or share a picture of your design. Share over 
Facebook® , Flickr®  or Twitter® .

Select a size for the picture, then save the picture to your 
computer or share it over Facebook®, Twitter® or Flickr®. A 
progress bar shows during the upload.

Size
Select a size for your picture. Choose from Standard, 2x, 3x, 
and 4x. Standard size is the size of the picture in Design Player or Life View.

Save
Click Save  to save the picture to your computer. The Save As dialog appears for you to 
save the picture, with the default file name being the same as the design. Change the 
name as desired.
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The following file formats may be saved: JPEG Low Quality (.jpg), JPEG High Quality (.jpg), 
Tagged Image File Format uncompressed (.tif ) and Portable Network Graphics (.png).

Social Media
Upload the picture to Facebook® , Flickr® , or Twitter® . Log in to the Social Media 
website to upload your picture. A progress bar shows during the upload.

Share Video
Save or share a video of your design. Share over Facebook® , Flickr®  or YouTube® .

Name the video and select its size, quality and speed. Then save it to your computer or 
share it over Facebook®, Flickr® or YouTube®. A progress bar is displayed while the video is 
created.

The higher the image quality, the slower the speed of upload and download.

Video Title and Created By
The video title and the name of the creator are used on the opening frames of the video. 
Enter the name of the video, and the name of the creator.
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Size
The size of the moving image in pixels. The higher numbers create a higher quality video. 
Choose from 1080p (HD), 720p (HD), 480p and 360p. The initial setting is 480p.

Quality
The bit rate, or speed of data transfer. Choose between Low, Medium and High. The initial 
setting is Medium.

Speed
Set the speed of the Design Player for the video. Choose from Standard, 2x, 4x, 8x, 16x, 
32x, 64x, and 128x. The initial speed is 16x.

This option is only available for videos created from Design Player.

Video Information
The Total Duration of the video in minutes and seconds, and the estimated file size in MB 
are displayed. The duration and size vary according to the Size, Quality and Speed of the 
video.

File Name
Select a folder and name for the video file. Click Select to browse to a different folder on 
your computer.

Start and Cancel
Click Start to create your video, using the settings that you chose above. A progress bar 
shows during the creation of the video, with an estimate of the creation time. Click Cancel 
to stop the video creation.

All other functions in the dialog box are unavailable (grayed out) during video creation.

Social Media
Upload the video to Facebook® , Flickr®  or YouTube® . Log in to the Social Media 
website to upload your video.
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Zoom Commands
A number of functions are available to make it easier to navigate around designs. These 
include the Zoom functions and the Overview Window. By default, each design is shown 
at a size so that the hoop fills the window, the same as if you click Zoom To Fit  after 
zooming in or out.

Shortcuts

You can also navigate around a design by selecting the colors to see and changing the range of stitches 
that are displayed.

Zoom To Rectangle
Use Zoom To Rectangle  to enlarge the view of an area of the design.

Click the Zoom To Rectangle icon  to the right of the status bar, and the mouse pointer 
changes to the zoom in pointer . Then either click a point on the design you want to 
zoom in towards, or click and drag a rectangle around the area you want to enlarge and 
release the mouse button to zoom.

Zoom To Rectangle is automatically deselected after you have used it.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 0

If you have a wheel mouse, hold the Ctrl key and move the wheel to zoom.

Pan Mode
Use the Pan feature to move around the screen easily. The Pan feature works when you are 
Zoomed In on part of the screen, making the scroll bars visible at the right and bottom of 
the work area.

Hold the Shift key down until the pan cursor  appears, then click and drag.

The pan occurs in real time, that is you see the work area move as you drag across the 
screen.

Alternatively, use the Overview Window to move around the screen when Zoomed In.

Zoom Out Keys: Ctrl + -

Zoom To Rectangle Keys: Ctrl + 0

Zoom In Keys: Ctrl + =

Zoom To Fit Keys: Ctrl + 9

Click and drag to zoom in on an area

Zoom to Fit
Drag to zoom in and out

Click to zoom in instantly
Click to zoom out instantly

Select or input percentage zoom
100% zoom
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Pan Around the Work Area
1 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
2 Click and drag to draw a box, then release to zoom in. Scroll bars appear to allow you to move around 

the screen at this higher zoom level.
3 Hold the Shift key down, then start to click and drag. The pan cursor  appears.
4 Click and drag until the pointer is in the desired part of the screen. (If you have a wheel mouse, you 

can click the wheel to pan around the screen.)
5 Lift the pen or release the mouse button.

Zoom To Fit
Use Zoom To Fit  to view the whole work area. Click the Zoom To Fit icon  and the 
view will zoom in or out to show the work area in the window.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 9

Zoom by Percentage
Use the drop-down list in the Status Bar to set percentage levels to zoom in from 10% up 
to 800%. Alternatively, enter a number in the percentage text box.

Select 100% to display the design at a magnification as close as possible to the Real Size setting you chose 
in PREMIER+™ 2 Configure.

Zoom Bar
Use the Zoom Bar to zoom in or out from the center of the picture or design.

The Zoom Bar is on the right side of the Status Bar.

Use the slider to zoom in or out of the picture or design, or click on the Zoom Out  or 
Zoom In  icons.
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8Creating & Managing Designs
A new design can be started with File, New , or File, New Window . This will start the 
ExpressDesign Wizard. Use the ExpressDesign Wizard to create a new design 
automatically, load a picture for a new design, load an existing design or start a new 
design with no picture.

In the Design window, you can use the File menu to Open  a design or Open Recent, or 
Load a Design with Drag and Drop.

Use the Insert functions to insert new  or existing designs , embroideries , 
SuperDesigns  or text  into an existing design.

To open an embroidery as a new design, use File, New , or File, New Window , to start a design with 

no picture, and then use Insert Embroidery  to convert an embroidery to a design.

When starting from a blank design, you may choose a hoop, and start creating your design 
with the Freehand, Precise, Shape, Command and Column features. However, it is more 
common to follow a picture when creating a design. Create your own picture using the 
functions in the Draw and Paint windows. Open an existing drawing with Open 
Drawing  or Insert Drawing . Open an existing painting with Open Picture  or 
Insert Picture , or use From Scanner or Camera  to load a picture from a scanner or 
digital camera.

After creating or editing your picture as desired, it is recommended to save it. Then either 
send the picture to the ExpressDesign Wizard, or start creating your design with 
QuickStitch™, Freehand and Precise Create features.

Save finished designs with Save  or Save As , then export the final embroidery with 
Export .
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Open Designs
Open
Use Open  to load an existing design outline file (extension .edo). PREMIER+™ 2 Create 
displays the Open dialog box so you can choose a design to open.

Open Recent with File, Recent or Load a Design with Drag and Drop from Windows® Explorer.
The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the .edo extension.

Files of Type
This is set to EDO Files (*.edo) and may not be changed, so that only design outline files 
can be opened.

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list  or details  view to icons with thumbnail images of the design 
outline files. For example, Extra Large icons .

Preview Pane
Preview the design outline file before opening .

Shortcuts
■ File Menu: 
■ Keys: Ctrl + O

Insert
Use Insert  to insert existing outline designs (.edo or .can files) into the current design. 
The Open dialog is displayed so that you can choose a design to insert. 

Click Open to load the 

Browse to a different folder

Click on a design to select it

Search for a design

Change the view or icon size

selected design

Previewed design

Hover to view the selected 
design’s details



PREMIER+™ 2 Create   Creating & Managing Designs              171

The design is inserted after the selected object or the last visible object in the design on 
the work area. The inserted design is automatically selected so that it can be moved, 
resized, mirrored, rotated, copied or cut. Designs are inserted at the size they were created, 
or automatically made small enough to fit the current hoop.

Use Insert to load a .can design outline file (from 5D™ or 4D™ Design Creator). Thumbnail image previews 
are not available for .can files. If the .can file contains a picture, the picture will not be loaded.

Shortcuts
■ Quick Access Toolbar; File Menu; Home Tab, Insert: 
■ Keys: Ctrl + I; Alt, 1; Alt, H, IN

Load a Design
1 In the File menu, click New .
2 In the Quick Access toolbar, click Insert .

Alternatively, click Insert in the Home tab.
3 In the Open dialog box, browse to the folder Documents\Premier+2\Samples\Create \Edo.

If desired, click Change Your View  to view icons of the designs.
4 Scroll down to show the thumbnail of the sleigh.

5 Click the picture of the sleigh and the design will be selected.

Click Open to load the selected design

Browse to a different folder

Click on a design to preview it

Hover to view the selected design’s details

Previewed design

Search for a design

Change the view or icon size
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6 Click Open to load the design onto the screen.
You can use Insert to transfer design elements between design files. Simply delete all the objects from a 
design except the desired design element (for instance, in a floral design delete everything except one 
flower that you want to use somewhere else). Save the isolated design element as a new outline design file 
(.edo). 
Open the design where you want to insert the isolated design element, then browse and insert it with 
Insert. If you do this several times then you will gradually build up your own library of design elements.

Load a Design with Drag and Drop
To drag and drop a design outline (.edo) file onto the screen, use Windows® Explorer.

Drag a Design to the Work Area
1 Open a Windows® Explorer window. If required, resize the Explorer window so you can see both 

Explorer and PREMIER+™ 2 Create.
In Windows® 10 and 8, click File Explorer on the Status Bar. In Windows® 7, right-click the Start button on 
the Taskbar, then click Explore. 

2 Browse through the drives and folders of your computer to find the 
Documents\Premier+2\Samples\Create\Edo folder.

3 Click on the desired design name or icon to highlight it.
4 Use the mouse to drag and drop the design onto the PREMIER+™ 2 Create screen. The design will be 

displayed on the screen.
5 Close Windows® Explorer.

Recent
Open previously used design outline (.edo) files via the file names in the Recent section of 
the File menu. Select the name of the desired design file.

Recently used designs may only be chosen from the File menu in the Design window. There is no recent files 
list for pictures.

Shortcut
File Menu: Recent

Copy Embroidery
Use Copy Embroidery  to make a copy of the design as an embroidery and place it on 
the clipboard, where it can be pasted into another PREMIER+™ 2 Embroidery System 
module. The whole design is copied as an embroidery, regardless of whether only part or 
all of it is selected.

Use Copy in the Draw or Paint window to copy part or all of a picture and place it on the clipboard, where it 
can be pasted into the same file or a new picture. For Drawing see “Copy” on page 160 and for Painting see 
“Copy” on page 395.
Use Copy to copy the selected objects. See “Copy” on page 361.
Copying to the clipboard replaces the contents previously stored there.

Shortcuts
■ Home Tab, Copy: 
■ Keys: Ctrl + Shift + C; Alt, H, CO, CE
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Save Designs
Save
Use Save  to save the design file under its current name and folder. When you save a 
design for the first time, PREMIER+™ 2 Create displays the Save As dialog box so you can 
name the design file. To change the name and folder of an existing design file, use Save As.

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + S; Alt, 2

Save As
Use Save As  to save and name the design file. PREMIER+™ 2 Create displays the Save As 
dialog box so you can name your design. To save a design with its existing file name and 
folder, use the Save command.

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + Shift + S; Alt, 3
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Export
Use Export  to save the design outline file in the current window as a flattened .vp4 file, 
or in an alternative embroidery format. The embroidery must fit in the currently selected 
hoop. Use the Design Player to see how the embroidery will be exported according to the 
current Optimize for Sewing options.

The preferred file format for exporting embroideries is Husqvarna Viking / Pfaff .vp4, as 
this will preserve background and appliqué information, thread color information and 
notes.

You can also export embroideries as Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby 
Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Husqvarna (.hus ,.shv), Husqvarna 
Viking /Pfaff (vp4, .vp3 and .vip), Janome (.jef and .sew), Melco Expanded (.exp), Pfaff (.pcs), 
Tajima (.dst) or Toyota (.10o).

The initial name will be the current file name with "Exported" added. The text "Exported" may be changed 
in PREMIER+™ 2 Configure.

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + E; Alt, 4

Optimize for Sewing Options
All of these options are initially selected when saving as a .vp4 file, or in any other format.

You can customize the initial Optimize for Sewing Options in PREMIER+™ 2 Configure.
Combine: Merge the embroideries into a single embroidery during Export.
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Combine is not enabled if there is only one design, and for embroidery formats that are automatically 
combined.
Remove Overlap: Prevent areas of stitches building up where embroideries overlap.

Remove Overlap is not available when Combine is not enabled.
Only deselect this option if, for example, your embroideries are low density and you wish to have a blend 
effect where they overlap.
ColorSort: Reduce the number of thread colors during Export. 

Optimize Stitch Length: Automatically remove small and insignificant stitches. See 
“Stitch Length Optimizer Options” on page 178.

Cutwork Needle lines in the Inspira Cutwork Needle "thread range" and Felting Needle colors in the Inspira 
Felting Needle "thread range" are unaffected by Optimize Stitch Length.

Decoration
Create Center or Line placement stitches for Decorations added in PREMIER+™ 2 
Embroidery Extra, or remove all decorations and their associated placement stitches.

Center or Line placement stitches are created automatically for decorations according to 
the options set in PREMIER+™ 2 Configure, which may be altered when you export the 
embroidery. Alternatively, create templates for cutters.

Center placement stitches are recommended when most decorations are individual and 
symmetrical. Line placement stitches are recommended when most decorations are 
individual and asymmetrical (such as bugle beads) or lines of closely spaced beads or 
sequins.

Create Center placement stitches: Create a small cross shape in stitches to show where 
the decoration is to be placed.

Create Line placement stitches: Create a single stitch that runs along the length of the 
decoration.

Remove all decorations and placement stitches: Remove all decorations and placement 
stitches from the exported version. This may be desired to create an embroidery with a 
complementary crystal transfer template (made using the Export Decoration Template 
dialog box in PREMIER+™ 2 Embroidery).

Hoop Orientation
Set the hoop orientation.

Rotate to fit natural hoop position: Rotate the embroidery if needed to fit with the 
default hoop orientation for the machine. This option is only available if the hoop on the 
main screen is in the rotated orientation. It is useful if you prefer to create a "landscape" 
shaped project in the rotated orientation.

Flip design for felting or reverse embroidery: Flip the embroidery for being stitched in 
reverse. If an embroidery contains a Felting Needle color effect this option is selected 
initially. See “Felting Needle” on page 147.
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Splitting options
Click the button to open the splitting options dialog box. See “Splitting for Multipart 
Hoops” on page 176.

Splitting for Multipart Hoops is available if .vp4, .vp3, .pes or .jef is chosen.

Additional Sections
Additional dialog sections are available, depending on the chosen file format.

■ If .pes is chosen, you can select your machine type, file version, hoop size and rotation.
■ If .jef is chosen, you can select your machine type, hoop size and rotation.

OK
View the Save, or Saving As dialog, depending on the selected file format.

Export an Embroidery
1 Create an embroidery design.
2 Save the design. See “Save As” on page 173.
3 Click Export . The Export dialog box appears.
4 Select an embroidery format from the drop-down list.
5 Select your optimization options.
6 If you are using a multipart hoop, set Intelligent or Straight Line split.
7 Click OK.
8 The Save As dialog will appear. Save the embroidery as desired. 

When exporting an embroidery, the message 'Design is too large or will not fit in hoop.' may appear. This 
means that some part of your embroidery is not entirely within the hoop. Move the design so that it fits 
inside the hoop. If desired, use the arrow keys to nudge the embroidery in small steps.

Splitting for Multipart Hoops
This dialog is available if .vp4, .vp3, .pes or .jef is selected as the file format.

Embroideries for Multipart hoops are split automatically, according to your Export 
settings. Use an Intelligent or Straight Line Split.

Note: There is no need to ensure embroideries are in one stitch area of the hoop; just place 
your embroideries in the most pleasing arrangement. 

Split Method
You can use one of two split methods:

■ Intelligent Split automatically calculates a split line that is routed through gaps or across 
movement stitches, cuts the minimum number of stitches, and minimizes cuts through 
solid sections of embroidery. Where possible, use Intelligent Split.

■ Straight Line Split cuts the embroidery straight across the center line of the overlap zone.
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Intelligent with Tolerance
Intelligent Split calculates a split line that cuts the minimum number of stitches, and 
minimizes cuts through solid sections of embroidery. For example, a large embroidery is 
split at a narrow section, and an embroidery that fits in one stitch area of the hoop is left in 
one piece even if it is part of a larger design.

Tolerance ensures that the Intelligent Split line stays a short distance from the edges of 
the overlap. This allows for play in the hoop when going from one hoop area to another, 
such as when aligning a hoop that has been turned to stitch out the other side of an 
embroidery.

You can set Tolerance from 0 to 3mm, in steps of 1mm. The initial setting is 1mm.

To use Intelligent Split with Tolerance, select the "Intelligent with Tolerance" checkbox, then enter a number 
in the Tolerance number box, or use the arrows to increase or decrease the Tolerance.

Straight with Compensation
Straight Line Split cuts straight across the center of the overlap zone. Straight Line Split 
will only split an individual embroidery if, before it is combined with everything else, it 
does not fit entirely into one stitch area of the hoop.

Lettering is split straight down the middle, as with any other type of embroidery. This may cut through 
characters rather than gaps and spaces. In such cases, it is recommended to use Intelligent Split instead.
Compensation adds overlapping stitches along the edges where the embroidery is split. 
This compensates for pull on the fabric.

Alignment Stitch for Turnable Hoops
Select this option to add an alignment cross at the end of each embroidery section when 
using the HUSQVARNA VIKING® Designer Majestic™, PFAFF® creative Grand Dream™, 
Universal Multipart hoop, or Brother Jumbo Frame. A hoop movement to the alignment 
cross is added at the beginning of the next section. The next embroidery section can then 
be correctly aligned, or alignment can be confirmed.

None Use None if you can split an embroidery without cutting through any of the design 
elements. Compensation is initially set to None.

Low Use Low when cutting through a lightly stitched embroidery or when the split lines go 
through only a few stitch areas.

High Use High when the embroidery is dense, when the split lines make long splits through 
stitch areas, or when stitching onto materials such as knitted or stretchy fabric.
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Stitch Length Optimizer Options
Use the Stitch Length Optimizer Options dialog box to automatically remove small and 
insignificant stitches. You can adjust the stitch removal sensitivity, or the minimum 
significant stitch length.

Stitch Length Sensitivity
Adjust the sensitivity of the optimization. Low is set as the default.

■ Choose from Low, Medium or High.

Minimum Significant Stitch Length
Select the shortest stitch length that you consider to be significant. Stitches below this 
length are removed during the optimization process. The default stitch length is 0.8 mm.

Cutwork Needle lines are unaffected by the Minimum Significant Stitch Length.
■ Choose from 0.6 mm, 0.8 mm or 1.0 mm.
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Export Appliqué Pieces
Use Export Appliqué Pieces  to save or print appliqué outlines ready for cutting.

There are five appliqué piece export methods:

■ Export for Cutter: Save as SVG, DXF or FCM files for use in fabric cutters
■ Export for Cutwork Needles: Save as VP4 or VP3 stitch files that can be used with 

INSPIRA™ Cutwork Needles
■ Print Templates: Print as an outline template to stick or pin to fabric and then cut out
■ Print Appliqué Pictures: Print directly onto printable fabric or an iron-on transfer; this 

also prints the image of the appliqué piece
■ Export for Custom Layout: Save as PNG files with the fabric image placed as the fill for 

each shape. This is designed for use with fully customized layouts.

Export for Cutter
Export the appliqué piece as an SVG, DXF or FCM image file for use in a fabric cutter.

Set the units of measurement (millimeters or inches), and select a file type. Click Export to 
save the file.

The maximum size for the Brother ScanNCut FCM format is 12" x 12" (305mm x 305mm).

Export an SVG, DXF or FCM file 

Use 2 or 4 cutwork needles

Add secure points for fabric stability

Export a .vp3 or .vp4 stitch file

Print as an outline template for cutting out

Print onto printable fabric or an iron-on transfer

Save as a PNGfile for use with a graphics package

for use in a fabric cutter
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Recommended file formats for cutters:

Export for Cutwork Needles
Export the appliqué piece for cutting with INSPIRA™ Cutwork Needles. Select 2 or 4 
needles, choose whether to use secure points for fabric stability and their length, and use 
a .vp3 or .vp4 stitch file.

Print Templates
Print the appliqué piece as an outline template to stick or pin to fabric and then cut out. 

Select a printer and paper size in the Print Setup dialog box. See “Print Setup” on 
page 418.

Print Appliqué Pictures
Print directly onto printable fabric or an iron-on transfer; this also prints the image of the 
appliqué piece.

Flip the picture for an iron-on transfer, and select a printer and paper size in the Print 
Setup dialog box. See “Print Setup” on page 418.

Export for Custom Layout
Save as PNG files with the fabric image placed as the fill for each appliqué piece shape. 
This is designed for use with fully customized layouts, for example if you wish to arrange or 
adjust the appliqué shapes in a graphics package.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + Shift + E

Cutter Software Export Format

Cricut Explore® Cricut Design Space 3.1512 SVG (points)

KNK Zing Air® Make the Cut! 4.6.1 (Zing Plugin 2.1.0) SVG (points)

Silhouette Cameo® Silhouette Studio 3.6.57 ss
(Use "As Is" import settings)

DXF (millimeters)

Brother ScanNCut® (2) Direct to USB stick or machine FCM

Sizzix Eclips2 eCal2 2.203 SVG (points)
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9Using Commands
Commands are instructions such as the Color Change  (marker ) that changes the 
thread at the start of a new color block. The Stop  (marker ) tells an embroidery 
machine to stop without a color change. Use Alignment Stitches (marker ) to add 
stitches at the beginning of an embroidery to align the embroidery, for example to a 
background picture.

Color Change and Pick Color
Use Color Change , Add Color Change , Pick Color , or the Quick Colors palette to 
select a new thread color for the stitch objects you are about to add to the design. The first 
Color Change is initially set to medium blue. A Color Change command is shown by a 
small blue circle with a C .

To change an existing color, double-click the desired color in the color worksheet on the 
Design Panel, or select the color in the worksheet and click Color change . Alternatively, 
right-click the color in the FilmStrip and select Properties. The Color Selection dialog box 
opens.

To delete a color change, select the Color Change in the FilmStrip or on the work area, 
then click the Delete icon , use the Delete key, or right-click in the FilmStrip and select 
Delete. The first Color Change in a design may not be deleted.

To insert a color, select the object after which the color change is desired, and click Add 
Color Change , click in the Quick Colors, or right-click in the FilmStrip and select Insert 
Color Change from the context menu. Alternatively, click one of the Quick Colors to select 
a new color.

Select a color from the Color Selection box that appears. You may choose any thread 
shade from the available thread manufacturers' palettes (for instance, Sulky Rayon 40 or 
Robison-Anton Cotton 50) or a thread you have added to MyThreads. Select colors by 
visual selection or by typing in a shade number. Alternatively you can choose a ’Quick 
Color’ Theme and then select one of the 32 Quick Colors. See “Quick Color Themes” on 
page 201. Optionally, add a thread or needle effect to the selected thread. Once the 
desired color is selected, click OK.

Shortcuts
■ Quick Create Tab; Freehand Create Tab; Precise Create Tab, Command:  & ; Edit 

Tab:
■ Keys: Alt, Q, C, C; Alt, Q, C, P; Alt, R, C, C; Alt, R, C, P; Alt, P, C, C; Alt, P, C, P; Right-click 

FilmStrip, H

Color Selection
The Color Selection dialog box appears when you click Add Color Change , right-click a 
color change marker , or right-click an object in the FilmStrip and select Insert Color 
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Change. Alternatively, on the Design Panel select a color in the worksheet and click Color 
Change , or double-click a color in the color worksheet.

You may choose any thread shade from the available thread manufacturers' palettes (for 
instance, Robison-Anton Rayon 40 or Sulky Cotton 30) or a thread you have added to 
MyThreads. Select colors by visual selection or by typing in a shade number. Alternatively, 
click one of the Quick Colors to select the nearest matching thread color. Once the desired 
color is selected, click OK. See “Color Selection” on page 144.

When you select a new thread color, the color worksheet will show the change and the 
work area will show the block of stitches in the new color.

To keep the full color information including thread shade numbers, export your 
embroideries as file type .vp4.

Design Property Colors
Use Design Property Colors  to show or hide thread colors in the Color Select area that 
are part of an object’s property, for example an alternative border color or color gradients. 

Color Change Properties
The Color Change command is shown by a small blue circle with a C .

To delete an existing color, select it in the FilmStrip, or click a nearby object and use the 
left and right arrow keys to move to the Color Change, then click Delete. To change a color, 
click the color block in the color worksheet on the Design Panel, or right-click the color 
change in the FilmStrip and select Properties.

For full details, see “Color Change and Pick Color” on page 181.

Stop
Use Stop  to create a Stop command that is used to tell the embroidery machine to 
stop without a color change, and use the Stop properties dialog box to add a message to 
the Stop command. The Stop command is shown by a small red circle with an S .

Select a thread range

Show chosen thread ranges

Search for a thread number

Click a thread color
to select a thread

View the thread information

Click a Quick Color to select
a matching thread color

Choose a Quick Color Theme

Puffy Foam height

Twin needle gap
& second color

Second thread
color

Wing needle

Felting needle

Cutwork needle
angle
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A common use for the Stop command is to pause the machine while a piece of appliqué fabric is placed in 
the hoop, then again after it is tacked down with running or double stitch so the excess material can be 
trimmed before satin borders are used to cover the edge of the fabric.
To delete a Stop, select the Stop command, then click the Delete icon , use the Delete 
key or right-click in the FilmStrip and select Delete.

To select a Stop, click near it and use the left and right arrow keys to select it, or select it directly in the 
FilmStrip. It will be highlighted in the FilmStrip.
To view Stop commands with their messages, use the Design Player, or view them in the printed worksheet.

Shortcuts
■ Freehand Create Tab; Precise Create Tab, Command: 
■ Keys: Alt, R, P; Alt, P, P; Right-click FilmStrip, O

Insert a Stop Command
1 Open a design, then click the Freehand Create or Precise Create tab.
2 Move to the position in the FilmStrip where you want to place the 

Stop command.
3 Click Stop . A Stop command is inserted at the selected 

position. It is shown by a small red circle with an S .
4 Right-click on the Stop command in the work area, and the Stop 

properties dialog box opens.
Alternatively, right-click the Stop command in the FilmStrip and 
select Properties.

5 Use the Quick Text drop-down menu to insert a stitchout hint, or 
enter a message. See “Stop Properties” on page 183.

6 Click OK to save the text.

Stop Properties
Add a stitchout hint to a Stop Command in the Stop 
properties dialog box.

Select a Quick Text comment from the drop-down menu, or 
enter text in the Comment text field. Click OK to save the 
text. Up to 200 characters may be entered.

To view Stop commands with their messages, use the Design Player, or 
view them in the printed worksheet.

Quick Text
Select one of the following texts:

■ Place the appliqué fabric now
■ Cut around the appliqué
■ Place the appliqué shape onto the placement line
■ Cut the hole in your fabric
■ Place the puffy foam on the fabric now
■ Remove any excess puffy foam
■ Check alignment now.
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Single Stitch
Use Single Stitch  to create a Single Stitch or series of Single Stitches, according to the 
length set in Preferences or the properties box. The length may vary. A Single Stitch may 
be broken up into stitches from 1mm to 12mm in 1mm steps.

Typically it would be set to a relatively long length of around 10mm in order to produce an effect from a 
long stitch.
Single stitches are represented by a line in the currently selected color. Depending on the 
default Stitch Length set in Preferences , more than one stitch may be generated 
between two points when a stitch is placed.

Single Stitches are useful as short traveling stitches, and to achieve various hand stitching effects.

Shortcuts
■ Freehand Create Tab; Precise Create Tab, Command: 
■ Keys: Alt, R, N; Alt, P, N

Single Stitch Properties
Set the Length of single stitches from 1 to 12mm in steps 
of 1mm. The initial setting is shown in Creating Stitches 
Preferences .

Break up into smaller stitches
Break up stitches longer than the selected length into 
stitches of this length.

Alignment Stitches
Use Alignment Stitches to add stitches at the beginning of an 
embroidery that you can use to align the embroidery, for 
example with a background picture on fabric.

An Alignment Stitch is shown by a small purple circle with an A .

Five types of alignment stitch are available: Cross, Top Left 
Corner, Top Right Corner, Bottom Left Corner and Bottom 
Right Corner. When first placed, a Cross is used.

Alignment Stitch
Use Alignment Stitch  to insert a cross-shaped alignment 
stitch.

Click to place alignment stitches, which are shown as crosses in the current color. Each 
cross is 10mm wide. Two or three alignment crosses should be sufficient in most 
circumstances.

Use the Alignment Stitches dialog to select a corner alignment stitch. These alignment 
stitches are corner shaped, so they can be used even if your design goes up to the edge of 
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the chosen hoop. Choose from: Top Left Corner , Top Right Corner , Bottom Left 
Corner , Bottom Right Corner  or Point .

Shortcuts
■ Freehand Create Tab; Precise Create Tab, Command: 
■ Keys: Alt, R, G; Alt, P, G

Place an Alignment Stitch
1 In the Freehand Create, or Precise Create, tab select Alignment Stitch .
2 Click the point on the picture where you want to add an alignment stitch. 

A cross-shaped stitch and Alignment Stitch marker  are added at the point where you click.
3 Click Undo  to remove any unwanted alignment stitches.
4 Select an alignment stitch in the FilmStrip and right-click it, or right-click an alignment stitch in the 

work area, to open the Alignment Stitches dialog. Here you can select another alignment stitch type. 
5 Click OK to close the dialog.
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10Appliqué and Colors

Appliqué
Add appliqué when creating an area or line, with the ability to choose your preferred 
fabric or picture and an appliqué placement method.

Select Appliqué  when creating an area or line, choose an appliqué fabric or picture in 
the Appliqué Selection dialog box, and choose a placement method in the Appliqué tab 
of the Fill Area and Line options. See “Appliqué” on page 87.

Click Select Appliqué Fabric in the Appliqué drop-down menu to choose an appliqué 
fabric in the Appliqué Selection dialog box. See “Appliqué Selection” on page 186.

Shortcuts
■ Quick Create Tab, Fill Area and Line; Freehand Create Tab, Fill Area and Line; Precise Create 

Tab, Fill Area and Line:
■ Keys: Alt, Q, A; Alt, R, A; Alt, P, A

Appliqué Selection
Use the Appliqué Selection dialog box to select a fabric or picture to use for appliqué. Click 
OK to use the selected appliqué fabric.

Appliqué Type
Choose an appliqué type (or simply select one of the recently used swatches). Select from:

■ Quick
Select a color and texture for your fabric. See “Quick Appliqué Options” on page 187.

Select a Quick Color & texture

Choose an appliqué type

Choose a system fabric

Load an individual picture 

Preview the appliqué fabric

Reuse a recent fabric

or add a new one

for printed appliqué

Print a sheet of appliqué fabric
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■ Fabric
Select a background fabric, or add a new background fabric from a picture. Set the angle 
for the fabric. See “Fabric Options” on page 187.

■ Picture
Create in individual non-tiling appliqué from a picture. For instance, use a photo for a 
printed appliqué memory piece. See “Picture Options” on page 188.

■ Cut-out
Create an appliqué placement line as a guide to where the fabric should be cut to form a 
hole; for example, for reverse appliqué.

Quick Appliqué Options
The Quick Appliqué Options are available when Quick is selected in 
Appliqué Type. 
Select a color and texture for your fabric.

Color
Click the color sample to change the color in the Colors dialog 
box. See “Colors Dialog Box” on page 203.

Quick Colors
Click one of the Quick Colors to select a color for the fabric. Use the drop-down menu to 
choose a different Quick Colors theme, or to create your own theme. See “Quick Color 
Themes” on page 201.

Texture
Select the texture to use for the fabric. Click on the down arrow and choose the desired 
fabric type.

Fabric Options
The Fabric Options are available when Fabric is selected in 
Appliqué Type. 

Load Previously Saved Fabric
Use Load Previously Saved Fabric  to load a 
sample fabric, or a fabric from My Fabrics, in the Picture Viewer. See “Background Picture 
Viewer” on page 188.

Add New Background Fabric
Use Add New Background Fabric  to create a new fabric background in the 
Background Wizard. See “Background Wizard” on page 189.

Angle
Use Angle to change the angle at which the pattern will be displayed.

You may also change the angle and position of the fabric pattern directly by selecting the appliqué piece in 
the work area.
Enter an Angle from 0 to 359 degrees. The initial setting is 0. Alter the Angle by entering a 
number in the box, or use the up and down arrows to change the number. Changes in 
Angle are visible in the preview pane.
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Print Sheet
Print a sheet of appliqué fabric from the selected Quick Appliqué or Fabric pattern. Flip the 
picture for an iron-on transfer, and select a printer and paper size in the Print Setup dialog 
box. See “Print Setup” on page 418.

Picture Options
The Picture Options are available when Picture is selected in Appliqué Type. 
Click Select Picture to create a picture background in the Load Picture Wizard. See “Load 
Picture Wizard” on page 195.

Fabric Preview
The chosen fabric is previewed on the right.

Recent Swatches
Select a recently used fabric to use again.

■ Keys: Alt, Q, A, F; Alt, R, A, F; Alt, P, A, F

Background Picture Viewer
Use the Picture Viewer to select a fabric from the system fabrics, or from the My Fabrics 
folder with fabric backgrounds you have added.

To open the Picture Viewer, in the Appliqué Selection dialog box select Fabric, then click Load Previously 

Saved Fabric .
Open a folder, and scroll down and click a fabric to select it. Click OK to load the fabric in 
the Appliqué Selection dialog box.

To create a new fabric in the Background Wizard, in the Appliqué Selection dialog box select Fabric, then 

click Add New Background Fabric . See “Background Wizard” on page 189.

Choose a fabric folder

Scroll to view more fabrics

Click to select a fabric

Scroll to view more folders

Change the icon size

Load the selected fabric
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Background Wizard
Use the Background Wizard to create a new appliqué fabric from a picture.

Choose Picture
Use the Choose Picture page of the Background Wizard to select a picture for the new 
appliqué fabric.

From Scanner or Camera will not be available if you do not have a WIA compliant scanner or digital 
camera attached to your computer.

Load a Picture
Click Load a Picture  to open a picture from clipart, or one you have previously saved, 
scanned or created in an image editor. Click to select a picture, then click OK to continue.

Hover the pointer over a picture to see a tooltip showing its name. The name may also be displayed below 
the picture, depending on the chosen icon size.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 

Select a picture file on
your computer

Paste a copied picture

Import a file from a scanner
or camera

The picture is previewed

Load a picture from Facebook®, 
Instagram®, Flickr®, or Twitter®  

Choose a picture folder

Scroll to view more pictures

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture
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uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf) 
and Windows Icon (.ico).

Load a Picture for a Background
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 If desired, change the icon size to see more or fewer pictures.
4 Click on a picture to select it.
5 Click OK to open the picture in the Choose Picture page, with its name underneath.
6 Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture  to load the picture in the Clipboard Block.

Paste Picture is not available if the Clipboard block is empty.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s 
scanning or downloading program to another program, in this case the PREMIER+™ 2 Create module of 
the PREMIER+™ 2 Embroidery System. If the manufacturer provides the appropriate software components 
needed for WIA compliance, these should have been installed when the device was installed.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the Picture, it will be shown 
in the Choose Picture page.

Social Media Picture
Load a picture from Facebook® , Instagram® , Flickr® , or Twitter® . Log in to the 
Social Media website to load the desired picture.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.
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Rotate and Crop Picture
Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the background, and rotate the picture. If required, adjust the crop lines to select 
the desired part of the picture.

■ To adjust the crop area, position the mouse over the crop boundary until a double-headed 
arrow  appears, then click and drag to move the boundary line.

■ To move the crop area, position the mouse inside the crop boundary until a four-headed 
arrow  appears, then click and drag to move the whole rectangle.

■ To redraw the crop area, click and drag outside the crop boundary to draw a new 
rectangle, which can then be adjusted as required.

Initially, about half the area of the picture is selected from the middle of the picture, as 
shown by the dashed box in the picture on the left. The preview on the right shows four 
copies of the selected fabric area tiled together.

The tiled preview will change dynamically as you change the crop area.

To see where the four sections of the background are 
joined, select the Show Divider option. Dashed lines show 
where the tiled sections will be joined. This is useful for 
patterned fabric, to ensure the pattern repeats as desired.

When the desired area is selected, click Next.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the 
picture angle as desired. This is often necessary with 
scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

Drag crop lines to select area

Drag inside area to move it

Click outside area to redraw it

Show divider lines for tiled area
Zoom in and out

Change the angle of the picture
Use the default crop settings

Select the whole picture

Correct the perspective in the picture Save the picture
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When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

The fabric preview on the right is not affected by zoom.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Enable perspective correction

Drag the red handles 
to select an area

Adjust the proportions of the picture Save the edited picture
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Set Size
Use Set Size to enter a real measurement of the fabric so that it will be displayed at real 
size when it is used as the appliqué fabric.

The cropped section of fabric is shown in the preview. Click and drag the arrows at either 
end of the yellow line to place a line across the picture. This should match a measurement 
you have made across the same area of the real fabric.

Then enter the length of the line in the ’Length of displayed line’ text box, or use the up/
down arrows.

The length can be from 1mm to 300mm. However, the fabric tile must not be larger than 
300mm x 300mm, so if the line does not span the whole picture it must be shorter than 
300mm.

If the length would make the fabric tile larger than 300mm in either dimension, a message will appear. 
Repeat the process so that the tile is smaller.
Click OK and the measurement you entered will be shown next to the picture. Check that 
the line and the length matches the measurement you made of the real fabric. If desired, 
click and drag the arrows to place a new line and re-enter the line length.

When the line is measured correctly, click Next.

Drag the arrows to place the line

Input the length of the line
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Set Background Name
Use Set Background Name to save the finished appliqué fabric in a category and give it a 
name. The categories are the folder names you will see when browsing for existing 
backgrounds.

Background Name
If you started with an existing picture, the picture name will be shown by default as the 
name for the new background. If you scanned a new picture, it will not have a name so 
you will need to enter a name.

Fabric Category
The default category is My Fabrics. To choose a different category, browse among the 
folders in Fabrics.

Select from existing categories, or click Make New Category to provide the name of a new 
category.

Make New Category
To make a new category, click Make New Category, and enter a new folder name. Click OK 
to create the category.

The new category will be created as a subfolder for the currently selected type.
When make a new category, it will be available as a Fabric Category next time you use the 
Background Wizard.

Finish
Click Finish to save the new background with the specified name in the specified Fabric 
Category and close the Background Wizard. The selected or new background will be 
displayed in the work area.

Select an existing category

Create a new category

Enter a background name
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Load Picture Wizard
Use the Load Picture Wizard to use a picture as an individual non-tiled appliqué 
background, for example for a printed appliqué memory piece.

Choose Picture

Use the Choose Picture page to select the picture you wish to use as a background.

Load a Picture
Click Load a Picture  to open a picture from your My Pictures folder. Alternatively, 
browse to a folder elsewhere on your computer. 

Hover the pointer over a picture to see a tooltip showing its name. The name may also be displayed below 
the picture, depending on the chosen icon size.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
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Image File Format uncompressed (.tiff., tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

Load a Picture with the Viewer
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 If desired, change the icon size to see more or fewer pictures.
4 Click on a picture to select it.
5 Click OK to open the picture with its name underneath.
6 Click Cancel to exit without selecting a picture.

Paste Picture
Click Paste Picture  to load the picture in the Clipboard Block. The picture is shown in 
the preview area.

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA is a standard method for transferring pictures from the device’s scanning or downloading program to 
another program. If the manufacturer provides the appropriate software components needed for WIA 
compliance, these should have been installed when the device was installed. 
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the picture, it will be shown 
in the Choose Picture page.

Social Media Picture
Load a picture from Facebook® , Instagram® , Flickr® , or Twitter® . Log in to the 
Social Media website to load the desired picture.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Next
Go to the Rotate and Crop Picture page.
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Rotate and Crop Picture

Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the appliqué background. If required, rotate the picture, and click and drag the 
boundary line of the crop area to select the desired part of the picture.

Click and drag anywhere inside the crop box to move the crop box.

If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop 
it expanding.
When the desired area is selected, click Finish.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the picture angle as desired. This is 
often necessary with scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Crop
Select the section of the picture that is to be used to create the appliqué background. If 
required, rotate the picture, and click and drag the handles on the boundary line of the 
crop area to select the desired part of the picture.

Click and drag anywhere inside the crop box to move the crop box.

If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop 
it expanding.
When the desired area is selected, click Finish.
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Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Choose Picture page.

Finish
Use the selected image for the appliqué.
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Appliqué Method
Use the Appliqué tab of the Fill Area and Line properties dialog box to select an Appliqué 
Method for appliqué placement, and set the Appliqué Piece Margin. See “Fill Area and Line 
Properties” on page 86.

Appliqué Placement
When appliqué is created, additional 
stitches are added at the beginning 
of the appliqué piece for placing the 
appliqué fabric. Use these options to 
determine how these stitches are 
added. The border used to finish the 
appliqué is the chosen line type in 
the Line tab of the Fill Area and Line 
properties dialog box.

Appliqué Method
Select the appliqué method before or after creating an area or line. Choose from:

• None
• Standard Appliqué
• Pre-cut Piece
• Pre-placed Piece
• Cut-out

Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to 
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the 
fabric may be trimmed. Finish the edges with the selected border stitching.

Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork 
needles.

Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.

Pre-placed Piece
Place the appliqué fabric before stitching.

Place the appliqué layer in position, then stitch down the appliqué fabric with double 
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border 
stitching.

Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example 
for reverse appliqué.
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Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the 
stitched outline. Finish the edges with the selected border stitching.

Select Fabric
Use Select Fabric to choose a fabric for your appliqué in the Appliqué Selection dialog box.

Click Select Fabric and the Appliqué Selection dialog box appears. See “Appliqué 
Selection” on page 186.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.
Placement stitches are set to 2.0mm initially. To alter the stitch length for individual lines, use the Break 
Apart function for the area.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.

Export Appliqué
Use Export Appliqué Pieces  in the File menu to save or print appliqué outlines ready 
for cutting.

There are five export methods: save as SVG, DXF or FCM files for use in fabric cutters, save 
as VP4 or VP3 stitch files for use with Inspira Cutting Needles, print as an outline template 
to cut around, print directly onto printable fabric or an iron-on transfer (this prints the 
image of the appliqué piece), or save as SVG files with the fabric image placed as the fill for 
each shape (for use with fully customized layouts).

See “Export Appliqué Pieces” on page 179 for more information.
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Quick Color Themes
Use Quick Color Themes for quick selection of thread colors using a related set of colors. 
Create your own Quick Color Themes, which are available for selecting thread colors in 
PREMIER+™ 2 Create, and in the Color Selection dialog box in other modules. Also use 
Quick Color Themes to set fabric colors in the Appliqué Selection dialog box.

Select a Quick Color
1 Open a dialog box with the Quick Colors area.
2 Click the drop-down menu below, or to the right of the Quick Colors to choose a Quick Color Theme.

In this menu you can also select Edit Themes to create a new theme, or edit a Custom theme.
3 Click the desired Quick Color. The nearest shade that is available from the current thread range will be 

selected. 
This is also a quick way to jump to threads of that color (for example, click light yellow in the Standard 
Theme to jump to light yellow thread shades).

Add a Quick Color Theme
You can add or customize your own Quick Colors themes in the Color Selection or 
Appliqué Selection dialog box in most PREMIER+™ 2 Embroidery System modules.

1 Open a dialog box with the Quick Colors area such as the Color Selection dialog box.
2 Click the drop-down menu to the right of the Quick Colors and select Edit Themes. The Edit Quick 

Color Themes dialog box opens.
Note that if one of the system Themes is selected, the editing options will be unavailable (grayed out).

3 Select a Theme from the drop-down menu at the top.
Your new Theme will be based on the colors in this theme.

Select a Theme

Delete a custom ThemeCreate a new custom Theme

Give your Theme a name

Choose a color block to edit
Edit the selected color
Apply your changes

Color sample box

Copy a color to the sample box
Paste the sample box color

Replace all colors with the
sample box color
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4 Click the Add New button. A new theme ’Untitled’ appears.
5 Give your new theme a name, then click Apply. 

You can now select your new theme from the drop-down list 
at the top.

6 Select a color in the palette.
7 Click the Edit Color button. The Colors dialog box appears. 

See “Colors Dialog Box” on page 203.
8 Choose a new color from the Standard or Custom tab, then 

click OK. Your chosen color will replace the original color.
9 To copy a color, select a color in the palette, then click Copy 

Color. Your selected color will appear in the Color Box.
10 To paste the color in the Color Box, select a color in the 

palette, then click Paste Color. The color in the palette will be 
replaced.

11 To replace all colors in the palette, click Paste To All.
12 Click Apply to save the changes to your new Quick Color 

Theme.
13 Click Close to finish editing your new Theme.

To make further edits to your theme, select Edit Themes in the Quick Colors Theme menu.

Edit Quick Color Themes

Theme
Select a Theme from the drop-down list. 

Any new Theme will be based on the colors in this theme.

Add New
Click Add New to create a new theme.

Delete Theme
Click Delete Theme to remove a custom Theme.

You cannot delete system Themes.

Name
Enter the desired theme name.

Theme Colors
Click a color in the grid and a box will appear around the selected 
color.

Edit Color
Click Edit Color to change the currently selected color in the Colors 
Dialog Box. Alternatively, double-click a color to change it in the Colors Dialog Box.

Apply
Click Apply to save the changes you have made.

Copy Color
Click Copy Color to place the color in the color sample box, to the right of the button.

Use the color sample box to copy a color from one theme to another.
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Paste Color
Click Paste Color to replace the color in the currently selected grid position with the color 
in the sample box.

Paste To All
Click Paste To All to place the color in the sample box in all the grid positions. This is useful 
when starting a new Theme if you wish to vary the Theme around a single initial color.

Close
Click Close to finish editing the new theme. The new them is added to the end of the 
Theme list.

You will be asked if you want to save any changes you have made, if you have not clicked Apply.

Change a Quick Color Theme
Select an existing Quick Color Theme you wish to change from the Theme drop-down list, 
then click Edit Theme.

The predefined Quick Color Themes may not be edited. However, you may use any predefined theme as the 
basis for a new theme.
The options are the same as when you Add a Quick Color Theme. See “Edit Quick Color 
Themes” on page 202.

Delete a Quick Color Theme
1 In the Edit Quick Color Themes dialog box, use the Theme drop-down list to select the Theme you 

wish to remove. 
2 Click Delete Theme. A message will appear to remind you that this action may not be reversed. 
3 Click Yes and the theme will be deleted.

The predefined Quick Color Themes may not be deleted.

Colors Dialog Box
The Colors dialog box is used to choose or change 
a color for a thread, or modify any color in a Quick 
Colors Custom theme.

When the Colors dialog box appears, it shows the 
Standard color selection. If desired, click one of 
the Standard colors. A highlight shows the 
selected color. The New/Current box shows the 
difference between the newly chosen color and 
the color currently used.
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Click the Custom tab to be able to select any of 
the 16 million RGB colors.

Click in the blended color palette to choose a 
basic color, then use the slider at the side to 
choose the desired brightness level. The HSL and 
RGB values are updated as you change the color 
and the color is previewed in the New/Current 
box.

You can also directly enter Hue, Sat(uration), 
Lum(inance) (HSL) and/or Red, Green, Blue (RGB) 
values. Alternatively, use the up/down buttons on 
each of the HSL and RGB value boxes to make fine 
adjustments to the color.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value 
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue. 
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a 
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color. 
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value 
between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a 
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has 
three primary colors — red, green, and blue — that it creates by emitting light. These 
three colors are combined in various proportions to produce all the colors displayed on 
your screen. They are referred to as additive because they combine to produce white. 
Primary colors are measured as a value from 0-255. The colors produced by combining the 
three primaries are a result of the amount of each of those shades present. For example, 
pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red 
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to 
zero, the color is black; if all three are 255, they produce white.
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11Creating Fills and Lines
Create Fills and Lines with the QuickStitch™, Freehand Create, Precise Create and Shape 
functions. Set stitch options before creation, or edit them afterwards.

To edit a line or fill, right-click it in the FilmStrip or on the work area and change its properties in the Fill 
Area and Line Properties dialog. See “Fill Area and Line Properties” on page 86.

Creating with Quick Create
The Quick Create functions QuickStitch™ and QuickTrace are used to create new stitch 
objects (lines, fills or holes) by using color areas in the background picture.

Select the desired QuickStitch™ or QuickTrace function, then click your chosen part of the 
picture. Adjust Color Tolerance (if enabled), then click OK to create the object.

Using QuickStitch™ and QuickTrace
1 Select the desired QuickStitch™ or QuickTrace function in the Quick Create tab, according to the type 

of object you want.
2 Then, click in the desired area of the picture for QuickStitch™ functions or on the desired line for 

QuickTrace functions.
3 If Color Tolerance is enabled, the color area will be highlighted. Adjust tolerance, if desired.
4 Click OK to create the object(s). 

If Color Tolerance is not enabled, the object(s) will be created immediately.

Color Tolerance
Color Tolerance is available for all the QuickStitch™ and QuickTrace functions. It allows 
parts of a picture to be selected for filling or tracing according to how similar they are in 
color to the chosen color. Also, use Color Tolerance to preview the shape of the new stitch 
object, and to select the relative number of points in the line or border.

Turn Color Tolerance on and off with the Color Tolerance option in Preferences .

Select an Area with Color Tolerance
1 Set stitch options, then select the desired QuickStitch™ or QuickTrace function in the Quick Create 

tab.
2 Click on the color area or outline you wish to fill, border or 

trace. The Color Tolerance dialog box will appear. The 
tolerance value is always zero when the dialog box appears.

3 Set the number of points used in the outline for the object. 
High creates a more detailed, but less smooth, outline than 
Medium or Low.

4 Move the slider bar to the required Color Tolerance value. 
There are four ways to move the slider:
i) Click either side of it to move the slider by 20% in the 
relevant direction
ii) Click and drag the slider to any value
iii) Press the left and right arrow keys to change the Color Tolerance value in 1% steps
iv) Enter a Color Tolerance value directly in the number box
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5 A red and cyan highlight on the design area shows the 
area that will be filled or traced. If you have chosen to 
detect holes, any holes in the area will be highlighted by 
green and yellow lines. Adjust the Color Tolerance value 
until the required part of the picture is selected.

6 Click OK when you have selected the desired part of the 
picture. The fill or trace will be generated as usual.

7 Alternatively, if you want to start from a different point 
(e.g. a different band of color) click Cancel and nothing 
will happen. Then click the picture at the new point and 
set the Color Tolerance as required.

QuickStitch™ and Color Tolerance
Color Tolerance helps you to create new objects with QuickStitch™ across and/or around 
shaded or variegated areas of color, reducing or eliminating the need for placing areas by 
hand. Color Tolerance can be used with the following QuickStitch™ functions:

QuickTrace and Color Tolerance
Preview the outline that will be traced with Color Tolerance. This means you can see if 
there are any breaks in the outline, possibly caused by slight variations in shade in the 
outline which you can overcome by increasing the Color Tolerance. Color Tolerance can be 
used with the following QuickTrace functions:

Creating with Freehand and Precise Create
Use the Freehand and Precise Create functions to create new lines, fill areas or holes (stitch 
objects) by creating outlines directly on the design.

The outlines may follow a background picture, if desired, but the Freehand and Precise Create functions do 
not require a picture.
If the curve produced does not match the background picture as closely as desired, you can move, delete 
and insert points using the tools in the Home tab.
These functions are used either by drawing an outline as if using a tablet (the Freehand 
Create or Tablet functions) or by placing and adjusting points to define an outline (the 
Precise Create Bezier Line or Point Line functions).

Ties and movement stitches are added automatically between objects, when the option is selected in 

Preferences .

QuickStitch™ QuickStitch™ Satin

QuickStitch™ + AutoHole QuickStitch™ Multiple Satin

QuickStitch™ Hole

Double Trace Satin Line Trace

Quadruple Trace Motif Line Trace
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After a line or fill area has been created, right-click the area to change its properties in Fill Area and Line 
properties.
Alternatively, make a selection of fill areas visible and change them all with Global Properties, or hold the 
Ctrl key and click the desired fill areas in the FilmStrip, then right-click one of them and select Properties to 
change the properties for the selected objects.

Freehand Create
When using the Freehand Create, or tablet drawing functions, the stitch objects are 
created by drawing outlines on the design. 

Outlines can be drawn by using a pen on a graphics tablet or by using click and drag with a mouse. 
Freehand Create (tablet) mode provides a more natural drawing experience and is 
generally recommended.

Freehand Create (Tablet) functions:

Select the desired line or fill and border type, then draw each individual object by drawing 
a continuous line. When the pen is lifted, or the mouse button is released, the object is 
completed. The next line drawn creates another new object. This continues until the 
function is deselected.

Precise Create
When the Precise Create functions are selected, stitch objects are created by placing a 
series of points that define the outline, or by drawing Bezier lines. 

Placing points and Bezier lines allows precise positioning of curves, corners and straight 
line sections.

Precise Create (Point) functions:

Select the desired fill and/or border type, then each point is placed by a single click (or 
click and drag for Bezier lines). The outline is completed with a right-click. Right-click again 
to deselect the function.

Hold down Ctrl to place square (angular) points, instead of round (curved) points.

Creating Shapes
Use Shape  to place a selected shape in the work area and adjust its size and properties. 
Draw a ring, a square, a frame or other shape using Shape.

Create Freehand Area or Line Freehand Emboss Line

Freehand Hole Freehand MultiWave Line

Freehand Satin Area

Create Precise Area or Line (Point and 
Bezier mode)

Precise Emboss Line (Point mode only)

Precise Hole (Point and Bezier mode) Precise MultiWave Line (Point mode only)

Precise Satin Area (Point mode only)
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Shape
Use Shape  to draw a fill area with or without a border, or a line on the work area. Then 
adjust its size and properties. Select a fill and line to draw a fill area surrounded by a 
border, or select a line type only to draw a closed line with no fill.

Draw a ring, a square, a frame or other shape using Shape.

Shortcuts
■ Quick Create Tab:
■ Keys: Alt, Q, S

Draw a Filled Shape with a Border
1 In the Quick Create tab, ensure that Fill and Line are selected.
2 Select a fill and border type, setting the Options for Fill Area and Line as desired.
3 Add a color change, or adjust the color in the worksheet. This sets the color for the fill.
4 Click Fill Area and Line, and in the Line tab select (check) Insert Color Change. Then click Line Thread 

Color and set the color for the border.
5 Select the type of shape you wish to draw from the drop-down list.
6 Click the Shape icon . The shape is placed in the center of the work area 

as a selected block.
The dimensions of the box surrounding the shape are shown in the status bar.

7 Click and drag the shape to the preferred position, and resize it as desired 
using the square corner handles.
Hold down Ctrl as you click and drag to resize proportionally. Hold down Shift 
to resize from the center.

8 Right-click the shape and select Properties to change the stitch type and 
settings for the line and fill.
Note that the second color in the worksheet (the secondary color without a number by it) is the color for 
the border. You can also see it in the FilmStrip.l

9 If desired, draw another shape or click Undo  and draw the shape again.

Draw an Unfilled Shape
1 Click the Fill button to deselect it, and ensure that Line type only is selected.
2 Choose stitch type for the line.
3 Add a color change, or adjust the color in the worksheet. This sets the color for the line.

A border without a fill uses the primary color.
4 Select the type of shape you wish to draw from the drop-down list.
5 Click the Shape . The shape is placed in the center of the work area as a 

selected block.
The dimensions of the box surrounding the shape are shown in the status bar.

6 Click and drag the shape to the preferred position, and resize it as desired 
using the square corner handles.
Hold down Ctrl as you click and drag to resize proportionally. Hold down Shift 
to resize from the center.

7 Right-click the shape and select Properties to change the stitch type and 
settings for the line.

8 If desired, draw another shape or click Undo  and draw the shape again.
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QuickStitch™ Functions
Use the QuickStitch™ functions QuickStitch™ , QuickStitch™ + AutoHole  and 
QuickStitch™ Hole  to automatically fill clicked on color areas of the picture with fill 
areas of small stitches surrounded by a border, a line, or holes in fill areas. QuickStitch™ can 
create lines and fill areas with or without automatic holes.

Set stitch options before creation, or after a fill area has been created, you can right-click it in the FilmStrip 
or work area to change its properties in Fill Area and Line properties.
Using the Edit tab tools, you can make a number of fill areas of the same type (e.g. Pattern Fill) visible and 
change them all with Global Properties. Alternatively, hold the Ctrl key and click the desired fill areas in the 
FilmStrip, then right-click one of them and select Properties; the properties for all selected areas will be 
changed.

Create a QuickStitch™ Area
1 Set stitch options, then click the QuickStitch™ icon  or the QuickStitch™ + AutoHole  icon.
2 Click in the color area you wish to fill with stitches.
3 If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color 

Tolerance as required. The area selected by the Color Tolerance value will be previewed. If you 
selected a function with AutoHole, any holes in the area will be shown. Click OK to confirm.

4 Stitches representing the border and fill pattern set in the Options for Fill Area and Line appear in the 
area. For QuickStitch™ + AutoHole, any holes detected will be cut out.

5 Repeat to place as many fill areas as desired.
6 Right-click to deselect the function, or simply select another Create tool.
7 To edit the fill or the border, click the fill area to select it, then right-click it and change the properties 

in the Fill Area and Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 86.

QuickStitch™
Use QuickStitch™  to click in a color area to create a fill area 
with or without a border, or a line automatically. If required, 
use Color Tolerance to select a larger area according to the 
similarity of adjacent colors.

Shortcuts
■ Quick Create Tab, Fill Area and Line: 
■ Keys: Alt, Q, Q

Create a QuickStitch™ Fill Area
1 Select your fill and border type.
2 Click the QuickStitch™ icon .
3 Click in the color area you wish to fill with stitches.
4 If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color 

Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to 
confirm.

5 Stitches representing the border and fill pattern set in the Options for Fill Area and Line appear in the 
area.

6 Repeat to place as many fill areas as desired.
7 Right-click to deselect, or simply select another Create tool.



210          PREMIER+™ 2 Create   Creating Fills and Lines 

8 To edit the fill or the border, click the fill area to select it, then right-click it and change the properties 
in the Fill Area and Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 86.

Create a QuickStitch™ Line
1 Select your line type, ensuring that Fill is not selected.
2 Click the QuickStitch™ icon .
3 Click in the color around which you wish to create a border.
4 If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color 

Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to 
confirm.

5 A border will appear around the area.
6 Repeat to place as many borders as desired. 
7 Right-click to deselect, or simply select another Create tool.
8 To edit the border, click it to select it, then right-click and change the properties in the Fill Area and 

Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 86.

QuickStitch™ + AutoHole
Use QuickStitch™ + AutoHole  to fill an area with small 
stitches in alternating patterns automatically, while also cutting 
out 'holes' in the area, by clicking in a color area of the picture. If 
required, use Color Tolerance to select a larger area according 
to the similarity of adjacent colors.

Shortcuts

■ Quick Create Tab, Fill Area and Line: 
■ Keys: Alt, Q, H

Create a QuickStitch™ Area with a Hole Automatically
1 Select your fill and border type.
2 Click the QuickStitch™ + AutoHole  icon.
3 Click in the color area you wish to fill with stitches.
4 If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color 

Tolerance as required. The area selected by the Color Tolerance value will be previewed, and any 
holes in the area will be shown. Click OK to confirm.

5 Stitches representing the border and fill pattern set in the Options for Fill Area and Line appear in the 
area, and any holes detected will be cut out.

6 Repeat to place as many fill areas as desired.
7 Right-click to deselect, or simply select another Create tool.
8 To edit the fill or the border, click the fill area to select it, then right-click it and change the properties 

in the Fill Area and Line Properties dialog. Click OK to save the changes.
See “Fill Area and Line Properties” on page 86.
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QuickStitch™ Hole
Use QuickStitch™ Hole  to cut out holes within the currently 
selected fill area automatically, by clicking in the required color 
areas of the picture. If required, use Color Tolerance to select a 
larger area according to the similarity of adjacent colors.

This is useful to cut out holes in an existing fill area with a background 
picture.
Also use QuickStitch™ Hole  to create specific holes that were 
not previously removed. For example, some holes you wanted 
may have been included in the fill area because of the Color 
Tolerance setting.

Shortcuts
■ Quick Create Tab, Enhance: 
■ Keys: Alt, Q, U

Create a Hole in a Fill Area Automatically
1 Click in the fill area in which you want to create a hole.
2 Click QuickStitch™ Hole . 
3 Click in a defined color area within the fill area to cut out a hole.
4 Repeat to create more holes, as desired. 
5 Right-click to deselect, or simply select another Create tool.
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QuickTrace
Use the QuickTrace  functions Double Trace , Quadruple Trace , Satin Line 
Trace , or Motif Line Trace  to place double or quadruple lines of stitches, satin 
borders or motif lines by clicking lines in the picture. The traced design is created as a 
group.

All connected lines will be traced.

You can set stitch options before creation, or after. 

Double Trace and Quadruple Trace use the stitch length setting for Running Stitch in Fill Area and Line  
properties, as does Running Stitch used in Satin Line Trace. The Running Stitch sections for Motif Line trace 
use a fixed length of 1.5mm. The Satin Line and Motif Line for tracing use the settings in Fill Area and Line.
To change stitch settings after the stitches have been created, right-click an object to change the 
properties in the Fill Area and Line dialog box.
To change multiple objects, click a single object in the Group for the traced design, then right-click and 
choose Select Similar from Group . Right-click the object again, and select Properties to choose settings 
for all objects of that type, e.g. Running Stitch, in the design. See “Select Similar from Group” on page 356.
Alternatively, change all visible objects of one type with Global Properties, or hold the Ctrl key and click the 
desired objects in the FilmStrip, then right-click one of them and select Properties to change the properties 
for the selected objects.

Using QuickTrace
1 Zoom In so that you can clearly see the line where you wish to create the QuickTrace. This will help 

with thin outlines that are difficult to select.
2 Set stitch options, then in the Trace  drop-down menu on the Quick Create tab, select Double 

Trace , Quadruple Trace , Satin Line Trace , or Motif Line Trace .
3 Click the outline you wish to trace.

Double Trace Quadruple Trace

Satin Line Trace Motif Line Trace
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4 If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color 
Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to 
confirm.

5 The stitch lines or satin border will be created as a Group, and the function is automatically 
deselected. For satin border, a running stitch is used underneath the border to stabilize and connect 
border sections.

6 Repeat as desired.
7 To edit the border, click an object in the group to select it, then right-click and choose Select Similar 

from Group . Right-click again and change the properties in the Fill Area and Line Properties dialog. 
Click OK to save the changes. All stitch lines of the selected type will use the new settings.
See “Fill Area and Line Properties” on page 86.

Double Trace
Create two layers of stitches following the selected line 
automatically, by clicking on it. Double Trace produces a layer of 
double stitch, with some running stitch where needed. The 
trace begins and ends at the closest point on the selected 
outline to the previous object, and is created as a Group. If 
required, use Color Tolerance to select a larger area according to 
the similarity of adjacent colors. Stitch length may be from 1.0 to 
12mm. Set it beforehand, or if desired, alter it afterwards in the 
properties dialog.

Double Trace uses the stitch length setting for Running Stitch in Fill Area and Line  
properties.

For complex outlines, a group of double and running stitch lines is created to make up the trace. To alter 
the length of all the stitches, click a single object in the Group for the traced design, then right-click and 
choose Select Similar from Group . Right-click the object again, and select Properties to choose settings 
for all objects of that type, e.g. Running Stitch, in the design. Alternatively, in the Edit tab either hide all 
objects before and after the trace, then use Global Properties to adjust the stitch lengths, or hold the Ctrl 
key and select the desired stitches then right-click one and select Properties to adjust the stitch lengths for 
the selected lines.
Repeat to trace more lines, and right-click to deselect.

Shortcuts
■ Quick Create Tab: 
■ Keys: Alt, Q, T, D

Quadruple Trace
Create four layers of stitches following the selected line 
automatically, by clicking on it. Quadruple Trace produces a 
layer of running and a layer of triple stitches. The trace begins 
and ends at the closest point on the selected outline to the 
previous object, and is created as a Group. If required, use Color 
Tolerance to select a larger area according to the similarity of 
adjacent colors. Stitch length may be from 1.0 to 12mm. Set it 
beforehand, or if desired, alter it afterwards in the properties 
dialog.
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Quadruple Trace uses the stitch length setting for Running Stitch in Fill Area and Line  
properties.

For complex outlines, a group of running and triple stitch lines is created to make up the trace. To alter the 
length of all the stitches, click a single object in the Group for the traced design, then right-click and choose 
Select Similar from Group . Right-click the object again, and select Properties to choose settings for all 
objects of that type, e.g. Running Stitch, in the design. Alternatively, in the Edit tab either hide all objects 
before and after the trace, then use Global Properties to adjust the stitch lengths, or hold the Ctrl key and 
select the desired stitches then right-click one and select Properties to adjust the stitch lengths for the 
selected lines.
Repeat to trace more lines, and right-click to deselect.

Shortcuts
■ Quick Create Tab: 
■ Keys: Alt, Q, T, Q

Satin Line Trace
Create a satin border that follows the selected line 
automatically, by clicking on it. If required, use Color Tolerance 
to select a larger area according to the similarity of adjacent 
colors. The border width can be from 1 to 12mm. Set it 
beforehand, or if desired, alter it afterwards in the properties 
dialog. The Satin Line Trace is created as a Group.

The Satin Line uses the settings for Satin Line in Fill Area and 
Line  properties, and the Running Stitch uses the stitch 
length setting there for Running Stitch.

For complex outlines, a group of satin borders is created to make up the trace. To alter properties of all the 
borders, click a single object in the Group for the traced design, then right-click and choose Select Similar 
from Group . Right-click the object again, and select Properties to choose settings for all objects of that 
type, e.g. Running Stitch, in the design. Alternatively, in the Edit tab either hide all objects before and after 
the satin trace, then use Global Properties to adjust width, density and underlay, or hold the Ctrl key and 
select the desired satin borders then right-click one and select Properties to adjust width, density and 
underlay for the selected lines.
Repeat to trace more lines, and right-click to deselect.

Shortcuts
■ Quick Create Tab: 
■ Keys: Alt, Q, T, S



PREMIER+™ 2 Create   Creating Fills and Lines              215

Motif Line Trace
Create a motif line that follows the selected line automatically, 
by clicking on it. If required, use Color Tolerance to select a 
larger area according to the similarity of adjacent colors. The 
Motif Line Trace is created as a Group.

The Motif Line uses the settings for Motif Line in Fill Area and 
Line  properties. The Running Stitch sections for Motif Line 
trace use a fixed length of 1.5mm.

For complex outlines, a group of motif lines is created to make up the trace. 
Set options beforehand, or to alter properties of all the borders click a single object in the Group for the 
traced design, then right-click and choose Select Similar from Group . Right-click the object again, and 
select Properties to choose settings for all objects of that type, e.g. Running Stitch, in the design. 
Alternatively, in the Edit tab either hide all objects before and after the trace, then use Global Properties to 
adjust motif options, or hold the Ctrl key and select the desired motif lines then right-click one and select 
Properties to adjust motif options for the selected lines.
Repeat to trace more lines, and right-click to deselect.

Shortcuts
■ Quick Create Tab: 
■ Keys: Alt, Q, T, M
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Freehand and Precise Create Functions
Use the Freehand Create tablet drawing functions Create Freehand Area or Line , 
Freehand Hole , Freehand Emboss Line , Freehand MultiWave Line  and Freehand 
Satin Area , to create stitch objects by drawing outlines on the design.

See “Freehand Create” on page 207.
Use the Precise Create point placing and Bezier line functions Create Precise Area or 
Line , and Precise Hole , and the point placing functions Precise Satin Area , 
Precise MultiWave Line  and Precise Emboss Line  to create stitch objects by placing 
a series of points or Bezier lines that define the outline.

See “Precise Create” on page 207.

Create Freehand Area or Line
Use Create Freehand Area or Line  to draw a line to define 
the edge of an area filled with small stitches in repeating 
patterns with or without a border, or an unenclosed line.

Shortcuts
■ Freehand Create Tab, Fill Area and Line: 
■ Keys: Alt, R, R

Create a Line or Fill Area with Create Freehand Area or Line
1 In the Freehand Create tab select your line and/or fill type.
2 Click the Create Freehand Area or Line icon .
3 Draw a line along or around the desired area. 
4 When the line is complete, lift the pen from the tablet (or release the mouse button). If a fill was 

selected, the area is closed with a straight line back to the start point, and filled with stitches using the 
chose border and fill type.
You can change the border and fill in Fill Area and Line Properties.
When creating a fill area it is recommended to draw back to the start point. However, you can also adjust 
the shape on the work area, if the area is not the exact shape desired.

5 Continue to draw as many lines or fill areas as desired.
6 Right-click to deselect the function, or simply select another tool.

To change the object properties, right-click the line or fill area and edit the properties in the Fill Area and 
Line Properties dialog. See “Fill Area and Line Properties” on page 86.
To edit the object, or change the properties for more than one object at a time, use the FilmStrip. See 
“Editing a Design” on page 335.

Change Line or Fill Properties
■ Right-click the line or fill area and change its properties. Then click OK.

See “Fill Area and Line Properties” on page 86.
■ Alternatively, to change the properties of a number of lines or fills at one time, in the 

FilmStrip hold the Ctrl key and click each of the objects to be changed. Then right-click 
one of the selected objects and select Properties. The Fill Area and Line dialog box will 
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appear. All settings in the Fill Area and Line dialog box will be applied to your selected 
objects when you click OK.

■ If desired, move the start , end  and/or origin  for selected fill areas.

After moving the origin, use Life View  or Design Player  to see the effect.

Create Precise Area or Line
Use Create Precise Area or Line  to place points to create a 
line to define the edge of an area filled with small stitches in 
repeating patterns with or without a border, or an unenclosed 
line.

To draw the outline for a Line or Fill Area with Bezier Lines instead of Point 

Lines, click Bezier Mode  to enable drawing Bezier curves, then draw 
your Line or Fill Area. See “Bezier Mode” on page 222.

Shortcuts
■ Precise Create Tab, Fill Area and Line: 
■ Keys: Alt, P, R

Create a Line or Fill Area with Create Precise Area or Line
1 In the Precise Create tab select your line and/or fill type.
2 Click the Create Precise Area or Line icon . 

To draw the outline for a Line or Fill Area with Bezier Lines instead of Point Lines, click Bezier Mode  to 
enable drawing Bezier curves, then draw your Line or Fill Area. See “Bezier Mode” on page 222.

3 Click to place the first point. It appears as a small hollow yellow circle.
4 Click to place a second point. The new circle is now yellow, and the previous circle is white.
5 Continue placing points around the desired area, such as a chosen section of the background picture. 

If you are following the picture, place a point every time the direction of the picture outline changes. 
Curved lines are created automatically, unless fewer than three points are placed, in which case the lines 
will be straight. For corners and straight edges, hold down the Ctrl key. To delete the last point placed, use 
the Delete key.

6 Right-click to complete the area. Stitches will appear in the current thread color showing the line or 
fill area and border.

7 Continue to place as many objects as desired.
To change the line and fill properties, right-click the line or fill area and edit the properties in the Fill Area 
and Line Properties dialog. See “Fill Area and Line Properties” on page 86. 
To edit the line or fill, or change the properties for more than one area at a time, use the FilmStrip. See 
“Editing a Design” on page 335.
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Mitered Corners and Closed Shapes
When creating satin line by placing points, the corners of a satin 
border are mitered automatically when you hold down Ctrl and 
click to place a corner point. If you wish to make a closed shape 
with mitered corners, such as a square or rectangle, join the shape 
in the middle of one of the sides, as shown in the example. If the 
shape is joined at a corner, that corner will not be mitered as it will 
simply be two straight end points in the same place, rather than a 
true corner.

When drawing this type of satin line shape, overlap the start and end points 
slightly to ensure a neat join.

Freehand Hole
Use Freehand Hole  to cut out holes within the selected fill 
area, by drawing outlines to define the holes.

This function only affects the currently selected fill area.

Shortcuts
■ Freehand Create Tab, Enhance:
■ Keys: Alt, R, H

Create a Freehand Hole in a Fill Area
1 Select the area in which you want to cut the hole.
2 Click the Freehand Hole icon .
3 Draw a line around the edge of the desired area for the hole.
4 When the area is complete, lift the pen from the tablet (or release the mouse button). The area is 

closed with a straight line back to the start point.
It is recommended to draw back to the start point. However, you can also adjust the shape of the hole 
afterwards, if it is not the exact shape as desired.

5 Continue to cut as many fill holes as desired.
6 Right-click to deselect the function, or simply select another tool.

Precise Hole
Use Precise Hole  to cut out holes within the currently 
selected fill area, by placing points or drawing Bezier Lines to 
define the holes.

This function only affects the currently selected fill area.
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Shortcuts
■ Precise Create Tab, Enhance:
■ Keys: Alt, P, H

Create a Precise Hole in a Fill Area
1 Select the area in which you want to cut the hole.
2 Click the Precise Create tab.
3 Click the Precise Hole icon . 

To draw the hole with a Bezier Line, click Bezier Mode , then draw your hole. See “Bezier Mode” on 
page 222 for information on drawing Bezier Lines.

4 Click to place the first point. It appears as a small hollow yellow circle.
5 Click to place a second point. The new circle is now yellow, and the previous circle is white.
6 Continue placing points around the desired area, such as a chosen section of the background picture. 

If you are following the picture, place a point every time the direction of the picture outline changes. 
Curved lines are created automatically, unless fewer than three points are placed, in which case the lines 
will be straight. For corners and straight edges, hold down the Ctrl key. To delete the last point placed, use 
the Delete key.

7 Right-click to complete the hole. The hole will appear in the fill area.
8 Continue to cut as many holes as desired.

Emboss Line
Use the Emboss Line functions Freehand Emboss Line  and Precise Emboss Line  to 
create an embossed line on a fill area, satin area, or column.

Freehand Emboss Line 
Use Freehand Emboss Line  to draw a line to emboss on a fill area, satin area, or column.

Shortcuts
■ Freehand Create Tab, Enhance:
■ Keys: Alt, R, E; Alt, Q, E, F

Create a Freehand Emboss Line
1 In the Freehand Create tab select a fill area, satin area, or column.
2 Click the Freehand Emboss Line  icon.
3 Draw a line on the selected area. The emboss line will appear on the fill, with the first point as a square 

and later points as circles, except for a square final point.

To follow a background picture, select 2D View  in the View tab, and zoom in as necessary.

You can move points after the line has been created. To delete points, use Delete Points  in the Home 
tab.

4 Repeat to place as many embossed lines as desired. Right-click to deselect the function.

To change an embossed line, move its points, or use Insert Points  or Delete Point  in the Home tab.

Use Delete Emboss Line  in the Edit tab to remove an embossed line. See “Delete Emboss Line” on 
page 349.

Precise Emboss Line
Use Precise Emboss Line  to place points to emboss a line on a fill area, satin area, or 
column.
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Shortcuts
■ Precise Create Tab, Enhance:
■ Keys: Alt, P, E; Alt, Q, E, P

Create a Precise Emboss Line
1 Select a fill area, satin area, or column.
2 Click the Precise Create tab.
3 Click the Precise Emboss Line  icon.
4 Click to place the first point. It appears as a small hollow yellow circle.
5 Click to place a second point. The new circle is now yellow, and the previous circle is white.

To follow a background picture, select 2D View  in the View tab, and zoom in as necessary.
6 Continue placing points along the desired path. 
7 Curved lines are created automatically. For corners and straight sections, hold down the Ctrl key. 

You can move points after the line has been created. To delete points, use Delete Points  in the Home 
tab.

8 Right-click to end the line. The emboss line will appear on the selected fill or other area.
9 Repeat to place as many embossed lines as desired.

To change an embossed line, move its points, or use Insert Points  or Delete Point  in the Home tab.

Use Delete Emboss Line  in the Edit tab to remove an embossed line. See “Delete Emboss Line” on 
page 349.

MultiWave Line
Use the MultiWave Line functions Freehand MultiWave Line  and Precise MultiWave 
Line  to create a line that shapes the wave patterns in a MultiWave Fill.

Freehand MultiWave Line
Use Freehand MultiWave Line  to draw a line that shapes the wave patterns in a 
MultiWave Fill.

Use a long line to position the stitch lines in an embroidery, or use a short line to add texture to the 
stitching. The lines do not have to be within the fill area, however they should not cross each other. Vary the 
density or use a motif to change the effect.

Shortcuts
■ Freehand Create Tab, Enhance:

MultiWave Fill, using two long MultiWave lines to 
shape the flow of the fill within a leaf

MultiWave Fill, using a short MultiWave 
Line to add texture to an embroidery
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■ Keys: Alt, R, W; Alt, Q, W, F

Create a Freehand MultiWave Line
1 Select a MultiWave Fill area.
2 Click the Freehand Create tab.
3 Click the Freehand MultiWave Line  icon.
4 Draw a line over or near the selected area. 

The MultiWave line will appear on the fill, with the first point as a square and later points as circles, 
except for a square final point. The wave patterns in the fill will follow this line.

To follow a background picture, select 2D View  in the View tab, and zoom in as necessary.

You can move points after the line has been created. To add or remove points, use Insert Points  or 

Delete Points  in the Home tab.
5 Repeat to place as many MultiWave lines as desired. Right-click to deselect the function.

Use Delete MultiWave Line  in the Edit tab to remove a MultiWave line. See “Delete MultiWave Line” on 
page 349.



222          PREMIER+™ 2 Create   Creating Fills and Lines 

Precise MultiWave Line
Use Precise MultiWave Line  to place points to form a line that shapes the wave 
patterns in a MultiWave Fill.

Shortcuts
■ Precise Create Tab, Enhance:
■ Keys: Alt, P, W; Alt, Q, W, P

Create a Precise MultiWave Line
1 Select a MultiWave Fill area.
2 Click the Precise Create tab.

To follow a background picture, select 2D View  in the View tab, and zoom in as necessary.
3 Click the Precise MultiWave Line  icon.
4 Click to place your first point. The point appears automatically as a small hollow circle.
5 Click to place a second point.
6 Continue placing points along the desired path. 
7 Curved lines are created automatically. For corners and straight sections, hold down the Ctrl key. 
8 Right-click to end the line. The MultiWave line will appear on the fill, and the wave patterns in the fill 

will follow this line.

You can move points after the line has been created. To add or remove points, use Insert Points  or 

Delete Points  in the Home tab.
9 Repeat to place as many MultiWave lines as desired.

Use Delete MultiWave Line  in the Edit tab to remove a MultiWave line. See “Delete MultiWave Line” on 
page 349.

Bezier Mode
Use Bezier Mode  to draw shapes with finely graduated curves. Control the exact shape 
of the line using the black handles to either side of  the points you place.

Click to place Corner points, or click and drag to place curve points with 
handles.

For information on Control Points and the other Bezier Line editing tools, see “Convert 
Points and Bezier Lines” on page 346.

Creating Bezier Lines
When creating Bezier lines, press the Delete key to remove the last placed point.

• Click without dragging to create a Corner point (no handes)
• Click and drag to create a Smooth point (the handles are initially symmetric)

Use the Ctrl key while drawing to affect how the handles are placed:

• Hold down the Ctrl key while dragging to place the first handle opposite the position 
where the key was pressed, and the second handle where the mouse button was 
released (the handles are asymmetric and can be angled  ).

• Hold down the Ctrl key before clicking, then drag and release. A single handle is placed 
where the mouse button was released. 



PREMIER+™ 2 Create   Creating Fills and Lines              223

Editing Bezier Lines
When a point is dragged, its handles move with it, keeping the same angle and distance.

• The handles on a Smooth point can be moved independently along the straight line 
between the point and handles.

• The handles on a Symmetric point stay the same distance from their point when moved 
along the straight line between the point and handles.

• Hold down the Ctrl key while dragging a handle to create an angle at the 
point between the two handles.

• Use Insert Points  and Delete Points  on the Home tab to add and 
remove points from the Bezier line.

Shortcuts
■ Precise Create Tab, Options:
■ Keys: Alt, P, BM

Draw a Circle in Bezier Mode
1 In the Quick Access toolbar, click Change Hoop , and set the hoop to Universal, 100mm x 100mm - 

Universal Square Hoop 1.
2 Click the View tab, and ensure that Grid size is set to 10mm.
3 Click the Precise Create tab.
4 Ensure that Fill and Appliqué are not selected (not highlighted).
5 Set the Line Type to Triple Stitch .
6 Click Bezier Mode  to select (highlight) it.
7 Click Create Area or Line  to select it. The Bezier Mode pointer appears .
8 Click to place a point, then click to place three more of these square points in a rough curve.
9 Right-click to finish the line. The points are joined by straight lines.

These are Corner Points, in Bezier Mode they are joined by straight lines.
10 Click Undo to remove the line.
11 Starting 2 squares above the center of the hoop, click and drag to the 

right one square, to the crosshairs of the next grid square.
12 Release the mouse button.

A white square (a Point) appears at the placed where you clicked, and a 
black handle appears at the place where you released the button. This is 
the forward handle.

13 Note that a second handle has appeared the same distance behind 
the white point.
This is the backward handle, it is the same distance from the white point 
as the forward handle (it is symmetrical).

14 Starting 2 squares to the right of the center of the hoop, click and 
drag downwards one square, then release the mouse button.
A curved line appears between the two square white points.

15 Starting 2 squares below the center of the hoop, click and drag one 
square to the left to place the next section of the curved line.

16 Then, starting 2 squares to the left of the center of the hoop, click 
and drag one square upwards to place another section of the curved 
line. 
You should now have three quarters of a circle.

17 Move the pointer over the square white point on the right. The 
pointer changes to the Move pointer .

18 Drag the point and place it exactly where the grid lines cross.
19 Move the pointer over the forward handle for that point (the black 

handle below the point that you just moved).
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20 Drag the handle a short distance downwards. The backward handle for this point moves the same 
distance upwards.
While you are still placing points, if you adjust the handles they behave symmetrically. You can also drag to 
add symmetrical handles to a Corner point.

21 Move the handle to the right and left.
Note that the curved line changes shape as you move the handle.

22 Move the forward handle so that both handles are over the cross 
hairs of the squares above and below the point, and so that the line 
between the handles runs along the grid line.

23 Adjust the other points and handles so that you have a smooth three 
quarters curve.

24 Right-click to place the line. 
25 In the FilmStrip, right-click the Triple Stitch line that you just drew, 

and select Properties from the Context menu.
26 In the Line tab of the Fill Area and Line dialog box, select (check) 

Closed Border Line, then click OK. The line becomes a circle.

Edit a Bezier Line
27 Click the Home tab.
28 Click Edit Points . The points and their handles are displayed.
29 Move the pointer over the handle above the point on the right (the 

backward handle for the second point in the line).
30 Drag the handle a short distance downwards. This time the handle 

below (the forward handle) does not move, and the shape of the 
circle distorts.
When editing a line the points are Smooth, and not Symmetric. The 
handles can be moved independently along the straight line.

31 In the Convert Points  drop-down menu in the ribbon bar, select 
Convert Points to Symmetric . 
Edit Points  is no longer highlighted.

32 Move the pointer over the point whose handles you just changed. 
The pointer changes to the Convert Points to Symmetric pointer .

33 Click on the point. The handles are symmetrical, and the shape you 
drew becomes a circle again.

34 Right-click to deselect Convert Points to Symmetric. 
Edit Points is highlighted again.

35 Move the pointer over the handle above the point on the right and 
move it downwards. The handle below the point moves with the 
handle above the point.
Using Convert Points to Symmetric locks the handles into Symmetric 
mode while editing.

36 In the Convert Points  drop-down menu in the ribbon bar, select 
Convert Points to Smooth . Edit Points is no longer highlighted.
For more information on Control Points and the other editing tools, see “Convert Points and Bezier Lines” 
on page 346.

37 Move the pointer over the point whose handles you just changed. 
The pointer changes to the Convert Points to Smooth pointer .

38 Click on the point.
39 Right-click to deselect Convert Points to Smooth. Edit Points is 

highlighted again, and you can now move the handles 
independently.
If you move a handle very close to its point and release the mouse 
button, the handle will vanish. The section of the line without a handle 
becomes straight. Use Convert Points to Smooth to regain use of both 
handles.
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40 In the Convert Points  drop-down menu in the ribbon bar, select Convert Points to Corner . 
41 Move the pointer over one of the points in your line.  The pointer changes to the Convert Points to 

Corner pointer .
42 Click on the point. It now has no handles, and the sections of the line by it are straight.

There are no handles to drag, so you can only change the line by moving this Corner Point. Use Corner 
Points for straight lines.

43 Right-click to deselect Convert Points to Corner, and then in the Convert Points drop-down menu 
select  Convert Points to Smooth  and click that point again to return to handle adjustment.

44 Right-click to deselect Convert Points to Smooth.
To create a corner point with full control over the angle of the lines, hold down Ctrl and click the point. You 
can then move the handles independently.
To create a flower design from a motif using Bezier lines see “Draw a Flower using Bezier Curves” on 
page 227.

How to Create Lines with Precise Create
Outline the Fleur de Lys With a Satin Line

1 Click File, New  or File, New Window  and in the Choose Design Type page of the 
ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'Fleur de lys with bars’.
Alternatively, use the design from “Create the Band and Feathers for a Fleur de Lys” on page 312.

2 Click the Precise Create tab.
3 Ensure that Fill and Appliqué are not selected (not highlighted).
4 Click Create Area or Line  to select it. The Create Cursor appears .
5 Note the position of the Create Cursor . This marks the end of the last object in the design.

If it is not on the left side of the base of the left feather, follow steps 6 to 9.
6 Ensure that Line is selected, and in the Line drop-down list select Running Stitch .
7 Move the pointer towards the Create Cursor, until it changes to the diagonal pointer  and click to 

place a point over the Create Cursor.
8 Place a second point to draw a straight line to the left side of the base of the left feather.
9 Right-click to end the line.

If desired, use 2D and zoom in to see more clearly.
10 In the Line drop-down menu, select Satin Line .
11 Placing the first point on top of the Create Cursor , place points to draw a line around the left 

feather to the base on the right. Use Ctrl to place square points at the tip.
12 Right-click twice to finish the line, and to deselect Create Precise Area or Line.
13 Right-click the satin line to open the Fill Area and Line dialog box.
14 Ensure that Density is set to 4 and that Underlay is selected (checked). Set Width to 2.5mm. 
15 Click the Favorites tab. Click ’Set these options as the current settings’ . Then click OK to close Fill 

Area and Line dialog box.
When you next use Satin Line, the settings that you have just set up for satin line will be used. This is an 
alternative way to set the Options.

16 In the Line drop-down menu select Running Stitch .
17 Use Create Precise Area or Line  to create a straight line from the Create Cursor to the left side of 

the base of the middle feather, and right-click to finish the line.
A satin line is not placed along the side of the band as the whole of the band will be outlined in satin later.

18 In the Line drop-down menu, select Satin Line .
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19 Create Precise Area or Line  is still selected. 
Draw a line around the middle feather from 
the Create Cursor  to the base on the right. 
Use Ctrl to place square points at the tip.
Place roughly the same number of points on 
similar curves so that the feather borders have 
the same appearance.

20 Right-click to finish the line.
21 In the Line drop-down menu select Running 

Stitch  and then use Create Precise Area or 
Line to create a straight line from the Create 
Cursor to the left side of the base of the right 
feather.

22 In the Line drop-down menu, select Satin 
Line . Then use Create Precise Area or Line 
to draw a line around the right feather from 
the Create Cursor  to the base on the right. 
Use Ctrl to place square points at the tip.

23 Right-click to finish the line.
24 Click Life View  to see the border around the feathers. Click Cancel.
25 In the Line drop-down menu select Running Stitch . Starting at the Create Cursor, use Create 

Precise Area or Line  to create angled lines around the right side of the band and down to the base 
of the fleur de lys.

26 Right-click to finish the line.
27 In the Line area, select Satin Line . Then use Create Precise Area or Line  to draw a line around 

the base of the fleur de lys.
Use Ctrl to place square points where the base joins the band, and at the tips and angles of the base.

28 Click to place a square point where the base of the fleur de lys meets the band on the left.
29 Click to place a square point at each corner of the band, finishing back where you started at the left 

side of the base of the fleur de lys.
30 Right-click twice to finish the line, and to deselect Create Precise Area or Line.
31 Click Life View  to see the border around the complete 

fleur de lys. Click Cancel.
32 In the FilmStrip, scroll up to the top. This takes you to the 

start of the design.
33 Select the Satin Line circle. This should be object number 

3 in the FilmStrip.
34 Click Move to Front of Design .

The circular satin line will be placed at the front of the design 
(the bottom of the FilmStrip), below the satin line for the 
base of the fleur de lys. It will be stitched out last.

35 In the FilmStrip, scroll up to the top.
36 Select the blue thread color in position 1.
37 Right-click the thread and select Properties. The Color 

Selection dialog box opens.
38 Ensure that the thread range is set to Robison-Anton 

Rayon 40, and enter 2232 in the Find Thread box. Thread 
2232 (Ecru) will be selected. Click OK.
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39 In the Design Panel, click the Edit  button 
next to the Notes box.

40 In the Notes dialog box use the quick 
keyword selector to add the keyword 
’Heirloom’. Click the plus sign next to the 
heading to see more options and add the 
keywords ’Free Standing Lace’ and ’Cutwork 
Richelieu’ from the list. Then click OK.

41 Click Life View  to view the finished 
design. Click Cancel.

42 Click Save  and browse to 
Documents\Premier+2\My Designs.

43 Set the file name to 'Fleur de Lys' and click 
Save.

44 Click Export , and set the file format to 
.vp4, then click OK.
The preferred file format for saving 
embroideries is .vp4 format as this will preserve 
the separate parts of multipart designs. It also 
preserves thread color information and notes.

45 In the Save As dialog box, browse to Documents\Premier+2\My Designs and export the embroidery 
as Fleur de Lys_Exported.

46 Click Print  to print the embroidery worksheet.
For free-standing lace, embroider your design on heavy-weight water-soluble stabilizer. When finished, 
rinse the embroidery in lukewarm water to remove the stabilizer. Let dry and press the lace flat.
Alternatively, embroider the design with cutwork for the fleur de lys feathers. Hoop up with linen fabric and 
water-soluble stabilizer underneath. When you embroider the design, trim out the cutwork areas.

Draw a Flower using Bezier Curves
1 Open PREMIER+™ 2 Create and in the Choose Design Type page of the ExpressDesign Wizard, select 

Load a Picture into the Paint Window. Click Next.
2 In the Choose Picture Window, click Load a Picture , browse to the folder 

Documents\Premier+2\Samples\Create\Pics, and load the file 'Motif Flower.png’. Click Next.
3 In the Rotate and Crop Picture page, click Select All, then click Next.
4 In the Design Size page, select Enter Design Size, click Change Hoop, and set the hoop to Universal, 

100mm x 100mm - Universal Square Hoop 1. click Next.
5 In the Reduce Colors page, click Finish.
6 Click the View tab, and ensure that Grid size is set to 10mm.
7 In the FilmStrip, right-click the color block and select Properties from the Context menu.
8 in the Color Selection dialog box, click the pink in the Quick Colors (the second color in the bottom 

row)  and then click OK.
9 Click the Precise Create tab.
10 Ensure that Fill and Appliqué are not selected (not highlighted).
11 Set the Line Type to Satin Line .
12 Click Fill Area and Line  to open the properties dialog box.
13 Set the Line width to 1.5mm, then click OK.
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14 Click Bezier Mode  to select (highlight) it.
15 Click Create Area or Line  to select it. The Bezier Mode 

pointer appears .
See “Draw a Circle in Bezier Mode” on page 223 for the 
essentials of drawing Bezier lines.

16 At the left side of the base of the petal at the top, click and 
drag up and slightly to the left, then release the mouse 
button.

17 Starting where the petal to the left meets the petal you are 
drawing, click and drag upwards a short distance to where 
the next set of grid lines cross.

18 Click (without dragging) to place a point at the tip of the 
petal. This is a Corner point.

19 Move the pointer over the second square white point. The 
pointer changes to the Move pointer .

20 Drag the point a short distance up and to the left, along the 
outline of the petal until the curved line underneath fits the 
outline of the drawing.

21 Click and drag downwards a short distance from the mid 
point of the right side of the petal.

22 Click to place a single point where the the line touches the 
next petal.
As you become more skilled, try clicking and dragging to place 
a curved line using a single point at the base of the petal.

23 Right-click to place the line.
The curve of the line will probably need some adjustment, but 
this is better done later, after you have placed lines for the other 
petals.

24 At the left side of the base of the petal to the right of the one 
that you just drew, click and drag upwards a short distance, 
then release the mouse button.

25 Starting where the petal to the left meets the petal you are 
drawing, click and drag diagonally towards the top right 
corner of the hoop.

26 Release the mouse button when you reach the grid line 
above.

27 Click (without dragging) to place a point at the tip of the 
petal.

28 From the mid point of the right side of the petal, click and 
drag diagonally towards the bottom left corner of the hoop.

29 Click to place a single point where the the line touches the 
next petal.

30 Use the Move pointer to adjust the position of the white 
squares so that the curved line fits the picture behind.
You can further adjust the Bezier line using the black handles.
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31 Right-click to place the line.
32 Starting at the bottom left of the third petal, click and drag a 

short distance diagonally to the right to place the first point.
33 Where the outline of the petal meets the grid, click and drag 

a horizontal line a short distance to the right to place the 
next part of the curve.

34 Click to place a point at the tip of the petal.
35 Mid way down the other side of the petal, click and drag to 

the left and slightly down to place the next point.
36 At the base of the petal, click to place a final point, then 

right-click to place the line.
37 Place Bezier curve lines to draw the other petals, finishing at 

the petal to the left of where you started.
If you move the black handle to the left or right as you draw, 
you can place the curve to follow the outline, often with no 
need for later editing.

38 In the ribbon bar, click Add Color Change .
39 Click the yellow at the bottom right corner of the Quick Colors, then click OK to select the yellow 

thread.
40 Set the Fill Type to Pattern Fill  (it will be highlighted).
41 Starting at the top of the center of the flower, click and drag a short distance to the right, then release 

the mouse button.

42 Click and drag vertical and horizontal lines of similar lengths to place the other three points creating 
the circle.

43 Right-click to place the center of the flower.
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44 Click the Home tab, then click Edit Points . The points you drew for the center of the flower can be 
seen.

45 In the FilmStrip, click on each petal in turn, and make a note of the ones you will need to adjust.
46 Click the View tab.
47 Click Object View , to see the outline of the Bezier lines clearly.
48 Drag the Background slider to fade the background so that the Bezier lines can be seen over the 

original picture.
49 Adjust the handles on the points to make the Bezier line follow the 

background.
If the handles from two different points overlap, move both nearer to 
their own point, to smooth the curve.

50 Switch between Object View  and 3D View  to check the effect 
of your changes on the Satin Line.
For more information on editing, see “Edit a Bezier Line” on page 224.

51 When you have made your changes on one petal, select the next 
petal in the FilmStrip and adjust that one.
If you find that one of corner points actually has very short handles, 
either use Convert to Corner  in the Home tab to change it to a corner, 
or drag the handles sufficiently close to their point that they vanish.

52 Save your flower. You can adjust it further when you open the file again.

Editing Fills and Lines
Edit a fill or line in the Fill Area and Line properties dialog.

Edit a Line or Fill
■ Select the desired fill area or line, and right-click it. The Fill Area and Line properties dialog 

appears.
See “Fill Area and Line Properties” on page 86.
Alternatively, to change the properties of selected fills or lines at one time, do as follows:

1 In the FilmStrip, hold the Ctrl key and click each of the fills or lines to be changed. 
2 Right-click one of the selected areas and select Properties. The Fill Area and Line dialog box will 

appear. All settings in the Fill Area and Line dialog box will be applied to your selected fills and lines 
when you click OK.

You can also move the green start , red end  and/or orange origin  marker for selected fill areas.
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Creating Holes
Use the Hole functions QuickStitch™ Hole , Freehand Hole  and Precise Hole  to 
create holes in existing fill and satin areas.

Alternatively, use QuickStitch™ + AutoHole  to add holes automatically during fill creation. See 
“QuickStitch™ + AutoHole” on page 210.

Create Holes in a Fill
1 Click the desired area to select it.
2 In the Fill Area of the Create tab, click the desired Hole function.

Choose from QuickStitch™ Hole , Freehand Hole  and Precise Hole .
3 Cut the hole using the selected hole function.
4 Repeat to create more holes, as desired. Right-click to deselect, or simply select another Create tool.

QuickStitch™ Hole
See “QuickStitch™ Hole” on page 211.

Freehand Hole
See “Freehand Hole” on page 218.

Precise Hole
See “Precise Hole” on page 218.

Fill Area with holes using Pattern Fill 111 
from Hearts

Fill Area with holes using Motif Fill Pattern 
6 from General Motifs 1

Fill Area with Satin border and holes using 
Motif Fill Pattern 6 from General Motifs 1

Fill Area with Satin border and holes using 
Pattern Fill 109 from Hearts
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12Using Fill Areas
Fill Areas are areas of fill surrounded by a border. The fill can be any of the fill types, or ’No 
Fill’. The border can be any of the line types, or ’No Line’.

You can change any fill type into another fill type, or into a Satin Area.

Fill Types
Select the Fill type from the drop-down list in the Quick Create, Freehand Create or Precise 
Create tabs, or in the Fill Area and Line properties dialog:

Pattern Fill Area with Pattern 39 
from Animals 1

Pattern Fill Area with Multicolor 
Gradient

Motif Fill Area with two motifs, 
13 and 19, from Hand Stitches 2

Motif Fill Area with motif 6 from 
General Motifs 1, QuickStitch 
Autohole and a 1.5mm Satin 
Border

Shape Fill Area using Shape 23 
and Motif 1 from Hand 
Stitches 1

MultiWave Fill, using a density 
of 15, and a short Freehand 
MultiWave Line to add texture

Pattern Fill QuiltStipple Fill MultiWave Fill

Motif Fill Contour Fill Echo Fill

Shape Fill Crosshatch Fill Satin Area

Radial Fill Curved Crosshatch Fill No Fill

Spiral Fill
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Creating Fill Areas
Create Fill areas with the QuickStitch™, Freehand and Precise Area or Line, or Shape 
functions. 

Set the Fill, Line and Appliqué buttons as desired by clicking to turn that area type on or off. Then choose a 
fill type from the drop-down menu below the button, and set the properties in the Fill Area and Line 
options. Use one of the Create functions to make the new fill area.
See “Creating with Quick Create” on page 205, “Creating with Freehand and Precise Create” on page 206, 
and “Creating Shapes” on page 207.
Either add holes at the time of fill creation using QuickStitch™ + AutoHole, or add holes to 
an existing fill. See “Creating Holes” on page 231.

You can select your fill type, and the line type for the surrounding border, in one of the 
Create tabs before creating the fill.

Alternatively, change either the fill or border type afterwards using Fill Area and Line properties. Use the 
Favorites tab to make the chosen settings into Favorites that may be applied to other areas, or into the 
current settings, to use as default for new areas of this type.

Pattern Fill
Pattern Fill areas use small stitches in repeating patterns that cover an area completely 
using typical density values. The density and color can also be changed with single 
gradient density and multigradient density.

Pattern Fill Area with Pattern 3 
from Standard 1

Pattern Fill Area with Single 
Color Gradient Density

Pattern Fill Area with Pattern 39 
from Animals 1

Pattern Fill Area with Multicolor 
Gradient

Fill Area with Pattern 114 from 
Hearts and a 4.0mm Satin 
Border.

Fill Area with Satin border and 
holes using Pattern Fill 109 
from Hearts
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The Fill Area and Line properties for Pattern Fill has sections for setting all the properties 
on a pattern fill area. It appears when you click a pattern fill area so that the points 
defining its shape are shown, and then right-click. It also appears when you click the Fill 
Area and Line button in the Options section on one of the Create tabs.

Use the Pattern Fill properties dialog box to change the pattern, density and stitch angle 
used for fill areas.

Alternatively, adjust the angle of the fill pattern with the handle on the Origin marker .

Pattern Fill — Pattern

Patterns
Use the Pattern area to select the desired 
pattern category and number.

Select the desired pattern number. There are 
several ways to select patterns:

• Click the drop-down arrow below the pattern 
sample and scroll down to choose a pattern 
Category, and a pattern. Click the desired 
pattern sample and the Pattern number is 
shown.

• Enter a favorite Pattern number directly in 
the Pattern box. As you type the number, the 
correct pattern sample is selected 
immediately.

Choose a Category
and Pattern

Search for a Pattern
by number

Set Standard density Use gradient density

Set the pattern Angle

Adjust the area’s size

Choose Underlay 
density

Settings for Single &
Multicolor gradient

Use a My Fills pattern
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• Use a My Fill pattern created with Manage My Fills. See “Manage My Fills” on page 285.

The pattern number can be seen in the FilmStrip.
View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 369.

Change a Fill Area to a Leaf Pattern
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign 
Wizard” on page 134.

2 Click File, Preferences  and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and set the Grid size to 5mm.
4 In the color worksheet on the Design Panel, click the check box for the 

fourth color (slate blue) to hide objects, mainly satin borders, using that 
thread color. This will make it easier to select the fill areas.
When you pause the arrow pointer over a color in the worksheet, a popup 
description of the thread appears.

5 Click the Home tab.
6 Ensure that Edit Points  is selected.
7 Click inside the left petal near the edge. The points defining the shape 

of the fill area will appear. It will be shown as a Pattern Fill on the status bar and in the FilmStrip.

If the Status Bar says Box Select, this is selected instead of Edit Points . Click Edit Points and look again.
8 Right-click on the work area 

and the Fill Area and Line 
dialog box will appear 
showing the properties for 
Pattern Fill.
The Fill Area and Line dialog 
box enables you to change the 
fill and line types in your 
design, and set the properties 
for the lines and fills.

9 Click the down arrow below 
the fill sample in the Pattern 
area.

10 The fill Category is currently 
set to Standard 1. Scroll up 
the fill gallery to the 'Plants & 
Flowers 1' Category.

11 Place the pointer over the 
pattern sample in row two, 
column two. The pattern 
number is 164.
Patterns may also be selected 
directly by entering the desired 
pattern number in the Pattern 
box.

12 Click to select pattern 164.
13 Check that Density is set to 2, 

as desired.
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14 Change the angle to 45. Click Apply to see the new pattern 
in the left petal, then click OK. The pattern has changed in 
the petal, and you can see the fill number in the FilmStrip.
Even if you click Cancel, Apply has changed the stitches. 
Therefore, to return to the original pattern you would need to 
click Undo .
You could also change the angle of the pattern with the handle 
on the Origin marker .
To change the middle petal to a single gradient fill, see “Create 
a Single Color Gradient Fill in a Petal” on page 239.

Pattern Fill — Options
Use the Options area to see and change the settings for fill angle, underlay and 
compensation.

Angle
The angle of the fill pattern, as shown by the arrow. The thread is at a 
right angle to the fill pattern. Set the Angle from 0 to 359 degrees. 
The initial setting is 0.

The fill angle will also affect the orientation of the gradient. You can also change 

the fill angle with the handle on the Origin marker .

Underlay
Choose from None, Low, Medium or High density underlay. Underlay is a low density fill 
that is perpendicular to the stitches of the actual fill area. Underlay is useful for stabilizing 
large fill areas. Underlay is initially set to Low.

Underlay stitches are not generated for areas using gradient density, although the property can be 
selected in case you switch the area back to a standard density area.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 20. The higher the number, the bolder the area appears. The 
initial setting is 0.

Set the pattern Angle

Set Compensation

Choose Underlay density
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Pattern Fill — Density
Use the Density area to see and change the density settings and the color Gradient of the 
fill.

The color on a fill area can change over a range, or have multiple color changes across the 
fill. This is ideal for gradual color changes such as sunsets, subtle shadow effects and so on.

Gradient is not initially selected.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Standard Density

Set the standard Density from 2 to 80. The lower the number, the 
closer together the stitches and the more stitches are produced.

The initial setting is 2.

Single Color Gradient

Use Single Color Gradient to change the density across a fill 
with only one color. Set a value for the start and end density 
markers for the fill, and the density gradually changes between 
the two values. Add multiple markers for a more complex 
pattern.

The markers can each take a value of 2 to 80, which means you can reverse 
the gradient simply by swapping the start and end values.
If you change a gradient density fill back to standard, then you should also 
select the desired underlay.
The example shows a Gradient of 2 to 15, with a fill angle of 90°.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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Use Density Gradient for loosely stitched areas so that the traveling stitches will go around the outside of 
the fill area. Set the start and end densities to the same number. If the Density Gradient option was not 
used the traveling stitches would cross the fill area and show through.
Use the adjustment marker above the gradient bar to change the gradient across the fill.

Reset
Reset your changes and use the initial settings.

Add Marker
Click Add Marker to add a value marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial value for the marker will be between the existing 
markers. Edit the density value, and move the value and adjustment markers as desired.

This means that you can have any combination of density values across the fill area. 
Remember, a higher value means the fill is less dense.

Density
Density is used to change the density of the stitching. Set Density from 2 to 80. The higher 
the number, the less dense the fill. The initial start marker setting is 2, and end marker 
setting is 8.

Remove
Click Remove to delete the highlighted marker.

Change a Fill to Single Color Gradient
1 Open the Fill Area and Line properties dialog.
2 In the Density area, click the Gradient option. The Gradient box will become available.
3 Select (check) the Single Color Gradient box.
4 Click a value maker (the marker below the gradient bar) and change the value in the Density box to 

the required density value.
5 Click Apply to view your changes.
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6 Move the adjustment marker above the gradient bar to vary the change in density across the fill.
7 Click Add Marker to add another value marker and adjustment marker.
8 Change the density of the fill as desired.

9 Click OK to close the Fill Area and Line properties dialog.
If you change a gradient density fill back to standard, then you should also select the desired underlay.

Create a Single Color Gradient Fill in a Petal
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign 
Wizard” on page 134, and added a leaf pattern to in “Change a Fill Area to a Leaf Pattern” on page 235.

2 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and ensure that Grid size is set to 5mm.
4 In the color worksheet in the Design Panel click the check box for the fourth color (slate blue) to hide 

the satin borders using that thread color. This will make it easier to select the fill areas.
5 Click inside the middle petal. The points defining the shape of the fill area will appear, and the Pattern 

Fill area will be selected in the FilmStrip.
6 Right-click on the work area and the Fill Area and Line 

dialog box will appear, showing Pattern Fill.
7 Enter 109 in the Pattern Box. In the Pattern gallery, this 

is the design in row 1, column 1 of the Hearts category. 
8 Click Apply to see the pattern.

If needed, move the Fill Area and Line dialog box to one 
side to see this.

9 Click the Gradient checkbox. The Gradient options 
become available.

10 Ensure that Single Color Gradient is selected. A bar with 
a marker at either end becomes available.

11 Click Add Marker. A third marker is placed in the middle 
of the bar, highlighted in blue.
All three markers initially use the stitch density set above 
(this should be 2).

12 Click the marker box on the left. It is highlighted in blue.
13 In Density, use the up arrow to change the number to 

35. The number and position of the lines in the density 
bar changes.
The lines in the density bar represent the density of the stitching.

14 Leave the Density for the middle marker at 2.
15 Click the marker box on the right.
16 Change the density for the marker on the right to 35.

This will create lightly stitched areas at the edges of the fill area, and a heavily stitched area in the middle.
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17 Change the Angle to 0, then click OK. The heart pattern fill is densely stitched in the center and lightly 
stitched at top and bottom.

Notice that underlay has been automatically set to None. This occurs when Single Color Gradient or 
Multicolor Gradient density is selected.
To fill the right petal with a bee pattern that you create, see “Use a Bee for a My Fill Pattern” on page 287.

Multicolor Gradient

Use Multicolor Gradient to change the color across a fill with 
only one density. Set colors for the start and end markers for the 
fill, and the color gradually changes between the two values.

Use the marker above the gradient bar to change the color 
gradient across the fill.

Reset
Reset your changes and use the initial settings.

Add Marker
Click Add Marker to add a color marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial color for the marker will be the same as the currently 
highlighted marker. Change the color and move the color and adjustment markers as 
desired.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the 
highlighted marker

Delete the selected
marker

Set the stitch density
for the whole fill
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This means that you can have any combination of colors across the fill area.

Thread Color
Use Thread Color  to change the color of the currently highlighted marker. The Color 
Selection box will be displayed.

See “Color Selection” on page 181.

Remove
Click Remove to delete the highlighted marker.

Create a Multicolor Gradient Fill
1 Open the Fill Area and Line properties dialog.
2 In the Density area, click the Gradient option. The Gradient box will become available.
3 Select (check) the Multicolor Gradient box.
4 Click a color maker (the marker below the 

gradient bar) and click Thread Color to open 
the Color Selection dialog box.

5 Change the color to the required color and 
click OK.

6 Click Apply to view your changes.
7 Move the adjustment marker above the 

gradient bar to vary the change in color 
across the fill.

8 Click Add Marker to add another color marker 
and adjustment marker.

9 Change the color of the fill as desired.
10 Click OK to close the Fill Area and Line properties dialog.

Fill a Petal with a Multicolor Gradient Density Fill
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign 
Wizard” on page 134.

2 Click File, Preferences  and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and ensure that Grid size is set to 5mm.
4 In the color worksheet in the Design Panel, click the check box for the fourth color (slate blue) to hide 

the satin borders using that thread color. This will make it easier to select the fill areas.
5 Select the fill area for the middle petal, then right-click to see the Fill Area and Line dialog box.
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6 Enter 255 in the Pattern Box. In the Pattern gallery, this is the design in row 1, column 3 of the 
Gradient & Lace category.
The top four patterns in this category are recommended for multicolor gradient (the other eight are 
suitable for a weave pattern combined with parallel crosshatch, as used for lace designs).

7 Change the Angle to 0. 
8 Ensure that the Gradient checkbox is 

selected.
9 Click Add Marker to place a third marker in 

the middle of the bar, highlighted in blue.
10 Click Multicolor Gradient. The gradient bar 

is now colored, as are the markers.
The selected marker has a dark blue outline, 
and the pointer is highlighted in blue.

11 Click the marker box on the left.
12 Click Thread Color . The Color Selection 

dialog box is displayed.
13 Ensure that Robison-Anton Rayon 40 is 

displayed in Thread Range.
14 Click in the Find Thread box and enter 

'2502'. Thread color 2502 (Memphis Belle) 
will be found in the list. Click OK to change 
the color.

15 Double-click the marker box in the middle. 
The Color Selection dialog box opens.
This is a quick way of displaying the dialog.

16 In the Color Selection dialog box change the color to 2259 (Wild Pink), then click OK.
17 Double-click the marker box on the right and change the color to 2286 (Tulip).

The bar is now shaded from pale pink, to dark pink, to purple. The stitches for each color are calculated 
from the original density value.

18 Click Apply. The design will show how the colors will be blended when stitched out.
If needed, move the Fill Area and Line dialog box to one side to see this.

19 Click OK to close the Fill Area and Line dialog box.
To fill the left petal with a Radial Fill with gradient density, see “Use a Radial Fill in a Petal” on page 255.
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Motif Fill
Motif fill areas  contain repeated small stitches placed using one of the Universal or 
machine motif patterns. Motif patterns typically have spaces between the stitches. A motif 
fill area can also have holes defined inside it. The motifs can be at any angle and at 
different sizes, and different motifs can be used on alternating lines.

Motif Fill Properties
The Fill Area and Line properties for Motif Fill has tabs for setting all the properties on a 
motif fill area. It appears when you click a motif fill area so that the points defining its 
shape are shown, and then right-click. It also appears when you click the Fill Area and Line 
button in the Options section on one of the Create tabs.

Motif Fill Area with default 
motif 5 from General Motifs 1

Motif Fill Area with motif 6 from 
General Motifs 1

Motif Fill Area with two motifs, 
13 and 19, from Hand Stitches 2

Motif Fill Area with motif 22 from 
Candlewicking 1 and a 2.0mm 
Satin Border

Motif Fill Area with motif 6 from 
General Motifs 1 and 
QuickStitch Autohole

Motif Fill Area with motif 6 from 
General Motifs 1, QuickStitch 
Autohole and a 2.0mm Satin 
Border
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Motif Fill — Motif 1
The Motif 1 tab is always shown first when the Motif Fill properties appear.

Use the Motif 1 tab to select the first motif and its size.

Motif
Use Motif to select the motif and its size.

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some 
motifs are symmetrical and will have no apparent change when they are reversed.

Select a motif Group, Category and pattern

Select the motif size

Preserve motif Height / Width ratio

Flip the motif vertically or horizontally
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Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Motif Fill — Motif 2
Use the Motif 2 tab to select a second optional motif and its size.

Use Motif 2
Select this option to use a second motif in the motif fill. The second motif will be placed on 
alternating lines with the first motif.

Motif
Use Motif to select the motif and its size.

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.
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Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some 
motifs are symmetrical and will have no apparent change when they are reversed.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Motif Fill — Spacing
Use the Spacing tab to set the spacing for the motifs.

Center Motifs 1 and 2
When this option is selected the narrower of the two motifs has extra stitches added at 
either side to make it the same width as the wider motif. This is so that the motifs can be 
centered, or so the horizontal offset between them will remain constant.

Gap
The Horizontal gap adds or removes space between motifs along the line. The Vertical gap 
adds or removes space between lines of motifs.

Set the Horizontal and Vertical gaps from -50% to +100%.

Offset
The Horizontal offset moves the motifs along each line, relative to the previous line. The 
Vertical offset adjusts the position of every other line of motifs, so that it is nearer to one 
line than the next or previous line.

Set the Horizontal and Vertical gaps from -50% to 50%.

Space the motifs regularly

Set the distance between
motifs and lines of motifs

Set the relative position of
motifs and lines of motifs
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The offset is limited to 50% each way because, for instance, a 75% offset would be the same as a -25% 
offset.

Motif Fill — Options
Use the Options tab to see and change the settings for fill angle, stitch type and length.

Angle
The angle of the motif fill pattern, as shown by the arrow. Set the Angle from 0 to 359 
degrees.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of 
stitches from 1 to 12mm in steps of 0.1mm.

Use Motif Fills in Two Petals
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.

2 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and ensure that Grid size is set to 5mm.
4 Select the fill area for the middle petal, then right-click to see the Fill Area and Line dialog box.
5 In the Fill drop-down menu at the top left, select Motif Fill . The Motif 1 tab of the motif fill 

properties is displayed.
6 Set the Group to Universal and the Category to Candlewicking 1. Pattern 1 is selected automatically, 

which is the desired Pattern.
7 Click the Spacing tab.

Adjust the motif angle

Select a line type

Set the stitch length
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8 Set the Horizontal Offset to 50%.

9 Click OK. The effect is displayed in the work area.
10 Select the fill area for the petal on the right, then right-click to see the Fill Area and Line dialog box.
11 In the Fill drop-down menu at the top left, select Motif Fill .
12 Set the Group to Universal and the Category to General Motifs 1. Click the drop-down arrow for 

Pattern, scroll up the list and select Pattern 2.
13 Click Apply to preview the effect. If needed, move the Fill Area and Line dialog box to the left to view 

the effect.
14 Click the Motif 2 tab.
15 Click ’Use Motif 2’ so it is selected. The Motif 2 options become available.
16 Set the Group to Universal and the Category to General Motifs 1. Click the drop-down arrow for the 

Motif 2 Pattern, scroll up the list and select Pattern 2.
17 Click the Spacing tab.
18 Set the Vertical Offset to 30%.
19 Click the Motif 1 tab.
20 Click the Mirror option for Motif 1 so it is selected. The motif will be mirrored vertically.
21 Click Apply to preview the effect.
22 Click the Options tab.
23 Change the Angle to 200 and select Triple as the stitch type.
24 Click OK. Click Life View  to see the effect, then click Cancel.

Add a motif line flower to the left petal in “Create a Flower with Motif Lines” on page 329.

Insert Motif Fill in an Appliqué Petal
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsApplique_Picot’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on 
page 136, and added a picot motif line to in “Change Satin Line to Picot Motif Line” on page 333.

2 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and ensure that Grid size is set to 5mm.
4 Click the edge of the petal on the right. Its nodes (points) are displayed.
5 In the status bar the stitch type is displayed as Satin Line Appliqué. 
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In the FilmStrip the object should also be Satin Line Appliqué. You can select objects in the FilmStrip, or 
press the right and left arrow keys to step through the objects in the design.

6 Right-click the work area to see the Fill Area and Line properties for this Satin Line.
7 In the Fill drop-down menu at the top left, select Motif Fill .

It will currently be shown as No Fill.
8 In the Motif 1 tab set the Motif Group to Universal, and the Category to Hand Stitches 1. 
9 Click the drop-down arrow for Pattern and select Pattern 17, a tied cross.
10 Click OK to close the dialog box.
11 Notice that the motif fill in the petal on the right is the same color as the border stitches. The motif fill 

will look nice in variegated thread.
12 In the FilmStrip, right-click the petal in the middle (FilmStrip item number 2) and select Insert Color 

Change. The Color Selection dialog box will appear.
This places the color change between the two petals.

13 Click Show All Thread Ranges, then click the drop-down arrow for the Thread Range and select 
Robison-Anton Rayon Vari 40.

14 In the shade list, browse for 2370 (4CC Melody) or enter 2370 in the Find Thread box. Click OK. 
This changes the color for the Motif Fill, but also changes the color of all the objects that follow it.

15 Right-click the Motif Fill area to open Fill Area and Line properties.
16 Click the Line tab.
17 Click (check) Insert Color Change, and then click Line Thread Color . The Color Selection dialog box 

opens.
18 Click the drop-down arrow for the Thread Range and select Robison-Anton Rayon 40.
19 Type 2275 in the Find Thread box to select 2275 (Slate Blue). Click OK.
20 The thread color is now a dark blue. Click OK to close the Fill Area and Line dialog box.
21 Click Life View . The motif fill in the petal on the right is now shown in variegated thread, with a 

blue border, but the petal on the left is variegated. It should be changed to blue. Click Cancel to close 
the dialog box.
The border color change affects only the color of the border around the motif fill area. It does not affect any 
other objects. So a separate color change is needed.

22 In the FilmStrip, ensure that the Motif Fill petal 
is selected.

23 Right-click on the FilmStrip, then click Insert 
Color Change and the Color Selection dialog 
box will appear.

24 Click the drop-down arrow for the Thread 
Range and select Robison-Anton Rayon 40.

25 Type 2275 in the Find Thread box to select 
2275 (Slate Blue). Click OK.

26 Click Life View . The borders are now all 
blue, with a variegated thread motif fill area.

27 Click Cancel.
Add a contour fill flower to the left petal in 
“Create a Contour Fill Flower” on page 264.
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Shape Fill
Shape fill areas use one of 75 different shapes. Vary the stitch density, use motif lines for 
the fill and add holes.

The Fill Area and Line properties for Shape Fill has tabs for setting all the properties on a 
shape fill area. It appears when you click a shape fill area so that the points defining its 
shape are shown, and then right-click. It also appears when you click the Fill Area and Line 
button in the Options section on one of the Create tabs.

Shape Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

Shape Fill Area using Shape 11 
and Density 18

Shape Fill Area using Shape 23 and 
Motif 1 from Hand Stitches 1

Select a shape for the fill 

Set the stitch density for the fill

Use motif lines in the fill

Select a motif for the fill
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Shapes
Click the drop-down arrow and select the desired shape from the list.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain line to follow the shape 
selected for the fill. Click the Motif tab to choose a motif.

Shape Fill — Motif
The selected Motif is only used by the Shape Fill if the Use Motifs option is selected on the 
Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Set the gap between the motifs in the line
Adjust the position of the motifs in the line

Select a stitch type for the motif lines
Set the stitch length for the motif lines

Select a motif Group, Category and pattern

Set the motif size and Height / Width ratio
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Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for 
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif 
direction. Some motifs are symmetrical and will have no apparent change when they are 
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of 
stitches from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended 
value for each motif.

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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Use Shape Fills in Three Petals
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.

2 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and ensure that Grid size is set to 5mm.
4 Select the fill area for the petal on the right, then right-click to see the Fill Area and Line dialog box.
5 In the Fill drop-down menu at the top left, select Shape Fill . The Options tab of the shape fill 

properties is displayed.
6 Set Density to 20. This will create a lightly stitched pattern.
7 Click the drop-down arrow for Shapes and choose the five pointed star (shape number 26).

8 Click OK to apply the changes.
9 Select the fill area for the middle petal, then right-click to see the Fill Area and Line dialog box.
10 In the Fill drop-down menu at the top left, select Shape Fill . The Options tab of the shape fill 

properties is displayed.
11 Ensure the Density is set to 8.
12 Click the drop-down arrow for Shapes. Scroll down the list and choose the badge shape numbered 

48.
13 Click OK.
14 Move the origin point  straight up the vertical grid center line until it is just above the petal.

Notice how the point of radiation changes. 
15 Select the fill area for the petal on the left, then right-click to see the Fill Area and Line dialog box.
16 In the Fill drop-down menu at the top left, select Shape Fill . The Options tab of the shape fill 

properties is displayed.
17 Ensure the Density is set to 8.
18 Click the drop-down arrow for Shapes. Scroll down the list and choose the curvy frame numbered 65.
19 Click the Use Motifs option so that it is selected, then click the Motif tab.
20 From the Universal Group, select the Hand Stitches 1 Category.
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21 Scroll down the Pattern list and select pattern 11 (the closed fly stitch).

22 Click OK. The effect is displayed in the Create window.
23 Move the origin point  up so that it is just within the top right area of the petal.
24 Click Save  and browse to the folder Documents\Premier+2\My Designs.
25 Change the File name to 'PetalsShapeFill' and click Save.

26 Click Print  to print the embroidery worksheet.
27 Click Export Embroidery  and ensure that .vp4 is set as the file format. Click OK.
28 In the Save As dialog, browse to the folder Documents\Premier+2\My Designs and click Export. The 

embroidery is saved as PetalsShapeFill_Exported.
There is no need to change the file name, as it is taken automatically from the design file name. 
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Radial Fill
Radial fill areas  use a pattern of radiating lines from an origin point  that can be 
moved. Vary the stitch density and add holes.

Radial Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 20.

Use a Radial Fill in a Petal
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign 
Wizard” on page 134, and added a multicolor gradient fill in “Fill a Petal with a Multicolor Gradient Density 
Fill” on page 241.

2 Click File, Preferences  and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

Radial Fill with origin moved to top of 
heart

Set the density from 2 to 40
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3 Click the View tab, and ensure that Grid size is set to 5mm.
4 Click inside the petal on the left to select the fill area. It will be shown as a Pattern Fill on the status bar.
5 Right-click on the work area and the Fill Area and Line dialog box will appear.
6 In the Fill drop-down menu at the top left, select Radial Fill . The options in the tabbed pages 

below change.
The tabbed pages in the Fill Area and Line dialog box show the properties for the currently selected Fill and 
Line.

7 The Options tab is initially selected. Set the Density to 8. This gives a lightly stitched, but distinctive, 
radial fill pattern.

8 Click OK. The description of the area on the status bar will change to Radial Fill.
Notice that the stitch lines of the radial fill radiate from the middle of the petal shape.

9 Click and drag the origin marker  of the radial fill up and to the right until it is about one grid 
square from the corner of the petal.
The origin  is the start point for the repeating pattern in a pattern fill and the point from which stitches 
radiate in a radial fill, shape fill or spiral fill.

10 Click outside the petal, so that the fill area is no longer selected. You can now see the effect of moving 
the origin.

11 Click Zoom To Fit .
To fill the right petal with a spiral fill, see “Fill a Petal with a Spiral Fill with Gradient Density” on page 259.

The stitch lines radiate from 
the origin.

Move the origin to the top 
right.

Click outside to view the 
radial fill.
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Spiral Fill
Spiral fill areas  use a spiral pattern from an origin  point that can be moved. Use 
constant or gradient density, and add holes.

Spiral Fill — Options

Density
The density on a spiral fill area can change over a range, or have multiple density changes 
from the origin to the edge of the fill. Use Standard or Gradient density fill.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Standard Density

Set the standard Density from 2 to 80. The lower the number, the 
closer together the stitches and the more stitches are produced.

The initial setting is 2.

Spiral Fill using Gradient Density Spiral Fill with origin moved to top of 
heart

Set the density from 2 to 80

Select Gradient fill
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Gradient Density

Use Gradient Density to change the density across the Spiral Fill. Set a value for the start 
and end density markers for the fill, and the density gradually changes between the two 
values. The start value is used at the origin of the spiral fill, and the end value is used at the 
edge.

The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by 
swapping the start and end values.
The example shows a Gradient of 2 to 15, with a fill angle of 90°.

Use the marker above the gradient bar to change the gradient across the fill.

Add Marker
Click Add Marker to add a marker. The initial value for the marker will be between the 
existing markers. Edit the value and move the marker as desired.

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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This means that you can have any combination of density values across the fill area. Remember, a higher 
value means the fill is less dense. The marker furthest to the left affects the spiral fill at the origin, then from 
left to right to the edge of the spiral fill.

Remove
Click Remove to delete the highlighted marker.

Use a Gradient with a Spiral Fill
1 Open the Fill Area and Line properties dialog and click the Density tab.
2 Click the Gradient option. The Gradient box will become available.
3 Click a value maker (the marker below the gradient bar) and change the value in the Density box to 

the required density value.
4 Click Apply to view your changes.
5 Move the adjustment marker above the gradient bar to vary the change in density across the fill.
6 Click Add Marker to add another value marker and adjustment marker.
7 Change the density of the fill as desired.

8 Click OK to close the Fill Area and Line properties dialog.

Fill a Petal with a Spiral Fill with Gradient Density
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign 
Wizard” on page 134, and added a multicolor gradient fill and radial fill in “Fill a Petal with a Multicolor 
Gradient Density Fill” on page 241 and “Use a Radial Fill in a Petal” on page 255.

2 Click File, Preferences , and ensure that Color 
Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and ensure that Grid size is set 
to 5mm.

4 Select the fill area for the petal on the right, then 
right-click to see the Fill Area and Line dialog box.

5 In the Fill drop-down menu at the top left, select 
Spiral Fill . The density tab of the spiral fill 
options is displayed.

6 Select the Gradient density option.
7 Change the marker on the left (the start value) to 

20.
8 Change the marker on the right (the end value) to 

4.
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This will create a lightly stitched pattern at the origin of the spiral fill, shading to a more heavily stitched 
pattern at the edges.

9 Click OK. The spiral fill is displayed in the third petal.
10 Click Save  and browse to the folder Documents\Premier+2\My Designs.
11 Change the File name to 'PetalsFill2' and click Save. The file is saved as PetalsFill2.edo.
12 Click Export Embroidery  and ensure that .vp4 is set as the file format. Click OK.
13 In the Save As dialog, browse to the folder Documents\Premier+2\My Designs and click Export. The 

embroidery is saved as PetalsFill2_Exported.
There is no need to change the file name, as it is taken automatically from the design file name. 

14 Click Print  to print the embroidery worksheet.
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QuiltStipple Fill
QuiltStipple fill areas  use stipple stitch in a curved or straight lines. Vary the gap 
between stitch lines, use running or triple stitch, and add holes.

QuiltStipple Fill — Options

Style
Choose between curved or straight.

QuiltStipple Fill using a curved style QuiltStipple Fill using a straight style

Curved Straight

Select curved or straight stipple lines

Set the spacing between the stipple lines

Select a stitch type for the stipple lines

Set the stitch length for the stipple lines
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Spacing
Set the Gap to the preferred distance between lines of stitching. This also, where possible, 
is the border inside the area, between the edge of the area and the fill pattern.

Set the Gap from 1 to 20mm in steps of 0.1mm. It is initially set to 5.0mm.

Stitch
Select Running or Triple stitch for stitching out the fill. Set the Length of stitches from 1 to 
12mm in steps of 0.1mm. Length is initially set to 2mm.

Insert QuiltStipple Fill in a Petal
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsApplique_Butterfly Line’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on 
page 136, and added a motif line to in “Change Satin Line to Motif Line in an Appliqué Petal” on page 332.

2 Click the View tab, and ensure that Grid size is set to 5mm.
3 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 

Before and After Trims is selected.
4 Click along the edge of the middle petal to select the petal.
5 In the status bar the stitch type is displayed as Satin Line Appliqué. 

In the FilmStrip the objects should also be Satin Line Appliqué. You can select objects in the FilmStrip, or 
press the right and left arrow keys to step through the objects in the design.

6 Right-click the work area to see the Fill Area and Line properties for this Satin Line.
7 In the Fill drop-down menu at the top left, 

select QuiltStipple Fill .
It will currently be shown as No Fill.

8 In the Options tab, set the Gap in Spacing to 
2.0mm.

9 Click OK.
10 In the Quick Access toolbar, click Save  

and browse to the folder 
Documents\Premier+2\My Designs.

11 Change the File name to 'PetalsApplique1' 
and click Save to save your design file.

12 Click Export Embroidery  and ensure 
that .vp4 is set as the file format. Click OK.

13 In the Save As dialog, browse to the folder Documents\Premier+2\My Designs and click Export. The 
embroidery is saved as PetalsApplique1_Exported.
There is no need to change the file name, as it is taken automatically from the design file name. 

14 Click File, Print. Deselect (uncheck) Print Plan View and Print Picture.
15 Click Print  to print the embroidery worksheet.

To change the appliqué fabric for the petals, right-click and in the Fill Area and Line dialog box click the 
Appliqué tab. Click the Select Fabric button and choose a Quick Color for a fabric, or click Fabric and then 

load  a fabric with the Picture Viewer.
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If desired, open the embroidery in PREMIER+™ 2 Embroidery Extra to preview on a garment or fabric 
background, as in the example.
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Contour Fill
Contour fill areas  use contour stitch lines. Vary the gap between stitch lines and the 
length of the stitches, use running, double or triple stitch, and add holes.

Contour Fill — Options

Spacing
Set the Gap to the preferred distance between lines of stitching. This also is the border 
inside the area, between the edge of the area and the fill pattern.

Set the Gap from 0.2 to 5mm in steps of 0.1mm. It is initially set to 2.0mm.

Stitch
Select Running, Double or Triple stitch for stitching out the fill. Set the Length of stitches 
from 1 to 12mm in steps of 0.1mm. Length is initially set to 2mm.

Create a Contour Fill Flower
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsApplique_MotifFill’.

Contour Fill, using Triple Stitch and a 
3.0mm gap

Set the space between the 

Select a stitch type for the contour lines

Set a stitch length for the contour lines

lines in the fill
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Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on 
page 136, and added a motif fill to in “Insert Motif Fill in an Appliqué Petal” on page 248.

2 Click the View tab, and ensure that Grid size is set to 5mm.
3 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 

Before and After Trims is selected.
4 Click the Paint tab.
5 Click the MiniPics icon  and the Picture Viewer dialog box will appear.

Browse to the folder ProgramData\VSMSoftware\Premier+2\MiniPics\Paint\Medium.
6 Click the purple and yellow flower called '17.axw'.
7 Click the Close button in the dialog box.
8 Click and drag inside the selection box to move the flower. Position it in the larger end of the petal on 

the left.
9 Click Pick Foreground Color , then click on the purple in the petals of the flower head. The color in 

the color box changes to purple.
10 Click Flood Fill  and the pointer changes to the paint bucket .
11 Click the yellow in the center of the flower and it will be filled with the same purple as the petals.
12 Click the View tab.
13 Click 2D View . 

This enables you to see the picture behind the appliqué fabric.
14 Click the Quick Create tab.
15 Ensure that Fill is selected, then click the fill drop-down menu and select Contour Fill .
16 Ensure that Line and Appliqué are not selected. This will create a fill area without a border or 

appliqué.
17 Click QuickStitch™ .
18 Click inside the flower. The Color Tolerance dialog box will appear.
19 Click OK to close the Color Tolerance dialog box and right-click to deselect the fill tool. The flower 

head is filled with stitches that follow the contours of the petals.
20 Right-click the work area to open 

the Fill Area and Line properties 
dialog.

21 In Spacing on the Options tab, set 
the Gap to 1.2mm. Click OK.

22 Click Life View  to view the 
finished embroidery, then click 
Cancel.

23 Click Save  and browse to the 
folder Documents\Premier+2\My 
Designs.

24 Change the File name to 
'PetalsApplique2' and click Save.

25 Click Export Embroidery  and 
ensure that .vp4 is set as the file 
format. Click OK.

26 In the Save As dialog, browse to 
the folder 
Documents\Premier+2\My 
Designs and click Export to save 
the design as 
PetalsApplique2_Exported.

27 Click Print  to print the 
embroidery worksheet.
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Crosshatch Fill
Crosshatch fills are used in quilting, and to create free-standing lace.

Crosshatch Fill — Options
The Crosshatch Fill Properties enable you to set the gap, style, line angle, stitch type and 
stitch length for the crosshatched lines of stitching in the fill. The preview changes 
according to the options chosen.

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default, 
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter 
Angles to create an asymmetrical crosshatch pattern, if desired.

Crosshatch Fill, using Diamond style and 
an Angle of 75 degrees

Select a style for the Crosshatch fill
Set the angle for one or both crosshatch lines

Adjust the gap between the stitch lines

Select a stitch type for the 

Set the stitch length for fill lines

Set the width for zigzag lines

Preview your settings

crosshatch lines
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Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 45 degrees.

Square
There are no additional options for the Square fill.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.

The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create 
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine 
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to 
the same angle as the Diamond style previously used, and Angle2 is initially set to this 
angle plus 90 degrees.

Stitch Type
Select a stitch type for the crosshatch fill. Choose from:

■ Running Stitch
■ Double Stitch
■ Double Zigzag
■ Triple Stitch

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Zigzag Width
Set the Zigzag width for Double Zigzag stitch from 0.1 to 6mm in steps of 0.1mm. The 
initial setting is 0.6mm.

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh. After embroidering on water soluble stabilizer, the mesh of stitches provides 
strength when the stabilizer is washed away.

Creating and Changing Fills: Fleur de Lys Background and Base
1 In the Quick Access toolbar, click Change Hoop , and set the hoop to Universal, 100mm x 100mm - 

Universal Square Hoop 1.
2 Click the View tab, and ensure that Grid size is set to 5mm.
3 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 

Before and After Trims is selected.
4 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load a Vector Picture as Objects into the Draw Window, then click Next. 
In the Choose Picture page, click Load a Picture , browse to the folder 
Documents\Premier+2\Samples\Create\Pics, and load the picture 'Fleur de lys.wmf’.

5 Click Next and in the Design Size page click Enter Design Size, change the Size to 90mm, and click 
Width. Click Finish to load the picture into the work area.

6 Click the Quick Create tab.
7 In the Fill Area and Line section, click the Fill drop-down menu and select Crosshatch Fill . In the 

Line drop-down menu select Satin Line . Ensure that Appliqué  is not selected.
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8 In the Options section, click the Fill Area and Line button. The Fill Area and Line dialog box opens at 
the Options tab for Crosshatch Fill.

9 In Spacing set the Gap to 2.5mm. Set Style to Diamond, and ensure the Angle for Diamond is 45.
10 In Stitch Type select Double Zigzag. Set Stitch Length to 2.0mm, and Zigzag Width to 0.6mm.

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh. After embroidering on water-soluble stabilizer, the mesh of stitches provides 
strength when the stabilizer is washed away.

11 Click the Line tab.
12 Ensure that Density is set to 4 and that Underlay is selected (checked). Set Width to 3.0mm.

These settings are for the fill area and its border. They are parts of the same object.
13 Click OK to close Fill Area and Line properties.
14 Click QuickStitch™ + AutoHole .
15 Click within the circle, but outside the fleur 

de lys. The dashed line will show the area 
selected for the fill area, with a different 
colored dashed line around the fleur de lys.

16 Click OK and the crosshatch fill area will 
appear.

17 Right-click to deselect QuickStitch™ + 
AutoHole.
A satin border is created around the outside of 
the circle, and around the edge of the fleur de 
lys (the edge of the hole).
In the FilmStrip the Crosshatch Fill area and its 
borders are shown as a single object.
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18 Select the Crosshatch Fill area, and in the Edit tab click Break Apart . 
Where there was one object (the Crosshatch Fill) there are now three 
(Crosshatch Fill, and two Satin Lines). These objects can be edited individually.

19 Click the Satin Line in the shape of a fleur de lys at the bottom of the 
FilmStrip.

20 Right-click, and in the context menu click Delete . The fleur de lys satin 
line will be removed from the FilmStrip.
This removes the border around the fleur de lys hole, and leaves the border 
around the circle.

21 Click the View tab and drag the Background slider to the central point 
(Fade Background ). You can now see the stitching better.

22 Click the Quick Create tab.
23 Click Line so that it is not selected.
24 In Options, click the Fill Area and Line button. The Fill Area and Line 

dialog box opens at the Options tab.
There should be no Line tab. If a Line tab is present, close the Fill Area and 
Line properties and deselect the Line button.

25 In Spacing set the Gap to 2.4mm. 
26 Set Style to Parallel, and set the Angle for Parallel to 90.
27 In Stitch Type, ensure Double Zigzag is selected. Leave Stitch Length at 2.0mm, and Zigzag Width at 

0.6mm. Click OK to close Fill Area and Line properties.
28 Click QuickStitch™ .
29 Click in the bottom of the fleur de lys. The dashed line surrounds only the base of the fleur de lys, and 

does not go into the green band area. 
This is not a problem as this area will be stitched separately.

30 Click OK in the Color Tolerance dialog box. A parallel crosshatch fill area will appear.
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31 Right-click to deselect QuickStitch™.
32 Click the Fill drop-down menu and select 

Pattern Fill . Then in the Options section 
click Fill Area and Line button. The Fill Area 
and Line dialog box opens at Pattern Fill.

33 Set the fill Pattern to 257 (this is in the 
Gradient & Lace category).

34 Select (check) Gradient, then click Single 
Color Gradient and set the start and end 
markers to 6. (Delete any other markers.)
When a single color gradient is set with both 
markers at the same number, the traveling 
stitches will go around the fill area rather 
than across it. This is recommended for 
loosely stitched pattern fills such as this one.

35 Set Angle to 0 and set Compensation to 0. 
Click OK to close Fill Area and Line 
properties.
Underlay does not have to be adjusted as it is 
automatically set to None for the gradient 
density fill.

36 Click QuickStitch™ .
37 Click in the bottom of the fleur de lys and click OK in the Color Tolerance dialog box. A linear fill 

appears over the area of parallel crosshatch fill.
38 Right-click to deselect QuickStitch™.

This combination of fill areas creates a loosely stitched ’weave’ effect that will still have strength when the 
stabilizer is washed away.
Patterns 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create a 
weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine 
with Pattern 258, and so on.

39 To create a band and feathers for the fleur de lys, see “Create the Band and Feathers for a Fleur de Lys” 
on page 312.
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Curved Crosshatch Fill
Curved Crosshatch fills  use curving lines in the crosshatch, which can be used to create 
a feeling of depth. They are used in quilting, and to create free-standing lace.

Curved Crosshatch Fill Properties
The Curved Crosshatch Fill properties dialog box enables you to set the curve, gap, style, 
line angle, stitch type and stitch length for the curved crosshatched lines of stitching in 
the fill.

You can also change the curves in the crosshatch lines using the handles in the work area.

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default, 
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter 
Angles to create an asymmetrical crosshatch pattern, if desired.

Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 45 degrees.

Square
There are no additional options for the Square fill which creates a crosshatch pattern of 
lines set at 90 degrees.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.

Adjust the gap between the stitch lines

Select a stitch type for the 

Set the stitch length for fill lines

curved crosshatch lines

Set the angle for one or both 
curved crosshatch lines

Select a style for the 
Curved Crosshatch fill

Set the curve for the curved crosshatch lines

Use a Motif with the fill
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The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create 
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine 
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to 
the same angle as the Diamond style previously used, and Angle2 is initially set to this 
angle plus 90 degrees.

Stitch Type
Select a stitch type for the curved crosshatch fill. Choose from:

■ Running Stitch
■ Double Stitch
■ Triple Stitch
■ Motif Line

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Curved Crosshatch
Use Lines 1 and 2 to change the curve on the crosshatch lines.

You can also change the curves in the crosshatch lines using the handles in the work area.

Lines 1
Change the position of the origin for one of the sets of curved lines.

Set percentage Curve In and Curve Out from -100 to 100. The initial setting for Curve In % 
and for Curve Out % is 50.

Lines 2
Change the position of the origin for the other set of curved lines.

Set percentage Curve In and Curve Out from -100 to 100. The initial setting for Curve In % 
and for Curve Out % is 50.
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Curved Crosshatch Fill — Motif
The selected Motif is only used by the Curved Crosshatch Fill if the Motif Line option is 
selected on the Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.

Set the gap between the motifs 
Adjust the position of the motifs 

Select a stitch type for the

Set the stitch length

Set the motif size and 

Select a motif Group, Category 
and pattern

Height / Width ratio

motif lines
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Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are 
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for 
each motif.

Curved Crosshatch Fill in a Teardrop
1 Click File, New , or File, New Window , and in the Express Design Wizard, select the bottom 

option, Start a New Design with no Picture, then click Next twice.
2 In the Design Size page, set the hoop to Universal, 100mm x 100mm - Universal Square Hoop 1 and 

click Finish.
3 Click the Quick Create tab.
4 Ensure that the Fill and Line buttons are selected, and that Appliqué is not selected.
5 In the Fill drop-down menu select Curved Crosshatch Fill, and in the Line menu select Satin Line.
6 In Options, click Fill Area and Line to open the Fill Area 

and Line dialog box.
7 In the Options tab, set Gap to 3.5mm.
8 In the Line tab set Width to 1.5mm.
9 Click OK to close the Fill Area and Line dialog box.
10 In the Shape drop-down list, select Shape 41, a teardrop.
11 Click Shape . A curved crosshatch fill area appears on 

the work area in a selection box with blue handles. The 
crosshatch follows the curves of the shape. It has four 
pink triangular handles.

12 Hold down the Ctrl and Shift keys, and drag a corner 
handle to enlarge the teardrop from the center so that 
the teardrop is about 80mm high.
Ensure that all of the pink handles are within the hoop.

13 Right-click outside the selection box, while keeping the 
teardrop selected.
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This deselects the Box Select function.
14 Click and drag the handle on the left towards the left. The vertical crosshatch lines become less 

curved.
15 Click and drag the handle at the bottom upwards. The horizontal lines curve towards the top.

The four handles enable you to adjust the curves of the lines in the fill. Use the handles to make the curves 
in the fill follow the outline of the shape.

16 Right-click the fill area and select Properties in the context menu. The Fill Area and Line properties 
dialog box opens.

17 Use the title bar on the properties dialog box to drag it one side, so that you can see the teardrop.
18 In Style, select Parallel, then click Apply. The fill is now curved vertical lines.

The Style options set the type of parallel or crosshatched fill. Use Angle to set the angle for the lines.
19 Select Square, then click Apply to return to the original style.
20 In Spacing, set the Gap to 4.0mm, then click Apply. The lines are now further apart.

Use Gap to set the distance between the crosshatch lines.
21 In Lines 1 set Curve In and Curve Out to 0%, then click Apply. The 

horizontal hatching in the fill now consists of straight lines. 
Setting Lines 2 to 0% as well would form a square grid. Lines 1 and 2 set 
the initial curve of the lines in the fill. Use the pink handles to adjust the 
curves within the shape.

22 In Stitch Type, note that several line types are available. Select Motif 
Line, then click the Motif tab.

23 Set the Group to Universal and the Category to Hand Stitches 1. 
Pattern 1, a chain stitch pattern, is selected automatically.

24 Set the Height to 1.0mm. The Width will automatically change to 
2.5mm because Proportional is selected.

25 Click Apply. The Curved Crosshatch Fill now uses a motif in the stitch 
lines.

26 Adjust the lines in the fill further, as desired.
Use Curved Crosshatch Fill for intersecting patterns and 3D effects.
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MultiWave Fill
MultiWave Fill areas  use a wave pattern defined by a line, or lines, drawn on the fill 
area. Vary the density, or use a motif for the stitch lines.

Change the direction of the stitch lines, or add texture, with Freehand MultiWave Line and Precise 
MultiWave Line. See “Freehand MultiWave Line” on page 220.

MultiWave Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain 
line to follow the line angle selected for the fill. Click the Motif tab 
to choose a motif.

MultiWave Fill, using a density 
of 15

MultiWave Fill, using a density 
of 15, a Freehand MultiWave 
Line, and a Hand Stitches 1, 
Pattern 1 motif

MultiWave Fill, using a density 
of 15, and a short Freehand 
MultiWave Line to add texture

Set the stitch line density for the fill

Use a motif line

Select a motif
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MultiWave Fill — Motif
The selected Motif is only used by the MultiWave Fill if the Use Motifs option is selected on 
the Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.

Set the gap between the motifs in the line

Adjust the position of the motifs in the line

Select a stitch type for the motif lines
Set the stitch length for the motif lines

Set the motif size and Height / Width ratio

Select a motif Group, Category and pattern
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Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for 
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif 
direction. Some motifs are symmetrical and will have no apparent change when they are 
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of 
stitches from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended 
value for each motif.

Create MultiWave Fill Leaves
1 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 

Before and After Trims is selected.
2 Click File, New , or File, New Window , and the Choose Design Type page of the ExpressDesign 

Wizard will appear.
3 Click Start a New Design with no Picture then click Next. The Select Background Type page will 

appear.
This will ensure that there is no design or picture loaded.

4 Click Draw Window, then click Next. The Design Size page will appear.
5 Click Change Hoop and the Hoop Selection dialog box will appear.
6 Ensure that Enter Hoop Size is not selected, then select the Universal Hoop Group, 240mm x 150mm - 

Universal Large Hoop 2. Ensure the Orientation is Rotated, and click OK. The chosen hoop is 
previewed.

7 Click Finish to close the wizard.
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8 Click MiniPics  and the MiniPics viewer 
will appear.

9 In the Picture Viewer, browse to the folder 
Draw\Fill\Flowers.

10 Double-click the first design 
’01_Floral1.mini’ to select it.

11 Click Close to close the viewer.
12 Notice there is a selection box around the 

leaves. Hold the Ctrl key down and drag 
the bottom right handle down until it is 
half a grid square above the bottom hoop 
corner.

13 Then hold the Ctrl key down and drag the 
top right handle up until it is half a grid 
square below the top hoop corner.

14 Click Alignment, Center in Hoop .
15 With the leaves selected, click File, Send to Wizard .

If you are asked about saving changes to ’Untitled’ (the 
MiniPic picture), click No.

16 In the Send To Wizard dialog box, select ’Retain individual 
object layers’, then click OK. The Design window opens 
displaying an embroidery design based on the leaf picture.
The design uses Pattern fill leaves with a running stitch 
outline. This suits the scale of the design in the hoop. If a 
larger hoop was used, the real-life outline would be wider and 
triple stitch (if 1-3mm wide) or a satin line (if over 3mm wide) 
would be used for the outline.

17 The design is also displayed in the FilmStrip on the left.
Right-click the Color Change (object number 5) above the Running Stitch at 
the bottom and select Properties from the context menu. The Color 
Selection dialog box is displayed. 

18 Ensure that Robison-Anton Rayon 40 is displayed in Thread Range.
19 Click in the Find Thread box and enter '2558'. Thread color 2558 (Buttercup) 

will be found in the list.
20 Click OK to change the color.

This will change the stem to a bright gold color.
21 In the FilmStrip, click object 2 (the top Pattern Fill object).
22 Hold the Ctrl key, and click object 4 (the bottom Pattern Fill object). Both fills 

are now selected in the FilmStrip.
23 Right-click over one of the two highlighted sections in the FilmStrip and 

select Properties from the context menu. The Fill Area and Line dialog box 
for the Pattern Fills will appear, showing the Patterns tab for Pattern Fill.

24 In the Fill drop-down menu at the top left, select MultiWave Fill . The tabbed pages below change, 
displaying the Options tab.
Notice that Density is set to 20 by default. This gives a lightly stitched, but distinctive, MultiWave fill 
pattern.

25 Click the Line tab.
26 Insert Color Change should already be selected (checked). Click Line Thread Color . The Color 

Selection dialog box opens.
27 Ensure that Robison-Anton Rayon 40 is displayed in Thread Range.
28 Click in the Find Thread box and enter '2558'. Thread color 2558 (Buttercup) will be found in the list.
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29 Click OK to change the color. The thread color is now a bright gold.
30 Click OK to close the Fill Area and Line dialog box.

In the two leaves on the right, you can now view the 
stitch density and pattern created by using the default 
MultiWave Fill settings.

31 Click the top leaf to select it.
In the status bar and FilmStrip you can check to ensure 
the MultiWave Fill is selected. You can use the arrow keys 
on the keyboard to step through the objects.

32 In the Design Panel, click the Overview tab.
33 Use the Zoom Bar to zoom in on the top leaf, and click 

and drag in the overview window to position it in the 
center of the screen.

34 Click the Freehand Create tab.
35 Click MultiWave Line . The pointer will change to 

the pen pointer .
36 Starting above the leaf, draw a line down the middle of the leaf from top to bottom, finishing below 

the leaf.
The stitch lines within the leaf will change to follow the direction of the line that you drew.

37 Right-click to deselect the function. The node points on the line will be 
displayed.
Adjust the nodes as desired.

38 Right-click twice in the work area while the fill in the leaf is selected. The 
Fill Area and Line dialog box is displayed.

39 Leave the stitch Density at 20, and move the Fill Area and Line dialog box 
to one side so that you can see the leaf.

40 Select (check) Use Motifs.
41 Click the Motif tab.
42 In the Universal Group, change the Category to Candlewicking 1, then 

select Pattern 1.
43 Click Apply. Candlewicking knots will appear along the stitch lines in the 

fill.
44 Click OK to confirm the change.
45 Click Life View . The complete design is displayed.

Life View enables you to see the complete design while still zoomed in, 
without the selection node points and background image.

46 Click Cancel.
47 Click Save  and browse to the folder Documents\Premier+2\My 

Designs.
48 Change the File name to 'ThreeLeavesA' and click Save.

This saves your work as a design file in .edo format. If you make a mistake you can go back to your saved 
version.

49 Use the Overview window to move to the leaf on the right.
50 Click the leaf to select it. (Check in the status bar that the MultiWave Fill is selected.)
51 Click the Precise Create tab.
52 Click MultiWave Line . 
53 Starting to the left of the leaf, click to place points just above the top edge of the leaf. End the line of 

points to the right of the leaf.
54 Right-click to finish the line.

You do not need to follow the edge exactly.
55 Starting to the left of the leaf, and below the first line, click to place a line of points just below the 

bottom edge of the leaf. End the line to the right of the leaf.
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56 Right-click to place the line.
Do not place the two lines right next to each other, 
as this can greatly increase the stitch density. If the 
lines are too close you can adjust the nodes 
afterwards.
Depending on the desired effect in an area you 
may add an unlimited number of MultiWave lines.

57 Right-click to deselect the MultiWave line tool.
58 Right-click the fill in the leaf. The Fill Area and 

Line dialog box is displayed.
59 Change the Density to 15 and click OK.
60 Adjust the nodes in the MultiWave lines until the 

desired effect is reached.
To add or remove nodes, use Insert Points  or 
Delete Points  in the Home tab.

61 Click Life View . The complete design is displayed. 
Click Cancel.

62 In the Quick Access toolbar, click Save As  and save 
the file as 'ThreeLeavesB'.

63 Use the Overview window to move to the leaf on the 
far left.

64 Click the Home tab.
65 Click the leaf to select it.
66 Click Box Select . A selection box with blue handles 

appears around the leaf.
67 Click Copy , then click Paste . A copy of the leaf 

fill area is placed on top of the original.
68 Click the lower copy (4) in the FilmStrip.

The lower part of the color block for this entry is turquoise. 
This is the color for the running stitch outline around the 
leaf. 
You can also see this color as a secondary color in the Color Select box in the Design panel. Hover over the 
turquoise in the Color Select box, and the leaf is highlighted in the work area. This is a way to locate the 
object using a secondary color.

69 Right-click in the FilmStrip and select Properties. The Fill Area and Line dialog box appears.
70 In the Fill drop-down menu at the top left, select MultiWave Fill .
71 Ensure that the Density is set to 20, and click the Line tab.
72 In the Line tab, deselect (uncheck) the Insert Color Change checkbox. Then 

click OK.
The leaf outline will now be the same color as the fill.

73 Click the Pattern Fill (number 3) to select it.
74 Right-click in the FilmStrip and select Properties. The Fill Area and Line 

dialog box appears.
75 Set Density to 3.
76 Change the Angle to 55.

This is at 90 degrees to the main curvature of the MultiWave Fill.
77 Click the Line tab.
78 Insert Color Change should already be selected (checked). Click Line 

Thread Color . The Color Selection dialog box opens.
79 Ensure that Robison-Anton Rayon 40 is displayed in Thread Range.
80 Click in the Find Thread box and enter '2558'. Thread color 2558 (Buttercup) 

will be found in the list. Click OK.
81 Click OK again to close the Fill Area and Line dialog box.
82 With the Pattern Fill (number 3) still selected, right-click in the FilmStrip and select Insert Color 

Change.
83 Click in the Find Thread box and ensure that thread color 2558 (Buttercup) is selected.
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84 Click OK to change the color. This bright color will contrast with the color of the Pattern Fill beneath 
the MultiWave Fill.

85 Click the MultiWave Fill.
86 Right-click in the FilmStrip and select Insert Color Change.
87 Click in the Find Thread box and enter '2547'. Thread color 2547 (Pebblestone) will be found in the list.
88 Click OK to change the color. This 

changes the rest of the design back to 
the paler shade used by the Pattern Fill.

89 Click Life View . The final design is 
displayed.

90 Click Cancel.
91 In the Quick Access toolbar, click Save 

As  and save the file as 
'ThreeLeavesC'.

92 Click Export Embroidery  and ensure 
that .vp4 is set as the file format. Click 
OK.

93 In the Save As dialog, browse to the 
folder Documents\Premier+2\My 
Designs and click Export to save the 
design as ’ThreeLeavesC_Exported’.
The preferred file format for saving 
embroideries is .vp4 format as this will 
preserve the separate parts of multipart 
designs. It also preserves thread color 
information and notes.

Echo Fill
Echo Fill  places echo lines within and around a shape. Choose from rounded, square 
and diagonal corners, set the gap between the echo lines and the number of lines, and 
select the stitch type and length.

Echo Fill — Options
The Echo Fill properties dialog box enables you to place echo lines within a shape. Set the 
fill type, style, gap, stitch type and stitch length.

Rounded corners Square corners Diagonal corners
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Echo Area
Internal Fill: Fill the selected area with lines, using the chosen Gap between the lines of 
stitching.

Internal Lines: Place the chosen number of lines around the inside of the selected area, 
using the selected Gap.

External Lines: Place the chosen number of lines around the outside of the selected area, 
using the selected Gap.

External and Internal Lines: Place the chosen number of lines around the outside and 
inside of the selected area, using the selected Gap.

Echo Lines
Set the number of echo lines. The minimum number of lines is 1, and the maximum 
number of lines is 30. The initial number is 5.

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 2mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from 1, 2 or 3. For a square shape:

• 1  will create rounded corners

• 2  will create square corners

Choose rounded, square or
diagonal corners for the fill

Select a stitch type for the lines

Select a stitch length for the lines

Place echo lines inside and/or 

Set the Gap between the echo lines

around a shape
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• 3  will create diagonal corners

Rounded corners (1) is initially selected.

Stitch type
Select a line type for the echo lines in the fill. Choose from:

• Running Stitch
• Double Stitch
• Triple Stitch

Stitch Length
Set the stitch length for the echo lines from 1 to 12mm in 0.1mm steps. The initial setting 
is 2mm.

Satin Area
See “Satin Area Options” on page 296.

No Fill
For No Fill , no fill type is selected. Only the properties for the selected line are 
available.

Use this where only a line is desired.
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Manage My Fills
Use Manage My Fills  to load new pictures for fill 
patterns, export an existing My Fill pattern as a picture 
and delete unwanted My Fills. 

If you have a design using a My Fill pattern and give it to a 
friend, it is likely that their My Fill database will have different 
patterns to your My Fill database. Export the My Fill pattern and 
give the picture to your friend to import into their My Fill 
database. 

Shortcuts
■ Edit Tab: 
■ Keys: Alt, E, F

Export
Use Export to save a My Fill pattern as a picture. The picture can then be copied and 
imported into a friend’s My Fills.

Click Export and the Save As dialog box appears. The file name is automatically set to the 
number used for the pattern in your My Fills.

The following file formats may be saved: Windows or OS2 Bitmap (.bmp), JPEG Low Quality 
(.jpg), JPEG High Quality (.jpg), Tagged Image File Format uncompressed (.tif ) and 
Portable Network Graphics (.png).
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Delete
To remove an unwanted My Fill pattern, select the desired pattern then click Delete. A 
message will appear to ask for confirmation.

Click OK to remove the pattern.

When a My Fill pattern is deleted, any designs that used that pattern will use standard Pattern 3 until a new 
pattern is chosen.

Import
Use Import to create a new My Fill based on a picture or a previously exported My Fill. 
After importing a picture, that fill will be available in the My Patterns  category of the 
Fill Area and Line Properties dialog. Click the Import button and an open dialog box will 
appear where you can choose the picture to import.

The height and width of the picture must each be from 120 to 700 pixels.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 
uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf) 
and Windows Icon (.ico).

Click the desired picture, then click Open.

The picture is automatically converted to black and white to determine the best positions for stitch points. 
Therefore, you are likely to find the best results from simple pictures drawn in black and white.
A My Fill pattern is repeated every 0.1mm for each pixel in the source picture. For example, 
if your picture is 300 x 200 pixels, it will be repeated every 30mm horizontally and 20mm 
vertically if the fill angle is set to 0.
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Use a Bee for a My Fill Pattern
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign 
Wizard” on page 134, and added a leaf pattern and single gradient fill to in “Change a Fill Area to a Leaf 
Pattern” on page 235 and “Create a Single Color Gradient Fill in a Petal” on page 239.

2 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab and ensure that Grid size is set to 5mm
4 In the color worksheet in the Design Panel, click the check 

box for the fourth color (slate blue) to hide the satin borders 
using that thread color. This will make it easier to select the 
fill areas.

5 Click the Edit tab.
6 Click Manage My Fills  and the Manage My Fills dialog box 

will appear.
7 Click Import and the open a file dialog box will appear.
8 Browse to the folder Documents\Premier+2\Samples\Create 

\Pics.
Simple black and white pictures are recommended. The height 
and width of the picture must be between 120 and 700 pixels.

9 Click 'Bee.bmp', then click Open. The bee fill will be created 
and a preview sample will be shown in the Manage My Fills 
dialog box.

10 Click Close.
11 Select the fill area for the petal on the right, then right-click 

to see the Fill Area and Line dialog box. The Options tab is displayed.
12 In the Pattern section, click My Patterns . The 

the first fill in the My Patterns 1 category (the bee) 
is displayed.
You could also browse to view all patterns in this 
category from the drop-down list.
Note that the bee design has automatically been 
given pattern number 501. You could enter this 
number to go directly to the bee pattern.

13 Set the Angle to 20, then click OK.
Alternatively, you could use the handle on the Origin 
marker  to change the fill angle.

14 Click Design Player . This enables you to 
preview the way that the design will be stitched 
out, with no markers.

15 Use the Play button  at the bottom left to start 
playing through the stitches in the embroidery.
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16 Use the controls to play forwards or backwards 
through the embroidery at different speeds, 
jump to the start or end of the stitches, and stop 
at any time.
Use the Design Player  or Life View  when you 
wish to preview a design with no objects selected.

17 Click Cancel.
18 Click Display all Objects  to show the blue 

petal borders.
19 Click Save  and browse to the folder 

Documents\Premier+2\My Designs.
20 Change the File name to 'PetalsFill1' and click 

Save to save your design file.
21 Click Export Embroidery  and ensure that .vp4 

is set as the file format. Click OK.
The preferred file format for saving embroideries is 
.vp4, as this will preserve background and appliqué 
information, thread color information and notes.

22 In the Save As dialog, browse to the folder 
Documents\Premier+2\My Designs and click 
Export. The embroidery is saved as 
PetalsFill1_Exported.
There is no need to change the file name, as it is 
taken automatically from the design file name.

23 Click File, Print.
24 Deselect (uncheck) Print Plan View and Print Picture.

Print Plan View shows the picture with the embroidery printed over it. Print Picture prints the background 
picture. These features are useful where embroidery is used to enhance a picture.

25 In Worksheet options, ensure that Design Scale is set to 100% and ensure that Grid and all the Print 
Information boxes are checked. Click OK.

26 Select two pages to see both pages of the worksheet.

27 Click Print  to print the embroidery worksheet.
The embroidery worksheet will be printed at full size.
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13Creating and Using Satin Areas

Satin Area
Create Satin Areas with the Satin Area functions: QuickStitch™ Satin , QuickStitch™ 
Multiple Satin , Freehand Satin Area  and Precise Satin Area . 

Adjust the properties of your satin area with Satin Area Options.

Use the Favorites tab to make the chosen settings into Favorites that may be applied to other areas, or into 
the current settings, to use as default for new areas of this type.

QuickStitch™ Satin
Use QuickStitch™ Satin  to fill an area with satin stitches 
automatically, by clicking in a color area of the picture. If 
required, use Color Tolerance to select a larger area according to 
the similarity of adjacent colors.

Set stitch options before creating, or after satin areas have been 
created, right-click an area and use Fill Area and Line properties 
to change density, pattern and underlay, or change to another 
stitch type.

You can change all visible or selected satin areas with Global Properties, or by selecting 
the objects to change and changing one of them in Fill Area and Line properties. Stitch 
angle lines and start and end points can be adjusted on satin areas individually.

QuickStitch™ Satin works best with relatively simple areas of the picture that do not have any complex 
branches. For example, if the area has long branches or branches that double-back on each other, you 
may not get the best result.



290          PREMIER+™ 2 Create   Creating and Using Satin Areas 

For branching or other complex areas, use QuickStitch™ Multiple Satin. Alternatively, edit the picture to 
make separate areas of any extra branches.

Shortcuts
■ Quick Create Tab, Satin Area: 
■ Keys: Alt, Q, K

Create a QuickStitch™ Satin Area
1 Set stitch options, then in the Quick Create tab click the QuickStitch™ Satin icon .
2 Click in the color area you wish to fill with stitches.
3 If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color 

Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to 
confirm.

4 Satin stitches will appear in the area.
5 Repeat to place as many satin areas as desired.
6 Right-click to deselect, or simply select another Create tool.
7 Right-click the Satin Area. The Fill Area and Line properties dialog opens.
8 Select each satin area in turn, right-click to change the satin properties of an area and click OK.

See “Satin Area Options” on page 296.
9 Alternatively, to change the properties of a selection of satin areas at one time, in the FilmStrip, hold 

the Ctrl key and click each of the satin areas to be changed. Then right-click one of the selected areas 
and select Properties. The Fill Area and Line dialog box will appear. All settings in the Fill Area and Line 
dialog box will be applied to your selected satin areas when you click OK.

10 Also in the work area, if desired, move the green start  or red end  and adjust angle lines for 
satin areas.

A tree from the Paint MiniPics with many branches Left as one color, a single QuickStitch™ Satin area is 
created

Use QuickStitch™ Multiple Satin areas Or split up the branches by using different colors
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QuickStitch™ Multiple Satin
Use QuickStitch™ Multiple Satin  to fill a branching or other 
complex area with satin stitches automatically, by clicking in a 
color area of the picture. If required, use Color Tolerance to 
select a larger area according to the similarity of adjacent 
colors.

Shortcuts
■ Quick Create Tab, Satin Area: 
■ Keys: Alt, Q, M

Create a QuickStitch™ Multiple Satin Area
1 Set stitch options, then in the Quick Create tab click the QuickStitch™ Multiple Satin  icon.
2 Click in the color area you wish to fill with stitches.
3 If Color Tolerance is enabled then the Color Tolerance dialog box will appear. Adjust the Color 

Tolerance as required. The area selected by the Color Tolerance value will be previewed. Click OK to 
confirm.

4 Satin stitches will appear in the area.
5 Repeat to place as many satin areas as desired.
6 Right-click to deselect, or simply select another tool.
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Freehand Satin Area
Use Freehand Satin Area  to draw outlines to define the edge of an area filled with satin 
stitch. Satin areas are best suited to shapes without branches. If there are branches that 
double-back on the main part of a satin area, the satin area may not give the desired 
result.

After satin areas have been created, right-click an area and use Fill Area and Line 
properties to change density, pattern and underlay, or change to another stitch type.

You can change all visible or selected satin areas with Global Properties, or by selecting 
the objects to change and changing one of them in Fill Area and Line properties. Stitch 
angle lines and start and end points can be adjusted on satin areas individually.

If the edge of the area does not match the background picture as closely as desired, you 
can move, delete and insert points on the work area.

Shortcuts
■ Freehand Create Tab, Satin Area: 
■ Keys: Alt, R, T

Create a Freehand Satin Area
1 Set stitch options, then in the Freehand Create tab click the Freehand Satin Area  icon.
2 Draw a line around the edge of the desired area. 
3 When the area is complete, lift the pen from the tablet (or release the mouse button). The area is 

closed with a straight line back to the start point, and filled with satin stitches.

Satin Area created as a strip around the 
picture shape, so stitches are short 

enough to leave as plain satin

Large Satin Area covering the whole 
picture shape, with a pattern to break up 

long stitches
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It is recommended to draw back to the start point. However, you can also adjust the shape of the area if it is 
not exactly as planned.

4 Continue to draw as many satin areas as desired.
5 Right-click to deselect the function, or simply select another Create tool.

Change Satin Area Properties
1 Select each satin area in turn, right-click to change the satin properties of an area and click OK.

See “Satin Area Options” on page 296.
2 If desired, move the start  or end  and adjust angle lines for satin areas.
3 To change the properties of a number of satin areas at one time, in the FilmStrip, hold the Ctrl key and 

click each of the satin areas to be changed. Then right-click one of the selected areas and select 
Properties. The Fill Area and Line dialog box will appear. All settings in the Fill Area and Line dialog 
box will be applied to your selected satin areas when you click OK.
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Precise Satin Area
Use Precise Satin Area  to place points, to define the edge of an area filled with satin 
stitch. Satin areas are best suited to shapes without branches. If there are branches that 
double-back on the main part of a satin area, the satin area may not give the desired 
result.

After satin areas have been created, right-click an area and use Fill Area and Line 
properties to change density, pattern and underlay, or change to another stitch type.

You can change all visible or selected satin areas with Global Properties, or by selecting 
the objects to change and changing one of them in Fill Area and Line properties. Stitch 
angle lines and start and end points can be adjusted on satin areas individually.

If the edge of the area does not match the background picture as closely as desired, you 
can move, delete and insert points on the work area.

Shortcuts
■ Precise Create Tab, Satin Area: 
■ Keys: Alt, P, T

Create a Precise Satin Area
1 Set stitch options, then in the Precise Create tab click the Precise Satin Area icon . The first point 

appears automatically as a small yellow circle, which is in the same place as the last point of the 
previous object.

2 Click to place a second point close to the first one.

Satin Area created as a strip around the 
picture shape, so stitches are short enough 

to leave as plain satin

Large Satin Area covering the whole 
picture shape, with a pattern to break up 

long stitches
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3 Continue placing points around the desired area, such as a chosen section of the background picture. 
If you are following the picture, place a point every time the direction of the picture outline changes. 
Curved lines are created automatically. For corners and straight edges, hold down the Ctrl key. To delete 
the last point placed, use the Delete key.

4 Right-click to complete the area. Stitches will appear in the current thread color showing the satin 
area.

5 Repeat to place as many satin areas as desired.

Change Satin Area Properties
1 Select each satin area in turn, right-click to change the satin properties of an area and click OK.

See “Satin Area Options” on page 296.
2 If desired, move the start  or end  and adjust angle lines for satin areas.
3 To change the properties of a number of satin areas at one time, in the FilmStrip, hold the Ctrl key and 

click each of the satin areas to be changed. Then right-click one of the selected areas and select 
Properties. The Fill Area and Line dialog box will appear. All settings in the Fill Area and Line dialog 
box will be applied to your selected satin areas when you click OK.
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Satin Area Options
Use the Satin Area Options tab to set density, compensation, pattern and underlay for 
satin areas.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click 
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number 
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.

Add new patterns using Manage My Fills.
View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 369.

Underlay
Set the Underlay option that will be used for satin areas. Zigzag creates zigzag lines of 
running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places 
lines of running stitch just inside the edges of the satin areas. Use edge walk when the 
satin areas have both wide and narrow sections. For very wide areas of satin, select both 
underlay types.

Zigzag is initially selected.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 30. The higher the number, the bolder the area appears.

Density
Set Density from 2 to 80. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 4.

Set the stitch density for the satin

Select an underlay type for the satin

Adjust the area’s size
Choose a Category and pattern

Search for a pattern by number

Click to use no pattern
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Using Satin Areas: Blue Jay Embroidery
1 In the Quick Access toolbar, click Change Hoop  and in the Hoop Selection dialog box set the 

Hoop Group to Universal, and select 100mm x 100mm - Universal Square Hoop 1. Click OK.
2 Click the View tab, and ensure that Grid size is set to 5mm.
3 Click File, Preferences  and ensure that Color Tolerance is selected 

(checked). 
Use Color Tolerance to see which areas will be created when using the 
QuickStitch™ features. As you become more comfortable with the 
software, you may wish to turn it off, depending on the quality and color 
of your image.

4 Check to see that Tie Off Before and After Trims is selected.
Tie Off Before and After Trims inserts tie-offs between stitch areas, as 
appropriate.

5 Click File, New , or File, New Window , and in the Choose 
Design Type page of the ExpressDesign Wizard select Load a Picture 
into the Paint Window, then click Next.

6 Click Load a Picture  and in the Picture Viewer browse to 
Documents\Premier+2\Samples\Create \Pics. Load the picture 
Birds4.png, click OK and in the Choose Picture page click Next.

7 In the Rotate and Crop Picture page click Select All to leave some background around the bird, then 
click Next.

8 Click Next in the Design Size page, and click Finish in the Reduce Colors page. The blue jay is 
displayed as your background picture.

9 Click the Quick Create tab to open the Design window.
10 In the FilmStrip, right-click the color at the top and choose Properties.
11 In the Color Selection dialog ensure that Robison-Anton Rayon 40 is selected as the thread range.
12 Enter 2614 (Pro Lusty Blue) as the thread number and click 

OK.
13 Click QuickStitch™ Satin .
14 Click on the medium blue on the lower back of the jay.

The Color Tolerance dialog appears, with the lower back 
area surrounded by a red and cyan line.

15 Click OK to confirm.
The lower back of the blue jay is now covered by a medium 
blue satin area.

16 In the Command section of the Quick Create tab, click the 
Color Change drop-down menu, and select Color 
Change .

17 In the Color Selection dialog, select 2522 (Bridgeport Blue) 
and click OK.

18 Ensure that QuickStitch™ Satin  is still selected.
19 Click the light blue on the top of the jay’s head, then click OK in 

Color Tolerance. The top of the head is filled with a pale blue 
satin area.

20 Click on the light blue on the upper back of the jay, then click 
OK in Color Tolerance. The rest of the back and the upper and 
lower wing is filled with a pale blue satin area.
If it is not filled already, fill the pale blue in the lower part of the 
wing with a QuickStitch™ Satin area.

21 Click Zoom To Rectangle , and drag a rectangle to zoom in 
on the jay’s tail.

22 Click the Precise Create tab, and then click Satin Area .
23 Hold the Ctrl key and click to place the first point at the top left 

corner of the top pale blue tail section.
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24 Release the Ctrl key and place a point in the middle of the top of this tail section. The point is round.
Round points are used for curved edges to the area.

25 Hold the Ctrl key and place a point at the top right corner of this 
section. This point is square.
Square points are used for straight sections of the edge of the area, or for 
corners.

26 Still holding the Ctrl key, click to place a point at the bottom right 
corner of the tail section.

27 Release the Ctrl key and place two round points for the curve at the 
bottom of the tail section.

28 Hold the Ctrl key and place a square point for the bottom left corner of the tail section. This 
completes the tail section.

29 Right-click to finish the satin area.
30 Hold the Ctrl key and click to place a first square point at the top left corner of the second pale blue 

tail section.
31 Release the Ctrl key and place two round points in the middle of the top of this tail section.
32 Hold the Ctrl key and place a square point at the top right corner of this section, and then another 

square point for the bottom right corner.
If you misplace a point, move the pointer over the top of that point and when the pointer changes to the 
move pointer , drag it to the correct position. Then continue to place points.

33 Release the Ctrl key and place two round points for the curve at the bottom of the tail section, then 
hold the Ctrl key to place a square point for the bottom left corner, and to finish the section.

34 Right-click to complete the area.
35 Place round and square points to create the third pale blue tail section, then right-click to finish.
36 Create the final pale blue tail section by placing points. Use a square point for the notch on the 

bottom edge.
37 Right-click again to close the Precise Satin Area tool.
38 Click the View tab, then click 2D View  to see the picture 

behind the stitching in 2D, then adjust the points on the final 
area as desired. You can also drag the pink hexagonal control 
points on the stitch angle lines to change the angle of the 
stitching.
Hold the Ctrl key when dragging square points, so that they remain 
square.
If desired, click the Home tab to use Delete Points  to remove 
points, and Insert Points  to add points.

39 Click the other tail sections in turn to select them, and make any 
adjustments needed.
Click 3D View  to return to view the stitches in 3D, and then 
click Zoom to Fit  to view the whole design.

40 Click the Select Last Visible icon  on the FilmStrip, to ensure that you are at the end of the design.
41 Click the Precise Create tab.
42 In the Command section of the Precise Create tab, click the Color Change  icon.
43 In the Color Selection dialog, select 2440 (Blue Ink) and click OK.
44 Click Zoom To Rectangle  to zoom in on the bottom of the wing.
45 Click Satin Area  and place points for the 

satin area. Use square points for sharp 
angles, and round points for curves.

46 Right-click to complete the area.
47 Note that between the feathers at the 

bottom of the wing, parts of the stitching 
overlap the line that you drew.
Click Undo  to remove the area that you placed.

48 Click the Quick Create tab, and then click QuickStitch™ Multiple Satin .
49 Click the bottom of the wing, then click OK in Color Tolerance. The new satin area is created in several 

sections. It follows the outline of the area with no overlap.
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Use QuickStitch™ Multiple Satin when creating complex satin areas. Alternatively, create several sections 
using one of the Freehand tools.

50 Click Zoom to Fit  to view the whole design.
51 Click the beak, then click OK in Color Tolerance. The beak is created separately from the flash above.
52 Click Zoom To Rectangle  to zoom in around the eye.
53 Click the Freehand Create tab.
54 Click Satin Area .
55 Starting at the top, draw a line around the edge of the blue part of the eye, finishing near where you 

started. Then lift the pen from the tablet (or release the mouse button). 
The area is closed with a straight line back to the start point, and filled with satin stitches.

56 Right-click to close the tool.
57 Adjust, add and delete points and angle lines as desired.
58 Click Zoom to Fit  to view the whole design.
59 Click the Quick Create tab, and then click the QuickStitch™ Satin  button.
60 Fill the remaining area on the head, and the dark blue tail sections with satin, then right-click to close 

the tool.
61 In the Fill drop-down menu, select Pattern Fill.
62 Ensure that Line and Appliqué are not selected.

This will create an area of pattern fill with no border line.
63 Click Zoom To Rectangle  to zoom in around the legs.
64 Click the Precise Create tab.
65 In the Fill Area and Line area, click Create Area or Line .
66 Hold the Ctrl key and click to place straight lines for each of the legs. Right-click to complete each fill 

area, then right-click to close the tool.
The QuickStitch™, Freehand and Precise tools work exactly the same, regardless of whether you are 
creating a line, fill or satin area.

67 Click Zoom to Fit  to view the whole design.
68 Click Color Change  and in the Color Selection dialog, select 2343 (Eggshell) and click OK.
69 Click the Quick Create tab, and then click QuickStitch™ Satin .
70 Click to fill the white middle section of the wing.
71 Click the QuickStitch™  button, and click to fill the white area above the legs, and the small white 

area above the beak.
72 Click QuickStitch™ + AutoHole .
73 Click the white area of the face that includes the eye. The area is filled 

with the eye still visible.
You can create holes in fills, but not in satin areas.

74 Right-click to close the tool.
75 Click Life View  or Design Player  to view how the blue jay 

embroidery will be stitched out.
76 Click Save , browse to Documents\Premier+2\My Designs and 

save the embroidery design as Blue Jay.edo.
77 Click Export  and export the embroidery as Blue Jay_Exported.
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14Creating Columns
Create columns with the Column functions. Choose from Satin Column , Feathered 
Satin , Richelieu Bars  or Tapered Motifs .

You can select your column type in the Create tabs before creating the fill.

Alternatively, change the column type afterwards using Fill Area and Line properties. 
Use the Favorites tab to make the chosen settings into Favorites that may be applied to other areas, or into 
the current settings, to use as default for new areas of this type.

Column
Select the column type from the Create tabs:

Satin stitch will 'pull up' in the direction that the stitches are sewn, so it is advisable to lay 
down underlay stitches for stabilization.

You can set automatic underlay in the Column properties dialog.

Column
Use the Column functions to place one of the following column types: Satin Column , 
Feathered Satin , Richelieu Bars  or Tapered Motifs .

The first and last pairs of points in a column are always square (control points).
Right-click the created column to change its settings, or convert it to any other column type.

Satin Column Richelieu Bars

Feathered Satin Tapered Motifs
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Create a Column
1 Click the Freehand Create or Precise Create tab.
2 Set stitch options, then click the desired Column 

function and click to place the first point of your 
column (Point 1).
A movement stitch will be placed between the last object 
in the design and this point.

3 Click to place Point 2 to start the other side of the 
column. A line will be placed to indicate the width of 
the column.
The first and last pairs of points in a column are always 
square (control points).

4 Click to place Points 3 and 4 for the next section of the column. The first column section appears.
5 Repeat to place points indicating the width and position of the column. 

The outline shape of the column is drawn.
6 Right-click to place the column, or simply select another Create tool. The 

stitches for the column will appear in the work area.
7 Right-click a second time to deselect the function, or simply select 

another Create tool.
If desired, click the column to select it, and then right-click it to open the 
Column dialog. Here you can change the settings, or select a different 
column type from the drop-down list.

Draw a column with Bezier Curves
1 Click the Precise Create tab.

Bezier Mode is only available in the Precise Create tab.
2 Select Bezier Mode .
3 Set stitch options, then click the desired Column function 

and click and drag to place the first point of your column 
(Point 1).
A movement stitch will be placed between the last object in 
the design and this point.

4 Click and drag to place Point 2 to start the other side of the 
column. A line will be placed to indicate the width of the column.

5 Click and drag to place Points 3 and 4 for the next section of the column. The first column section 
appears.

6 Repeat to place points indicating the width and position 
of the column. The outline shape of the column is drawn.

7 Right-click to place the column.
8 Right-click a second time to deselect the function.

If desired, click the column to select it, and then right-click it 
to open the Column dialog. Here you can change the 
settings, or select a different column type from the drop-
down list.
The Bezier lines in a Column cannot be changed to a Point Line. See “Convert to Point Line” on page 347.
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Satin Column
Use Satin Column  to place a column of satin in the work area.

Place alternate points to define a column of continuous satin 
(zigzag stitches that fill the column from one side to the other). 

Click the Options button, or right-click a Satin Column to set 
density, compensation, pattern (for wide columns) and underlay. 

Shortcuts

■ Freehand Create, Column; Precise Create, Column: 
■ Keys: Alt, R, S; Alt, P, S

Satin Column Options
Use the Satin Column Options to set density, compensation, pattern (for columns wider 
than around 8-10mm) and underlay.

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Feathered 
Satin, Richelieu Bars and Tapered Motifs.

If no column is currently selected, this option will be grayed out.

Convert to Satin Area
Click Convert to Satin Area  to change the column to a Satin Area. The Fill Area and Line 
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 296.

Set the Standard density

Select an underlay type for the satin

Adjust the area’s size
Choose a Category and pattern

Search for a pattern by number

Use gradient density

Settings for Single & Multicolor gradient
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Click Undo  to change back to a column.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click 
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number 
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.

View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 369.

Patterns can only be used for columns wider than about 8-10 mm.

Underlay
Set the Underlay option that will be used for the satin column. Zigzag creates zigzag lines 
of running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places 
lines of running stitch just inside the edges of the satin column. Use edge walk when the 
satin columns have both wide and narrow sections. For very wide satin columns, select 
both underlay types.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 30. The higher the number, the bolder the area appears. The 
initial setting is 0.

Density
Set Density from 2 to 80. The lower the number, the closer 
together the stitches and the more stitches are produced. The 
initial setting is 4.

Gradient
Use the Gradient settings to see and change the density settings 
and the color Gradient of the satin.

The color on a satin column can change over a range, or have multiple color changes 
across the area. This is ideal for gradual color changes such as subtle shadow effects. 
Gradient is not initially selected.

Single Color Gradient

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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Use Single Color Gradient to change the density across a satin column with only one color. 
Set a value for the start and end density markers for the fill, and the density gradually 
changes between the two values. Add multiple markers for a more complex pattern.

The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by 
swapping the start and end values.
Use the adjustment marker above the gradient bar to change the gradient across the area.

Use Reset to cancel your changes and use the initial settings.

Click Add Marker to add a value marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial value for the marker will be between the existing 
markers. Edit the density value, and move the value and adjustment markers as desired. 
This means that you can have any combination of density values across the area. A higher 
value means the fill is less dense.

Density is used to change the density of the stitching. Set Density from 2 to 80. The higher 
the number, the less dense the satin. The initial start marker setting is 4, and end marker 
setting is 4.

Click Remove to delete the highlighted marker.

Multicolor Gradient

Use Multicolor Gradient to change the color across a satin column with only one density. 
Set colors for the start and end markers for the area, and the color gradually changes 
between the two values.

Use the marker above the gradient bar to change the color gradient across the area.

Use Reset to cancel your changes and use the initial settings.

Click Add Marker to add a color marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial color for the marker will be the same as the currently 
highlighted marker. Change the color and move the color and adjustment markers as 
desired. This means that you can have any combination of colors across the area.

Use Thread Color  to change the color of the currently highlighted marker. The Color 
Selection box will be displayed.

See “Color Selection” on page 144.
Click Remove to delete the highlighted marker.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the 
highlighted marker

Delete the selected
marker

Set the stitch density
for the whole fill
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Feathered Satin
Use Feathered Satin  to create columns of satin that are 
feathered on one, or both sides.

Place alternate points to define a column of feathered satin 
(zigzag stitches where the start and end points of the stitches are 
random rather than all parallel).

Click the Options button, or right-click a Feathered Satin column, 
to select whether one or both sides of the column will be 
feathered, and set the stitch length and density. 

Use feathered satin for realistic feathers or fur in animal designs, or shading in flowers. Typical shapes are 
arches, semicircles, circles and ovals, and squares, rectangles and triangles are also possible.

Shortcuts
■ Freehand Create, Column; Precise Create, Column: 
■ Keys: Alt, R, D; Alt, P, D

Create Feathered Satin
1 Click the Freehand Create or Precise Create tab.
2 Set stitch options, then click the Feathered Satin icon .

To use Bezier lines instead of placing points, click to enable Bezier Mode , then draw your Feathered 
Satin column using Bezier lines. See “Draw a column with Bezier Curves” on page 301.

3 Click to place the first point of your feathered satin column.
A movement stitch will be placed between the last object in the design and this point.

4 Click to place Point 2 to start the other side of the column. A line will be placed to indicate the width 
of the column.

5 Click to place Point 2 to start the other side of the section.
6 Click to place Points 3 and 4 for the first part of the feather satin column. A line will appear, showing 

the stitch angle between these points.
7 Click to place further points for the next parts of the feather satin column.
8 Repeat to place as great a length of feathered satin column as desired.
9 Right-click to place the column, or simply select another Create tool.
10 Right-click again to deselect the function, or simply select another Create tool.
11 If desired, right-click the column and change the properties for the column. Alternatively, select 

several objects in the FilmStrip and right-click one to the change the settings for all, or use Global 
Properties to change the properties of all visible feathered satin or satin feathered on one side.

Feather Both Sides Feather One Side
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Feathered Satin Options
Use the Feathered Satin Options to set density, Feather Type, and Stitch Length.

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Satin 
Column, Richelieu Bars and Tapered Motifs.

If no column is currently selected, this option will be grayed out.

Convert to Satin Area
Click Convert to Satin Area  to change the column to a Satin Area. The Fill Area and Line 
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 296.

Click Undo  to change back to a column.

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced. The 
initial setting is 15.

Feather Type
Select which side of the column to feather. The available options 
are Both, SideA or Side B, according to the side where the first (A) or second (B) point was 
placed.

Stitch Length
Set the Length of feathering stitches from 2 to 30mm in steps of 1mm. The initial setting is 
30mm.

Set the density for the feathered satin

Select which side of the column to feather

Set the length of the feathering stitches
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Feather Both Sides
Create a satin column with both edges feathered.

The start and end points of the stitches are random rather than all parallel. The final width 
of the section is 2-2.5 times larger than it is for standard satin, as shown.

The maximum stitch lengths of the feathered satin may be from 2 to 30mm and the satin 
density may be from 2 to 40.

Feather One Side
Create a satin column with one edge feathered.

One edge is feathered, so the start and end points of the stitches on the feathered edge 
are random rather than all parallel. The final width of the column is 1.5 to 1.75 times larger 
than it would be for standard satin, as shown.

The maximum stitch lengths of the feathered satin may be from 2 to 30mm and the satin 
density may be from 2 to 40.

The side of the feathering is determined by the relative position of point 1. If desired, the 
feathered side may be altered in the properties dialog.
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Richelieu Bars
Use Richelieu Bars  to place bars in the work area. Richelieu bars 
are often used in lace designs.

Place alternate points to define a column of Richelieu bars (short 
sections of satin perpendicular to the direction of the column).

Click the Options button to set the width and density of the satin 
bars and either the number of bars or the gap between them.

To use Bezier lines instead of placing points, click to enable Bezier Mode , 
then draw your Richelieu Bars using Bezier lines. See “Draw a column with 
Bezier Curves” on page 301.

Shortcuts
■ Freehand Create, Column; Precise Create, Column: 
■ Keys: Alt, R, B; Alt, P, B

Richelieu Bars Options
Use Richelieu Bars Options to set the width and density of the satin bars, the gap between 
the bars, and the number of bars.

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Satin 
Column, Feathered Satin and Tapered Motifs.

If no column is currently selected, this option will be grayed out.

Set the width for the bars
Set the stitch density for the bars

Set the minimum distance 

Set the number of bars
Use a bar at both ends of 

Set underlay for the Richelieu bars

between the bars

the column



PREMIER+™ 2 Create   Creating Columns              309

Convert to Satin Area
Click Convert to Satin Area  to change the column to a Satin Area. The Fill Area and Line 
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 296.

Click Undo  to change back to a column.

Satin
Set the Width of the satin bars from 1mm to 6mm in steps of 0.1mm. The initial setting is 
2mm.

Set the Density of the satin bars from 2 to 15. The initial Density is 4.

Method
Select a method for setting the number of bars.

Select Minimum Gap Size to set the distance between the bars from 1mm to 50mm in 
steps of 1mm. The initial setting is 6mm.

Select Number of Bars to set the number of bars from 1 to 50. The initial number is 6.

Turn off Include Additional First and Last Bar if the edges of the Richelieu bar area are to be 
covered in satin. This option is initially selected.

Underlay
Choose from Edge walk, Center link with zigzag return, and Web double with zigzag 
return. All three options are initially selected.

■ Edge walk places lines of running stitch just inside the edges of the satin bars. 
■ Center link with zigzag return places a central line of running stitch, with a zigzag return 

line. 
■ Web double with zigzag return places a crosshatch pattern of stitching with a zigzag 

return line.

Vary the combination of underlay, depending on the type of design. It is recommended to use all three 
types for free-standing lace.
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Tapered Motifs
Use Tapered Motifs  to create columns of motifs. Tapered motifs 
are often used in lace designs.

Place alternate points to define a line of motifs that vary in size 
according to the width of the column.

Click the Options button, or right-click a Tapered Motifs column to 
set the desired motif, stitch length and either the number of motifs 
or the gap between them.

To use Bezier lines instead of placing points, click to enable Bezier Mode , 
then draw your Tapered Motifs using Bezier lines. See “Draw a column with Bezier Curves” on page 301.

Shortcuts
■ Freehand Create, Column; Precise Create, Column: 
■ Keys: Alt, R, M; Alt, P, M

Tapered Motifs Options
Use the Tapered Motifs Options to set the motif type, stitch type, and placement method.

Column Type Selection
If desired, select a different column type from the drop-down list. Select from Satin 
Column, Feathered Satin and Tapered Motifs.

If no column is currently selected, this option will be grayed out.

Convert to Satin Area
Click Convert to Satin Area  to change the column to a Satin Area. The Fill Area and Line 
properties dialog for Satin Area is displayed. See “Satin Area Options” on page 296.

Set a stitch type for the motifs

Set the stitch length for the motifs

Adjust the position in the column

Set the gap between the motifs
Number of motifs in the column

Select a motif and its orientation

Retain proportions within column
Set the motif width
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Click Undo  to change back to a column.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for 
instance, if you have placed a Tapered Motifs column and wish to reverse the motif 
direction. Some motifs are symmetrical and will have no apparent change when they are 
reversed.

Mirror
Use this option to mirror the motif across the line of motifs. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Stitches
Select Running or Triple stitch for stitching out the motifs. Set the Length of stitches from 
1 to 20mm in steps of 0.1mm. Length is initially set to the recommended value for each 
motif.

Method

Minimum Gap Size
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Number of Motifs
Set the number of Motifs from 2 to 50. The initial number is 6.
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Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

Proportional
Use this option to keep the relative height and width of the motif in proportion when 
when the column width is changed. This option is selected by default.

Width
The Width is initially set according to the chosen motif. The maximum and minimum 
values for Width are individual to each motif.

Creating Columns
Create the Band and Feathers for a Fleur de Lys

1 Click File, New , or File, New Window , and in the 
Choose Design Type page of the ExpressDesign Wizard 
select Load Existing Design, then click Next. In the Open 
Existing design page, click Load a Design , browse to 
the folder Documents\Premier+2\Samples\Create\Edo, 
and load the file 'Fleur de lys crosshatch and base’.
Alternatively, use the design from “Creating and Changing 
Fills: Fleur de Lys Background and Base” on page 267.

2 Click File, Preferences , and ensure that Color 
Tolerance is selected (checked), and that Tie Off Before 
and After Trims is selected.

3 Click the View tab, and ensure that Grid size is set to 5mm.
4 Click the Precise Create tab.
5 Deselect the Fill and Appliqué buttons.
6 Click the Pattern Fill at the bottom of the FilmStrip.
7 In the Line drop-down list select Running Stitch .

Good digitizing minimizes the use of movement stitches, which slow down the embroidery machine even if 
they are trimmed automatically. We will use Running Stitch to travel to the next area of the design.

8 Click Create Area or Line . 

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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9 Note the position of the Create Cursor . This 
marks the end of the last object in the design.

10 Move the pointer towards the Create Cursor, until 
it changes to the diagonal pointer .
The diagonal pointer indicates that the next object 
will be created from the same point as the previous 
one, with no movement stitch.

11 Hold down the Ctrl key and place a square point 
at the position of the Create Cursor.

12 With the Ctrl key held down, place a point in the 
right corner of the band around the fleur de lys.

13 Then going in a counter-clockwise direction, 
place four more square points at the corners of 
the band, finishing in the right corner.
The running stitch line around the band will provide 
an outline preventing the satin stitches from pulling 
in.

14 Right-click to complete the line.
15 In the Options area of the Create tab, click the 

Column button and select Satin Column  in 
the drop-down menu. The Column properties 
dialog box opens at the Options tab for Satin 
Column.

16 Set Density to 4, set Compensation to 0 and set Pattern to 0.
17 In Underlay select both Zigzag and Edge Walk. 
18 Click OK to close Column properties.
19 Click Satin Column . Place the first point for the satin column at the position of the Create 

Cursor , in the right corner of the band around the fleur de lys.
20 Place another point as close as possible to the first using the place points pointer .

Adjust the position of the point if the move pointer  appears instead.
This places the second point for the satin column almost on top of the first.

21 Place two points on the opposite sides of the center of 
the band, and two points next to each other in the left 
corner. This will create a diamond shaped area of satin 
stitch.
A minimum of four points is required to create a column.

22 Right-click to finish the column.
23 Right-click again to deselect Satin Column.
24 Use Zoom To Rectangle  to zoom in on the band 

around the fleur de lys.
25 Right-click to deselect Zoom To Rectangle.
26 Click the View tab.
27 Click 2D View . The display changes to 2D.
28 If desired, adjust the points for the band around the 

fleur de lys.
29 Click the Precise Create tab.
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30 Click Precise Emboss Line .
31 Hold Ctrl and place five points 

to form a diamond shape within 
the band around the fleur de lys.
Use the grid as a guide when 
placing the points for embossing.

32 Right-click to finish the 
embossed line.

33 Right-click to deselect Precise 
Emboss Line.

34 Click Zoom To Fit .

35 Click Life View  to see the 
embossed band, then click Cancel.

36 In the Options area of the Create tab, click the 
Column button and select Richelieu Bars  
in the drop-down menu. The Fill Area and 
Line dialog box opens at the Options tab for 
Richelieu Bars.

37 Set Width to 2.0mm and set Density to 4.
38 In Method select Number of Bars, and set 

the number to 5. Deselect (uncheck) 
’Include Additional First and Last Bar’.
No additional first and last bar at either end 
of the area will be needed as the ends will be 
covered by a satin line.

39 In Underlay select all three options. 
40 Click OK to close Column properties.

For free-standing lace it is recommended to 
use all the underlay options to add stability.

41 Click Richelieu Bars .
42 Place a point at the tip of the right feather 

of the fleur de lys.
43 Place a second point using the place points 

pointer , as close as possible to the first.
44 Place a pair of points a little way down the 

feather.
45 Place five or six more pairs of points, 

following the curve of the feather.
A line should join each pair of points, making parallel lines that run across the feather. If the lines run 

diagonally, click Undo  and try again, or edit the points after creation. You may optionally add more 
points using Insert Points in the Home tab.
The first and last pairs of points will automatically be square (control) points for any column, including 
Richelieu bars.

1

2

3

4

5
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46 Place two final corner points at the base of the feather.

47 Right-click twice to finish the bars, and to deselect Richelieu Bars.
You may wish to move points to make the curve smooth.

48 Ensure that Running Stitch  is selected as the Line type.
49 Click Create Area or Line . 
50 Hold Ctrl and place the first point of the line at the Create Cursor .
51 With Ctrl held, place a second point where the right side of the middle feather 

meets the band around the fleur de lys.
52 Release Ctrl and place a series of points along the right side of the middle 

feather up to its tip.
This line of running stitch will later be covered by a satin border.

53 Right-click twice to end the line and to deselect Create Area or Line.
54 Click Richelieu Bars .
55 Place the first point for the Richelieu Bars at the Create Cursor ;, at the tip 

of the middle feather of the fleur de lys.
The settings are the same as for the right feather, so only check them if you think 
they may have changed.

56 Place the second point as close as possible to the first.
57 Then place a pair of points a little way down the feather. 
58 Place four more pairs of points, following the curve of the feather. Then place 

two final corner points at the base of the feather. Right-click twice to deselect.
Although the top of the diamond is included in this area, it will not be affected as there is no stitching here.

59 Use Create Area or Line  to create a line of 
Running Stitch  to the tip of the left feather.

60 Click Richelieu Bars .
61 Place two square points at the tip of the left 

feather of the fleur de lys. Then place five or six 
pairs of round points down the feather. Place two 
final corner (square) points at the base of the 
feather and right-click to deselect. 

62 In the View tab click 3D View  to see the design 
in 3D.
To place an outline around the fleur de lys, see 
“Outline the Fleur de Lys With a Satin Line” on 
page 225.
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15Using Lines
Lines can be created as individual parts of the design, or as a border to a fill area.

You can use Fill Area and Line properties to convert any line (or area) type to any other line or area type, 
including appliqué options.
Use the QuickStitch™, Freehand Create, Precise Create and Shape functions to create lines. 
See “Creating Fills and Lines” on page 205.

Select the line type from the drop-down Line menu in the Quick Create, Freehand Create, 
or Precise Create tab.

Alternatively, right-click the line you created and change its properties in the Fill Area and Line properties 
dialog. Use the work area or FilmStrip to change the position of the line and its properties, or to edit 
selected lines.
To create a line without a fill, deselect the Fill button on the Create tab.

Line Types
Create individual lines using the following line types:

You can select your fill type, and the line type for the surrounding border, before creating the fill. 
Alternatively, change either the fill or border type afterwards using Fill Area and Line properties.

Running Stitch Satin Line

Double Stitch Motif Line

Double Zigzag No Border Line

Triple Stitch

Running Stitch Motif Line using Pattern 2 
from Hand Stitches 1.

Satin Line
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Running Stitch
Running stitch  is a row of small stitches going forward.

Use lines of running stitch for light markout or as underlay for satin columns and fill areas. 
Running stitch is also useful for traveling stitches between sections of a design, if it can be 
placed where it will be covered by later stitch objects.

Running Stitch Properties

Length
Set the Length of Running stitch from 0.3 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

If you change a running line back to standard stitching after using INSPIRA® Cutwork needles, the stitch 
length will need to be altered from 0.3mm.

Closed Border
Set the line as an open line or a closed line (a shape).

Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area 
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Set the stitch length

Create a cutwork line

Select 2 or 4 cutwork needles

Create stability gaps in the cutwork line
Set the distance between the gaps

Use different fill and border colors



318          PREMIER+™ 2 Create   Using Lines 

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection 
dialog is displayed. 

See “Color Selection” on page 181.
Insert Color Change is only used when the line forms the border to a fill area.

Cutwork
The cutwork needle features allow you to draw a cutting line within your design, 
optimized for the INSPIRA® Cutwork Needles. Use two or four cutwork needles, and add 
secure points for fabric stability.

Create Cutwork Needle Line
Enable the cutwork needle feature. By default this feature is not selected (checked).

When cutwork is selected Insert Color Change is no longer available. The stitch length is automatically set 
to 0.3mm and cannot be adjusted.

Method
Choose between:

■ 2 Cutwork Needles
■ 4 Cutwork Needles

By default 2 needles is selected.

With 2 needles, a bladed needle set at one angle is used to cut around the shape, and then the second 
needle travels around the shape cutting at a different angle.
With 4 needles a more precise cutting method is used, where each needle is used for the section of the 
shape that closely matches its angle. This method is recommended for more delicate fabrics.

Secure Points
Select Include Secure Points to create gaps in the cutwork needle line. By default Include 
Secure Points is selected.

This allows the cut fabric to remain attached for stability while all the cutwork needle lines are created. 
Afterwards it can be easily trimmed with scissors.
Set the Distance Between Secure Points from 10mm to 100mm in steps of 1mm. The initial 
setting is 30mm.
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Double Stitch
Double stitch  is a row of small stitches going forward, followed by a row of small 
stitches going backward, so it ends at the same point where it began.

Use double stitch for markout and to place branching outlines that need to return to their 
starting points.

Double Stitch Properties

Length
Set the Length of Double stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Closed Border
Set the line as an open line or a closed line (a shape).

Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area 
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection 
dialog is displayed.

Set the stitch length from 1mm to 12mm

Use a different color for the border

Set the color for the border

Use a line or a shape (a closed line)
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See “Color Selection” on page 181.
Insert Color Change is only used when the line forms the border to a fill area.
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Double Zigzag
Double Zigzag stitch  is a row of small stitches going 
forward, followed by a zigzag row of small stitches going 
backward, so it ends at the same point where it began.

Double Zigzag is a special stitch type, recommended for lace. A running 
stitch line is retraced in a zigzag pattern to create a mesh if sections are 
placed together. Alternatively, use this stitch type for crosshatch fill.

Double Zigzag Properties

Length
Set the Length of Double Zigzag stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Zigzag Width
Set the Width of the Zigzag part of the stitch from 0.2 to 6mm in steps of 0.1mm.

The initial setting is 0.6mm.

Include a Linking Stitch
Use a linking stitch between sections of Double Zigzag stitch.

Closed Border
Set the line as an open line or a closed line (a shape).

Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area 
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection 
dialog is displayed.

See “Color Selection” on page 181.

Set the stitch length
Set the width of the zigzag line
Use a linking stitch between sections of
Double Zigzag

Use a different color for the border

Set the color for the border

Use a line or a shape (a closed line)
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Insert Color Change is only used when the line forms the border to a fill area.
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Triple Stitch
Triple stitch  is a row of small three-part stitches, each composed of one stitch going 
forward, one going backward then one going forward. The stitch length can be changed 
from 1mm to 12mm.

Use triple stitch for heavy markout or as heavy joining lines between sections of a design.

Triple Stitch Properties

Length
Set the Length of Triple stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Closed Border
Set the line as an open line or a closed line (a shape).

Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area 
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection 
dialog is displayed.

Set the stitch length

Use a different color for the border

Set the color for the border

Use a line or a shape (a closed line)
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See “Color Selection” on page 181.
Insert Color Change is only used when the line forms the border to a fill area.
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Satin Line
Satin Line  is a line of constant-width satin stitch. The width 
of the line can be set from 1 to 12mm.

Satin Line Properties
Set density, width and taper for satin line.

Density
Set Density from 2 to 15. The lower the number, the closer 
together the stitches and the more stitches are produced. The 
initial setting is 4.

Embroidery on thicker fabrics usually looks better with more stitch coverage, 
or a low density setting. Choose a low value such as 2 or 3 for heavy knit 
fabrics, a higher value such as 5 or 6 for a light material like linen or satin. 

Width
Set Width for satin border from 1 to 12mm. The initial setting is 4mm.

Underlay
Use this option to place edge walk underlay inside each edge of the satin border. Underlay 
will not be generated if the Border Width is set below 2mm.

Closed Border
Set the line as an open line or a closed line (a shape).

Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area 
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Set the stitch density for the line
Set the satin line width

Use edge walk underlay inside each 
edge of the line

Use a different color for the border

Set the color for the border

Use a line or a shape (a closed line)

Taper the ends of the satin line
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Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection 
dialog is displayed.

See “Color Selection” on page 181.
Insert Color Change is only used when the line forms the border to a fill area.

Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your satin lines.

Use these options to create mitered or pointed ends for your satin lines.

Start Point
Use these options to change the type of line beginning for the satin line. Select a taper 
type, then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the satin line. Select a taper type, then 
set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

Motif Line
Use Motif line  to draw a line of motifs.

Use motif lines for decorative stitches and details.
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Motif Line Properties

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Set the gap between the motifs in the line

Adjust the position of the motifs in the line

Select a stitch type for the motif line
Set the stitch length for the motif line

Select a motif Group, Category and pattern

Set the motif size and Height / Width ratio

Use a different color for the border

Set the color for the border

Use a line or a shape (a closed line)
Taper the start or end of the motif line
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Fit To Line
Select this option to make the shape of the motifs follow the curves of the line. 

Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for 
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif 
direction. Some motifs are symmetrical and will have no apparent change when they are 
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motifs. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of 
stitches from 1 to 20mm in steps of 0.1mm. Length is initially set to the recommended 
value for each motif.

Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your motif lines.

For Motif Lines, the Central Point option starts at the first stitch point in the first motif in 
the line. The precise position of the point will vary, depending on the motif used.

Use these options to create mitered or pointed ends for your motif lines.

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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Start Point
Use these options to change the type of line beginning for the Motif Line. Select a taper 
type, then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the Motif Line. Select a taper type, 
then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

Closed Border
Set the line as an open line or a closed line (a shape).

Use Closed Border to change an open line to a closed one, or vice versa. This allows you to create a fill area 
with a closed or open border (a border that runs all the way around a fill area, or only part of the way).

Insert Color Change
Insert a color change between a border line and the enclosed fill area. The Color Selection 
dialog is displayed.

See “Color Selection” on page 181.
Insert Color Change is only used when the line forms the border to a fill area.

Create a Flower with Motif Lines
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill_Motif fills'.
Alternatively, use the petals design that you created in “Create a Petal Design with the ExpressDesign 
Wizard” on page 134, and added two motif fills to in “Use Motif Fills in Two Petals” on page 247.

2 Click the View tab, and ensure that Grid size is set to 5mm.
3 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 

Before and After Trims is selected.
4 Click the Paint tab. The picture on which the design is based is shown.
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5 Click the MiniPics icon  and the viewer 
dialog box will appear.
Browse to the folder \MiniPics\Paint\Medium. 
The folder browser only shows subfolders of 
the MiniPics folder.

6 Click the purple and yellow flower called 
'17.axw'.
If you position the arrow pointer over a 
thumbnail without clicking, the name of the 
MiniPic will be shown. The MiniPic is called 
'17.axw'.

7 Double-click the flower to load it in the 
work area.

8 Click Close to close the viewer.
9 Notice there is a selection box around the flower. Click and drag inside a 

colored area in the selection box to move the flower. Position it in the larger 
end of the petal on the left.

10 Click outside the selection box to deselect the flower MiniPic.
11 Click Pick Foreground Color , then click on the purple in the petals of the 

flower head. The color in the color box changes to purple.
12 Click Flood Fill  and the pointer changes to the paint bucket .
13 Click the yellow in the center of the flower and it will be filled 

with the same purple as the petals.
14 Click the Home tab.
15 Select the fill area for the petal on the left. It will also be 

highlighted in the FilmStrip.
16 With the blue Pattern Fill selected, click Delete  to delete it.

This removes the fill area from the petal so that we can create a 
flower using motif lines.

17 Click the Quick Create tab.
18 In the FilmStrip, select the blue color that was used for the fill.

19 Right-click in the FilmStrip and select Display Only From Start. 
All objects after the blue color will be hidden. In the FilmStrip, you will be 
able to see a blue color block and the violet colored pattern fill (or motif fill if 
you filled the other two petals).

20 In the Quick Create tab, deselect the Fill and Appliqué buttons.
21 In Line click the drop-down arrow and select Motif Line .
22 In the Options section click Fill Area and Line. The Fill Area and Line 

properties for Motif Line opens.
The line selection drop-down is grayed out (unavailable). The line type is set to 
Motif Line, so only its properties are shown. After creating a line you may change 
its type and properties.
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23 Set the Motif Group to Universal, and the Category to Hand Stitches 1, Pattern 1, the desired chain 
stitch pattern, is selected automatically.

24 Set the Height to 1.5mm. The Width will automatically change to 
3.0mm because Proportional is selected.

25 Click OK to close the dialog box.
26 Click QuickStitch™ .
27 Click inside the flower. A dashed line of alternating colors will 

appear around the flower, showing the area that is selected for 
outlining with the Motif Line. Also, the Color Tolerance dialog box 
will appear, with the Tolerance set to zero.
Use Color Tolerance to preview the area of the picture that defines the 
new QuickStitch™ area or line. This is useful even when it is not 
necessary to adjust the Tolerance value.

28 Click OK and a chain stitch line will appear around the flower. 
Right-click to deselect the function.

29 Click the Freehand Create tab.
30 Click Create Area or Line . The pointer changes to a pen .
31 Click and drag to draw a line from the flower up to the top right 

point of the petal.

Don’t worry if the line is wobbly, you will change it below.
32 Release the mouse button, or lift your pen from the tablet, and a chain stitch line will appear.
33 Right-click to deselect the function.
34 Select the line that you just drew and use the Zoom Bar to zoom in on the line.
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35 Move the points (nodes) on the line to smooth it, making it into a gentle curve.
When you click on a square node it becomes round. Square nodes are used for straight sections, round for 
curved sections. To make a node square, hold down the Ctrl key when you click on it.

36 If desired, use Insert Points  or Delete Points  in the Home tab to add or remove points from the 
line. Right-click to deselect.

37 Use Life View  to preview the results, then click Cancel.
38 Double-click the second color (pale blue) in the color worksheet and the Color Selection dialog box 

appears.
Alternatively, scroll up the FilmStrip and click the Color at the beginning of the light blue objects. Right-
click on the FilmStrip and select Properties.

39 Click Show All Thread Ranges, then click the drop-down arrow for the Thread Range and select 
Robison-Anton Rayon Vari 40.

40 In the shade list, browse for 2370 (4CC Melody) or enter 2370 in the Find Thread box. Click OK.
41 Click the Edit tab.
42 Click Display All Objects  and Zoom To Fit .
43 Click Save  and browse to the folder Documents\Premier+2\My Designs.
44 Change the File name to 'PetalsMotif' and click Save.
45 Click Print  to print the embroidery worksheet.
46 Click Export Embroidery  and ensure that .vp4 is set as the file format. Click OK.
47 In the Save As dialog, browse to the folder Documents\Premier+2\My Designs and click Export. The 

design is saved as PetalsMotif.
There is no need to change the file name, as it is taken automatically from the design file name.

Change Satin Line to Motif Line in an Appliqué Petal
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicApplique’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on 
page 136.

2 Click the View tab, and ensure that Grid size is set to 5mm.
3 Click File, Preferences , and ensure that Color Tolerance is selected 

(checked), and that Tie Off Before and After Trims is selected.
4 Select the satin line for the petal on the left, then right-click to see the Fill 

Area and Line dialog box.
5 In the Line drop-down menu at the top right, select Motif Line . The 

Line tab of the Fill Area and Line properties dialog box will appear.
6 Set the Motif Group to Universal, and the Category to Hand Stitches 2. 

Pattern 1, the desired butterfly stitch pattern, is selected automatically.
7 Click Proportional so that it is no longer selected, then set the Height to 

4.0mm.
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8 Click OK. Click Life View  to see the effect, and click Cancel.
To change the inside of the middle petal to a QuiltStipple fill, see “Insert QuiltStipple Fill in a Petal” on 
page 262.

Change Satin Line to Picot Motif Line
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicApplique’.
Alternatively, use the petals design that you created in “Create Appliqué Areas with Express Border” on 
page 136.

2 Click the View tab, and ensure that Grid size is set to 5mm.
3 Click File, Preferences , and ensure that Color Tolerance is selected (checked), and that Tie Off 

Before and After Trims is selected.
4 Click the edge of the middle petal. Its nodes (points) are displayed.
5 In the status bar the stitch type is displayed as Satin Line Appliqué. 

In the FilmStrip the objects should also be Satin Line Appliqué. You can select objects in the FilmStrip, or 
press the right and left arrow keys to step through the objects in the design.

6 Right-click the work area to see the Fill Area and Line properties for this Satin Line.
7 In the Line drop-down menu at the top right, select Motif Line . The Line tab of the motif line 

properties will appear.
8 Set the Motif Group to Universal, and the Category to Hand Stitches 1.
9 Click the drop-down arrow for Pattern and select Pattern 7, a buttonhole picot stitch.
10 Click the Fit To Line and Mirror options so they are selected. This will ensure that the shape of the 

motif curves to follow the outline of the petal and the blanket stitch will be inside the picot edge.
11 Set the Stitch type to Triple.

12 Click OK.
Add a motif fill to the right petal in “Insert Motif Fill in an Appliqué Petal” on page 248.

Add a Triple Stitch Embellishment to a Satin Line
1 In the Quick Create tab, ensure that Fill and Line are selected.
2 Ensure that Fill is set to Pattern Fill and Line is set to Satin Line.
3 Right-click the thread color in the FilmStrip and select Properties. Then set the thread to a pale color.
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4 Click Fill Area and Line and choose a pattern for the Pattern Fill.
5 Click the Line tab and ensure that Width is set to 4mm.
6 Select (check) Insert Color Change, then click Line Thread 

Color  and choose a medium color for the border.
7 Select a shape from the drop-down list.
8 Click the Shape icon . The shape is placed in the center of the 

work area as a selected block.
9 Resize the shape as desired using the square corner handles.

Hold down Ctrl as you click and drag to resize proportionally. Hold 
down Shift to resize from the center.

10 In the FilmStrip click the Pattern Fill shape to select it.
11 In the Home tab click Copy , and then click Paste 

This will place the copied shape on top of the original. Duplicate would place it slightly to one side.
12 Right-click the copy in the FilmStrip and select Properties from the 

context menu.
13 In Fill, select No Fill . The Line tab opens.
14 In Line, select Triple Stitch, then click Apply.

In the FilmStrip the second shape is now described as Triple Stitch.
Note that the upper line exactly follows the line below.

15 Click Line Thread Color  and in the Color Selection dialog box 
set the thread to a darker color.

16 Click OK twice to view the shape in the work area.
17 Click outside the design to see both lines clearly.

You could also embellish a satin line with a chain stitch or other motif 
line.

18 Select both shapes in the FilmStrip, then in the Home tab click 
Group .
This will keep the two lines together until Ungrouped. 

No Border Line
No Border Line  is used where a fill area is desired without a border, for example an 
area of QuiltStipple fill.
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16Editing a Design
Use the Edit tab to view colors, to display and hide objects in the design, and to edit parts 
of the design. 

After you have created an object such as a line, fill or hole, you may want to change its 
properties; for example the motif size, fill pattern, appliqué fabric or stitch length. Click the 
object to select it, then right-click it to change its settings in the properties dialog box. See 
“Fill Area and Line Properties” on page 86.

To change an object within a group, select the object in 
the FilmStrip, and then right-click it and select 
Properties in the context menu.

If an object is difficult to select in the work area, select it in the 
FilmStrip. Alternatively, click a nearby object in the FilmStrip and 
then use the arrow keys to step through the objects until the 
desired object is selected in the work area. 
To change the properties of all visible objects of the selected type, 
right-click in the FilmStrip and select Global Properties.

Select Objects
In PREMIER+™ 2 Create, designs are made up of a 
sequence of lines and areas (e.g. stitch lines, fills and 
columns). Each area, line or column is defined by a 
number of points that can be seen on the work area. 
The selected object is highlighted in the FilmStrip in the 
Design window.

To change the properties of all visible objects of the selected type, 
right-click in the FilmStrip and select Global Properties.

Select a Place to Insert New Objects
To add stitch objects such as areas, lines and columns 
between existing objects, select an object in the 
FilmStrip or work area, then create the new object. The 
new object is placed below the object that you 

Show only the previous or next color in the design
Display all objects in the design

Set Start & End markers to display an object range
Remove an enhancement from a fill area

Show and hide particular object types

Show selected objects

Set the properties for the selected object(s)
Create and manage fill patterns

Edit individual objects
Select objects similar to the one selected

Thread
Color

Bar

Object Object
Type

Scroll
Bar
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selected. If you select an object within a group, the new objects will be created as part of 
that group.

Unless you choose a new color, the color of newly inserted objects will be the same as the object above 
them.
Use the display options on the Edit tab or the right-click context menu to hide objects that 
you do not want to change. 

The color worksheet, object filters and Draw Range are also useful to isolate an object so 
that it is easier to select the desired insertion point.

Insertion Markers
When a Freehand Create or Precise Create tool is selected, a marker shows the location of 
the last point of the preceding object. This is where new objects will be inserted:

■ When objects will be added to the end of the design, the marker is pink .
■ When objects are to be inserted (i.e. the selected object is not the last object in the 

design), the marker showing the final point of the selected object is orange .

■ When objects are to be inserted, a blue marker  shows the position of the first point in 
the next object in the design.

Select an Object to Edit
In the work area, click on an individual object to show the points that make it up and 
check what type it is in the Object Identification Box on the bottom right of the status bar. 

The object is also highlighted in the FilmStrip. You may click the desired object in the FilmStrip and the 
object will be selected on the work area.
If you click on an object in a group, the whole group will be selected and highlighted in 
the FilmStrip. To select an object within that group, click on it in the FilmStrip.

To edit the shape of a selected object within a group, right-click on the work area to enter Edit Points mode. 
Then adjust its shape.
After locating the desired object, click and drag its points to change the shape of the 
object. In the Home tab you can insert extra points , delete unwanted points  or 
delete the object . 

Alternatively, right-click to access a dialog box to alter its properties, such as Fill Pattern or Stitch Length.

Stepping Through Designs
In Edit Points mode, use the left and right arrow keys on the keyboard to step through all 
the objects in sequence. Alternatively, click an object in the FilmStrip and use the up and 
down arrow keys on the keyboard to step through all the objects in sequence. 

If you are in Box Select mode , the selected object will move in the work area. Right-click on the work 
area to enter Edit Points mode.
The color worksheet, object filters and Draw Range are also useful to isolate objects.
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How to Step Through Design Objects
1 In the Design window, ensure that Edit Points mode is selected.

In Edit Points mode the pointer is an arrow. If the Box Select pointer  can be seen, right-click to enter 
Edit Points mode.

2 Click any object. Its points will be shown and the object type will be shown on the bottom right of the 
status bar.

3 Use the right arrow key on the keyboard to select the next object. Its points are shown and the object 
type is shown on the status bar. If you already have the last object in the design selected, it will 
remain selected.

4 Use the left arrow key on the keyboard to select the previous object. Its points are shown and the 
object type is shown on the status bar. If you already have the first object in the design selected, it will 
remain selected.

Change Object Settings
How to Change Settings for a Single Object

1 Select the object in the work area or FilmStrip.
2 Right-click the object. The Area and Line properties dialog for the object is displayed.
3 In the Area and Line properties dialog make the desired changes.

Change Multiple Objects’ Settings
1 Open the Design window.
2 To make it easier to select the desired object, use the color worksheet, or the Hide Object Types 

buttons and slider bars in the Edit tab to hide other objects.
3 To select an object directly on the work area, click on the desired object, or click an adjacent object 

then use the left and right arrow keys to step through to the required object (for example, to select a 
color change).

4 To select an object with the FilmStrip, scroll through the FilmStrip and select the desired object, or 
click any object and use the up and down arrow keys to step through the FilmStrip.

5 To change the properties of the selected object, right-click on the work area, or right-click on the 
FilmStrip and select Properties. The properties dialog box for the object type will appear.

6 To change the properties of all visible objects of the selected type, right-click on the FilmStrip and 
select Global Properties. (Alternatively, choose Select Similar from Visible, then Properties from the 
FilmStrip context menu.) The properties dialog box for the object type will appear.

7 To change the properties of selected objects, hold the Ctrl key and click the desired objects in the 
FilmStrip. Right-click one of the selected objects and select Properties. The properties dialog box for 
the object type will appear.
To change properties of objects in only one group, choose select Similar from Group, then Properties from 
the FilmStrip context menu.

8 To change the stitch type for the selected object, choose the desired object type from the line or fill 
drop-down list in the Fill Area and Line dialog box. The properties for the new object type will appear.

9 Change the settings in the properties dialog box then click OK to apply the new settings. Click Cancel 
if you decide not to save the new settings.

10 When you click OK for changing Global Properties or the properties for a number of selected objects, 
all the settings in the dialog box will be applied to all visible or selected objects of that type.

11 Repeat as desired with other objects, then click Life View or Design Player to see the design as it will 
be stitched.
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Delete
Use Delete  to remove the currently selected object(s) from the design. 

To delete commands, use the left and right arrow keys on the keyboard to step through all 
the objects in sequence until the desired command is selected. Alternatively, select the 
desired command using the FilmStrip.

The color worksheet, object filters and Draw Range are also useful for isolating objects.

Shortcuts
■ Home Tab: 
■ Keys: Del; Alt, H, DE; Right-click FilmStrip, D

Delete an Object
1 Click the desired object in the work area or FilmStrip, or click near it and use the left and right arrow 

keys on the keyboard until it is selected.
2 In the Home tab, click the Delete icon  (or press Delete on the keyboard) and the object is deleted. 

If a gap is left by the deleted object, a movement stitch will be inserted.

Insert Commands
Use the FilmStrip to insert a new Color Change or Stop immediately after the selected 
object. Right-click in the film strip, then select the desired option from the context menu 
that appears.

Insert Color Command
Use Insert a Color Change  to insert a color change after the currently selected object. 
The Color Selection dialog box appears so you can choose the new color.

See “Color Selection” on page 144.

Insert Stop Command
Use Insert a Stop  to insert a Stop command after the currently selected object.

A Stop will not be inserted if this would place two Stops together.

Change Objects’ Sequence
Objects may be moved up and down the FilmStrip with click and drag, 
or with the arrow (Layout Order) buttons. This changes the order of the 
objects, and hence changes the order in which the stitches are created for the final 
embroidery.

Moving an Object With Click and Drag
1 To move an object with click and drag, click the desired object and drag it up or down the FilmStrip. A 

bar moves up and down the list to show the new list position. 
2 Release to drop the object at the desired point. Movement stitches are automatically inserted or 

removed as needed.
If objects are dragged or inserted between two items in a group they will become part of that group, except 
if they are inserted immediately after the group header. To insert at the beginning of the group, drag into 
the middle, then move up.
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Moving an Object With the Layout Buttons
1 To move an object with the Layout Order buttons, click the desired object. It is highlighted in the 

FilmStrip.
2 Click Move Backwards  to move the object one step up the FilmStrip (towards the first stitch 

object in the design). A bar moves up the list to show the new position.

Move Forwards  will move the object one step down the FilmStrip. Move to Back  will make the 

object the first to be stitched out, and Move to Front  the last.
3 Move the object to the desired position.

To move a selection of objects, either click the top of a sequence then hold the Shift key 
and click the bottom of the desired sequence, or hold the Ctrl key and click the desired 
objects. Then click the desired Layout Order button. Alternatively, use click and drag by 
moving the bar up or down the list to the desired point, then release the mouse button.

If desired, use the color worksheet and Hide Object Types buttons to hide other objects. This can make it 
quicker to move the desired object.
When using click and drag to move to a part of the list that is not visible, move the pointer 
above the top or below the bottom of the list and the list will scroll automatically. To scroll 
faster, move the pointer further above or below the list. Move the pointer back into the list 
to stop scrolling.

Moving an object up and down the FilmStrip does not change the position of the object 
on the work area. However, it may change the appearance of the design according to 
whether or not it changes the overlap with adjacent objects.

The first color change may not be moved in the FilmStrip. Also, no object may be moved above the first 
color change in the FilmStrip, except another color change. This ensures that the initial color change in the 
design cannot be removed, and nothing can be moved before it, but it can be replaced.

Layout Order
The Layout Order buttons are used to move objects within the FilmStrip.

Move Forwards
Move Forwards  brings the object one step down the FilmStrip.

Shortcuts
■ FilmStrip: 
■ Keys: Ctrl + [; Right-click FilmStrip, L, F

Move Backwards
Move Backwards  brings the object one step up the FilmStrip.

Shortcuts
■ FilmStrip: 
■ Keys: Ctrl + ]; Right-click FilmStrip, L, B

Move to Front
Move to Front  places the object at the bottom of the FilmStrip or Group.
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Shortcuts
■ FilmStrip: 
■ Keys: Ctrl + Shift + [; Right-click FilmStrip, L, N

Move to Back
Move to Back  places the object at the top of the FilmStrip or Group.

Shortcuts
■ FilmStrip: 
■ Keys: Ctrl +Shift + ]; Right-click FilmStrip, L, C

Display Group Contents
Use Display Group Contents  to switch between viewing the objects within Groups in 
the FilmStrip, and seeing only the Group heading rows in the FilmStrip.

Deselect Display Group Contents to aid in moving groups within the design.

Shortcut

■ FilmStrip: 
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Edit Lines and Areas
The shape of a line or area can be changed by moving the points that define its outline.

To choose a different object, click it on the work area or the FilmStrip. Alternatively, use the 
left and right arrow keys to step through the objects in the order they are used in the 
design. When selecting an object directly on the work area, click near one of the points 
that define it.

If the visible colors or the object filters are changed, the last visible object is automatically selected. 
Therefore, change the view of the design before selecting the object you wish to edit. See “Viewing Pictures 
and Designs” on page 140.
When the desired line or area is selected, its points can be 
moved. The points are shown as small circles or squares. Some 
stitch object types, such as Single Stitches have a fixed number 
of points.

Square points are used for straight sections and corners. Round points are 
used for curves.
Other objects, such as fill areas, running stitch and satin lines, 
can have any number of points, and points may be inserted 
and deleted, allowing greater control over their shapes. The 
start and end points for fill and satin areas can be changed, 

A Single Stitch is defined 
by two points 
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typically to reduce the need for trimming. Satin areas have angle lines that are used to 
control the satin angle.

Color change and stop commands, and alignment stitches are shown as a single point 
when selected.

Move Points
The points that define the currently selected stitch object (satin 
column, fill area, running stitch, etc.) are shown as small squares 
and circles.

Also, the object type is shown in the FilmStrip and on the status 
bar. The FilmStrip also shows the shape of stitch objects, where 
relevant. The points used to start and end fill and satin areas are 
shown by the start  and end  markers. Some types of fill 
areas also have an origin, marked by a orange circle  (for 
Pattern Fill, the marker has a handle). Satin areas also have stitch 
angle lines with hexagonal ends.

To choose an object to edit, click it on the work area or the FilmStrip. Alternatively, use the left and right 
arrow keys to step through the objects in the order they are used in the design. When selecting an object 
directly on the work area, click near one of the points that define it.
Once the points are shown, click and drag the squares or circles to move them.

Moving the points that define a satin area may also affect the stitch angle lines, but moving the stitch 
angle lines does not affect the shape of a satin area.

Edit Points
Use Edit Points  to enable the moving and editing of an object’s points if another 
function is being used. Alternatively, click an object to select it and you will be in Edit 
Points mode.

Shortcuts

■ Home Tab, Points; Status Bar: 

Fill areas have as many points as needed to 
define their outlines, and also have 

moveable start, end and origin markers

Satin areas have moveable start and end 
markers and adjustable stitch angle lines

Start
Marker

Origin
Marker

End
Marker

Start
Marker

End Marker

Stitch Angle
Lines
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■ Keys: Enter; Alt, H, E

Select and Move Points
1 In the Home tab, click Edit Points . 
2 Click an object in the FilmStrip, or on the work area, to select it and view its points. 
3 Drag the points to change the shape of the object.

Moving the points that define a satin area may affect the stitch angle lines, but moving the stitch angle 
lines will not affect the shape of a satin area.

Make Lines Straight or Curved
The outlines defining most types of lines and areas can have both curved and straight 
sections:

To have any curves, lines must be defined by at least four points. The first point of a fill or 
satin area is always a 'corner' (square) point. The first and last pair of points for a column 
are always square.

To change a curve (round) point to a square point, hold down the Ctrl key and click the 
point without moving it. When adjacent points are corners, the line between them will be 
straight. This is useful if, for instance, a point was not added as a corner at the desired 
place on a fill area or stitch line.

To change a corner point to a curve (round) point, simply click the point without moving 
it. There must be at least two round points next to each other to make the lines curved, so 
if there is one round point between two square points then the lines to the round point 
will be straight.

If a line does not have enough points to make the desired section curved, use Insert Point  to add an 
extra point to use for the curve.

Move the Start and End Points for Areas
The start and end points for fill and satin areas are shown by circular markers. The start 
marker  is on the inside of the object, and the end marker  is on the outside of the 
object.

Click and drag the desired marker. Move the marker to the point that you wish to use as 
the new start or end point of the area. Drop at the desired point and the position of the 
marker will change.

Point is a curve Point is a corner after Ctrl + click
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The marker snaps to the nearest point on the edge of the object. If an area does not have a point in the 

desired position, use Insert Points  to add an extra point.

Move the Origin for Areas
Some types of fill areas have an origin, marked by a orange 
circle . This is used to move the start point for the pattern 
in a pattern fill, or the center point for Radial fill, Spiral fill and 
Shape fill types. For a pattern fill, the origin has a handle for 
adjusting the angle of the fill.

This means that in a pattern fill area you can control how the pattern is 
repeated, and its angle.

For Radial fill, Spiral fill and 
Shape fill areas, the origin can 
be moved. This sets the start 
point for the fill, such as the 
point from which stitches 
radiate on a Radial fill.

The origin can be moved 
anywhere on the design area. 
This allows you, for example, 
to create several of the same 
types of fill area with a 
common origin. Simply move the origin to the same grid position for all the desired areas, 
so that the pattern of stitches is unified across the chosen areas.

Change the Stitch Angle for Satin Areas
Satin areas have stitch angle lines that show and 
adjust the angle of the stitches across the area. The 
stitch angle lines have hexagonal handles at each end 
that are used to adjust each line individually.

Click and drag the desired hexagonal handle. Drop at 
the desired point and the position of the angle line will change. If the line does not move, 
this is because the new end point is not usable. This will happen if, for example, you 
attempt to force two angle lines to cross each other within the area.

Delete Angle Lines
To delete angle lines, click Delete Points  then click the hexagon at either end of the line 
to be deleted. Right-click when you have finished deleting angle lines and/or points.

A satin area must have at least one angle line. Therefore, the last angle line may not be deleted.
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Insert Points
Use Insert Points  to add a new point to the currently selected line.

Points may be inserted into all line and area types except Single Stitch. With this object type Insert Points 
and Delete Points are not available. For columns, a pair of points will be added.
Points may also be inserted into emboss lines and MultiWave lines.
Click the Insert Points icon , then click the position on the selected object where you 
want to add the point. Also use Insert Points  to add stitch angle lines to satin areas 
with click and drag. 

Shortcuts
■ Home Tab, Points: 
■ Keys: Ctrl + Shift + D; Alt, H, IP

Insert a Point in a Line
1 Click the desired object to show the points that make it up.
2 Click the Home tab.
3 Click the Insert Points icon , then click the place on the outline of the object where you want to 

add the new point.
The Insert Points icon is only available for objects that can have points inserted.

4 To add a stitch angle line to a satin area, click and drag to draw a line across the desired section of the 
area. If the angle line does not appear, then it is not allowed in the place you attempted to draw it.
A stitch angle line cannot cross another stitch angle line. New lines must be added roughly parallel to the 
existing lines.

5 Right-click to deselect Insert Points.
6 Click and drag to move any of the points in the object to alter its shape.
7 If desired, click the Insert Points icon  again and repeat.

Delete Points
Use Delete Points  to delete points from the currently selected line. 

Points may be deleted from all line and area types except Single Stitch. With this object type Insert Points 
and Delete Points are not available. For columns, a pair of points will be deleted. 
Points may also be deleted from emboss lines and MultiWave lines.
Click the Delete Points icon , then click the points on the selected object that you want 
to delete. Stitch angle lines can be removed from satin areas by clicking the hexagonal 
control point at either end of the line. Right-click to finish.

You may not delete all the points for an object. A fill or satin area must have at least three points. Satin 
border, motif lines and running, double and triple stitch lines must have at least two points. A satin area 

must also have at least one angle line. To remove all the points for an object, use Delete .

Shortcuts
■ Home Tab, Points: 
■ Keys: Ctrl + D; Alt, H, DP

Delete a Point in a Line
1 Click on an object to show the points that make it up.
2 Click the Home tab.
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3 Click the Delete Points icon , then click the points you wish to delete. They will be removed and 
the object will change shape accordingly. To remove an angle line for a satin area, click the hexagonal 
control point at either end of the line.

4 Right-click to deselect the function.
The Delete Points icon is only available for objects that can have points deleted.

5 Click and drag to move any of the points in the object to alter its shape.
6 If desired, click the Delete Points icon  again and repeat.

Convert Points and Bezier Lines
Use the Convert Points  functions to change between types of points in a line in Bezier 
Mode, or to change a Point Line to a Bezier Line, or a Bezier Line to a Point Line.

For information on how to draw and adjust Bezier Lines, see “Bezier Mode” on page 222.

Shortcuts
■ Home Tab, Points: 
■ Keys: Alt, H, CP

Convert Points to Corner
Use Convert Points to Corner  to change the selected point in a Bezier line to a Corner 
point (a point with no handles). Right-click to deselect the function.

Shortcuts
■ Home Tab, Points: 
■ Keys: Alt, H, CP,  CP

Change a Bezier Mode Point to a Corner Point
1 Click on an object created in Bezier Mode to show the points that make it up.
2 Click the Home tab.
3 In the Convert Points  drop-down menu in the ribbon bar, select Convert Points to Corner .  

Edit Points  is no longer highlighted.
4 Move the pointer over one of the points in your object.  The pointer changes to the Convert Points to 

Corner pointer .
5 Click on the point. It now has no handles, and the sections of the line by it are straight.
6 Click to adjust any other points that you want to change in your design.
7 Right-click to deselect the function. 

Edit Points is highlighted again.
8 If desired, click the Convert Points to Corner  again and repeat.

For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 224.

Convert Points to Smooth
Use Convert Points to Smooth  to change the selected point in a Bezier line to a Smooth 
point (a point with handles that can be adjusted independently). Right-click to deselect 
the function.

Shortcuts
■ Home Tab, Points: 
■ Keys: Alt, H, CP,  CT
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Change a Bezier Mode Point to a Smooth Point
1 Click on an object created in Bezier Mode to show the points that make it up.
2 Click the Home tab.
3 In the Convert Points  drop-down menu in the ribbon bar, select Convert Points to Smooth . 

Edit Points  is no longer highlighted.
4 Move the pointer over one of the points in your object.  The pointer changes to the Convert Points to 

Smooth pointer .
5 Click on the point. It now has two handles, and the dashed line between them is straight.
6 Click to adjust any other points that you want to change in your design.
7 Right-click to deselect the function. 

Edit Points is highlighted again.
8 If desired, click the Convert Points to Smooth  again and repeat.

For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 224.

Convert Points to Symmetric
Use Convert Points to Symmetric  to change the selected point in a Bezier line to a 
Symmetric point (a point with handles that are the same distance from the point).  Right-
click to deselect the function.

Shortcuts
■ Home Tab, Points: 
■ Keys: Alt, H, CP,  CS

Change a Bezier Mode Point to a Symmetric Point
1 Click on an object created in Bezier Mode to show the points that make it up.
2 Click the Home tab.
3 In the Convert Points  drop-down menu in the ribbon bar, select Convert Points to Symmetric . 

Edit Points  is no longer highlighted.
4 Move the pointer over one of the points in your object.  The pointer changes to the Convert Points to 

Symmetric pointer .
5 Click on the point. It now has two handles at an equal distance from the point, with a straight dashed 

line between them.
6 Click to adjust any other points that you want to change in your design.
7 Right-click to deselect the function. 

Edit Points is highlighted again.
8 If desired, click the Convert Points to Symmetric  again and repeat.

For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 224.

Convert to Point Line
Use Convert to Point Line to change the selected Bezier Line to a Point Line. 

The change takes place immediately.

The Bezier lines in a Column cannot be changed to a Point Line. See “Draw a column with Bezier Curves” on 
page 301.

Shortcut
■ Keys: Alt, H, CP,  CL

Change a Bezier Line to a Point Line
1 Click on an object created in Bezier Mode.

The Bezier lines in a Column cannot be changed to a Point Line.
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2 Click the Home tab.
3 In the Convert Points  drop-down menu in the ribbon bar, select Convert to Point Line. 

The line changes to a standard Precise Create line immediately.

Curved points are added to the line when it is converted. If you change your mind, use Undo rather than 
converting back. 

4 If desired, select another object and click Convert to Point Line again to repeat.

Convert to Bezier Line
Use Convert to Bezier Line to change the selected Point Line to a Bezier Line. The change 
takes place immediately.

A smoothly drawn line with the minimum of points is more likely to produce a good result.

Shortcut
■ Keys: Alt, H, CP,  CC

Change a Point Line to a Bezier Line
1 Click on an object created in Point Mode.

This is an object that was created with Quick Create, Freehand Create or drawn 
by placing points in Precise Create.

2 Click the Home tab.
3 In the Convert Points  drop-down menu in the ribbon bar, select Convert 

to Bezier Line. The line changes to a Bezier line immediately.
If you change your mind, use Undo rather than converting back. 

The number of points in the Bezier line will depend on the number of points in 
the original line. Delete points and adjust the handles on the remaining points 
to optimize the Bezier line.
If desired, select another object and click Convert to Bezier Line again to 
repeat.

Delete
Use the Delete  drop-down menu on the Edit tab to delete one 
or more holes or emboss lines from the currently selected area, or one or more MultiWave 
lines from the currently selected MultiWave Fill area.

Delete Hole
Use Delete Hole  to delete one or more holes from the currently selected area. Right-
click when you have finished deleting holes.

Shortcuts
■ Edit Tab, Object: 
■ Keys: Alt, E, D, H
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Delete a Hole in an Area
1 Click on a fill area containing one or more holes.
2 Click the Edit tab.
3 In the Delete drop-down menu, click Delete Hole .
4 Click the hole you wish to delete. The hole is removed.
5 Right-click to deselect the function.

The Delete Hole icon is only available for objects that can have holes deleted.
6 If desired, click the Delete Hole icon  again and repeat.

Delete Emboss Line
Use Delete Emboss Line  to delete one or more embossed lines from the currently 
selected area. Click any node point on the line to be deleted. Right-click when you have 
finished deleting emboss lines.

Shortcuts
■ Edit Tab, Object: 
■ Keys: Alt, E, D, E

Delete an Embossed Line on an Area
1 Click on an area containing one or more embossed lines.
2 Click the Edit tab.
3 In the Delete drop-down menu, click Delete Emboss Line . 
4 Click a node point on the line you wish to delete. The embossed line will be deleted.
5 Right-click to deselect the function.

The Delete Emboss Line icon is only available for objects that can have embossed lines deleted.
6 If desired, click the Delete Emboss Line icon  again and repeat.

Delete MultiWave Line
Use Delete MultiWave Line  to delete one or more MultiWave lines from the currently 
selected MultiWave Fill area. Click any node point on the line to be deleted. Right-click 
when you have finished deleting MultiWave lines.

Shortcuts
■ Edit Tab, Object: 
■ Keys: Alt, E, D, W

Delete a MultiWave Line from a MultiWave Fill Area
1 Click on a MultiWave Fill area containing one or more MultiWave lines.
2 Click the Edit tab.
3 In the Delete drop-down menu, click Delete MultiWave Line .
4 Click a node point on the line you wish to delete. The MultiWave line will be deleted.
5 Right-click to deselect the function.

The Delete MultiWave Line icon is only available for objects that can have MultiWave lines deleted.
6 If desired, click the Delete MultiWave Line icon  again and repeat.

Break Apart
Use Break Apart  to break apart a fill area with a border into a separate line and fill area.
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Use this feature to duplicate individual parts of an area, or for fine adjustments. For 
example, use it to change the stitch length of an Appliqué placement line from the default 
of 2.0mm.

Shortcut
■ Keys: Alt, E, B

Break Apart an Area with a Border into a Line and a Fill
1 Click the Edit tab.
2 Click on a fill area with a border.

Note that in the FilmStrip the area is listed as a single item, e.g. Pattern Fill.
3 Click Break Apart . The selected area will be separated into a fill and a line, together with color 

commands if the line is a different color.
4 If desired, select another fill area and click Break Apart again to repeat the process.

Reverse Functions
Reverse Column End to End
Reverse the order of all the points defining a column so that the start becomes the end, 
and vice versa.

This option is only available when a column is selected.

Shortcut
■ Keys: Alt, E, R, E

Reverse Column Side to Side
Swap each pair of points within a column. 

Thus, if a column started with a left point and ended with a right point, then all right 
points would be swapped to become left points. The column would then start on the right 
and end on the left.

This option is only available when a column is selected.

Shortcut
■ Keys: Alt, E, R, S

Reverse Line
Reverse the order of the points defining a line so that the start becomes the end, and vice 
versa.

This option is only available when a line is selected.

Shortcut
■ Keys: Alt, E, R, L

Select a Block of Objects
The select functions on the Home tab allow you to select a block of objects. A selected 
block of objects can be resized, rotated, mirrored, moved, copied and cut. You may find it 
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easier to select a block when you have selected colors to display and/or changed the 
range of objects that are visible. 

When a block has been selected, it has a selection box around it on the work area. The 
selection box has blue handles which are used to resize, rotate and flip the block.

The handles are blue because you can freely manipulate the selection without changing density or stitch 
length in the objects. This is because the stitches are only generated when you use Export Embroidery.
Click and drag inside the block to move it. Click and drag the square corner handles  to 
resize the block. Hold down the Ctrl key as you click and drag to resize proportionally. 
Hold down Shift to resize from the center. Click and drag the round rotate handle  to 
rotate the block freely. Click and drag the center of rotation  to rotate around a different 
point. Click the triangular handles to flip the block horizontally  or vertically .

When making a selection, only objects that are completely enclosed by the selection line will be included in 
the selection. You will often need to cross Running stitches to make a selection. These objects would not be 
included because you have not completely enclosed them.

Inserting or Pasting a Block
When a new selection is added to a design by paste or one of the insert functions, it is 
automatically selected as the current block and Box Select is activated. 

Deselecting a Block
Click the work area outside a block to deselect it. The selection box around the block will 
disappear. Right-click to deselect a block and also turn off the current select function.

Select Last Visible
Use Select Last Visible  on the FilmStrip to select the last object that has not been 
hidden by Color Select, any of the object Filters, or the End slider.

Use Select Last Visible to ensure that new objects that you create appear at the end of your design.

Shortcut
■ FilmStrip: 

Flip Vertical Handle

Rotate
Handle

Resize
Handle

Center of
Rotation

Flip
Horizontal

Handle
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Box Select
With Box Select , click and drag to draw a rectangle around the area you want to select. 
When you lift the pen or release the mouse button, the block will show you the extent of 
your selection. Right-click to deselect. Only objects that are completely enclosed by the 
selection line will be selected. 

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

Box Select is also activated automatically when a block is pasted into a design.

Shortcuts
■ Home Tab, Select; Status Bar: 
■ Keys: Alt, H, B

Use Box Select
1 If desired, use the FilmStrip, Draw Range sliders, Filters and color worksheet to hide objects so that it 

is easier to see the required objects.
2 Click the Box Select icon .
3 Click and drag to draw a rectangle around the required objects.
4 Lift the pen or release the mouse button when the required objects are enclosed. They will become 

the current selection, indicated by a rectangle with blue handles.
5 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new box around the required objects.
6 Right-click to cancel the Box Select tool, which will also deselect any selected objects.

Freehand Point Select
With Freehand Point Select , click a series of points to create an irregular outline of 
straight or curved lines around the desired area. Click Freehand Point Select and the 
pointer changes to the Freehand point select pointer . Click a series of points to create 
an irregular outline of straight or curved lines around the desired area, using Ctrl+click to 
place a square (straight line) point. Click and drag  to reposition an existing point. Click 
Delete to remove the last–placed point. Right-click when the area is complete. The 
selection box will show you the extent of the block. Freehand Point Select may be easier to 
use than Freehand Select for precise selections. Click to deselect. Only objects that are 
completely enclosed by the selection line will be selected.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

Shortcuts
■ Home Tab, Select; Status Bar: 
■ Keys: Alt, H, FP

Use Freehand Point Select
1 If desired, use the FilmStrip, Draw Range sliders, Hide Object Types buttons and color worksheet to 

hide objects so that it is easier to see the required objects.
2 Click Freehand Point Select . The pointer changes to the Freehand Point pointer .
3 Click to place the first point for the selection. A yellow node appears.
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4 Click to place a series of points around the desired area.
As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

5 Use Ctrl+click to place square nodes for straight lines.
6 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.

If you click while the Freehand Point pointer  is active, another point will be added to the line.
7 When your line is as desired, right-click to surround the area with a selection box.
8 Right-click to deselect Freehand Point Select.

Freehand Select
With Freehand Select , click and drag to draw an irregular outline around the desired 
area. When you lift the pen or release the mouse button, the area is closed automatically 
with a straight line between the last pointer position and the start position. The block will 
show you the extent of your selection. Right-click to deselect. Only objects that are 
completely enclosed by the selection line will be selected.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

Shortcuts
■ Home Tab, Select; Status Bar: 
■ Keys: Alt, H, FS

Use Freehand Select
1 If desired, use the FilmStrip, Draw Range sliders, Hide Object Types buttons and color worksheet to 

hide objects so that it is easier to see the required objects.
2 Click the Freehand Select icon .
3 Click and drag to draw a line around the required objects. The objects inside the line will become the 

current selection, indicated by a rectangle with blue handles.
4 The line is closed automatically in a straight line between your start point and end point. If you are 

not close enough to your start point then you could leave out some desired objects by accident.
5 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new line around the required objects.
6 Right-click to cancel the Freehand Select tool, which will also deselect any selected objects.

Select All Visible
Select All Visible  is a one-click function that selects all visible objects in the design. 
Right-click to deselect.

Shortcuts
■ Home Tab, Select; Status Bar: 
■ Keys: Alt, H, SA
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Use Select All Visible
1 Use the FilmStrip, Draw Range sliders, Hide Object Types buttons and color worksheet to hide objects 

so that only the required objects are visible. Alternatively, for selecting a single object for adjustment, 
click the desired object in the FilmStrip, either right-click the FilmStrip and click Display Only Selected 
so that only the chosen object is visible, or click Only Selected  in the Edit tab.

2 Click the Select All Visible  icon.
3 The currently visible objects will become the current selection, indicated by a rectangle with blue 

handles.
4 Right-click to cancel the Select All Visible tool, which will also deselect any selected objects.

Select None
Use Select None  to deselect all of the objects in the work area, including any outside 
the hoop.

Use the color worksheet and the Draw Range to select which objects are visible in the 
current design. This is useful to isolate particular objects, especially if they are more than 
one color, or you only wish to apply a function to part of an area.

Shortcuts
■ Home Tab, Select; Status Bar: 
■ Keys: Alt, H, SN

Replace Selection
Use Replace Selection  to replace the currently selected objects with the new selection. 

Replace a Selection
1 Place several objects on the work area.
2 Use Box Select  (or another of the selection tools) to select some of these objects.
3 With Replace Selection  selected, click Box Select  and select some different objects.

The new selection replaces your old selection.

Shortcuts
■ Home Tab, Select: 
■ Keys: Alt, H, RS

Add To Selection
Use Add to Selection  to add the new selection to the currently selected objects. 

Add to a Selection
1 Place several objects on the work area.
2 Use Box Select  (or another of the selection tools) to select some of these objects.
3 With Add to Selection  selected, click Box Select  and select some different objects.

The new selection is added to your old selection.

Shortcuts
■ Home Tab, Select: 
■ Keys: Alt, H, A
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Remove From Selection
Use Remove from Selection  to remove the new selection from the currently selected 
objects.

Remove from a Selection
1 Place several objects on the work area.
2 Use Box Select  (or another of the selection tools) to select some of these objects.
3 With Remove From Selection  selected, click Box Select  and select some of the objects within 

your selection.
The new selection is removed from your old selection.

Shortcuts
■ Home Tab, Select: 
■ Keys: Alt, H, RF

Multiple Select and Groups
Multiple Select
Use multiple select to select more than one object at a time. 

In the FilmStrip, hold down the Ctrl key and click the desired objects. A selection box will 
be placed around the selected objects. Alternatively, use one of the multiple select tools in 
the Select area. 

The selected objects are surrounded by a selection box with a solid outline, and blue 
handles. Lettering, SuperDesigns and inserted embroideries retain their orange (Group) 
handles. The whole selection can be scaled, rotated and mirrored. 

If you click outside the selection box, the designs will become separate. Use Undo , or select them again 
to recreate the multiple selection.

Grouping Selected Objects
In PREMIER+™ 2 Create, you can edit objects individually, in a selected block, or in groups 
which remain as a selection after saving. To reshape or change the properties of an 
individual object inside a group, select it on the FilmStrip.

When a design including groups is loaded using Insert  or Open , all sections will be grouped 
together, ready for moving, resizing and so on.
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Group
Use Group  to make a more permanent group of all the currently selected objects. Use 
Group to group the objects permanently, or to make a temporary Group while moving or 
editing them.

A group can be modified in the same way as a selection. 
You can move, resize, mirror and rotate it.
Group  can only be used in conjunction with 
one of the selection tools.

The grouped objects are surrounded by a 
selection box with a solid outline, and orange 
handles. The group can be scaled, rotated and 
mirrored.

If you click outside the selection box, and then click one of 
the objects within the group, the objects will still be 
grouped.

Shortcuts
■ Home Tab, Group: 
■ Keys: Alt, H, G; Right-click FilmStrip, G

Ungroup
Use Ungroup  to split the currently selected group into the objects which make it up.

Ungroup can only be used when a group is selected.

Shortcuts
■ Home Tab, Group: 
■ Keys: Alt, H, U; Right-click FilmStrip, N

Select Similar from Visible
Use Select Similar from Visible  to select all visible objects with similar properties (i.e. 
the same name in the FilmStrip); for example, select all Radial Fill areas, or all Satin Lines.

It will select all Pattern Fills, whether or not they have a border, but not select Pattern Fill 
Appliqué areas at the same time as Pattern Fill.

Shortcuts
■ Edit Tab; FilmStrip Context Menu: 
■ Keys: Alt, E, M, V; Right-click FilmStrip, V

Select Similar from Group
Use Select Similar from Group  to select all objects with similar properties (i.e. the same 
name in the FilmStrip) that are in the same Group.

Objects with similar properties that are in a different Group, or in no Group will not be selected.
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Shortcuts
■ Edit Tab; FilmStrip Context Menu: 
■ Keys: Alt, E, M, G; Right-click FilmStrip, U

Modify a Block of Objects
Move a Block of Objects
Move a selected block using click and drag, or nudge. Click inside the block and drag it to 
the required position, or use the arrow keys to nudge it into place. When a block is moved, 
movement stitches are inserted before and after the block to connect it to the previous 
and following objects.

If you accidentally move the center of rotation, simply click and drag inside the selection box again.

How To Move a Block of Objects
1 Click anywhere inside the selection and drag it to the required position. The rectangle around the 

selection will be dragged with the pointer.
2 Lift the pen or release the mouse button to drop the selection in place. The selected objects will be 

redrawn in their new location.
3 Alternatively, use the arrow keys to nudge the selection into position, then click outside the block to 

place it.
4 When you move a selection, you may sometimes move the center of rotation by accident. Simply 

release the center of rotation, then click and drag the selection as usual. The center of rotation will 
snap back to the center of the selection when you drop the selection in its new position.

Resize a Block of Objects
Click and drag one of the blue square corner handles to resize. Hold down Ctrl as you click 
and drag to resize proportionally.

How To Resize a Block of Objects
1 If you want to keep the selected objects in proportion, hold down the Ctrl key.
2 Click and drag any of the square resize handles.
3 Lift the pen or release the mouse button, and then release the Ctrl key if you used that to keep the 

proportions. The selection will be redrawn at its new size.

Mirror a Block of Objects
Mirror a block of stitches vertically or horizontally using the blue flip handles on the block 
selection box.

Horizontally Flip Block
Click the Flip Horizontal handle  to mirror a block horizontally.

Vertically Flip Block
Click the Flip Vertical handle  to mirror a block vertically.
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Rotate a Block of Objects
Click and drag the rotation handle to rotate the block freely to any angle. 

If desired, move the center of rotation before rotating the block.

The selection box around the block is rotated around the center of rotation. The block will 
be redrawn in its new position.

Move the Center of Rotation
The center of rotation  is initially shown in the middle of the block. Click on or within 
the center of rotation, then drag it to any position in the design. This changes the pivot 
point around which the block rotates.

When the block is moved or resized, the center of rotation is returned to the center of the block.

Rotate 45 Degrees
Use Rotate 45  to rotate the selected block of objects in 45 degree steps. If desired, 
move the center of rotation  before rotating.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, R4

Modify Block
Use Modify Block  to open the Modify Block dialog, where you can show and change 
the size, rotation and skew of the currently selected block.

If no objects are selected, the whole design will be modified.

Shortcuts
■ Tools, Home Tab: 
■ Keys: Alt, H, M, M

Flip Vertical Handle

Rotate
Handle

Resize
Handle

Center of
Rotation

Flip
Horizontal

Handle
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Modify Block
Use the Modify Block  dialog box to show and change the 
size and rotation of the currently selected block.

Modify the currently selected block as desired, then click OK 
to show your changes in the work area.

Click Undo  to reverse your changes.

Size

Height and Width %
Show and change the height  and width  percentage 
of the currently selected block.

The size in millimeters to which the block will be changed is 
shown to the right.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Rotate

Angle
Enter an angle, from 0 to 359 degrees, in the Angle box. The preview shows the selected 
angle.

If desired, move the center of rotation  before rotating.

Resize a Bicycle Design
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'Bicycle’.

2 Ensure the Home tab is selected, and click Box Select .
3 Click and drag to draw a rectangle around the bicycle. 
4 Release the mouse button and the bicycle is surrounded by a 

selection box with blue handles.
The blue handles indicate that when the size of the design is changed it 
will be resized. The stitches are recalculated to maintain the original 
density.

5 Note the number of stitches in the design. You can see this in the 
Information area on the Design panel.

6 Click Modify Block . The Modify Block dialog box appears.
7 In the Size section, ensure Proportional is checked, then change 

Height percentage  to 75%. 
The Width percentage will increase by the same amount.

8 Click OK. The bicycle decreases in size, and the number of stitches is 
reduced from 23606 to approximately 17842.

9 Left-click outside the select box to deselect the design.
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Scale to Fit Hoop
Use Scale to Fit Hoop  to resize the design in the work area proportionally, to fit within 
the boundaries of the hoop, centered in the hoop. This is useful to resize a whole design to 
fit in a different hoop, although you need to consider whether to change settings or stitch 
types. For example, if you enlarge a design, it may be beneficial to add a pattern to wide 
satin columns.

The whole design will be resized, including hidden areas.

Shortcuts
■ Home Tab, Modify Block: 
■ Keys: Alt, H, M, S

Change Design Size
Use the Change Design Size  dialog box to alter a design 
automatically to a new size, allowing for the stitch objects 
used. Resize the design to the desired width or height, then 
click OK to show your changes in the work area.

Click Undo  to reverse your changes.

It is not possible to resize the design to a size greater than the 
selected hoop. If a larger size is entered, the design will be scaled to fit the selected hoop, 
and a warning message displayed. To enlarge the design more, select a bigger hoop 
before using Change Design Size.

Size
Enter the desired Width or Height in millimeters. 

Select Width or Height to select the dimension to use when resizing.

Shortcuts
■ Home Tab, Modify Block: 
■ Keys: Alt, H, M, C

Cut, Copy and Paste Objects
Once objects have been selected with Box Select, Freehand Point Select, Freehand Select 
or Select All Visible, they can be cut and copied. Only objects that are completely enclosed 
by the selection line will be selected. The selection of objects on the clipboard can be 
pasted as many times as desired in the Design window, or into a separate PREMIER+™ 2 
Create window.

Cut a Block of Objects
Use Cut  to cut out the selected objects and place them on the clipboard. The selection 
can then be pasted back in.

Use Delete  to remove a block of objects from the design. See “Delete” on page 338.
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Shortcuts
■ Home Tab: 
■ Keys: Ctrl + X; Alt, H, CU; Right-click FilmStrip, T

Copy
Use Copy  to Copy the selected objects to the clipboard, without affecting the current 
selection. The selection can then be pasted back in. If no objects are selected, the whole 
design will be copied.

Use Copy Embroidery to copy the whole design to another PREMIER+™ 2 Embroidery System module.

Shortcuts
■ Home Tab: 
■ Keys: Ctrl + C; Alt, H, CO; Right-click FilmStrip, C

Paste a Block of Objects
Use Paste  in the Home tab to paste the objects on the clipboard back into the design, 
or into a separate PREMIER+™ 2 Create window. The first object in the block is placed in 
the same position on the work area after the selected object or the last visible object in 
the design.

Color Changes are only transferred if they are within the copied block. If there are no Color 
Changes in a pasted block then all the objects will use the thread color already in use 
where the block is pasted.

Embroideries that have been copied from other PREMIER+™ 2 Embroidery System modules may not be 
pasted into PREMIER+™ 2 Create, because they are not copied as objects. However, you may use Insert 
Embroidery  to import embroideries from other PREMIER+™ 2 Embroidery System modules, and you 
can move a design from PREMIER+™ 2 Create to another PREMIER+™ 2 Embroidery System module with 
Copy Embroidery .

Shortcuts
■ Home Tab, Paste drop-down: 
■ Keys: Ctrl + V; Alt, H, PA; Right-click FilmStrip, P

Paste Into Center
Use Paste, Paste Into Center  in the Home tab to paste the objects on the clipboard into 
the center of the work area. The first object in the block is placed after the selected object 
or the last visible object in the design.

Color Changes are only transferred if they are within the copied block. If there are no Color Changes in a 
pasted block then all the objects will use the thread color already in use where the block is pasted.

Shortcuts
■ Home Tab, Paste drop-down: 
■ Keys: Ctrl + Shift + V; Alt, H, P, PI
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Paste and Replace
Use Paste and Replace in the Home tab Paste drop-down to paste the objects on the 
clipboard, replacing the currently selected objects.

Color Changes are only transferred if they are within the copied block. If there are no Color Changes in a 
pasted block then all the objects will use the thread color already in use where the block is pasted.

Shortcuts
■ Home Tab, Paste drop-down
■ Keys: Alt, H, P, PR

Paste Into Window
Use Paste Into Window in the Home tab Paste drop-down to paste the objects on the 
clipboard into a new window.

Color Changes are only transferred if they are within the copied block. If there are no Color Changes in a 
pasted block then all the objects will use the default thread color.

Shortcuts
■ Home Tab, Paste drop-down
■ Keys: Alt, H, P, PW

Clipboard Block
When objects are copied they are placed on the Clipboard Block 
(usually called the clipboard). The selection of objects on the 
clipboard can be pasted as many times as desired within 
PREMIER+™ 2 Create.

Duplicate
Use Duplicate  to make a copy of the selected objects, which is automatically pasted on 
the work area below and to the right of the original and after the selected objects in the 
stitch sequence. 

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, DU; Right-click FilmStrip, I

Insert Embroidery
Use Insert Embroidery  to insert any embroidery into the current design. 

To insert an .edo or .can design outline file, use Insert . See “Insert” on page 170.

An inserted embroidery is automatically converted to stitch objects and placed as a group. 
The first object in the group is placed after the selected object or the last visible object in 
the design. The group can be moved, resized, mirrored, rotated, copied or cut. 
Embroideries are inserted at the size they were created.
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To open an embroidery as a design, use File, New  to start a design with no picture, and Insert 

Embroidery  to convert an embroidery to a design.

To see the name of an embroidery, position the arrow pointer over the desired thumbnail. 
A label showing the file name will appear.

The following embroidery file formats may be loaded: Bernina (.art version 1, 2, 3), 
Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES (.pes version 2 - 10), 
Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna 
(.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and 
Toyota (.10*).

Files that hold color information, such as .vp4, .vp3, .vip, .hus, .shv, .dhv, .pcs, .pes, .jef, .sew 
and .xxx, are shown in the nearest match to the colors in which they were created for the 
selected Thread Range (set in PREMIER+™ 2 Configure). For files that do not store colors, 
such as .dst, .exp and .10?, the embroidery will be shown in a default color sequence.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, IE

How to Insert an Embroidery
1 Click the Insert Embroidery icon . The Open dialog box will appear.
2 Browse to the desired embroideries folder.
3 Use the scroll bars to view all the embroideries within the folder.
4 Click on an embroidery to select it, then click Open to insert the embroidery into the work area.

The embroidery is converted to a group of objects and placed in the center of the work area. 
Use Ctrl + click in the Open dialog box to insert multiple embroideries. Each embroidery will be inserted as 
a separate group. Use Display Group Contents  to view the inserted groups.
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Insert Lettering
Use Insert Lettering  to insert lettering from any PREMIER+™ 2 Embroidery System font 
into the current design. The first object in the inserted character is placed after the 
selected object or the last visible object in the design. The character is also placed as a 
group so that it can be moved, resized, mirrored, rotated, copied or cut. Characters are 
inserted at the selected size relative to the 'A' character in the font.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, IL

Insert Lettering in a Design
1 In the Home tab click the Insert Lettering icon  and the Insert Lettering dialog box will appear.
2 Click the drop-down arrow next to the font Category and select the desired category.
3 Click the drop-down arrow next to the font name and select the desired font. The available characters 

in the font will be highlighted in the table.
Only characters that have been created for the font may be selected.

4 Click the desired character and it will be shown highlighted.
5 Click Insert. The character will appear on the work area as a group, so you can adjust it as desired.

Alternatively, double-click to insert the character.
6 Repeat to place additional characters as desired.

Subsequent characters are placed to the right of the previous character, creating a line of text that can be 
selected, moved and adjusted as desired.
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Insert SuperDesign
Use Insert SuperDesign  to insert a SuperDesign from the 
SuperDesign sets available in PREMIER+™ 2 Create. 
SuperDesigns are special designs that can be resized with 
constant stitch density. Some SuperDesigns are 
multicolored, and the stitch type and style for many can be 
changed. Alter the size, proportions, stitch type and thread 
color. 

Choose a Style for certain SuperDesign sets, for example 
the Animals 1 set contains Natural, Sepia and Line styles.

SuperDesign sets are grouped into categories. Each set contains 9 
SuperDesigns. The SuperDesign gallery shows thumbnails of all the 
SuperDesigns in the currently selected SuperDesign set. 

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, IS

Insert a SuperDesign
1 In the Home tab, click Insert SuperDesign . The Insert SuperDesign dialog box opens.
2 Search for a SuperDesign in the Search box (see “Search for a SuperDesign” on page 365), or choose a 

SuperDesign Category from the drop-down Category menu. The preview will show the first design 
set in that category.
Select a single Category, or browse All categories.

3 Click the drop-down arrow below the Category list, and choose a SuperDesign set, then click a design 
to select it.

4 Set the Size in millimeters as desired, from 5mm to 200mm. This sets the height of the SuperDesign, 
and the width is set proportionally.

5 Click Insert. The SuperDesign is inserted in the work area as a Group, leaving any existing 
SuperDesigns unchanged.

Search
You can search for a SuperDesign by name, folder name, or keyword.

Enter the desired text in the Search box and press Enter. Click Clear Search to remove the 
search text, and use the drop-down menu to reuse previous searches.

Click Clear Search before browsing SuperDesigns by Category.

Search for a SuperDesign
1 In the Home tab, click Insert SuperDesign  to open the Insert SuperDesign dialog box.
2 Enter a search term in the Search box, for example ’christmas’, and press Enter. A gallery of search 

results appears by the pointer.
3 Scroll down to view all of the Christmas designs. Alternatively, click the drop-down menu in the 

dialog box to view the Christmas designs.
These are from Christmas categories, and single designs with a Christmas theme.

4 Note that the SuperDesign Category drop-down menu is not available. Click the Clear Search button 
below the Search box. The most recently used category becomes available.

5 In the Search box enter ’dog’, then press Enter.
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Besides 18 household pets, there are also three pictures of a sausage in a roll (a hotdog). Searching may 
sometimes produce unexpected results!

6 Click the Clear Search button to return to Category view.
7 In the Search box enter ’lion’, then press Enter. There 

are six different Lion designs.
8 Place the pointer over the first four lions in turn.

The first three are part of the Animals set in the 
Appliqué Category, and the fourth is from Tassels. They 
are all named Lion. You can search on Category or 
SuperDesign name.

9 Place the pointer over the last two lions.
The fifth and sixth lions are from Zodiac, and are 
named Leo. The term "Lion" is from the keywords for 
these SuperDesigns.

10 Click to select the first Leo, then click Insert. The lion 
is inserted as a group in the work area.
The Search function finds all varieties of a particular SuperDesign, there is no need to click the Style option 
for a SuperDesign set individually when using Search. In the example above, the appliqué lions using Satin 
Line, and the two styles of Motif Line are found.

Insert ExpressDesign
Use Insert ExpressDesign  to create a new design in the ExpressDesign Wizard. Use 
ExpressDesign into Rectangle  to create a new design that is a best-fit to a rectangular 
area you draw, and use ExpressDesign into Hoop  to create a new design that is a best-
fit to the currently selected hoop.

Insert ExpressDesign is used to add new design elements to an existing design, but can also be used to 
create the first part of a new design, or used repeatedly to compose a design from elements created in the 
ExpressDesign Wizard.
See “Insert ExpressDesign” on page 100.
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Notes and Settings
Notes
Click Notes  to display the Notes, then click 
Edit  to change the Notes for the currently 
selected design. The Notes dialog will appear.

The Notes dialog allows free text and keywords to 
be added to the Notes for the selected design. Type 
additional Notes in the Notes box.

Use Ctrl+Enter to start a new line of text.

Up to 2000 characters can be entered in the Notes.

Keywords
Select Keywords for the design from the list, then 
click Add to add them to the Notes for the design.

Add Notes to a Design
1 Click Notes . The Notes are selected in the Notes and Settings pane.
2 To edit the Notes, click Edit .
3 In the Notes text box make your desired changes to the Notes.

Use Ctrl+Enter to start a new line of text.
4 To add Keywords, select the keyword from the category heading or subcategory in the scrolling list. 

Then click Add.
Double-click to expand the folders until the desired keyword is highlighted. (Alternatively click on the + 
sign.)

5 Click OK to save your amended Notes and added keywords.
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Settings
Click Settings  to display the Settings, then click 
Edit  to change the Settings for the currently 
selected design. The Settings dialog will appear.

Use Ctrl+Enter to start a new line of text.

Up to 2000 characters can be entered in the 
Settings.

When you wish to store the settings for an area, use the 

’Show a text summary for these options ’ option on the 
Favorites tab of the Fill Area and Line properties dialog.
Use Ctrl + C and Ctrl + V to Copy and Paste the text to the 
Settings dialog.

Add Settings Information to a Design

1 Select the design for which you want to amend the settings. The design will be highlighted.
2 Click Settings .
3 Click Edit .
4 In the Settings text box make your desired changes to the Settings.

Use Ctrl+Enter to start a new line of text.
5 Click OK to save your amended Settings.

Undo and Redo
Undo
Use Undo  to reverse the last action. Unlimited Undos are possible except in the Paint 
window, where there is a maximum of 10. Every time you click on Undo, the previous 
action is reversed. If you are not satisfied with the result of the Undo, click Redo.

To remove an area that was not the last created, select it, then click Delete .

The Zoom commands cannot be reversed using Undo.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Z

Redo
Use Redo  to reverse the last action that was undone by Undo. If you are not satisfied 
with the result of the Redo, click Undo. 

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Y
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Fill and Satin Patterns
Set the Fill Pattern number for fill areas, satin areas and columns. When a pattern fill area is 
first created, for example by converting from another stitch type, the initial setting is 
pattern 3. Standard satin uses Pattern 0, which is not available for Pattern Fill areas.

Patterns in categories other than Standard are recommended for use in relatively large fill areas, as they 
have repeating patterns which work well when 'tiled' together. Pattern 36 produces a 'satin effect' fill stitch.
The first four patterns in the Gradient & Lace category (253-256) are recommended for multicolor gradient.
Patterns 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create a 
weave effect for lace designs. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm 
to combine with Pattern 258, and so on.
For a complete reference to all the fill patterns that can be used, see the Fill Patterns Sample Guide. This is 
provided as a PDF for viewing and printing.

Animals 1 — Patterns 37 to 48

Arrows — Patterns 49 to 60

Circles 1 — Patterns 61 to 72

Circles 2 — Patterns 73 to 84

Climate — Patterns 85 to 96
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Diamonds — Patterns 97 to 108

Gradient & Lace — 
Patterns 253 to 264

Hearts — Patterns 109 to 120

Leisure 1 — Patterns 121 to 132

Mosaic 1 — Patterns 133 to 144

Mosaic 2 — Patterns 265 to 276

People — Patterns 145 to 156
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Plants & Flowers 1 — 
Patterns 157 to 168

Polygons — Patterns 169 to 180

Rope & Chains — 
Patterns 181 to 192

Squares 1 — Patterns 193 to 204

Squares 2 — Patterns 205 to 216

Standard 1 — Patterns 1 to 12

Standard 2 — Patterns 13 to 24
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Standard 3 — Patterns 25 to 36

Transport — Patterns 217 to 228

Waves 1 — Patterns 229 to 240

Waves 2 — Patterns 241 to 252
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17Managing Paintings
In the Paint window, you may open pictures with Insert Picture  and Open Picture . 
You can also obtain a picture from a scanner or digital camera with From Scanner or 
Camera .

To open drawings, see “Managing Drawings” on page 92.
The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 
uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf) 
and Windows Icon (.ico).

Use Insert Picture  or Open Picture  if you wish to adjust a picture in its original form before using it 

to create a design in the ExpressDesign Wizard. A picture opened with Insert Picture  or Open 

Picture  will not have its colors reduced or modified, as it would in the ExpressDesign Wizard.

Insert Picture , Open Picture , and From Scanner or Camera  are only available when there are 
no stitch objects in the design. To use these features, click File, New and select Start a New Design with no 
Picture, select Paint Window, then click Finish. In the Paint tab use the desired function.
Pictures may be saved with a new name and location using Save As Picture .

Insert Picture
Use Insert Picture  to browse pictures before opening them into the current window. 
PREMIER+™ 2 Create displays the Picture Viewer so you can choose which picture to open.

Open a folder, and scroll down and click a picture to select it. Click OK to load the picture 
on the work area.

You can change the icon size, and show the names of the pictures.

Shortcut
■ File Menu: 

Choose a picture folder

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture
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Use Insert Picture to Load a Picture
1 With the Paint tab selected, click File, Insert Picture . The Picture Viewer appears. 
2 Browse through the drives and folders of the computer to the desired folder. 
3 Click on an icon to select the picture.
4 Click Open to load the picture into the work area.

Alternatively, double-click the icon for the picture.

Open Picture
Use Open Picture  to open an existing picture in a new window. PREMIER+™ 2 Create 
displays the Picture Viewer so you can choose which picture to open.

Open a folder, and scroll down and click a picture to select it. Click OK to load the picture 
on the work area.

You can change the icon size, and show the names of the pictures.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + O

Use Open Picture to Load a Picture
1 With the Paint tab selected, click File, Open Picture . The Picture Viewer appears.
2 Browse through the drives and folders of the computer to the desired folder. 
3 Click on an icon to select the picture.
4 Click Open to load the picture into the work area.

Alternatively, double-click the icon for the picture.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from the selected scanner, digital camera or other suitable device. Only devices that use 
use Windows Image Acquisition (WIA) can be used to obtain pictures.

Choose a picture folder

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture
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WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s 
scanning or downloading program to another program, in this case the PREMIER+™ 2 Create module of 
the PREMIER+™ 2 Embroidery System. If the manufacturer provides the appropriate software components 
needed for WIA compliance, these should have been installed when the device was installed.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the picture, it will be shown 
in the work area.

PREMIER+™ 2 Create displays pictures in High Color (16-bit), so some difference may be noticeable 
compared with the display in other picture viewing programs if your computer is set to True Color (24-bit or 
32-bit). This does not affect the quality of the embroideries produced.
Pictures may also be scanned directly into the ExpressDesign Wizard.

Shortcut
■ File Menu: 

Save As Picture
Use Save As Picture  to save changes to a picture you have edited, or save a picture you 
have created with the PREMIER+™ 2 Create painting tools, or save a picture after it has 
been loaded and modified with the ExpressDesign Wizard.

The following file formats may be saved: Windows or OS2 Bitmap (.bmp), JPEG Low Quality 
(.jpg), JPEG High Quality (.jpg), Tagged Image File Format uncompressed (.tif ) and 
Portable Network Graphics (.png).

Shortcut
■ File Menu: 
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18Creating a Painting
A full range of painting functions is available for raster graphics files (created using a grid 
of pixels, and less easily resizable than vectors). In addition to the standard features, 
PREMIER+™ 2 Create includes a MiniPics function for adding special small clipart, and a 
range of Image Effects for improving pictures ready for creating designs.

Use the Paint tab to select and edit your picture.

Use the Paint window control panel to select colors, and paint lines and fill areas for your 
picture.

Choose Painting Colors
Color Box and Color Palette
Use the Color box and Color palette to choose the colors for 
painting.

Color Box
The Color box at the right of the window displays the currently 
selected foreground and background colors. The top color is 
the foreground (for drawing with left-click) and the bottom 
color is the background (for drawing with right-click with most 
tools).

Resize, crop, and fill the background to the picture

Show the GridCut, copy, paste or delete an area of the picture
Use a selection tool to choose part or all of the picture

Improve the picture brightness, color, sharpness and definition

Rotate or mirror part or all of the picture

Pick a color from the palette

Pick foreground color

Pick background color

Choose a color theme

View and swap the foreground and background colors

Add a line, shape or clipart to your picture

Flood fill areas of the picture

Paint with brush or pen
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Click the double-headed arrow in the corner of the Color box to swap the foreground and background 
colors.

Alter a Color in the Color Box
1 Left-click on a color from the Color palette to select it as the foreground color.
2 Right-click on a color from the Color palette to select it as the background color.
3 To alter the range of colors in the Color palette, click the Theme drop-down list and select one of the 

themes.
4 To choose a color that is not in the Color palette, double-click on either of the colors in the Color box 

to bring up the Colors dialog box. (After a color is chosen, it will be placed as foreground or 
background depending on which color was clicked in the Color box.)

5 To select a color from the picture on the screen use the Pick Color (foreground  and 
background ) functions in the Paint window control panel.

Themes
To alter the range of colors in the Color palette, click the Theme drop-down list and select 
one of the themes: Standard, Spring, Summer, Fall or Winter. The default theme is 
Standard.

You can select a personal palette by using Edit Themes. Use Edit Themes to create and 
select personal color palettes. See “Quick Color Themes” on page 201.

Color Palette
The Color palette below the Color box provides 32 commonly used colors. Left-click on a 
color of the palette to place it in the Color box as the foreground color. Right-click on a 
color of the palette to place it in the Color box as the background color.

Pick Color
Use Pick Foreground Color  and Pick Background Color  to select a color from the 
picture on the screen and make it the foreground or background color in the Color box.

This is useful for choosing colors from the picture for drawing that do not appear in the 
Color palette.

Pick Foreground Color
Use Pick Foreground Color  to select a color from the picture on the screen and make it 
the foreground color in the Color box.

Shortcut

■ Paint Window Control Panel: 
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Pick Background Color
Use Pick Background Color  to select a color from the picture on the screen and make it 
the Background color in the Color box.

Also use Pick Background Color  to choose the desired background color from the picture before using 

the selection functions, Shapes  and so on.

Shortcut

■ Paint Window Control Panel: 

Pick a Color
1 Click Pick Foreground Color  or Pick Background Color . The pointer changes to an 

eyedropper .
2 Click the desired color in the picture to make it the foreground or background color in the Color box, 

as desired.

Colors Dialog Box
The Colors dialog box is used to choose a new color for the foreground or background 
color, or modify any color in the Color palette.

The color selected in the Colors dialog box is set to 
the foreground color if the top color in the Color 
box was double-clicked to bring it up, or if a color 
in the Color palette was double-clicked with the 
left mouse button. It is set to the background 
color if the bottom color in the Color box was 
double-clicked to bring it up, or if the color in the 
Color palette was double-clicked with the right 
mouse button.

When the Colors dialog box appears, it shows the 
Standard color selection. If desired, click one of 
the Standard colors. A highlight shows the 
selected color. The New/Current box shows the difference between the newly chosen 
color and the color currently used.

Click the Custom tab to be able to select any of 
the 16 million RGB colors.

Click in the blended color palette to choose a 
basic color, then use the slider at the side to 
choose the desired brightness level. The HSL and 
RGB values are updated as you change the color 
and the color is previewed in the New/Current 
box.

You can also directly enter Hue, Sat(uration), 
Lum(inance) (HSL) and/or Red, Green, Blue (RGB) 
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values. Alternatively, use the up/down buttons on each of the HSL and RGB value boxes to 
make fine adjustments to the color.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value 
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue. 
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a 
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color. 
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value 
between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a 
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has 
three primary colors — red, green, and blue — that it creates by emitting light. These 
three colors are combined in various proportions to produce all the colors displayed on 
your screen. They are referred to as additive because they combine to produce white. 
Primary colors are measured as a value from 0-255. The colors produced by combining the 
three primaries are a result of the amount of each of those shades present. For example, 
pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red 
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to 
zero, the color is black; if all three are 255, they produce white.

Painting Tools
Paintbrush
Use the Paintbrush  to paint lines on the picture that follow the movement of 
the pointer. Select a round or square brush in one of five different widths.

Shortcut

■ Paint Window Control Panel, Create: 

Draw a Line with the Paintbrush
1 Select the desired color in the Color panel. Use Pick Color  if you want to select a color from the 

picture.
2 Click the Paintbrush icon .
3 Change the line width and style if desired by clicking on the desired setting in the Tool 

Options box.
4 Click and drag across the work area from the desired start point to the desired end point 

to draw a line. A line appears showing the freehand line as it is drawn. Lift the pen or 
release the mouse button and the line is completed. Each time you drag and release a 
new line will be drawn, until another feature is selected.

You can single-click to place dots of color.
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Line
Use Line  to draw straight lines with round or square ends in the picture using one of 
five different widths.

Shortcut
■ Paint Window Control Panel, Create: 

Draw Straight Lines with the Line Tool
1 Select the desired colors for foreground and background in the Color panel. Use Pick Color  if you 

want to select colors from the picture.
2 Click the Line icon .
3 Change the line width if desired by clicking on the desired setting in the Tool Options 

box.
4 Click and drag across the work area from the desired start point to the desired end point 

to draw a line. A line appears "attached" to the pointer showing the size of the line that 
will be drawn. The length of the line in pixels is shown in the status bar. Lift the pen or 
release the mouse button and the line is drawn in the foreground color.

5 Each time you drag and release a new line will be drawn, until another feature is selected.
If desired, use right-click and drag to draw lines in the background color.

Calligraphy
Use Calligraphy  to paint lines on the picture. Select from two different pen angles and 
four different line widths.

Shortcut
■ Paint Window Control Panel, Paint: 

Draw Lines with the Calligraphy Pen
1 Select the desired color in the Color panel. Use Pick Color  if you want to select a color from the 

picture.
2 Click the Calligraphy icon .
3 Change the line width and style if desired by clicking on the desired setting in the Tool 

Options box.
4 Click and drag across the work area from the desired start point to the desired end point 

to draw a line. A line appears showing the freehand line as it is drawn. Lift the pen or 
release the mouse button and the line is completed. Each time you drag and release a 
new line will be drawn, until another feature is selected.
You can single-click to place short lines of color. If desired, use right-click and drag to draw lines in the 
background color.

Drawing Shapes
Shapes
Use Shapes  to draw shapes in the design. The shape will be drawn as a closed line, that 
may be filled. Select your shape from the drop-down list. Seventy-five different shapes are 
available.

Shapes is enabled until another tool is selected.
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Hold the Ctrl key down when using Shapes  to keep the original proportions of the shape. For example, 
use Ctrl to draw a square rather than a rectangle, or a circle instead of an ellipse.

Shortcut
■ Paint Window Control Panel, Create: 

Draw a Shape
1 Select the desired line and fill colors and types.
2 Click the Shapes icon .
3 Select the type of shape you wish to draw from the drop-down list in the tool options box.
4 Click one of three options: outline only, fill only and outline with fill.
5 Click and drag across the work area from the desired start point to the desired end point and the 

shape appears in the design area. 

Draw the shape with the right mouse button held down to reverse the outline and fill colors.
Lift the pen or release the mouse button and the shape appears.

6 If the shape needs to be moved, use either Box Select  or Freehand Select  to select the 
rectangle, and then move the rectangle to the desired position. Alternatively, click Undo  and 
draw the shape again.

Shape Options
These options cover the types of shape, and how they are drawn.

Shape Type
Select one of 75 shape types from a drop-down list.

Shape Options
Choose from: outline only, fill only and outline with fill.

Flood Fill
Use Flood Fill  to fill an area of the picture with the foreground or background color. The 
pointer changes to the paint bucket . The area to be filled is defined by other colors 
surrounding it or the edges of the work area. Left-click to fill an area using the foreground 
color, or right-click to use the background color. Flood fill will not flow across gaps 
between separate areas of the same color. Either fill each area separately, or use other 
drawing tools to 'patch up' a shape to make it a continuous area of the same color.

Shortcut
■ Paint Window Control Panel, Create: 

Select a shape Choose outline, fill, or both Draw your shape
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Flood Fill an Area
1 Select the desired color for the foreground and background in the Color panel. Use Pick Color  if 

you want to select colors from the picture.
2 Click the Fill icon  and the pointer changes to the paint bucket .
3 Change the color sensitivity of Flood Fill with Tolerance, by clicking on the desired setting 

in the Tool Options box.
4 Click on a color within your picture. Adjacent areas in the picture with a similar color to the 

area that you clicked are filled with the foreground color (or the background color, if you 
right-click).

5 Flood Fill is enabled until another tool is activated, or you right-click to deselect it.

MiniPics
Use MiniPics  to add any of the special small clipart pictures included with your 
PREMIER+™ 2 Embroidery System. An added MiniPic is automatically selected at the top 
left of the work area, ready to be moved or copied.

To see the name of a MiniPic, position the arrow pointer over the desired thumbnail. A 
label showing the file name will appear.

To move a MiniPic you must click in a colored (non-background) area.

Shortcut
■ Paint Window Control Panel, Create: 

Load a MiniPic
1 Click the Load MiniPics icon  and the 

Viewer dialog box will be displayed.
2 To look at MiniPics in a different folder, 

click the folder to view the contents of that 
folder.
The browser only looks for MiniPics folders in 
ProgramData\VSMSoftware\Premier+2 
\MiniPics\Paint, which is supplied with two 
subfolders for Medium and Small MiniPics.

3 Scroll down to see more MiniPics, if 
available. 

4 Click a thumbnail picture to select a 
MiniPic, then click the Open button at the 
bottom of the window. Alternatively, double-click on a thumbnail picture to load the MiniPic onto the 
screen. The MiniPic will be placed in the top left of the picture with a selection box around it.

5 Click and drag in a colored area of the newly placed MiniPic to place it in 
the required position on your picture. You can also resize the MiniPic, 
and flip it or rotate it. You may need to move the Viewer dialog box out 
of the way to position the MiniPic where you want it (click and drag the 
Viewer dialog box using its title bar).

6 Use the scroll bar to display all the MiniPics in the folder, and click a 
picture to choose a new MiniPic.

7 Carry on adding MiniPics as required. When you select the next MiniPic, 
the previous MiniPic is deselected and becomes part of the picture.

8 When you have finished, click Cancel. If you have a MiniPic selected in 
the picture, it can still be modified until you click outside the selection 
box to make it part of the picture.



PREMIER+™ 2 Create   Creating a Painting              383

Creating MiniPics
In addition to using the MiniPics supplied with your PREMIER+™ 2 Embroidery System, you 
may also create your own MiniPics.

Before Starting
To create your own MiniPics, you will need appropriate image editing software that is 
capable of saving pictures in Sun Raster Image (.ras) format. It is also recommended to 
have good knowledge of working with graphic files.

About MiniPics
Create Medium MiniPics at 400x400 pixels, and Small MiniPics at 250x250 pixels.

The color palette must be 256 colors (8 bit) or 16 million colors (24 bit).

White is treated as transparent when you load a MiniPic, so anything underneath the 
white part of a MiniPic will show through. If you want an area to be white in your MiniPic, 
use a "false white" such as very pale yellow, then change it to white with the Flood Fill tool.

To be available to the MiniPics function, your MiniPics must be saved within 
ProgramData\VSMSoftware\Premier+2\MiniPics\Paint. 

It is recommended that you create a new folder for saving your own MiniPics, such as 
ProgramData\VSMSoftware\Premier+2\MiniPics\Paint\MyMiniPics.

How To Make a MiniPic

Use an Existing Picture
■ Open an existing picture. Either crop around the required area or resize the whole picture 

to the size of a Medium or Small MiniPic.

Create a New MiniPic from a Blank Picture
■ Start a new image and set it to the size of either a medium (400x400 pixels) or small 

(250x250 pixels) MiniPic. Use the drawing tools in the graphic package to create the 
desired picture for the MiniPic.

Finalize and Save the New MiniPic
1 Ensure that the colors are solid color areas. See the existing MiniPics for examples.
2 Save the file in Sun Raster Image format with the “.ras” extension. If there are options for the Sun 

Raster Image format, ensure the file is saved as 'Standard - Type 1' with no image or file compression.

Change the File Extension
3 Start Windows® Explorer and browse to the folder where you saved the “.ras” file.

If the .ras file extension is not shown, you will need to allow file extension to be shown. Select either Tools, 
Folder Options or Organize, Folder and Search Options. The Folder Options will appear. Click the View tab. 
In the list of options, click 'Hide extensions for known file types' so that it is not selected. Click OK and the 
.ras extension will be shown.

4 Right-click on the file to bring up a context menu, and select the Rename option from the menu.
5 Edit the file name to change the extension from “.ras” to “.axw” and press Enter.
6 You will be warned about changing the file extension and asked if you want to continue.
7 Click Yes and the change to the file extension will be applied.
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Use the MiniPic
8 Start PREMIER+™ 2 Create and click the MiniPics icon  so that the MiniPics Viewer appears.
9 Browse to the folder where you saved your new MiniPic.
10 The viewer will show your new MiniPic, along with any MiniPics you have already created.
11 Click the MiniPic and it will be used in the picture.

Fill Background to Hoop
Use Fill Background to Hoop  to fill any empty areas between the picture and the hoop 
boundaries with the selected background color.

This can be useful in the following circumstances:

• If you change the shape of the hoop to add other elements, for example if you change 
from a square hoop to a rectangular hoop to add a MiniPic to the picture. 

• If you crop a picture before adding other elements.

When you load a picture in the Express Design Wizard, any area outside the picture is automatically filled. 
Use Fill Background to Hoop where the picture no longer matches the shape of the hoop.

Shortcuts
■ Paint Tab: 
■ Keys: Alt, D, L, B

Fill Empty Areas Around a Picture
1 Start PREMIER+™ 2 Create and in the Choose Design Type page of the ExpressDesign Wizard, select 

Load a Picture into the Paint Window.
2 In the Choose Picture page click Load a Picture  and load the picture 

Documents\Premier+2\Samples\Premier+2Emb\Pics2\Holidays\Ho09.png.
3 In the Rotate and Crop Picture page click Select All to keep the white background around the picture.
4 Click Next to complete the wizard. The picture is displayed in the hoop with a white background.
5 Use Box Select  to select the top half of the picture, then click Crop . The edges of the picture 

are now blue.
6 With the Paintbrush  draw a line across the white and blue areas. Only the part of the line on the 

white background appears.
7 Click the Home tab. The blue area in the hoop is the background fabric. It is not part of the picture.
8 Click the Paint tab, then in the ribbon bar click Fill, and Fill Background to Hoop . The blue areas of 

the picture are filled with the selected background color.
You can now draw on or flood fill these areas.

9 Click the Home tab again. The picture now fills all of the hoop.
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19Editing Paintings
Use one of the selection tools: Box Select , Freehand Select , Freehand Point 
Select , Ellipse Select , or Magic Wand Select  to select part of the picture as a 
block. 

If desired, use Exclude Background  with any of the selection tools.

After selection, delete, cut, copy, resize, rotate or 
mirror the selection. Crop the picture so that only the 
selected area remains. Apply effects to enhance or 
adjust only the selected area. 

To resize the block, click and drag one of the corner 
resize handles as desired. Hold down Ctrl as you click 
and drag to resize proportionally. Hold down Shift to 
resize from the center. Rotate the selection around 
the center of rotation to any degree with the rotate handle. Click and drag inside the 
selection to move it to a new position in the picture.

To deselect the area, click anywhere in the work area outside the selection box.

Select and Resize Areas
Box Select
Use Box Select  to select an area of the picture by drawing a square or rectangular box 
around it. 

Use Pick Color  before using any select tool to set the correct background color, then use Exclude 
Background if desired.
To resize, click and drag one of the corner resize handles as desired. Rotate the selection to 
any degree with the rotate handle. Click and drag inside the selection to move it to a new 
position in the picture.

To deselect the area, click anywhere in the work area outside the selection box.

Use Add to Selection  with any select function to increase the selected area, or use Remove From 

Selection  to make the currently selected area smaller.

After selection, delete, cut, copy, resize, rotate, or mirror the selection. Crop the picture so 
that only the selected area remains. Apply effects to enhance or adjust only the selected 
area.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SB

Resize
Handle

Rotate
Handle

Selection
Box

Center of Rotation
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Select an Area with Box Select
1 Select the desired Background color in the Color panel. Use Pick Color  if you want to select it from 

the picture. If desired, select Exclude Background.
2 Click Box Select .
3 Click and drag around the desired area of the picture. The selection will be shown by the dashed 

selection box.
4 Box Select is enabled until another tool is activated, or you right-click to deselect it.

Freehand Select
Use Freehand Select  to select an area of the picture by drawing a freehand line around 
it. This is useful when an area cannot easily be selected with a rectangular box. 

Use Pick Color  before using any select tool to set the correct background color, then use Exclude 
Background if desired.
To resize the selection, click and drag one of the corner resize handles as desired. Rotate 
the selection to any degree with the rotate handle. Click and drag inside the selection to 
move it to a new position in the picture.

If you draw partially around the area you wish to select, a straight line will be used from 
the last point back to the beginning of the selection. To deselect the area, click anywhere 
in the work area outside the selection box.

Use Add to Selection  with any select function to increase the selected area, or use Remove From 

Selection  to make the currently selected area smaller.

After selection, delete, cut, copy, resize, rotate or mirror the selection. Crop the picture so 
that only the selected area remains. Apply effects to enhance or adjust only the selected 
area.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SF

Select an Area with Freehand Select
1 Select the desired background color in the Color panel. Use Pick Color  if you want to select it from 

the picture.
2 Click Freehand Select .
3 Click and drag to trace a line around the desired area of the picture. The selection will be shown by 

the dashed selection box.
4 Freehand Select is enabled until another tool is activated, or you right-click to deselect it.

Freehand Point Select
Use Freehand Point Select  to select an area of the picture of any shape, defined by a 
series of points. 

Use Pick Color  before using any select tool to set the correct background color, then use Exclude 
Background if desired.
Click Freehand Point Select and the pointer changes to the Freehand point select 
pointer . Click a series of points to create an irregular outline of straight or curved lines 
around the desired area, using Ctrl+click to place a square (straight line) point. Click and 
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drag  to reposition an existing point. Click Delete to remove the last–placed point. 
Right-click when the area is complete. The selection box will show you the extent of the 
block. Freehand Point Select may be easier to use than Freehand Select for precise 
selections. Click to deselect.

Use Add to Selection  with any select function to increase the selected area, or use Remove From 

Selection  to make the currently selected area smaller.
If the wrong area is selected, click in the active window, but outside the selected area, to start making a 
new selection.
To resize, click and drag one of the corner resize handles as desired. Rotate the selection to 
any degree with the rotate handle. Click and drag inside the selection to move it to a new 
position in the picture.

After selection, move, delete, cut, copy, resize, rotate, or mirror the selection. Crop the 
picture so that only the selected area remains. Apply image effects to enhance or adjust 
only the selected area.

Freehand Point Select is enabled until another tool is activated. Right-click to deselect.

You may need to right-click twice if you have not completed the current selection.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SP

Select an Area with Freehand Point Select
1 Click the Freehand Point Select icon . The pointer changes to the Freehand Point pointer .
2 Click to place the first point for the selection. A yellow square node appears.
3 Click to place a series of points around the desired area.

As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

4 Use Ctrl+click to place square nodes for straight lines.
5 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.

If you click while the Freehand Point pointer  is active, another point will be added to the line.
6 When your line is as desired, right-click to surround the area with a selection box.
7 Right-click to deselect Freehand Point Select.

Ellipse Select
Use Ellipse Select  to select an area of the picture by drawing a circle or ellipse with a 
rectangular selection box around it. 

Use Pick Color  before using any select tool to set the correct background color, then use Exclude 
Background if desired.
Click Ellipse Select and the pointer changes to the ellipse select pointer . Click and drag 
around the area that you want to select.

If the wrong area is selected, click in the active window, but outside the selected area, to deselect.
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To resize, click and drag one of the corner resize handles as desired. Rotate the selection to 
any degree with the rotate handle. Click and drag inside the selection to move it to a new 
position in the picture.

Use Add to Selection  with any select function to increase the selected area, or use Remove From 

Selection  to make the currently selected area smaller.

After selection, move, delete, cut, copy, resize, rotate, or mirror the selection. Crop the 
picture so that only the selected area remains. Apply image effects to enhance or adjust 
only the selected area.

Ellipse Select is enabled until another tool is activated. Right-click to deselect.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SE

Select an Area with Ellipse Select
1 Click Ellipse Select .
2 Click and drag around the desired area of the picture. The selection will be shown by the dashed 

selection box.
3 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new ellipse around the required area.
4 Ellipse Select is enabled until another tool is activated, or you right-click to deselect it.

Magic Wand Select
The Magic Wand  selects an area of similar color to where you clicked. The color, hue 
and brightness are used when making this selection. 

Use Pick Color  before using any select tool to set the correct background color, then use Exclude 
Background if desired.
Click Magic Wand Select and the pointer changes to the magic wand pointer . 

If the wrong area is selected, click in the active window, but outside the selected area, to deselect.
Use the Tolerance settings to set the color variation for the Magic Wand selection. Select 
between No Tolerance, Low, Medium, Medium High and High.

The Magic Wand is enabled until another tool is activated. Right-click to deselect.

Use Add to Selection  with any select function to increase the selected area, or use Remove From 

Selection  to make the currently selected area smaller.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SW

Use Magic Wand Select
1 Click Magic Wand Select .
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2 Change the color sensitivity of the Magic Wand with Tolerance, by clicking 
on the desired setting in the drop-down menu.

3 Click on a color within your picture. Adjacent areas in the picture with a 
similar color to the area that you clicked are selected.
The selection will be shown by a dashed line.

4 If you want to make a new selection, click outside the current selection to 
deselect it. Then make a new selection.

5 The Magic Wand is enabled until another tool is activated, or you right-click to deselect it.

Invert Selection
When Invert Selection  is clicked all the currently selected areas become deselected, 
and the deselected areas become selected. 

This is useful when you want to apply an effect to everything except a small area.

If the wrong area is selected, click in the active window, but outside the selected area, to deselect.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SI, V

Exclude a Small Area when Selecting
1 Use one of the selection tools to select the area that you want to exclude from an effect.
2 Click Invert Selection .
3 The previously selected area becomes deselected, and the deselected area becomes selected.

Select All
Select All  is a one click function that selects all of the picture. This is useful to resize or 
reshape the entire picture.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SI, A

Select None
Use Select None  to deselect all of the picture.

Shortcuts
■ Paint Tab, Select; Status Bar: 
■ Keys: Alt, D, SI, N

Exclude Background
Use Exclude Background  to include or exclude areas matching the background color 
when making a selection using any of the selection tools.

Shortcuts
■ Paint Tab, Select: 
■ Keys: Alt, D, SK
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Replace Selection
Use Replace Selection  to replace the currently selected area with the new selection.

Replace a Selection
1 Place an image on the work area.
2 Use Box Select  (or another selection tool) to select an area.
3 Ensure that Replace Selection  is selected.

Replace Selection is initially selected.
4 Using Box Select , select a different area.

The new selection replaces your old selection.

Shortcuts
■ Paint Tab, Select: 
■ Keys: Alt, D, SR

Add To Selection
Use Add to Selection  to add the new selection to the currently selected area.

Add to a Selection
1 Place an image on the work area.
2 Use Box Select  (or another selection tool) to select an area.
3 Click Add to Selection .
4 Using Box Select , select a different area.

The new selection is added to your old selection.

Shortcuts
■ Paint Tab, Select: 
■ Keys: Alt, D, ST

Remove From Selection
Use Remove from Selection  to remove the new selection from the currently selected 
area.

Remove from a Selection
1 Place an image on the work area.
2 Use Box Select  (or another selection tool) to select an area.
3 Click Remove From Selection .
4 Using Box Select , select an area within your selection.

The new selection is removed from your original selection.

Shortcuts
■ Paint Tab, Select: 
■ Keys: Alt, D, SM

Resize Part of a Picture
When part of the picture has been selected with one of the selection tools, click and drag 
one of the corner resize handles to change the size of the area. When the pointer is over a 
resize handle the pointer changes to a double-headed arrow pointer . 
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Hold the Ctrl key down when resizing to keep the proportions the same. Hold the Shift key 
down to resize from the center. With selection tools other than Box Select, only the area 
that was selected is resized, even though the selection box appears rectangular.

If no part of the picture is selected, use the Resize  function to change the size of the whole picture.
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Resize and Crop the Picture
Resize
Use Resize  to increase or decrease 
the size of the whole picture. The 
Resize dialog box appears so you can 
enter a new picture size.

The Resize function only resizes the whole 
picture, so it does nothing if part of the 
picture is currently selected. If part of the 
picture has been selected, use the resize handles to resize the selection. See “Select and Resize Areas” on 
page 385. 
When the picture is resized it is automatically resampled. For example, if the picture size is 
increased, the resampling process interpolates (adds) pixels until the desired size is 
reached, matching the colors used to those already used in the picture. This produces a 
more pleasing result than if the pixels were simply expanded in size, which would produce 
a 'blocky' effect. However, it should be realized that whenever a picture is resized, some 
change occurs compared with the original.

A picture may be resized up to a maximum of 2000 pixels in each dimension.

Shortcuts
■ Paint Tab, Edit: 
■ Keys: Alt, D, I

Resize a Picture
1 Ensure that no part of the picture is selected.

When you use Resize  any selection is automatically deselected.
2 Click the Resize icon . The Resize dialog box will appear.
3 Move the slider bar until the desired width or height is shown, or type in the desired figure. The 

percentage related to the original picture is shown in the box to the right. For example if the width is 
increased from 1000 pixels to 1100, the Percentage of Original Width would be shown as 110%.

4 If the Proportional option is selected, the slider bars will move together to keep the Height and Width 
in proportion. Deselect Proportional to change the Height and Width separately.

5 Click OK when the desired size is shown. The picture will be resized and the new size will be shown on 
the status bar.

Crop
If you are going to use a picture in the ExpressDesign Wizard, it is recommended not to crop the picture 
with this Crop function. Instead, use the Rotate and Crop Picture page of the ExpressDesign Wizard to 
select the desired section of the picture.
Use Crop  to decrease the size of the picture by removing the parts that are not wanted. 
Use one of the selection tools, e.g. Box Select  or Freehand Select , to select the area 
of the picture that you wish to keep, then click the Crop icon . The parts of the picture 
outside the selection box are removed and the display adjusts to show the remaining part 
of the picture at the largest possible magnification.
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You must select an area of the picture before using Crop. Crop only removes rectangular areas of the 

picture, therefore the results will be the same whether you select the area using Box Select  or Freehand 

Select .

Shortcuts
■ Paint Tab, Edit: 
■ Keys: Alt, D, P

Rotate Part or All of the Picture
Rotate
Use Rotate  to rotate the whole picture by 
any degree. The Rotate dialog box appears so 
you can enter the rotation angle. 

The background color from the Color box is 
used for the background against which the 
picture is rotated. If desired, change the 
background color before rotating.

The Rotate function only rotates the whole picture, so it 
does nothing if part of the picture is currently selected. If 
part of the picture has been selected, use the rotate 
handle to rotate the selection. See Rotate Part of the 
Picture. To rotate part or all of the picture by exactly 90 
degrees, use Rotate 90 .

Shortcuts
■ Paint Tab, Edit: 
■ Keys: Alt, D, R

Rotate a Picture
1 Ensure that no part of the picture is selected.

Any selection will be automatically deselected.
2 Click Rotate  and the Rotate dialog box will appear.
3 Use the up and down arrows to select the desired angle of rotation, or enter the desired figure.

Because a rectangular picture is being rotated, a new background is seen around it. This is set to the 
background color in the Color box. If desired, change the color before rotating the picture.

4 When the rotation is as desired, click OK. The picture will be rotated and, if necessary, resized.

Rotate Part of the Picture
Rotate part of the picture using the Rotate Handle 
on the selection box.

To rotate part or all of the picture by exactly 90 degrees, use 
Rotate 90.

Rotate Part of a Picture
1 Select part of the picture using one of the selection tools.

Resize
Handle

Rotate
Handle

Selection
Box
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2 Click and drag the round rotate handle on the selection box to Rotate the area to any degree.
When an area is chosen with one of the selection tools, only the area that was selected is rotated, even if 
the selection box appears rectangular.

Rotate 90
Use Rotate 90  to rotate the selected part or all of the picture by 90 degrees. If no part of 
the picture has previously been selected, the whole picture is rotated. If part of the picture 
has been selected, only that area is rotated.

When an area is chosen with one of the selection tools, only the area that was selected is rotated, even if 
the selection box appears rectangular.

Shortcuts
■ Paint Tab, Edit: 
■ Keys: Alt, D, 9

Mirror
When an area is chosen with one of the selection tools, only the area that was selected is mirrored, even if 
the selection box appears rectangular.

Mirror Horizontally
Use Mirror Horizontally  to mirror the selected part or all of the picture from side to side. 
If no part of the picture has previously been selected, the whole picture is mirrored as 
soon as the function is chosen. If part of the picture has been selected, only that area is 
mirrored. 

Shortcuts
■ Paint Tab, Edit: 
■ Keys: Alt, D, MH

Mirror Vertically
Use Mirror Vertically  mirror the selected part or all of the picture from end to end. If no 
part of the picture has previously been selected, the whole picture is mirrored as soon as 
the function is chosen. If part of the picture has been selected, only that area is mirrored.

Shortcuts
■ Paint Tab, Edit: 
■ Keys: Alt, D, MV
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Delete
Use Delete  to delete the selected part of the picture from the screen. Delete does 
nothing if part of the picture is not currently selected. Use one of the selection tools to 
select part of a picture. The deleted area is replaced by the background color.

Shortcuts
■ Paint Tab, Clipboard: 
■ Keys: Alt, D, DE

Cut, Copy and Paste
Once objects have been selected with the selection tools, they can be cut and copied onto 
the clipboard. 

In the Paint window the part of the picture enclosed by the selection line will be selected.

Clipboard Block
When objects are copied they are placed on the Clipboard Block 
(usually called the clipboard). The selection of objects on the 
clipboard can be pasted as many times as desired within 
PREMIER+™ 2 Create.

Cut
Use Cut  to cut the selected part of the picture to the clipboard, where it can be pasted 
into the same file or a new picture. 

Cutting to the clipboard replaces the contents previously stored there. The area that is cut 
out is replaced by the background color.

Shortcuts
■ Paint Tab, Clipboard: 
■ Keys: Ctrl + X; Alt, D, X

Copy
Use Copy  to make a copy of the selected part or all of the picture and place it on the 
clipboard, where it can be pasted into the same file or a new picture.

Copying to the clipboard replaces the contents previously stored there.

Shortcuts
■ Paint Tab, Clipboard: 
■ Keys: Ctrl + C; Alt, D, C
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Paste
Use Paste  to place part or all of a picture that has been cut or copied to the clipboard 
onto the screen. The pasted area appears at the top left hand corner of the screen in a 
highlighted box, ready to be moved or altered.

Shortcuts
■ Paint Tab, Clipboard: 
■ Keys: Ctrl + V; Alt, D, V

Duplicate
Use Duplicate  to make a copy of the selected part or all of the picture, which is 
automatically pasted on the work area below and to the right of the original. 

Shortcuts
■ Paint Tab, Clipboard: 
■ Keys: Alt, D, DU

Undo and Redo
Undo
Use Undo  to reverse the last action that has been applied to the picture on the screen, 
such as moving, deleting or mirroring an area, drawing a line, box or ellipse, or an effect 
that has been applied. Undo can be used up to 10 times in the Paint window.

Only actions that change the picture can be reversed using Undo on the Picture window. For example, the 

Zoom commands and the Rotate , Resize  and Crop  functions in the Paint window also cannot 
be reversed with Undo.
The Undo and Redo steps are reset when a new picture is opened.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Z; Alt, 7

Redo
Use Redo  to reverse any actions that have been undone. Redo only works if nothing 
has happened after the last Undo. For instance, if you draw a line, then Undo and draw a 
rectangle then it is not possible to Redo the line because something different has 
happened instead. Redo can be used up to 10 times in the Paint window.

The Undo and Redo steps are reset when a new picture is opened.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Y; Alt, 8
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20Using Image Effects
Use Image Effects in the Paint window to change the picture and enhance the embroidery 
that is created; for instance, to make certain features stand out or improve the color 
representation of the picture. Effects act on the selected part or all of the picture.

Image Effects
The effect types are:

Luminosity Effects
■ Brightness
■ Contrast
■ Gamma

Color Effects
■ Saturation
■ Hue
■ Color Filter

Blur / Sharpen
■ Blur
■ Sharpen

Monochrome
■ Threshold

Cleaning
■ Outline Thinner
■ Find Outline
■ Expander
■ Despeckle

Select an Image Effect
1 Click the Effects drop-down arrow and a list of effects appears.
2 Click the desired effect type, then click Preview.
3 Adjust the effects until the Preview window at the right appears as desired.
4 Click OK and the effects will be applied.
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Luminosity Effects
The Luminosity Effects  page includes the Brightness, Contrast and Gamma sliders, and 
the Autolevel, AutoContrast, and Negative checkboxes.

For the best results, combine the use of the Luminosity Effects tools.

Shortcuts
■ Paint Tab, Effects: 
■ Keys: Alt, D, E, L

Brightness
The Brightness effect makes the selected part or all of a picture lighter or darker than the 
original. Use it to lighten pictures that are too dark.

Adjust Brightness from -10 to +10 in steps of 0.1. The default setting is 0.

Adjust Brightness for the whole picture, or use Box Select or another selection tool to choose an area of the 
picture to change.

Change the Brightness of a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Luminosity , and the Luminosity Effects page is displayed.
3 Adjust the Brightness between -10 and +10 relative to the starting point by typing in a number, using 

the left and right arrow keys, or by clicking and dragging the slider bar. To brighten the picture, move 
the slider to the right, use the right arrow key, or type a positive number in the box. To darken the 
picture, move the slider to the left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
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Contrast
The Contrast effect changes the amount of shading between areas for the selected part or 
all of a picture. Use it to make specific areas stand out. Adjust Contrast up to +10 or -10 
more or less than the original. Increasing the setting will increase the darkness of dark 
areas and the lightness of light areas.

Adjust Contrast from -10 to +10 in steps of 0.1. The default setting is 0.

Adjust Contrast for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change.

Change the Contrast in a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Luminosity , and the Luminosity Effects page is displayed.
3 Adjust the Contrast between -10 and +10 relative to the starting point by typing in a number, using 

the left and right arrow keys, or by clicking and dragging the slider bar. To increase, move the slider to 
the right, use the right arrow key, or type a positive number in the box. To decrease, move the slider to 
the left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.

Gamma
Use Gamma to adjust the brightness and contrast together so that dark areas are made 
brighter, but bright areas are not overexposed.

Adjust Gamma from 2 to 40 in steps of 1. The default setting is 10. Lower values will make 
the picture appear lighter.

Adjust Gamma for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change.

Adjust the Gamma in a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Luminosity , and the Luminosity Effects page is displayed.
3 Adjust the Gamma between 2 and 40 by typing in a number, using the left and right arrow keys, or by 

clicking and dragging the slider bar. To increase, move the slider to the right, use the right arrow key, 
or type a positive number in the box. To decrease, move the slider to the left, use the left arrow key, or 
type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.

Autolevel
Use Autolevel to adjust brightness and contrast in the picture automatically. Autolevel 
improves brightness and contrast in most pictures, and can be used to bring out the color 
in underexposed pictures. Autolevel is enabled by default.

Occasionally Autolevel does not improve the appearance of a picture, and may need to be switched off.

AutoContrast
Use AutoContrast to adjust the contrast between the bright and dark areas in the picture 
automatically, while retaining the detail. It can be used to sharpen a hazy picture. By 
default, AutoContrast is not selected.
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Negative
Negative inverts the luminosity of the picture, so that bright areas appear dark, and dark 
areas bright.

Reset
Reset the picture back to the original settings.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.
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Color Effects
The Color Effects  page enables you to adjust saturation and hue, and use color filters 
on the picture.

Shortcuts
■ Paint Tab, Effects: 
■ Keys: Alt, D, E, C

Saturation
The Saturation effect changes the amount of gray in the selected part or all of a picture. 
Adjust Saturation between -10 and +20. Increasing the setting enhances the intensity of 
colors in a picture, for instance, to make pale skin tones appear 'warmer'.

Adjust Saturation from -10 to +20 in steps of 0.1. The default setting is 0.

Adjust Saturation for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change. To turn part or all of a picture completely gray and create a grayscale effect, set 
saturation to -10.

Change the Saturation in a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Color , and the Color Effects page is displayed.
3 Adjust the Saturation between -10 (completely gray) and +20 relative to the starting point by typing 

in a number, using the left and right arrow keys, or by clicking and dragging the slider bar. To increase, 
move the slider to the right, use the right arrow key, or type a positive number in the box. To decrease, 
move the slider to the left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
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Hue
The Hue effect changes the shades of the colors in the picture. Adjust Hue between -180 
and +180.

A small adjustment can make considerable changes to the color of a picture.
Adjust Hue from -180 to +180 in steps of 1. The default setting is 0.

Adjust Hue for the whole picture, or use Box Select or another select tool to choose an area of the picture to 
change. To tint a picture with a specific color, use a Color Filter.

Change the Hue in a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Color , and the Color Effects page is displayed.
3 Adjust the Hue between -180 and +180 relative to the starting point by typing in a number, using the 

left and right arrow keys, or by clicking and dragging the slider bar. To increase, move the slider to the 
right, use the right arrow key, or type a positive number in the box. To decrease, move the slider to the 
left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.

Color Filter
Tint the picture using the selected color filter. The available picture filters are:

• Sepia (this is the default filter)
• Red
• Yellow
• Green
• Cyan
• Blue
• Magenta
• Spring (green-yellow tones)
• Summer (red-orange tones)
• Fall (brown-gold tones)
• Winter (blue-white tones)

Use the slider to set the intensity of the color tint. The default setting is 0% (no tint). 100% 
uses only the shades of the selected filter color.

Adjust a Color Filter from 0% to 100% in steps of 1. The default setting is 0%.

Use a Color Filter for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change.

Use a Color Filter
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Color , and the Color Effects page is displayed.
3 Select a color filter from the drop-down list.
4 Adjust the color tint between 0% (no tint) and 100% (your selected color) relative to the starting point 

by typing in a number, using the left and right arrow keys, or by clicking and dragging the slider bar. 
To increase, move the slider to the right, use the right arrow key, or type a positive number in the box. 
To decrease, move the slider to the left, use the left arrow key, or type a negative number in the box.

5 When the picture in the preview window at the right appears as desired, click OK.
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Reset
Reset the picture back to the original settings.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.
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Blur / Sharpen
The Blur / Sharpen  effect enhances or blurs the edges between differently colored 
areas in the selected part or all of a picture, by altering the contrast between pixels 
adjacent to defined lines and shaded areas. Use the Blur / Sharpen effect to change the 
focus of a picture.

Adjust sharpness for the whole picture, or use Box Select or another selection tool to choose an area of the 
picture to change.
Adjust Sharpness between -10 and 10 in steps of 0.1. The default setting is 0.0.

Shortcuts
■ Paint Tab, Effects: 
■ Keys: Alt, D, E, B

Blur or Sharpen a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Blur / Sharpen , and the Blur / Sharpen dialog box is displayed.
3 Adjust the Sharpness between -10 and 10 by typing in a number, using the left and right arrow keys, 

or by clicking and dragging the slider bar. To sharpen the picture, move the slider to the right, use the 
right arrow key, or type a positive number in the box. To blur the picture, move the slider to the left, 
use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.

Reset
Reset the picture back to the original settings.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
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or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.
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Monochrome
The Monochrome effect  turns all shades or colors in the selected part or all of a picture 
into either black or white. It acts on the whole picture, or a selected area. The 
Monochrome effect is useful to create defined color areas that you can then color with the 
painting tools for artistic effects.

Adjust the Monochrome Threshold between 0 and 255 in steps of 1. The default setting is 
127.

Use Monochrome on the whole picture, or use a selection tool to choose an area of the picture to change.

Shortcuts
■ Paint Tab, Effects: 
■ Keys: Alt, D, E, M

Change a Picture to Monochrome
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Monochrome , and the Monochrome dialog is displayed.
3 Adjust the Monochrome Threshold between 0 and 255 by typing in a number, using the left and right 

arrow keys, or by clicking and dragging the slider bar. To make more of the picture black, move the 
slider to the right, use the right arrow key, or type a higher number in the box. To make more of the 
picture white, move the slider to the left, use the left arrow key, or type a lower number in the box. 

4 When the picture in the preview window at the right appears as desired, click OK.

Reset
Reset the picture back to the original settings.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
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or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.
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Cleaning
The Cleaning effects  are:

• Outline Thinner
• Find Outline
• Expander
• Despeckle

Shortcuts
■ Paint Tab, Effects: 
■ Keys: Alt, D, E, N

Outline Thinner
Use Outline Thinner to reduce the thickness of the selected color area to one pixel only. 
The new outline will be halfway between the adjoining color areas, as they are widened to 
allow the selected color to be narrowed. The function works on any continuous color area 
within the picture, but it is most often used to thin an outline so that there are smaller 
gaps between areas of the picture. This can produce a more pleasing picture. The thinning 
process produces a thinner outline that is more suitable for the QuickStitch™ features.

Reduce the Thickness of an Outline
1 Click Open Picture  and open Thineg.bmp from Documents\Premier+2\Samples \Create\Pics. 

The black outline around the flower is relatively thick and looks unnatural. Use the Outline Thinner to 
make the black area narrower.

2 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
3 Click Cleaning , and the Cleaning Effects dialog is displayed.

If you do not select a line color with Pick Color, the current line color will be used. If this color is not used in 
the picture, the Outline Thinner will have no effect.

4 Use Pick Color  in the Static area to select the desired line color from the picture.
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Be careful where you click when using Pick Color. The color you click on is the color that will be thinned. If 
you click on a fill area, this area will be thinned and the outline around it will be thickened to compensate. 
Click Reset and try again.

5 Click the Outline Thinner checkbox.
6 In the preview pane the picture is redrawn with the thickness of the black outline reduced to one 

pixel. The green and yellow areas have become wider, as has the blue background. The new black 
outline runs through the center of the old one.

7 When the picture in the preview window at the right appears as desired, click OK.
The Outline Thinner tool may not work if your picture has dithering, for example a scanned image or one 
that has been converted from a JPEG file.

Reset
Reset the picture back to the original settings.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.
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Find Outline
Find Outline finds the outlines around color areas in the picture. This may turn solid lines 
in the picture into paired outlines. The color of the original area is used for the outline, and 
the area inside each outline is filled with the background color.

Find the Outline in a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Cleaning , and the Cleaning Effects dialog is displayed.
3 Use Pick Color  in the Static area to select the desired background color from the picture.

Alternatively, select the desired Background color in the Color panel before opening the Cleaning Effects 
dialog.

4 Select Find Outline by clicking the checkbox. In the preview pane, color areas in the picture will have 
been turned into outlines.

5 When the picture in the preview window at the right appears as desired, click OK.
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Expander
Expander increases the width of lines in the picture.

Expand the Width of Lines in a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Cleaning , and the Cleaning Effects dialog is displayed.
3 Use Pick Color  in the Static area to select the desired background color from the picture.

If the current background color is not used in the picture, the Expander will have no effect.
4 Either use the up and down arrows, or enter a number between 1 and 5 representing the width of the 

line to be used in pixels.
5 When the number is as desired, select (check) the Expander checkbox. In the preview pane all parts of 

the picture, except the background color, will be 1 or more pixel wider on each side (that is, a 
between 2 and 6 pixels wider). This will make all lines against the background color wider.

6 When the picture in the preview window at the right appears as desired, click OK.

Despeckle
Despeckle removes small spots from the picture anywhere between 1 and 99 pixels in size. 
The initial setting is 4 pixels.

It is useful for pictures that have been scanned.

Despeckle a Picture
1 Click the Effects drop-down arrow in the Paint tab and a list of effects appears.
2 Click Cleaning , and the Cleaning Effects dialog is displayed.
3 Either use the up and down arrows, or enter a number representing the size in pixels of the largest 

spot(s) to be removed.
4 When the number is as desired, select (check) the Despeckle checkbox. The picture should appear 

less speckled. 
If some of the detail that you wish to use to create your embroidery has been removed, click Reset. Then 
choose a smaller number and select Despeckle again.

5 When the picture in the preview window at the right appears as desired, click OK.
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21Preferences
Use Preferences  to set stitch length for single and motif stitches, and color tolerance 
and screen options. When these are changed, the new settings will be remembered when 
PREMIER+™ 2 Create is closed and reopened.

Shortcut
■ File Menu: 

General Preferences
Choose whether or not to use color tolerance, and the stitch length for single stitches 
when broken up.

Color Tolerance
Selecting the Color Tolerance option causes the Color Tolerance dialog to appear when 
any of the QuickStitch™ or QuickTrace functions are used. It allows parts of a picture to be 
selected for filling or tracing according to how similar they are in color to the chosen color.

This option is initially selected.

Single Stitches

Break Up
Select Break Up to break long Single Stitches into Running Stitches at the length set in 
Maximum Stitch Length.

Maximum Stitch Length
Set the maximum Single Stitch length from 1 to 12mm in steps of 1mm. The initial setting 
is 6mm.
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Single Stitches will be broken up into stitches of this length, unless the setting is altered in the properties 
box.

Creating Stitches Preferences
Select whether or not to automatically add tie stitches, the maximum stitch length for 
motifs, and the stitch length for Felting Needle color effects.

Tie Off Before and After Trims
Select this option to automatically add a tie stitch before and after a Trim.

When this option is not selected, no ties are automatically added.
This option is initially selected.

Minimum Gap to Add Trim
Set the minimum gap between objects to automatically add a trim.

Maximum Stitch Length for Motif
Set the maximum length of motif stitches used in motifs from 1 to 20mm in steps of 
0.1mm. The initial setting is 2mm.

Felting Needle Color Effect
Set the stitch length for Felting Needle stitches. These settings are used whenever a felting 
needle color is selected in PREMIER+™ 2 Create.

Break Up
Break up Felting Needle stitches into a preset minimum length.

Stitch Length
Set the stitch length for Felting Needle stitches from 0.1mm to 6.0mm in steps of 0.1mm. 
The initial setting is 0.4mm.
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22Printing
In different parts of the program you can print a design template, a picture background, or 
a drawing.

Print: Design Window
Use the Print options for the Design window to choose what to print. Any combination of 
embroidery worksheet, plan view and an individually printed picture can be selected.

The Print Setup button presents a Print Setup dialog box, where you specify the printer 
and its connection.

At least one of the main print options, Print Worksheet, Print Plan View or Print Picture, must be selected or 
there will be nothing to print. If none of these options is selected, the Print button will be grayed out 
(unavailable).

Shortcuts
■ QuickAccess Toolbar: 

Print
Click Print to open the Print page and print the project. See “Print” on page 418.

Worksheet
Select whether to print a worksheet, and the information to be printed on the worksheet, 
such as the Dimensions, Color Information, Notes and Technical Information. In addition, 
the scale may be altered and a grid turned on or off.

Print Worksheet
Select this option to print a worksheet for the embroidery. Use the Worksheet Options to 
alter the appearance and contents of the printed worksheet.

Select information

Select measurement units

Choose scale, grid & flip
Print worksheets

Preview the printout

Print a plan of the project

Print the background picture
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Design Scale
Select 25%, 50%, 75% or 100% scaling when printing your embroidery. This is how large 
the embroidery will print compared to the real size of a stitched out embroidery. Use a 
reduced Design Scale if you want to ensure that the worksheet fits on one page. Use the 
Print Preview on the right to see how many pages will be printed.

Grid
This determines whether or not a grid will be printed with the embroidery. If you turn this 
off you will still get a rectangle representing the hoop.

Flip design for felting or reverse embroidery
Flip the embroidery for being stitched in reverse, or for felting effects. 

Print Information
This determines what additional information is printed. All items are selected initially.

Dimensions
The size of the embroidery and the stitch count.

Hoop
The hoop used for the embroidery.

Color Information
The sequence of thread colors used and, if available, the thread specification (range and thread 
number). Stop Commands and their text (where present) are also shown.

Decoration Information
Information on the decorations used in PREMIER+™ 2 Embroidery Extra, and their size, 
color and number.

Notes and Settings
Any notes or settings that are included with the embroidery.

Export Options
The Export options used for the embroidery, as set in the Export dialog box.

Technical Information
The distance of each edge of the embroidery from the center of the embroidery.

Plan
Select whether to print a Plan View, and choose how to print the embroidery when you 
print the plan view. Use the plan view as a guide for aligning the embroidery to the 
picture.

Print Plan View
Select this option to print a plan view of the picture, with either the whole embroidery or 
the alignment stitches printed over the picture. When stitching out, use the plan view as a 
guide for aligning the embroidery to the picture.
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Print Whole Embroidery
The whole embroidery will be printed on the plan view. If there are alignment stitches 
under the embroidery, they may be obscured by the embroidery.

Print Alignment Stitches Only
Only the alignment stitches (if present) in the first color block in the embroidery will be 
printed. If the alignment stitches will be obscured by the rest of the embroidery, choose 
Print Alignment Stitches Only. Otherwise, it is generally better to choose Print Whole 
Embroidery.

Picture

Print Picture
Select this option to print a page that shows only the picture.

When you are ready to print the picture onto printable fabric or an iron-on transfer, select 
only this option. That is, deselect Print Worksheet and Print Plan View. This is so that you 
can load your printer with the printable fabric or transfer, without printing the worksheet 
or plan view first.

The picture can optionally be flipped and/or have the colors faded by 50%.

Flip Picture for Iron-On Tee Shirt Transfer
Use this option if you are printing onto iron-on transfer paper, instead of printing directly 
onto the fabric. This is typically used for transferring the picture to a tee-shirt. Using iron-
on transfer paper flips the picture, so use this option to flip it back again, ensuring that the 
picture is correctly orientated when it is ironed onto the tee-shirt.

Fade Picture
Use this option to fade the picture by 50%, if desired. This will make the threads stitched 
over the picture stand out.

Fade Picture affects both the plan view and the individually printed picture.

Align Picture To
Use this option to position the printed picture on your printable fabric or transfer paper. If 
you have a small picture, you can use this option to conserve the printable media by 
moving the printed picture to the top or bottom of the page. Alternatively, use center 
alignment to make hooping up easier.

Choose from Center, Top or Bottom. Use Print Preview to verify the size and position if you 
have already printed on the other part of the media.

Units of Measurement
Set the Units of Measurement for the Dimensions and Technical Information to mm or 
inches, as desired.
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Print Setup
Click the Print Setup button to see the Print Setup dialog box that is used to select the 
printer, what paper to use and the paper orientation.

Print: Draw Window

Select whether to alter the scale or turn the grid on or off.

The Print Setup button presents a Print Setup dialog box, where you specify the printer 
and its connection.

Shortcuts
■ File Tab/Menu: Print Drawing

Print
Click Print to open the Print page and print the drawing. See “Print” on page 418.

Design Scale
Select 25%, 50%, 75%, 100%, or Fit to Page scaling when printing your drawing. This is 
how large the drawing will print compared to the real size of the drawing. Use a reduced 
Design Scale if you want to ensure that the drawing fits on one page. The preview shows 
how many pages will be printed.

Print Scale
This determines whether the design scale will be printed with the drawing.

Grid
This determines whether or not a grid will be printed with the drawing.

Print Setup
Click the Print Setup button to see the Print Setup dialog box that is used to select the 
printer, what paper to use and the paper orientation.

Select the drawing scale
Print the scale with the drawing

Print the grid with the drawing
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Print Setup
This is displayed when you click the Print Setup button in the Print dialog box. Use Print 
Setup to select the destination printer and its connection.

Printer
Select the printer you want to use.

Paper Size
Select the size of paper that the embroidery is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Orientation
Choose Portrait or Landscape. Generally, you should not need Landscape for the standard 
hoop sizes as the embroidery is rotated automatically by the print process when you print 
an embroidery that uses a Rotated hoop.

Properties
Displays a dialog box that provides additional printing choices, specific to the type of 
printer you have selected.

Print

Print the embroidery displayed on the PREMIER+™ 2 Create preview. Other information, 
such as the Dimensions, Color Information, Notes and Technical Information is printed 
depending on the choices made in Page Setup. The scale may also be altered and a grid 
turned on or off in Page Setup. If possible, the hoop will be printed with the same 
orientation as on the screen. If a horizontal hoop is too wide to fit on the paper at the 
Design Scale chosen in Page Setup then the hoop will be rotated 90 degrees when it is 
printed.

The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options.
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Printer
Select the printer you want to use.

Properties
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Print to File
When this option is checked, you will be prompted for a file name after you click OK. The 
print job will then be saved with the file name you specify and can be sent to the printer at 
a later time.

This is an advanced Windows® printing option.

Print Range
Select the range of pages you wish to print.

Copies
Select the number of Copies you wish to print. If you choose to print more than one copy, 
you can choose to Collate the copies.
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23Quick Reference Guide

Design Window
Ribbon Tabs

File Tab/Menu
New Clear the screen ready to create or load a new design.

Ctrl + N

New Window Open an additional PREMIER+™ 2 Font Create window.
Ctrl + Shift + N

Open Open an existing design, replacing the design on the screen.
Ctrl + O

Save Save the design with the same name.
Ctrl + S; Alt, 2

Save As Save the design under a new name.
Ctrl + Shift + S; Alt, 3

Export Save the embroidery in the current window as a flattened .vp4 file, or in 
an alternative embroidery format.
Ctrl+ E; Alt, 4

Export Appliqué 
Pieces

Save or print appliqué outlines ready for cutting by a fabric cutter or 
INSPIRA™ Cutwork Needles.
Ctrl + Shift + E

Send Express Send the selected design to the screen of the connected embroidery 
machine.
Ctrl + K

Send Send the selected design to the MyFiles or Personal Files folder of the 
connected embroidery machine.
Ctrl + Shift + K

Send to 
mySewnet™

Send the selected embroidery to the mySewnet™ cloud for your 
mySewnet™ enabled embroidery machine.
Ctrl + W

Send to 
Machine via 
mySewnet™

Send the selected embroidery to your mySewnet™ enabled embroidery 
machine via the mySewnet™ cloud.

Insert Insert an existing design into your current project.
Ctrl + I; Alt + 1

Print Set printing options, preview and print the selected design(s) and 
background.

Recent Open recently used designs.

Preferences Set the stitch and screen options.

Exit Close the current window and prompt to save new and changed 
designs.
Alt + F4
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Home Tab
Clipboard

Copy Copy the selected objects to the clipboard, without affecting the 
current selection.
Ctrl + C; Alt, H, CO, CO

Copy Embroidery
Copy the design as an embroidery for use in another PREMIER+™ 2 
Embroidery System module.
Ctrl + Shift + C; Alt, H, CO, CE

Paste Paste the objects on the clipboard back into the design.
Ctrl + V; Alt, H, P, PA

Paste Into Center
Paste the objects on the clipboard into the center of the work area. 
Ctrl + Shift + V; Alt, H, P. PI

Paste and Replace
Paste the objects on the clipboard, replacing the currently selected 
objects. 
 Alt, H, P, PR

Paste Into Window
Paste the objects on the clipboard into a new window. 
 Alt, H, P, PW

Cut Cut out the selected objects and place them on the clipboard.
Ctrl + X; Alt, H, X

Duplicate Make a copy of the selected objects, which is automatically pasted on 
the work area below and to the right of the original.
Ctrl + D; Alt, H, DU

Delete Delete the selected object or the last object in the design.
Delete; Alt, H, DE

Select
Box Select Select a block of objects by drawing a rectangle.

Alt, H, B

Freehand Select Select a block of objects by drawing a line around the required objects.
Alt, H, FS

Freehand Point 
Select

Select a block of objects by clicking a series of points to create an 
irregular outline of straight or curved lines around the required 
objects.
Alt, H, FP

Select All Visible Select all visible objects as a single block.
Ctrl + A; Alt, H, SA

Select None Deselect all of the objects in the work area, including any outside the 
hoop.
Ctrl + Shift + A; Alt, H, SN

Replace 
Selection

Replace the currently selected designs with the new selection.
Alt, H, RS

Add To 
Selection

Add the new selection to the currently selected designs.
Alt, H, A
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Remove From 
Selection

Remove the new selection from the currently selected designs.
Alt, H, RF

Group Group selected objects together so they may be moved, resized or 
scaled and rotated together.
Alt, H, G

Ungroup
Ungroup a selected group so that each object may edited 
independently.
Alt, H, U

Rotate 45 Rotate the selected block of objects by 45 degrees.
Alt, H, R4

Modify Block Show and change the size and rotation of the currently selected block.
Alt, H, M, M

Scale to Fit Hoop
Resize the design in the work area proportionally to fit within the 
boundaries of the hoop.
Alt, H, M, S

Points
Edit Points Use Edit Points to enable the moving and editing of an object’s points 

if another function is being used. 
Return; Alt, H, E

Insert Points Add a new point to the currently selected line.
Ctrl + Shift + D; Alt, H, IP

Delete Points Delete points from the currently selected line.
Ctrl + D; Alt, H, DP

Insert
Insert Insert outline designs (.edo and .can files) into the current design by 

name or number. 
Alt, H, IN

Insert 
Embroidery

Insert embroidery files by name or number.
Alt, H, IE

Insert Lettering Insert lettering from PREMIER+™ 2 Embroidery System fonts.
Alt, H, IL

Insert 
ExpressDesign

ExpressDesign into Rectangle
Create a design automatically to fit in the selected area.
Alt, H, IR, IR

ExpressDesign into Hoop
Create a design automatically to fit in the hoop.
Alt, H, IR, IH

Insert 
SuperDesign

Insert a SuperDesign from the SuperDesign sets available in 
PREMIER+™ 2 Create
Alt, H, IS

Hoop
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Change Hoop Choose the hoop size you wish to use in PREMIER+™ 2 Create.
Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Life View Show how an embroidery exported from the project will look in 3D 
with real-world perspective. Share a picture or video of your design on 
your favorite social media site.
Ctrl + L; Alt 9; Alt, H, L

Design Player Play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery. Share a picture or video of your 
design on your favorite social media site.
Ctrl + J; Alt 0; Alt, H, J
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Quick Create Tab
Command

Color Change Insert a Color Change after the currently selected object.
Alt, Q, C, C

Pick Color
Choose a color from the background picture to set a new thread 
color.
Alt, Q, C, P

Quick Colors
Click one of the Quick Colors to set a new thread color.

Fill Area and Line

Fill Create a fill.

Pattern Fill
Create a fill area with small stitches in a repeating pattern.
Alt, Q, F, P

Motif Fill
Create a fill area with one or two motif stitches in a repeating 
pattern.
Alt, Q, F, M

Shape Fill
Create a fill area where the stitching lines follow one of 75 shapes, 
using motif lines if desired.
Alt, Q, F, S

Radial Fill
Create a fill area that radiates out from the center.
Alt, Q, F, R

Spiral Fill
Create a fill area that follows a spiral path from the center.
Alt, Q, F, L

QuiltStipple Fill
Create a stippled fill area.
Alt, Q, F, Q

Contour Fill
Create a fill area that follows the contours of the outline.
Alt, Q, F, C

Crosshatch Fill
Create a crosshatched fill area.
Alt, Q, F, X

Curved Crosshatch Fill
Create a curved crosshatched fill area.
Alt, Q, F, H

MultiWave Fill
Create a MultiWave fill area.
Alt, Q, F, U

Echo Fill
Create an Echo fill area.
Alt, Q, F, E
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Line Create a line or border.

Running Stitch
Create a border of running stitches (small consecutive stitches). 
Alt, Q, L, R

Double Stitch
Create a border of double stitch (small stitches going forward, 
followed by small stitches going backward).
Alt, Q, L, D

Double Zigzag
Create a line of small stitches going forward, followed by zigzag 
stitches going backward.
Alt, Q, L, Z

Triple Stitch
Create a border of triple stitch (small three-part stitches, each 
composed of one stitch going forward, one going backward then 
one going forward).
Alt, Q, L, T

Satin Line
Create a border of satin stitches of constant width.
Alt, Q, L, S

Motif Line
Create a border of motif stitches.
Alt, Q, L, M

Appliqué Use appliqué for the area.

Select Appliqué Fabric
Open the Appliqué Selection dialog box to select an appliqué 
fabric.
Alt, Q, A, F

QuickStitch™ Fill the selected area with stitches automatically.
Alt, Q, Q

QuickStitch™ + 
AutoHole

Fill the selected area with stitches and create holes automatically.
Alt, Q, H

Shape Select one of 75 shapes to draw as a fill area with or without a 
border, or as a closed line, on the work area.
Alt, Q, S; Alt, Q, P

Enhance
QuickStitch™ 
Hole

Insert a hole automatically in the selected fill area.
Alt, Q, U

Emboss Line

Freehand Emboss Line
Draw one or more embossed lines of needle points over the 
selected object(s).
Alt, Q, E, F

Precise Emboss Line
Place points to define one or more embossed lines of needle points 
over the selected object(s).
Alt, Q, E, P
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MultiWave Line

Freehand MultiWave Line
Draw one or more MultiWave lines within the selected MultiWave 
Fill object.
Alt, Q, W, F

Precise MultiWave Line
Place points to define one or more MultiWave lines within the 
selected MultiWave Fill object.
Alt, Q, W, P

Trace
Trace

Double Trace
Create a layer of double stitch, with running stitch where necessary, 
automatically following the selected line.
Alt, Q, T, D

Quadruple Trace
Create a layer of running and a layer of triple stitches automatically 
following the selected line.
Alt, Q, T, Q

Satin Line Trace
Create satin stitches of fixed width automatically following the 
selected line.
Alt, Q, T, S

Motif Line Trace
Create a line of motif stitches automatically following the selected 
line.
Alt, Q, T, M

Satin Area
QuickStitch™ Satin
Create a satin area automatically in the selected area.
Alt, Q, K

QuickStitch™ Multiple Satin
Create a multiple part satin area automatically in the selected areas.
Alt, Q, M

Options
Fill Area and 
Line

Open the options dialog for the fill area and line.
Alt, Q, OF

Satin Area Open the options dialog for the satin area.
Alt, Q, OS
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Freehand Create Tab
Command

Color Change Insert a Color Change after the currently selected object.
Alt, R, C, C

Pick Color
Choose a color from the background picture to set a new thread 
color.
Alt, R, C, P

Quick Colors
Select one of the 32 Quick Colors.

Single Stitch Insert Single Stitches of variable length.
Alt, R, N

Alignment Stitch Insert an alignment stitch.
Alt, R, G

Stop Insert a Stop after the currently selected object.
Alt, R, P

Fill Area and Line

Fill Create a fill.

Pattern Fill
Create a fill area with small stitches in a repeating pattern.
Alt, R, F, P

Motif Fill
Create a fill area with one or two motif stitches in a repeating 
pattern.
Alt, R, F, M

Shape Fill
Create a fill area where the stitching lines follow one of 75 shapes, 
using motif lines if desired.
Alt, R, F, S

Radial Fill
Create a fill area that radiates out from the center.
Alt, R, F, R

Spiral Fill
Create a fill area that follows a spiral path from the center.
Alt, R, F, L

QuiltStipple Fill
Create a stippled fill area.
Alt, R, F, Q

Contour Fill
Create a fill area that follows the contours of the outline.
Alt, R, F, C

Crosshatch Fill
Create a crosshatched fill area.
Alt, R, F, X
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Curved Crosshatch Fill
Create a curved crosshatched fill area.
Alt, R, F, H

MultiWave Fill
Create a MultiWave fill area.
Alt, R, F, U

Echo Fill
Create an Echo fill area.
Alt, R, F, E

Line Create a line or border.

Running Stitch
Create a border of running stitches (small consecutive stitches). 
Alt, R, F, R

Double Stitch
Create a border of double stitch (small stitches going forward, 
followed by small stitches going backward).
Alt, R, F, D

Double Zigzag
Create a line of small stitches going forward, followed by zigzag 
stitches going backward.
Alt, R, F, Z

Triple Stitch
Create a border of triple stitch (small three-part stitches, each 
composed of one stitch going forward, one going backward then 
one going forward).
Alt, R, F, T

Satin Line
Create a border of satin stitches of constant width.
Alt, R, F, S

Motif Line
Create a border of motif stitches.
Alt, R, F, M

Appliqué Use appliqué for the area.

Select Appliqué Fabric
Open the Appliqué Selection dialog box to select an appliqué 
fabric.
Alt, R, A, F

Create Freehand 
Area or Line

Fill an area with stitches by drawing a line around it.
Alt, R, R

Enhance
Freehand Hole Cut out holes within the selected fill area, by drawing outlines to 

define the holes.
Alt, R, H

Freehand 
Emboss Line

Draw one or more embossed lines of needle points over the 
selected object(s).
Alt, R, E



PREMIER+™ 2 Font Create   Quick Reference Guide              429

Precise Create Tab

Freehand 
MultiWave Line

Draw one or more MultiWave lines within the selected MultiWave 
Fill object.
Alt, R, W

Column
Freehand Satin 
Area

Draw an outline to create a satin area.
Alt, R, T

Satin Column Place alternate points to define a column of satin.
Alt, R, S

Feathered Satin Place alternate points to define a column of feathered satin.
Alt, R, D

Richelieu Bars Place alternate points to define a column of Richelieu bars (short 
sections of satin perpendicular to the direction of the column).
Alt, R, B

Tapered Motifs Place alternate points to define a line of motifs that vary in size 
according to the width of the column.
Alt, R, M

Options
Fill Area and 
Line

Open the options dialog for the fill area and line.
Alt, R, OF

Satin Area Open the options dialog for the satin area.
Alt, R, OS

Column Open the options dialog for the column. Choose from: Satin 
Column, Feathered Satin, Richelieu Bars and Tapered Motifs.
Alt, R, OC

Command
Color Change Insert a Color Change after the currently selected object.

Alt, P, C, C

Pick Color
Choose a color from the background picture to set a new thread 
color.
Alt, P, C, P

Quick Colors
Select one of the 32 Quick Colors.

Single Stitch Insert Single Stitches of variable length.
Alt, P, N

Alignment Stitch Insert an alignment stitch.
Alt, P, G

Stop Insert a Stop after the currently selected object.
Alt, P, P

Fill Area and Line

Fill Create a fill.



430          PREMIER+™ 2 Font Create   Quick Reference Guide 

Pattern Fill
Create a fill area with small stitches in a repeating pattern.
Alt, P, F, P

Motif Fill
Create a fill area with one or two motif stitches in a repeating 
pattern.
Alt, P, F, M

Shape Fill
Create a fill area where the stitching lines follow one of 75 shapes, 
using motif lines if desired.
Alt, P, F, S

Radial Fill
Create a fill area that radiates out from the center.
Alt, P, F, R

Spiral Fill
Create a fill area that follows a spiral path from the center.
Alt, P, F, L

QuiltStipple Fill
Create a stippled fill area.
Alt, P, F, Q

Contour Fill
Create a fill area that follows the contours of the outline.
Alt, P, F, C

Crosshatch Fill
Create a crosshatched fill area.
Alt, P, F, X

Curved Crosshatch Fill
Create a curved crosshatched fill area.
Alt, P, F, H

MultiWave Fill
Create a MultiWave fill area.
Alt, P, F, U

Echo Fill
Create an Echo fill area.
Alt, P, F, E

Line Create a line or border.

Running Stitch
Create a border of running stitches (small consecutive stitches). 
Alt, P, L, R

Double Stitch
Create a border of double stitch (small stitches going forward, 
followed by small stitches going backward).
Alt, P, L, D

Double Zigzag
Create a line of small stitches going forward, followed by zigzag 
stitches going backward.
Alt, P, L, Z
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Triple Stitch
Create a border of triple stitch (small three-part stitches, each 
composed of one stitch going forward, one going backward then 
one going forward).
Alt, P, L, T

Satin Line
Create a border of satin stitches of constant width.
Alt, P, L, S

Motif Line
Create a border of motif stitches.
Alt, P, L, M

Appliqué Use appliqué for the area.

Select Appliqué Fabric
Open the Appliqué Selection dialog box to select an appliqué 
fabric.
Alt, P, A, F

Create Precise Area or Line
Fill an area with stitches by placing points around it.
Alt, P, R

Enhance
Precise Hole Cut out holes within the selected fill area, by placing points to 

define the holes.
Alt, P, H

Precise Emboss 
Line

Place points to define one or more embossed lines of needle points 
over the selected object(s).
Alt, P, E

Precise 
MultiWave Line

Place points to define one or more MultiWave lines within the 
selected MultiWave Fill object.
Alt, P, W

Satin Area
Precise Satin 
Area

Place points to create a satin area.
Alt, P, T

Enhance
Satin Column Place alternate points to define a column of satin.

Alt, P, S

Feathered Satin Place alternate points to define a column of feathered satin.
Alt, P, D

Richelieu Bars Place alternate points to define a column of Richelieu bars (short 
sections of satin perpendicular to the direction of the column).
Alt, P, B

Tapered Motifs Place alternate points to define a line of motifs that vary in size 
according to the width of the column.
Alt, P, M

Options
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Fill Area and 
Line

Open the options dialog for the fill area and line.
Alt, P, OF

Satin Area Open the options dialog for the satin area.
Alt, P, OS

Column Open the options dialog for the column. Choose from: Satin 
Column, Feathered Satin, Richelieu Bars and Tapered Motifs.
Alt, P, OC
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Edit Tab
Display Range

Draw Previous 
Color Block

Step through the color blocks in reverse order.
Alt, E, P

Draw Next Color 
Block

Step through the color blocks one at a time.
Alt, E, N

Display All 
Objects

Display all objects and commands in the design.
Alt, E, A

Draw Range The upper slider bar sets the Draw From Start object. The lower 
slider bar sets the Draw To End object. Move the appropriate slider 
bar to change the start or end object. Objects are not displayed 
when the color block containing the objects is hidden.

Only Selected Show only the currently selected object.
Alt, E, Y

Only From Start Show only the currently visible objects from the start to the 
selected object.
Alt, E, S

Only To End Show only the currently visible objects from the selected object to 
the end of the design.
Alt, E, E

Hide Object Types
Lines Show and hide Running, Double and Triple Stitches, Tapered Motifs 

and Motif Lines.
Alt, E, HL

Fills Show and hide pattern fill areas, motif fill areas and shape, radial, 
spiral, QuiltStipple, contour and crosshatch fill areas.
Alt, E, HF

Satin Areas Show and hide satin areas.
Alt, E, HA

Columns Show and hide Satin Columns, Richelieu bars, feathered satin and 
satin lines.
Alt, E, HC

Single Stitches Show and hide Single Stitches and Alignment Stitches.
Alt, E, HS

Stops and 
Colors

Show and hide Color Change and Stop commands.
Alt, E, HP

Groups Show and hide Groups and all their contents.
Alt, E, HG

Appliqués Show and hide Appliqué areas.
Alt, E, HQ

Object
Delete

Delete Hole
Delete one or more holes from the currently selected area.
Alt, E, D, H
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Paint Tab
See “Paint Window” on page 441.

Delete Emboss Line
Delete one or more embossed lines from the currently selected 
area.
Alt, E, D, E

Delete MultiWave Line
Delete one or more MultiWave lines from the currently selected 
MultiWave fill area.
Alt, E, D, W

Break Apart Break a complex object into its constituent parts.
Alt, E, B

Reversal

Reverse Column End to End
Reverse the order of all the points defining a column so that the 
start becomes the end and vice versa.
Alt, E, R, E

Reverse Column Side to Side
Swap each pair of points within a column. 
Alt, E, R, S

Reverse Line
Reverse the order of the points defining a line so that the start 
becomes the end, and vice versa.
Alt, E, R, L

Manage My Fills Load new pictures for fill patterns, export an existing My Fill pattern 
as a picture and delete unwanted My Fills.
Alt, E, F

Select Similar from Visible
Select all visible objects with similar properties.
Alt, E, M, V

Select Similar from Group
Select all objects with similar properties that are in the same Group.
Alt, E, M, G

Properties Display the properties for the selected object.
Alt, E, O

Global 
Properties

Change the properties of all visible objects of a selected type.
Alt, E, G
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View Tab

Help Tab

Grid
Show Grid Show or hide the background grid, and set its size.

Show Grid: Alt, V, G; Size: Alt, V, S

Get Length Measure the distance between any two points on the work area.
Alt, V, L

Background
Fade Use the slider to Hide, Fade or Show the background image.

View Mode
3D View View objects as embroidery stitches.

Ctrl + T; Alt, V, 3

2D View View objects as individual stitches with no shading.
Ctrl + R; Alt, V, 2

Object View  View the outline of the objects in the design.
Ctrl + R; Alt, V, O

Hoop
Change Hoop Choose the hoop size you wish to use in PREMIER+™ 2 Create.

Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Panels
Show Design 
Panel

Show the Design Panel.
Alt, V, D

Show FilmStrip View the Filmstrip.
Alt, V, F

Help Topics List help topics.
F1; Alt, L, H

Internet FAQs Use the Internet to access answers to Frequently Asked Questions on 
the software.
Alt, L, I

Learning Center View interactive training tutorials and videos on the Internet.
Alt, L, L

Purchase Center Purchase additional modules on the Internet.
Alt, L, P

About PREMIER+™ 2 
Font Create

Display module information, version number and copyright.
Alt, L, A
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Design Window — FilmStrip
FilmStrip Items

Thread Color Bar
The color bar shows the color of each object, even when the Color Changes are hidden.

Object
Each object is represented graphically. Markers are shown for Color Changes, Alignment 
Stitches and Stops. A Color Change also shows a thread sample. All other object types 
show the shape of the objects as black outlines.

Object Type
The name of the object type is shown.

Layout Order
Move Forwards Bring one step closer to the front of the design.

Move Backwards Bring one step closer to the back of the design.

Move to Front Place at the front of the design.

Move to Back Place at the back of the design.

Display Group 
Contents

Switch between viewing the objects within Groups in the FilmStrip, 
and seeing only the Group heading rows in the FilmStrip.

Select Last Visible Select the last object that has not been hidden by Color Select, any 
of the object Filters, or the End slider.
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FilmStrip Context Menu
Display Only 
Selected

Show only the currently selected object or group of objects.

Display Only From 
Start

Display only the visible objects from the start of the design to the 
selected object. Hence, all objects after the selected object are 
hidden.

Display Only To 
End

Display only the visible objects from the selected object to the end 
of the design. Hence, all objects before the selected object are 
hidden.

Display All Objects Display all objects and commands in the design.

Cut Cut out the selected objects and place them on the clipboard.
Ctrl + X

Copy Copy the selected objects to the clipboard, without affecting the 
current selection.
Ctrl + C

Paste Paste the objects on the clipboard back into the design.
Ctrl + V

Duplicate Make a copy of the selected objects, which is automatically pasted 
on the work area below and to the right of the original.

Delete Delete the selected object or the last object in the design.
Del.

Insert Color 
Change

Insert a Color Change after the currently selected object. The Color 
Selection dialog box appears so you can choose the new color.

Insert Stop Insert a Stop after the currently selected object.

Group Group selected objects together so they may be moved, resized or 
scaled and rotated together.

Ungroup Ungroup a selected group so that each object may edited 
independently.

Select Similar 
from Visible

Select all visible objects with similar properties.

Select Similar 
from Group

Select all objects with similar properties that are in the same Group.

Properties Show the properties dialog box for the selected object.

Global Properties Show the properties dialog box for the selected type of object, to 
change the properties of all visible objects of that type.

Layout Order

Move Forwards
Bring one step closer to the front of the design.
Ctrl + [; Alt, L, F
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Design Window — Design Panel

Design Information
Stitch Count : The Stitch Count of the embroidery.

Height : The Height of the embroidery.

Width : The Width of the embroidery.

Colors : The number of colors in the embroidery.

Color Select
A worksheet panel showing the color blocks in the design. It is used to change the thread 
color and add thread or needle effects, show which color blocks are visible and turn the 
display of color blocks on and off.

Use Design Property Colors  to show or hide thread colors in the Color Select area that 
are part of an object’s property; for example, colors in multigradient density fill areas or 
satin columns.

Notes
Enter up to 2000 characters in the Notes for information and keywords about the design.

Settings
Enter up to 2000 characters in the Settings for information on the techniques used for the 
design.

Edit
Click Edit to update the Notes or Settings by using the dialog box.

Clipboard Block
The Clipboard Block shows the current selection that can be pasted into the work area.

Overview Window
The overview window gives a small overview of the whole work area for the current 
embroidery and background.

Move Backwards
Bring one step closer to the back of the design.
Ctrl + ]; Alt, L, B

Move to Front
Place at the front of the design.
Ctrl +Shift + [; Alt, L, N

Move to Back
Place at the back of the design.
Ctrl + Shift + ]; Alt, L, C
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Toolbars
Quick Access Toolbar

Status Bar
Use the Select Tools on the Status Bar to select objects in your design.

Insert Insert an existing design into your current project.
Ctrl + I; Alt, 1

Save Save the design with the same name.
Ctrl + S; Alt, 2

Save As Save the design under a new name.
Ctrl + Shift + S; Alt, 3

Export Save the design in the current window as a flattened .vp4 file, or in an 
alternative embroidery format.
Ctrl+ E; Alt, 4

Print Print the selected design(s) and background. To set page options, use 
File, Print.
Ctrl + P; Alt, 5

Change Hoop Choose the hoop size you wish to use in PREMIER+™ 2 Create.
Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Undo Undo the last action.
Ctrl + Z; Alt, 7

Redo Redo the previously undone action.
Ctrl + Y; Alt, 8

Life View Show how an embroidery exported from the project will look in 3D 
with real-world perspective. 
Ctrl + L; Alt, 9; Alt, H, L

Design Player Play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery.
Ctrl + J; Alt, 0; Alt, H, J

Edit Points Use Edit Points to enable the moving and editing of an object’s points 
if another function is being used. 

Box Select Select a block of objects by drawing a rectangle.

Freehand Select Select a block of objects by drawing a line around the required objects.

Freehand Point 
Select

Select a block of objects by clicking a series of points to create an 
irregular outline of straight or curved lines around the required 
objects.

Select All Visible Select all visible objects as a single block.
Ctrl + A

Select None Deselect all of the objects in the work area, including any outside the 
hoop.
Ctrl + Shift + A
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Use the Zoom Commands on the Status Bar to navigate around designs.

QuickLink Toolbar
For information about the contents of the QuickLink toolbar, please refer to the 
PREMIER+™ 2 Embroidery Guide.

Zoom

Zoom To 
Rectangle

Increase magnification of an area of the design.
Ctrl + 0

Zoom To Fit Fit work area to screen.
Ctrl + 9

100%
Display picture at 100% magnification.
Ctrl + 1

200%
Display picture at 200% magnification.
Ctrl + 2

400%
Display picture at 400% magnification.
Ctrl + 3

800%
Display picture at 800% magnification.
Ctrl + 4

75%
Display at 75% magnification.
Ctrl + 5

50%
Display at 50% magnification.
Ctrl + 6

25%
Display at 25% magnification.
Ctrl + 7

Zoom Out Decrease magnification.
Ctrl + -

Zoom In Increase magnification.
Ctrl + =
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Paint Window
File Tab/Menu

Paint Tab

New Clear the screen ready to create or load a new design.
Ctrl + N

New Window Open an additional PREMIER+™ 2 Create window.
Ctrl + Shift + N

Open Picture Open an existing picture, replacing the picture on the screen.
Ctrl + O

Insert Picture Insert an existing picture into your current project.

From Scanner or 
Camera

Display the program that is used to acquire pictures from the selected 
scanner, digital camera or other suitable device. 

Send To Wizard Send the picture to the ExpressDesign Wizard to create a new design.
Ctrl + K

Save As Picture Save the picture with a new name.
Ctrl + S

Preferences Set the stitch and screen options.

Exit Close the current window and prompt to save new and changed 
designs.
Alt + F4

Clipboard
Copy Copy the selected part or all of the picture and place it on the 

clipboard, where it can be pasted into the same file or a new picture.
Ctrl + C; Alt, D, C

Paste Paste part or all of a picture that has been cut or copied to the 
clipboard onto the screen.
Ctrl + V; Alt, D, V

Cut Cut out the selected part of the picture to the clipboard, where it can 
be pasted into the same file or a new picture.
Ctrl + X; Alt, D, X

Duplicate Make a copy of the selected part or all of the picture, which is 
automatically pasted on the work area below and to the right of the 
original.
Ctrl + D; Alt, D, DU

Delete Delete the selected part of the picture.
Delete; Alt, D, DE

Select
Box Select Select part or all of the picture by drawing a rectangle.

Alt, D, SB

Freehand Select Select part or all of the picture by drawing a line around the required 
area.
Alt, D, SF
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Freehand Point 
Select

Select part or all of the picture by clicking a series of points to create an 
irregular outline of straight or curved lines around the required area.
Alt, D, SP

Ellipse Select Select an elliptical area of the picture.
Alt, D, SE

Magic Wand 
Select

Select an area of the picture of similar color to the point where you 
click. Use the Tolerance settings to set the color variation for the Magic 
Wand selection.
Alt, D, SW, 1-5

Invert Selection

Invert Selection
Select everything outside the current selection.
Alt, D, SI, V

Select All
Select all of the picture.
Ctrl + A; Alt, D, SI, A

Select None
Deselect all of the picture.
Ctrl + Shift + A; Alt, D, SI, N

Exclude 
Background

Include or exclude areas matching the background color when making 
a selection.
Alt, D, SK

Replace 
Selection

Replace the currently selected area with the new selection.
Alt, D, SR

Add To 
Selection

Add the new selection to the currently selected area.
Alt, D, ST

Remove From 
Selection

Remove the new selection from the currently selected area.
Alt, D, SM

Edit
Resize Change the size of the picture.

Alt, D, I

Crop Crop the picture, leaving only the selected area.
Alt, D, P

Rotate Rotate the picture to any degree.
Alt, D, R

Fill Background 
to Hoop

Fill the empty areas between the picture and the hoop boundaries 
with the selected background color.
Alt, D, L, B

Mirror 
Horizontally

Flip the picture or selected area from side to side.
Alt, D, MH

Mirror Vertically Flip the picture or selected area from end to end.
Alt, D, MV

Rotate 90 Rotate the picture or selected area by 90 degrees.
Alt, D, 9

Effects
Effects



PREMIER+™ 2 Font Create   Quick Reference Guide              443

Paint Window Control Panel

Color Select Section

Color Box
Use the Color Box to select the foreground color (for left-click drawing) and background 
color (for right-click drawing). To select a color not shown in the Color palette double-click 
on either of the colors in the Color box to bring up the Colors dialog box. To select a color 
from the picture on the screen use the Pick Color function.

Theme
Select a color theme from the drop-down list.

Color Palette
The Color Palette provides 32 commonly used colors. A color is placed in the Color Box if 
you click on it, or right-click to choose a background color.

Luminosity Effects
Change Brightness, Contrast and Gamma for the picture, and select 
Autolevel, AutoContrast or Negative.
Alt, D, E, L

Color Effects
Change Saturation, Hue and Color Filter for the picture.
Alt, D, E, C

Blur / Sharpen
Enhance or blur the edges between differently colored areas.
Alt, D, E, B

Monochrome 
Turns all shades or colors into either black or white.
Alt, D, E, M

Cleaning
Use Despeckle, Find Outline, Expander or Outline Thinner on the 
picture.
Alt, D, E, N

View
Show Grid Show or hide the background grid.

Alt, D, G
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Paint Section

Clipboard Block
The Clipboard Block shows the current selection that can be pasted into the work area.

Overview Window
The overview window gives a small overview of the whole work area for the current 
picture and background.

Paintbrush Paint lines on the picture that follow the movement of the pointer.

Line Draw a straight line with the selected line width.

Calligraphy Click and drag to draw sculptured lines on the picture.

Shapes Add a shape to your picture.

Flood Fill Fill an area with the selected color.

MiniPics Select and add mini clipart pictures to the picture.
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Design Window — Font Control Panel

Create / Update Thumbnails
Select Create / Update Thumbnails to generate thumbnails automatically from 
SuperDesigns.

Character Set
Select the desired character set from the drop-down list.

Select the character or SuperDesign to be created or edited from the table of characters or 
SuperDesigns. 

Use Previous Page  and Next Page  to view the previous and next pages of characters in the font.

Create or Edit Font Start or modify a font or SuperDesign set.

Save Save any changes to the selected font or SuperDesign set.
Ctrl + S

Export As EDO Save the current font character or SuperDesign file as an EDO file to 
load into PREMIER+™ 2 Create or insert into another font or 
SuperDesign set.

Size Options Set the recommended minimum and maximum size for the font or 
SuperDesign set.

Universal Properties Standardize the use of object types within a font, change all objects 
of one type to another type, define the objects that can be edited in 
other modules, and compress the font.

Multiple Character 
Copy

Duplicate a range of characters within your font.

Move Guidelines Move the guidelines and baseline for the font. 

Show Font Grid Show or hide the dotted grid for designing characters.

Snap to Grid Force points to snap to position according to the font grid spacing.

Navigation Insert a Navigation object required for Space characters.

Font Background Choose any of the TrueType® and OpenType® fonts installed on your 
computer as a background for creating a font.

Insert Points on 
Straight Lines

Add points to straight lines that have few points on them, to improve 
kerning and results with curved line types. 
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Nearest Point

Thumbnail

Preview Size
Use the slider to set the font display size and the size used for Export As EDO, or Export 
Embroidery. 

Help
Show help for the control panel.

Bottom Left to 
Bottom Right

Select character that joins bottom left to bottom right.

Top Left to Top 
Right

Select character that joins top left to top right.

Bottom Left to Top 
Right

Select character that joins bottom left to top right.

Top Left to Bottom 
Right

Select character that joins top left to bottom right.

Open Picture Open an image file to use as a thumbnail for the current 
SuperDesign.

Save Picture Save an image file used as the thumbnail for the current 
SuperDesign.
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Index
Numerics
16-bit High Color.............................................. 375
2 Cutwork Needles .......................................... 318
24-bit or 32-bit True Color ............................ 375
256+...................................................................... 130
2D View................................................................ 140
3D View................................................................ 140
4 Cutwork Needles .......................................... 318
45 Degree Rotate ............................................. 358
90 Degree Rotate ............................................. 394

A
Abbreviation

Thread Name........................................... 144
About......................................................................... 2

MiniPics ..................................................... 383
Acquire Picture........................................ 196, 374
Add

Background Picture.............................8, 12
Quick Color Theme................................ 201

Add To Selection .................................... 354, 390
Advisor ................................................................. 121
Align Picture To................................................. 416
Alignment

Stitches ................................................. 84, 94
Alignment Stitch Style.................................... 184
Alignment Stitches .......................................... 184

Crosses....................................................... 184
Alignment Stitches Only................................ 416
All

Select.......................................................... 389
Alter Color in Color Box.................................. 377
Angle .......................................................... 236, 247

Background Picture..................... 191, 197
Block Rotation......................................... 359
Fill ................................................................ 236
Fill Pattern................................................. 236
For Satin Areas ........................................ 344

Angle Line
Delete......................................................... 344
Last.............................................................. 344

Angle Lines............................................... 342, 344
Animals 1 — Patterns 37 to 48.................... 369
Animated Demo ............................................... 163
Apart

Break........................................................... 349
Appliqué..............................31, 84, 87, 186, 199

Fabric................................................ 183, 186
Options...................................................... 128

Appliqué Pieces
Export......................................................... 179

Appliqué Selection .......................................... 186
Area

Get Length Of.......................................... 159
Make Block from Visible ...................... 353
Traveling Stitches Outside.................. 238
Types .............................................................79

Area and Line Properties ..................................86
Area Properties ....................................................86
Area Sensitivity ............................. 119, 124, 127
Areas ........................................................................96

Fill ................................................................... 80
Motif Fill ....................................................... 80
Move Origin ..............................................344
Move Start and End Points ..................343
Remove All Background Color ...........118
Satin..................................................... 82, 152
Select and Resize ..........................385, 395
Tie Off Between Automatically ..........413

Arrow Keys...........................................................342
Arrows — Patterns 49 to 60 ..........................369
Ascender ................................................................ 65
ASCII......................................................................... 65
AutoContrast ......................................................399
AutoHole

QuickStitch™ +.........................................210
Autolevel..............................................................399
Automatically

Picked Colors............................................130
Remove Background Color .................118
Tie Off Between Areas...........................413

B
Back Up

Font File........................................................ 11
SuperDesign File ....................................... 14

Background.........................................................142
Name...........................................................194
Remove Main Only.................................118
Select Type................................................133
Size...............................................................193
Wizard...............................................189–194

Background Color ...................................118, 376
Automatically Remove .........................118
Current........................................................118
Draw Lines.................................................380
Pick...............................................................118
Remove All Areas ....................................118
Swap with Foreground .........................377

Background Colors
Remove Multiple.....................................119

Background or Foreground Color ...............378
Background Picture....................................... 8, 12

Draw window............................................. 99
Backwards

Move..................................................156, 339
Bar

Scroll............................................................155
Thread Color ...................................155, 436
Zoom...........................................................168

Bars
Richelieu ....................................................308

Baseline ..............................................5, 24, 40, 65
Baseline Fonts ...................................................... 15
Basic Character Set ............................................. 18
Basic Color Order ..............................................117
Bells........................................................................171
Bezier Mode ................................................ 79, 222

Convert Points .........................................346
Black Lines ...........................................................119
Block

Clipboard.........................................362, 395
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Deselect..................................................... 351
Draw Next................................................. 150
Draw Previous ......................................... 149
Horizontally Flip ..................................... 357
Insert or Paste.......................................... 351
Make from Visible Area ........................ 353
Modify........................................................ 359
Rotation Angle........................................ 359
Vertically Flip ........................................... 357

Block Letter G .......................................................34
Block of Objects

Copy............................................................ 361
Cut ............................................................... 360
Mirror.......................................................... 357
Modify........................................................ 357
Move........................................................... 357
Nudge ........................................................ 357
Paste ........................................................... 361
Resize ......................................................... 357
Rotate......................................................... 358
Select.......................................................... 350

Blue ....................................................................... 204
Color Filter ................................................ 402

Blue Handles ...................................................... 351
Blur ........................................................................ 404
Border

Express................................................98, 103
Satin Width..................................................93
Type ............................................................ 126

Border Properties
Satin............................................................ 325

Borders
Satin...............................................................84

Bottom ................................................................. 416
Bottom Left Corner.......................................... 185
Bottom Right Corner....................................... 185
Boundaries

Between Color Areas ............................ 109
Strong Color............................................. 109

Boundaries Between Color Areas............... 109
Box Select.................................................. 352, 385
Break Apart......................................................... 349
Brightness ........................................................... 398
Browse

Thumbnails of Pictures ........................ 373

C
Calligraphy.......................................................... 380
Camera............................................. 196, 374, 441
Cap Height.............................................................65
Category...................... 244, 245, 251, 277, 327

Curved Crosshatch Fill.......................... 273
Font............................................................. 364

Center
Paste Into .................................................. 361

Center Alignment............................................. 416
Center Motifs 1 and 2 ..................................... 246
Center of Rotation ................................. 357, 358
Central Point ............................................ 326, 329
Change

Color ................................................. 143, 181
Existing Thread Color ................. 144, 181
File Extension .......................................... 383
Fill Properties........................................... 216
Hoop........................................................... 113
Object Settings ....................................... 337

Satin Area Properties...................293, 295
Sequence of Objects ...................156, 338
Size of Whole Picture.............................391
Stitch Angle for Satin Areas ................344
Thread.........................................................117

Change All To .....................................................117
Change Design Size .........................................360
Character.........................................................43, 65

Editing .......................................................... 43
Insert ...........................................................364
Samples........................................................ 34
Select Nearest Point Version................. 44
Sets ................................................................ 17

Character Set
Basic............................................................... 18
Cyrillic 1 ........................................................ 21
Cyrillic 2 ........................................................ 21
Extended...................................................... 19
Hiragana 1 ................................................... 22
Super-Extended ........................................ 20
Western 1..................................................... 21
Western 2..................................................... 21
Western 3..................................................... 21
Western 4..................................................... 21

Character Table.................................................... 43
Check Nearest Point Font................................. 73
Choose

Design Type ..............................................103
Drawing Colors ........................................376
New Drawing Color................................378
New Thread Color...................................203
Object to Edit ...........................................342
Picture...............................................105, 195
Thread Colors ...........................................116

Choose Picture
Background Wizard................................189

Circle
Draw ............................................................381

Circles 1 — Patterns 61 to 72........................369
Circles 2 — Patterns 73 to 84........................369
Click and Drag in FilmStrip ............................338
Climate — Patterns 85 to 96 .........................369
Clipboard Block .......................................362, 395
Close ...........................................................................2

PREMIER+ Embroidery...............................2
Closed Border76, 317, 319, 321, 323, 325, 329
Color ........................................................................ 33

16-bit...........................................................375
24-bit or 32-bit.........................................375
Automatically Remove Background 118
Background ..............................................118
Bar ................................................................155
Change Existing Thread .............144, 181
Choose New Drawing ...........................378
Choose New Thread ..............................203
Commands................................................153
Current Background ..............................118
Draw Lines in Background...................380
Edit ...............................................................202
False.............................................................119
Foreground or Background ................378
Information...............................................415
Last Thread................................................158
Models ..............................................204, 379
Order ...........................................................117
Palette.....................................376, 377, 443
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Paste ........................................................... 203
Pick.......................................... 143, 181, 377
Pick Background..................................... 118
Pictures ...................................................... 130
Select.......................................................... 438
Selection ............................... 116, 130, 144
Strong Boundaries................................. 109
Thread.................................... 124, 126, 203
Thread Preview ............................. 119, 122

Color Areas
Distinctive Boundaries......................... 109
Remove All Background...................... 118

Color Bar.............................................................. 436
Color Block

Draw Next................................................. 150
Draw Previous ......................................... 149

Color Box............................................................. 376
Alter Color................................................. 377

Color Change........................................... 143, 181
Insert ................................................ 158, 338
Marker........................................................ 144
Properties ................................................. 182

Color Change and Stop.................................. 338
Color Effects ....................................................... 401
Color Filter .......................................................... 402
Color Selection Dialog.................................... 144
Color Tolerance ....................................... 205, 412

Off...................................................................78
On...................................................................77

Color Tolerance and QuickStitch™ ............. 206
Color Tolerance and QuickTrace ................. 206
Color Worksheet ............................................... 148
Colors.............................................................26, 438

Automatically Picked............................ 130
Choose Drawing..................................... 376
Choose Thread........................................ 116
Dialog Box ...................................... 203, 378
Foreground and Background ............ 376
Number of ...................................... 116, 130
Reduce....................................................... 130
Reduced Preview ................................... 131
Remove Multiple Background........... 119
Swap Foreground and Background 377

Column ................................................................ 300
Continuous............................................... 300
Create Satin.............................................. 300

Column Properties..............................................89
Command

Insert Color..................................... 158, 338
Insert Stop ...................................... 158, 338

Commands .......................................................6, 84
Color and Stop ........................................ 153
Insert .......................................................... 338
Using .......................................................... 181

Compensation.............................................. 27, 91
Fill ................................................................ 236
Satin Area.................................................. 296

Complex Color Pictures ................................. 130
Compress ...............................................................50
Consistency ...........................................................26
Constant Width Satin...................................... 123
Context Menu.................................................... 437
Continuous............................................................40
Continuous Column........................................ 300
Continuous Fonts................................................16
Continuous Satin.................................... 302, 313

Contour
Fill ................................................................... 81

Contour Fill Options.........................................264
Contrast ................................................................399
Control Panel

Font..............................................................445
Picture Window.......................................443

Control Points....................................................... 71
Convert ................................................................... 49

Object Types............................................... 96
Convert Points....................................................346
Convert Points to Corner................................346
Convert Points to Smooth .............................346
Convert Points to Symmetric........................347
Convert to Bezier Line.....................................348
Convert to Point Line.......................................347
Convert to Satin Area ......................................302
Copies

Print Number............................................419
Copy.......................................................................395

Block of Objects ......................................361
Color ............................................................202
Embroidery ...............................................172
Multiple Characters.................................. 51
Objects .......................................................360
Picture.........................................................395

Copy Diacritic by Character............................. 52
Copy Diacritic by Shape.................................... 52
Copy Lower to Upper Case.............................. 52
Copy Upper to Lower Case.............................. 52
Corner Miter.......................................................... 30
Corner Mitering .................................................218
Create

Designs.......................................................169
Embroideries .............................................. 97
Freehand............................................ 78, 316
MiniPics ......................................................383
New MiniPic from Blank Picture ........383
QuickStitch™ and QuickTrace77, 186, 205
QuickStitch™ Satin Area .......................289
Satin Column............................................300

Create / Update Thumbnails........................... 45
Create Cursor......................................................313
Create Freehand Area or Line.......................216
Create Precise Area or Line............................217
Creating

Fonts.................................................................7
SuperDesigns ................................................7

Creating Fonts...................................................... 37
Creating Shapes .................................................. 78
Crop .......................................................................392

Picture.........................................................107
Picture for Fabric .....................................191

Crop Box...............................................................197
Crop Picture

Load Picture Wizard...............................197
Crosses

Alignment..................................................184
Place on Picture.......................................184

Crosshatch
Curved ........................................................271
Fill ................................................................... 81

Crosshatch Fill Properties...............................266
Current Background Color.............................118
Curved...................................................................261
Curved Crosshatch Fill............................. 82, 271
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Properties ................................................. 271
Curved Lines ...................................................... 343
Custom Color..................................................... 204
Cut ......................................................................... 395

Block of Objects...................................... 360
Objects....................................................... 360
Picture........................................................ 395

Cutwork ............................................................... 318
Cutwork Needle...................................... 147, 318
Cutwork Needle Line ...................................... 178
Cyan

Color Filter ................................................ 402
Cyrillic 1 Character Set ......................................21
Cyrillic 2 Character Set ......................................21

D
Database ................................................................65
Decoration Information................................. 415
Delete ............................................... 118, 286, 395

All................................................................. 118
Angle Lines............................................... 344
Emboss Line............................................. 349
Hole............................................................. 348
My Fill Pattern ......................................... 286
Object .............................................. 158, 338
Point ........................................................... 345
Quick Color Theme................................ 203
Wave Line.................................................. 349

Demo.................................................................... 163
Density ....................................................................91

Fill Properties........................................... 237
Gradient ................................ 237, 258, 303
Normal ............................................. 237, 257
Radial Fill ................................................... 255
Satin Area.................................................. 296
Satin Border ............................................. 325
Shape Fill......................................... 250, 276

Descender..............................................................66
Deselect Block ................................................... 351
Design

Aids ................................................................23
Choose Type ............................................ 103
Considerations...........................................26
Edit .............................................................. 335
Fit to Hoop................................................ 113
Information ................ 121, 124, 127, 163
Load ............................................................ 132
Load Existing ....................................99, 104
Load with Drag and Drop ................... 172
Open Existing .......................................... 132
Scale.................................................. 415, 417
Transfer Elements .................................. 172
With no Picture ................................99, 104

Design at Different Sizes...................................97
Design Information ......................................... 438
Design Player ..................................................... 161

Video Speed............................................. 166
Design Property Colors .................................. 182
Design Size ......................................................... 113

Enter ........................................................... 114
Design Size and Creating Embroideries......97
Design Underlay............................................... 121
Design Window ..................................................... 3

FilmStrip .................................................... 436
Font Control Panel................................. 445

Designing Fonts...................................................15

Designing with PREMIER+™ Create .............. 75
Designs

Create..........................................................169
Find ..............................................................135
Grouping....................................................355
Manage ......................................................169
Open............................................................170
Open Recently Used ..............................172
Save .............................................................173
Step Through ...........................................336
View .............................................................140

Desktop Shortcuts.................................................1
Despeckle ............................................................411
Detail Level in Picture......................................119
Details

Interior ........................................................111
Diacritic

Copy .............................................................. 52
Diagonal Corners

Echo Fill ......................................................284
Diamond

Curved Crosshatch Fill ..........................271
Diamonds — Patterns 97 to 108 .................370
Different Sizes ...................................................... 97
Digital Camera ...............................196, 374, 441
Digitize

First SuperDesign ..................................... 13
Letter A ............................................................9
Other Characters..........................................9
Other SuperDesigns ................................ 13

Digitizing
Characters and SuperDesigns.............. 69

Dimensions .........................................................415
Display

All..................................................................157
All Objects .................................................150
From Start........................................151, 157
Selected ...........................................151, 157
To End ...............................................151, 157

Display Group Contents .................................340
Distance

Between Secure Points .........................318
Double Stitch

Properties ..................................................319
Double Stitch - Stop - Satin ......... 87, 128, 199
Double Trace.......................................................213
Double with Zigzag Return...........................321
Double Zigzag....................................................321
Drag and Drop to Load Design ....................172
Draw ......................................................................376

All Objects .................................................150
Back to Start Point ..............216, 218, 293
Circle............................................................381
Left-Click ....................................................376
Lines in Background Color ..................380
Next Color Block......................................150
Outline....................................216, 218, 292
Previous Color Block ..............................149
Range ..........................................................150
Right-Click .................................................376
Shapes ........................................................380
Shapes From Center ..............................381
Square.........................................................381
Tablet Mode...................................... 78, 207

Draw a Circle in Bezier Mode ........................223
Draw a Flower using Bezier Curves ............227
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Draw Range........................................................ 433
Draw Window.............................................99, 104

Background Picture..................................99
Drawing Color

Choose....................................................... 376
Choose New............................................. 378

Drop Shadow with Two Colors.......................33
Dual Thread........................................................ 145
Duplicate................................................... 362, 396

E
Echo

Fill ...................................................................81
Echo Area ............................................................ 283
Echo Fill................................................................ 282
Echo Lines................................................. 282, 283
Edge

Feathered.....................................................94
Edit

Choose Object ........................................ 342
Color ........................................................... 202
Design........................................................ 335
Object Outlines....................................... 341
Page ............................................................ 433
Pictures ...................................................... 385
Quick Color Theme................................ 203
Select Object ........................................... 336

Edit a Bezier Line .............................................. 224
Edit Points ........................................................... 342
Editing

Characters....................................................43
Editing Fonts.........................................................37
EDO

Export As......................................................41
EDO File ..................................................................41
Effects ............................................................33, 145

Color ........................................................... 401
Hand Stitch............................................... 184
Image ......................................................... 397
Luminosity................................................ 398
Special...........................................................93

Effects and Filters ............................................. 397
Ellipse

Select.......................................................... 387
Emboss

Point ........................................................... 219
Tablet.......................................................... 219

Emboss Line
Delete......................................................... 349

Embroideries
Design Size and Creating.......................97
Insert .......................................................... 362

Embroidery
Copy............................................................ 172
Express................................................98, 103
Navigate .................................................... 167
On Heavy Knit Fabric .91, 237, 257, 325
On Linen.........................91, 237, 257, 325
On Satin.................. 91, 92, 237, 257, 325
On Thick Fabric .... 91, 92, 237, 257, 325
On Twill.........................................................92
Print Whole............................................... 416

Enclosed Shapes in Picture........................... 111
End ...........................................................................93
End Marker ............................................... 342, 343
End Point................................................... 326, 329

End Point for Area.............................................343
Enter Angles

Curved Crosshatch Fill ..........................272
Enter Design Size ..............................................114
Enter Size .............................................................114
Exclude Background ........................................389
Existing Design

Load..................................................... 99, 104
Open............................................................132

Existing Picture ..................................................383
Existing Thread Color ............................144, 181
Exit.......................................................................2, 42
Expand..................................................................109
Expand Pixel-Thin Lines ..................................119
Expander ..............................................................411

Outline Finder ..........................................109
Explorer ................................................................172
Export..........................................................174, 285
Export Appliqué Pieces...................................179
Export as EDO....................................................... 41
Export Options...................................................415
Express Border ........................................... 98, 103

Options.......................................................126
Express Embroidery ................................. 98, 103

Options.......................................................116
Express Trace .............................................. 98, 103

Options.......................................................123
ExpressDesign Wizard ....................................... 98

Insert From................................................100
Stitch Objects Created ............................ 85

Extended Character Set.................................... 19
Extensions for File Types ................................383

F
Fabric .....................................................................121

Appliqué ....................................................183
Embroidery on Heavy Knit91, 237, 257, 

325
Embroidery on Thick91, 92, 237, 257, 325
Rotate and Crop Picture .......................191

Fabric Advisor.....................................................121
Fabric and Stitch Type Options....................121
Facebook......................106, 165, 166, 190, 196
Fade Picture ........................................................416
Fall

Color Filter .................................................402
False Color ...........................................................119
Favorites ................................................................. 88
Feather

Both Sides..................................................307
Top ...............................................................307

Feather Both Sides............................................305
Feather One Side...............................................305
Feathered

Edge............................................................... 94
Feathered Satin..................................................305
Feathers

Fleur de Lys ...............................................312
Felting Needle....................................................147
Felting Needle Color Effect............................413
File

Back Up..................................................11, 14
Extension ...................................................383
Formats ...........................................................5
Hide Extensions.......................................383
Name...........................................................170
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File Menu................................................... 420, 441
File Tab ....................................................... 420, 441
Files

Font.................................................................. 5
Managing.....................................................37
Managing Font and SuperDesigns.....69
Sample............................................................ 1
SuperDesign ................................................. 5

Files of Type........................................................ 170
Fill

Angle ...................................................33, 236
Areas................................................................ 6
Contour ........................................................81
Crosshatch...................................................81
Curved Crosshatch ................................ 271
Echo .....................................................81, 282
Flood........................................................... 381
MultiWave....................................................81
Multiwave ................................................. 276
Precise........................................................ 217
Prefer .......................................................... 121
QuickStitch™............................................ 209
QuiltStipple.................................................81
Radial.............................................................80
Satin Effect ........................................93, 369
Shape ............................................................80
Spiral..............................................................81

Fill + AutoHole
QuickStitch™............................................ 210

Fill + Border ...........................................................31
Fill and Satin Patterns ........................................93
Fill Area

Properties Dialog ......................................86
Traveling Stitches Around................... 238

Fill Area Fonts .......................................................32
Fill Areas .................................................................80
Fill Background to Hoop................................ 384
Fill Options

Contour ..................................................... 264
QuiltStipple.............................................. 261
Radial.......................................................... 255
Shape ......................................................... 250
Spiral........................................................... 257

Fill Pattern........................................................... 369
Fill Patterns

Sample Guide.......................................... 369
Fill Properties

Change ...................................................... 216
Density....................................................... 237
Options...................................................... 236
Pattern ....................................................... 234

Fill Stitches.......................................................... 152
FilmStrip .......................................... 154, 183, 436

Choose Object ........................................ 342
Click and Drag......................................... 338
Context Menu ......................................... 437
Items................................................. 154, 436
Move Up and Down.............................. 338
Options...................................................... 157
Select Object ........................................... 155

Filter
Color ........................................................... 402

Filters .................................................................... 408
Filters and Effects ............................................. 397
Finalize and Save New MiniPic .................... 383
Find

Designs.......................................................135
Outlines............................................109, 410
Thread.........................................................144

Finder and Expander .......................................109
Finish .......................................106, 115, 131, 132
First Visible Object ..................................156, 339
Fit Design to Hoop............................................113
Fit Motif To Line

Curved Crosshatch Fill ..........................273
MultiWave Fill.......................252, 277, 328
Tapered Motifs .........................................312

Fit To Hoop ..........................................................101
Fit To Rectangle .................................................100
Fleur de Lys

Feathers......................................................312
Flickr ..........106, 161, 164, 165, 166, 190, 196
Flip

Horizontal..................................................394
Vertical........................................................394

Flip Block
Horizontally ..............................................357
Vertically ....................................................357

Flip design for felting or reverse embroidery415
Flip Picture for Iron-On Tee Shirt Transfer 416
Flood Fill ...............................................................381
Foam

Puffy.............................................................145
Folder

Options.......................................................383
Font ...........................................................39, 46, 66

Category ....................................................364
Character Table.......................................... 43
Create New.................................................. 56
Creating and Editing................................ 37
Files ...................................................................5
Name...........................................................364
New...................................................................7
Reopen Partially Completed................. 10

Font Control Panel............................................445
Font File

Back Up......................................................... 11
Managing .................................................... 69

Font Properties .................................................... 51
Fonts

Baseline ........................................................ 15
Continuous ................................................. 16
Designing .................................................... 15
Fill Area......................................................... 32
Nearest Point.............................................. 15
Satin............................................................... 32

Foreground and Background Colors..........376
Swap............................................................377

Foreground or Background Color ...............378
Format

JPEG.............................................................109
Formats of Files.......................................................5
Forwards

Move..................................................156, 339
Freehand ..............................................................206

Create with........................................ 78, 316
Fill + Border................................................. 31
Select.................................................353, 386

FreeHand Area or Line.....................................216
Freehand Create ........................................ 78, 207
Freehand MultiWave Line ..............................220
Freehand Point
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Select................................................ 352, 386
Freehand Satin Area.............................. 292, 294
Fur

Feathered Satin....................................... 305

G
Gamma

Picture........................................................ 399
Gap ......................................................... 66, 71, 246

Minimum .................... 251, 273, 277, 327
Get Length.......................................................... 159
Getting Started ...................................................... 1
Global Properties ......................................95, 158
Glossary ..................................................................65
Glow in the Dark............................................... 163
Gradient

Multicolor ....................................... 240, 304
Gradient — Patterns 253 to 264 ................. 370
Gradient Density .......................... 237, 258, 303
Grayness

Color Effects............................................. 401
Grayscale ............................................................. 401
Green .................................................................... 204

Color Filter ................................................ 402
Grid.............................................................. 141, 415

Printing...................................................... 417
Snap to....................................................... 141

Grid and Snap......................................................... 4
Grid Snap................................................................23
Group.......................................................... 158, 356

Curved Crosshatch Fill.......................... 273
Grouping Selected Objects .......................... 355
Groups

Using .......................................................... 355
Guidelines.........................................................5, 24

H
Hand Stitch Effects........................................... 184
Handles are Blue............................................... 351
Hearts — Patterns 109 to 120...................... 370
Heavy Knit Fabric ..................91, 237, 257, 325
Height................................................................... 438
Height and Width..... 244, 245, 252, 278, 328

Curved Crosshatch Fill.......................... 274
Tapered Motifs ........................................ 312

Help
Font Page.................................................. 446

Help Tab............................................................... 435
Hide

File Extensions ........................................ 383
Hide Object Types............................................ 152
High Color (16-bit) ........................................... 375
Hiragana 1 Character Set..................................22
Hole

Delete......................................................... 348
QuickStitch™............................................ 211

Home Tab............................................................ 421
Hoop ..................................................................... 415

Change ...................................................... 113
Fit Design to............................................. 113
Fit To ........................................................... 101
Splitting..................................................... 176

Hoop Group ....................................................... 114
Hoop Size ............................................................ 114
Horizontal Flip ................................................... 394
Horizontal Offset .................................................47
Horizontally Flip Block.................................... 357

How To
Change Object Settings .......................337
Make a MiniPic.........................................383

HSL .........................................................................204
Hue.........................................................................402
Hue Saturation Luminance (HSL)

Color Model ....................................204, 379

I
Identifying Start and End Points.................... 44
Image Effects ......................................................397
Import ...................................................................286
Inches ....................................................................159
Include Secure Points ......................................318
Included in My Hoops .....................................114
Information

Color ............................................................415
Design...........................121, 124, 127, 163
Print .............................................................415
Technical ....................................................415

Insert......................................................................170
Character ...................................................364
Color Command............................158, 338
Commands................................................338
Embroideries ............................................362
ExpressDesign..........................................100
Point ............................................................345
Select Object ............................................335
Stop Command .............................158, 338

Insert Lettering ..................................................364
Insert or Paste Block.........................................351
Insert Picture ......................................................373
Insert Points on Straight Lines ....................... 52
Instagram.........................................106, 190, 196
Intensity

Color Filter .................................................402
Interior Details ...................................................111
Invert Selection..................................................389
Iron-On Tee Shirt Transfer ..............................416

J
Join Neatly...........................................................218
Joining Point..................................................15, 40
JPEG Format........................................................109

K
Kern....................................................252, 278, 328

Curved Crosshatch Fill ..........................274
Kerning ............................................................66, 71
Keys

Left and Right Arrow .............................342

L
Lace

Richelieu Bars ...........................................308
Tapered Motifs .........................................310

Lace — Patterns 253 to 264 ..........................370
Large Lettering .................................................... 30
Last

Angle Line .................................................344
Thread Color .............................................158
Visible Object .................................155, 341

Last Visible
Select...........................................................351

Layout Order...................................156, 339, 436
Left and Right Arrow Keys .............................342
Left Taper ...................................................326, 329
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Left-Click Draw.................................................. 376
Leisure 1 — Patterns 121 to 132................. 370
Length

Of Area....................................................... 159
Stitch .............................................................92

Letter A ..................................................................... 9
Letter B....................................................................35
Lettering

Insert .......................................................... 364
Life View .............................................................. 162
Ligature...................................................................66
Limit

Offset.......................................................... 247
Line........................................................................ 380

Fit Motif To.................. 252, 273, 277, 328
Properties ............................................ 54, 86

Linen ..........................................91, 237, 257, 325
Lines.........................................................................96

Black ........................................................... 119
Echo ............................................................ 282
Expand Pixel-Thin .................................. 119
Motif ..............................................................84
Reduce Thick ........................................... 119
Stitch Angle.................................... 342, 344
Straight or Curved ................................. 343

Load
Design........................................................ 132

Load a Picture
Paint Window ...................................98, 103
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